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About this information product

...............................................................................................................................................................................................................................................................

Purpose This chapter is a preface that provides an overview of this information
product.

The purpose of this Provisioning Guide is to provide an overview of
WaveStar Network Management System (NMS) Release 4.2, explain
its capabilities, and describe the planning activities that must be done
before a system can be installed.

Reason for reissue This Provisioning Guide, Issue 1, is a new document that supports
WaveStar NMS, Release 4.2.

Safety labels This information product does not use safety labels.

Intended audience This guide is written primarily for network planners, engineers, and
sales teams. It may be used by anyone desiring specific information
about the features, applications, and operations of WaveStar NMS.

How to use this
information product

This section provides information that will help users of this
information product.
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The following table describes the information in each chapter of this
document.

Section Title Description

Preface About this information
product

Describes this document’s
purpose and intended audience,
how to use the document, and
how to comment on it.

Chap-
ter 1

Chapter 1, “The
WaveStar NMS
Provisioning Process ”

Provides an overview of the
WaveStar NMS provisioning
process.

Chap-
ter 2

Chapter 2, “Network
Element Configuration
Tasks”

Describes tasks associated with
controlled and noncontrolled
network elements.

Chap-
ter 3

Chapter 3,
“Provisioning Tasks”

Describes tasks related to digital
link, connection, optical layer,
subnet, and preplan restoration
provisioning.

Chap-
ter 4

Chapter 4,
“Provisioning
Concepts”

Describes provisioning concepts
associated with network elements,
connections, optical layers,
subnets, and preplan restoration.

Chap-
ter 5

Chapter 5, “Digital
Transmission Rates”

Describes the SDH and PDH
hierarchies, the relationships
among digital links, circuits and
the digital transmission hierarchy
WaveStar NMS supports.

Chap-
ter 6

Chapter 6, “Network
Element Port
Addresses ”

Lists the port addresses
associated with WaveStar NMS
network elements.

Index Index
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Conventions used This document uses the following typographical conventions to
distinguish between computer input and output.

• When describing the WaveStar NMS software, fields in windows
and field entries are identified with this font.

• When describing the UNIX environment, text and numbers that
the user inputs to the computer are identified with boldface
type.

• In the UNIX environment, text and numbers that the computer
outputs to the user are identified with monospace type.

Related documentation This information product is part of a set of documents that supports
WaveStar NMS.

List of documents

The document set that supports WaveStar NMS includes:

1. WaveStar NMS Getting Started Guide, (365-309-241) - provides
information needed when you are learning how to use the
WaveStar NMS software. It describes how to start and stop
WaveStar NMS, how to use the software, and how to interpret
the graphical user interface.
This document includes tasks and conceptual information.

2. WaveStar NMS Applications and Planning Guide, (365-309-242)
- describes the WaveStar NMS features and applications, provides
a product description and the hardware platforms for the product,
and describes system planning and engineering, ordering, and
product support.
This document contains conceptual information only.

3. WaveStar NMS Administration Guide, (365-309-245) - instructs
users on how to administer WaveStar NMS and the network.
This document includes tasks and conceptual information.

4. WaveStar NMS Maintenance Guide, (365-309-244) - instructs
users on how to maintain WaveStar NMS and the network.
This document includes tasks and conceptual information.

5. WaveStar NMS Provisioning Guide, (365-309-243) - instructs
users how to use WaveStar NMS to provision and manage a
network.
This document includes tasks and conceptual information.

Provisioning Guide About this information product
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Online documentation

An online HTML version of this document set is provided with
WaveStar NMS.

Screen help

The WaveStar NMS software includes screen help for each window,
which describes the purpose of the window, each of the fields, and
each of the buttons.

How to comment Customer satisfaction is extremely important to Lucent Technologies.
All users are encouraged to provide feedback on the WaveStar NMS
information products.

A customer comment form appears immediately after the title page of
this document. Please fill out the form and submit is as instructed on
the form.

How to order To order WaveStar NMS information products, contact your Lucent
Technologies customer team representative or contact the Lucent
Technologies Customer Information Center (CIC):

From the United States, call 1-888-LUCENT8, prompt 1.

From Canada, call 1-317-322-6619.

From Europe, the Middle East, and Africa, call 1-317-322-6416.

From Asia, the Pacific Region, China, the Caribbean, and Latin
America, call 1-317-322-6411.

Provisioning Guide About this information product
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1 The WaveStar NMS Provisioning
Process

Overview
....................................................................................................................................................................................................................................

Purpose This chapter provides an overview of the WaveStar NMS provisioning
process.

Important note This document instructs users how to provision WaveStar NMS.

This document contains two types of chapters:

• Task chapters describe provisioning tasks (that is, step-by-step
instructions).

• Conceptual chapters contain detailed information related to the
tasks.

Task chapters are located in the front of the document; conceptual
chapters follow the task chapters.

Contents
What is provisioning? 1-2

Terminology overview 1-3

Provisioning process description 1-8
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What is provisioning?
....................................................................................................................................................................................................................................

Overview Provisioning, as it pertains to WaveStar NMS, is the process of
establishing a connection through a WaveStar NMS managed network
and setting appropriate transmission parameters for a digital link,
optical link, optical multiplex section, optical channel trails, and
SDH/PDH circuit/trails for a specified rate.

This overview assumes that all of the administrative procedures
needed to have the system fully operational have been completed.

Supported actions WaveStar NMS allows users to perform the following actions for
provisioning:

• Add: users can provision new digital links, circuit/trails and
optical layers from WaveStar NMS.

• Disconnect: users can delete existing digital links, circuit/trails
and optical layers from WaveStar NMS.

• Modify: users can modify an existing circuit/trail to create a new
route.

• Merge: users can merge two or more circuits/trails of the same or
equivalent rate to form one new circuit/trail. This activity from
WaveStar NMS will not create any implementation commands.

• Preplan: users can establish a preplan circuit/trail in WaveStar
NMS for use with a service circuit/trail to restore service in case
of a service circuit/trail failure.

The WaveStar NMS Provisioning Process
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Terminology overview
....................................................................................................................................................................................................................................

Overview This section provides an overview of the common terms and concepts
necessary to understand the WaveStar NMS provisioning process.

For a complete listing of WaveStar NMS-related terms, refer to the
glossary section of the WaveStar NMS 4.0 Administration Guide.

Aggregate An aggregate is a collection of one or more network elements and/or
aggregates. An aggregate is represented by a single icon on the
Network Map.

Area Networks managed by WaveStar NMS can be subdivided into smaller,
manageable networks called areas. An area is a collection of nodes
and/or aggregates, and their associated links. An area is represented by
a single icon on the Network Map. Subdividing a network into areas
reduces overcrowding on the display and improves system
performance because smaller amounts of information are exchanged
by the subsystems.

Areas can be defined for any purpose. Examples of potentially useful
areas are:

• A set of nodes/aggregates dedicated to a subscriber

• A set of nodes/aggregates, which are or are not connected

• A set of nodes/aggregates in a geographic location or building

Black box A black box is a network element, displayed on the Network Map,
that is not monitored or controlled by WaveStar NMS. An example of
a black box is a non-Lucent network element.

Channels When either a digital link or trail is channelized, it is subdivided into
channels. For time division multiplexing (TDM) equipment, channels
represent the time slots with which information is carried within a
digital link or in a server trail. Channels are created by WaveStar
NMS for use during circuit/trail provisioning. When creating channels
for digital links, depending on the network element capability,
alternate channels, to accommodate provisioning different rates of
circuits/trails, are created.

The WaveStar NMS Provisioning Process
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Circuits Circuits generally carry customer service. Typically, circuits are
plesiochronous digital hierarchy (PDH) and can ride on PDH channels
or be mapped to SDH trails. Circuits can ride on trails and digital
links.

Circuits ride on:

• Paths (for example, a CEPT-1 circuit riding on a VC-12 path)

• Digital links (a circuit can ride on a digital link directly if the
digital link is channelized to one channel, such as a CEPT-1
circuit riding on a CEPT-1 digital link).

PDH circuits can be provisioned over:

• PDH facilities (for example, a CEPT-1 circuit on a channel of a
CEPT- 4 facility)

• SDH paths (for example, a CEPT-1 circuit on a VC-12 path)

SDH circuits cannot be provisioned over a PDH facility.

The following figure shows an example of the relationship among
digital links, trails, and circuits.

Digital links Digital links are fiber or electrical connections between two points.
These transport facilities are assignable to high-order and low-order
circuits to carry customer services. Digital links can be of two types:
SDH digital links or PDH digital links.

Figure 1-1 Relationship between digital links, trails, and circuits
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SDH digital links connect two SDH network elements or an SDH
network element and a black box or equipment.

PDH digital links are asynchronous connections between two PDH
ports of the network elements assignable to the PDH circuits.

The following figure shows an example of the relationship among
digital links, trails, and circuits.

Equipment Equipment is a functional unit in a network that is not displayed on
the Network Map and which WaveStar NMS cannot monitor or
control. An example of equipment is customer premises equipment.
Black boxes and equipment are also known as noncontrolled network
elements.

Network A network carries a payload from one point to another. This payload
can consist of data, voice, video, or images. Digital links and trails
carry the circuits that carry the data.

Network element A network element is a functional unit in a customer’s network that
displays on the Network Map and is controlled by the user. Network
elements supply switching, transmission, or multiplexing functionality
in a network and are either controlled or noncontrolled.

Figure 1-2 Relationship between digital links, trails, and circuits
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PDH Plesiochronous Digital Hierarchy is a transmission hierarchy that
involves multiple digital synchronous circuits running at different
clock rates.

Preplan Restoration Preplan Restoration allows for a back-up facility to be predefined for
an existing in service facility. WaveStar NMS stores the preplan
circuit in a database and accesses it when a failure occurs so as to
restore the facility.

Rings Rings are formed when the digital links connect all participating
network elements to form a closed loop, and the network elements
have ring forming capabilities.

SDH Synchronous Digital Hierarchy is a transmission hierarchy designed
to transport multiple digital signals with different capacities.

Tandem connection A tandem connection is the sublayer between the multiplex section
layer and the path layer that allows users to monitor the quality of the
signal transport within its managed domain. A tandem connection also
provides users with information about the total quality of a signal
before the signal travels from the user’s managed network to a
network managed by a different user. Users can create tandem
connections on paths that do not terminate in its managed network but
traverse its network from other user managed networks.

Trails A trail is a logical connection between two adjacent, or nonadjacent
network element. It may traverse one or more channels and supports
add/drop capability along the path.

Trails simplify provisioning by allowing users to establish routes
through digital links and network elements so that circuits can be
assigned to the path. This capability allows users to assign a circuit to
a path at the path’s A and Z ends without spelling out a list of digital
links and cross-connections that make up the trail. Two or more trails
may be connected as part of a circuit.

Trails ride on one or more digital links and also contain their own
payload and overhead sections.

Terminology overview The WaveStar NMS Provisioning Process
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The following figure shows an example of the relationship between
digital links, trails, and circuits.

Figure 1-3 Relationship between digital links, trails and circuits
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Provisioning process description
....................................................................................................................................................................................................................................

Overview The following is an overview of the WaveStar NMS provisioning
process as it relates to the order in which actions should occur.

Recommended order The order in which provisioning tasks should occur is as follows:

1. Add a network element.

2. Create aggregates and subnets (if needed).

3. Create an optical layer.

4. Provision digital links between the network elements (create
subnets if needed).

5. Provision trails and circuits.

6. Create preplans, if needed.
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2 Network Element Configuration
Tasks

Overview
....................................................................................................................................................................................................................................

Purpose This chapter contains tasks used to create, modify, and delete
controlled and noncontrolled network elements.
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Section I: Controlled Network Elements

Overview
....................................................................................................................................................................................................................................

Purpose This section discusses the provisioning tasks associated with adding
and deleting controlled network elements.

Important Note that WaveStar SNMS-controlled network elements are not added
to WaveStar NMS; they are automatically discovered by WaveStar
NMS.

Contents
Add an ITM-SC-controlled network element 2-4

Add an ITM-XM controlled network element 2-6

Delete an ITM-SC, ITM-XM, or WaveStar
SNMS-controlled network element

2-8
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Add an ITM-SC-controlled network element
....................................................................................................................................................................................................................................

Purpose Use this procedure to add an ITM-SC controlled network element to
the Network Map. This procedure is not intended for WaveStar DACS
or DACS VI network elements.

Important! Note that WaveStar SNMS-controlled network elements
are not added to WaveStar NMS; they are automatically discovered by
WaveStar NMS.

Before you begin Before you add a network element, consider the following items:

• The number of allowable network elements on a Network Map
varies with the WaveStar NMS configuration. When the limit is
reached, an error message will appear to inform the user the
network element could not be added because it exceeded the
number allowed.

• When a network element is first added to WaveStar NMS, its
corresponding icon is always displayed as green, regardless of
whether equipment or environment alarms exist. Therefore, you
should perform a manual database synchronization in order to
display the network element’s true state.

• Users must use the correct network element identification number
format. The identification number consists of up to 20
alphanumeric characters, including the /, - and _ characters. No
leading delimiters are allowed. The system does not, however,
support the following characters: space ( ), quote (″), percent
(%), star (*), dot (.), backslash (\), and pipe (|). Currently, only
upper case alphabetical characters are supported.

• Not all controlled network elements (e.g., ADM 16/1, TM1,
AM1, AM1Plus) can implement a one-way cross-connection.

Task Perform the following task to add an ITM-SC controlled network
element to the Network Map.
............................................................................................................................................................

1 From the Network Map, select Configuration > Network Element >
Add > (Select an NE Type from the list except for WaveStar DACS
or DACS VI).
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Result:

The NE window appears.

............................................................................................................................................................

2 In the EMS ID field, select an EMS ID from the list.

............................................................................................................................................................

3 Click OK.

Result:

The Connection dialog box appears. If the connection occurs,
the Create MIB Image from NE window appears.

............................................................................................................................................................

4 Specify the Network Element Name, NSAP Format, Area ID
(optional), Network Element SID, and Connection Type.

............................................................................................................................................................

5 Click Apply.

Result:

The network element appears on the Network Map and a
success message appears within the window’s Message panel.

Section I: Controlled Network Elements
Add an ITM-SC-controlled network element
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Add an ITM-XM controlled network element
....................................................................................................................................................................................................................................

Purpose Use this procedure to add an ITM-XM controlled network element to
the Network Map. This procedure applies to both WaveStar DACS
and DACS VI.

Before you begin Before you add an ITM-XM controlled network element, refer to the
items listed in the preceding task Add an ITM-SC controlled network
element.

Task Complete the following task to add an ITM-XM controlled
network element.
............................................................................................................................................................

1 On the Network Map, select Configuration > Network Element >
Add > (select either WaveStar DACS or DACSVI).

Result:

The Frame/Controller Profile form is displayed. The Main tab is
highlighted, and the Model field contains the selected network
element.

............................................................................................................................................................

2 In the NE ID field, enter the network element identification.

............................................................................................................................................................

3 (Optional) In the Acronym field, enter the acronym.

............................................................................................................................................................

4 Click the Parameters tab.

............................................................................................................................................................

5 In the User ID field, enter the user ID.

............................................................................................................................................................

6 In the Password field, enter the password.

............................................................................................................................................................

7 In the TCP/IP Address1 field, enter the TCP/IP address. In the case
of DACS VI, the NTN 1 and NTN 2 (Network Telephone Numbers)
have to be populated.

Section I: Controlled Network Elements Network Element Configuration Tasks
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............................................................................................................................................................

8 Click OK.

Result:

You are returned to the Frame/Controller Profile form.

............................................................................................................................................................

9 Click OK.

Result:

The system adds a WaveStar DACS (or DACS VI) network
element.

Section I: Controlled Network Elements
Add an ITM-XM controlled network
element
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Delete an ITM-SC, ITM-XM, or WaveStar SNMS-controlled
network element
....................................................................................................................................................................................................................................

Purpose Use this procedure to delete an ITM-SC, ITM-XM or WaveStar
SNMS-controlled network element from the Network Map.

Important! A network element may only be deleted if it is not
assigned with any digital link or circuit/trail (pending or in-effect). If
you delete a network element linked to another network element, the
network element is put in a “pending delete” state and not deleted
from the system database or Network Map.

Before you begin Before you delete a controlled network element, consider the
following items:

• A network element should only be deleted if there are no
in-effect or pending circuits connected to it. If there are
links/paths/circuits associated with the network element, the
corresponding network element will not be deleted (but will turn
gray). Note that users cannot back out of the pending delete state.
However, a database synchronization with the EMS can bring the
network element back to a normal state so long as the EMS still
reports that network element is still managed by it.

• No commands, such as delete cross-connect or port
reprovisioning, will be sent to a network element once it is in a
pending delete state.

In the case of an inadvertent deletion

If a network element is inadvertently deleted, perform a database
synchronization with the corresponding network element to recover it
to its original state.

If a network element is completely deleted, a database synchronization
cannot be performed on the network element. To recover the network
element in this case, perform a network element database
synchronization on the corresponding controller (EMS).

Task Complete the following task to delete a controlled network
element. Note that this procedure only deletes the network
element from the WaveStar NMS database; it leaves any
cross-connect information on the network element. If the database
has cross-connect information this procedure will fail. If you

Section I: Controlled Network Elements Network Element Configuration Tasks
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want the cross-connect information to remain in the EMS or
network element database, you will need to disconnect the
cross-connect through a virtual disconnect in WaveStar NMS.
............................................................................................................................................................

1 On the Network Map, right-click the network element to be deleted.

Result:

The Node menu is displayed.

............................................................................................................................................................

2 Select Node Operation > Delete Node.

Result:

A confirmation dialog box is displayed.

............................................................................................................................................................

3 Click Yes.

Result:

The network element is deleted or put in a “pending delete”
state.

Section I: Controlled Network Elements
Delete an ITM-SC, ITM-XM, or WaveStar
SNMS-controlled network element
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Section II: Noncontrolled Network Elements

Overview
....................................................................................................................................................................................................................................

Purpose This section presents provisioning tasks for adding, modifying and
deleting noncontrolled network elements, such as black boxes and
equipment.

Contents
Add a black box 2-11

Modify a black box 2-12

Display black box list 2-14

Search for a specific black box 2-15

Delete a black box 2-16

Add equipment 2-17

Modify equipment 2-18

Display equipment list 2-19

Delete equipment 2-20

Display ODO List 2-21

Network Element Configuration Tasks

....................................................................................................................................................................................................................................

2 - 1 0 Lucent Technologies 365-309-243
Issue 1, July 2001

2-21

2-20

2-19

2-18

2-17

2-16

2-15

2-14

2-12

2-11



Add a black box
....................................................................................................................................................................................................................................

Purpose Use this procedure to add a black box to the Network Map.

Task Complete the following task to add a black box to the Network
Map.
............................................................................................................................................................

1 From the Network Map, select Configuration > Black Box > Add.

Result:

The Add Black Box form appears.

............................................................................................................................................................

2 In the BBOX field, enter a name for the black box. This name will
appear on the Network Map.

............................................................................................................................................................

3 In the Acronym field, specify an acronym.

............................................................................................................................................................

4 (Optional) In the Customer Information field, enter any relevant
information about the black box you wish other users to view.

............................................................................................................................................................

5 Click OK.

Result:

A confirmation window appears and informs you of either the
success or failure of the operation.

............................................................................................................................................................

6 Click OK.

Result:

The black box is added to the Network Map.

Section II: Noncontrolled Network Elements Network Element Configuration Tasks
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Modify a black box
....................................................................................................................................................................................................................................

Purpose Use this procedure to modify a preexisting black box.

Task Perform the following steps to modify a preexisting black box.
This task assumes that you have already located a black box that
you wish to modify. To locate black boxes, refer to the Display
Black Box List task.
............................................................................................................................................................

1 From the Network Map, right-click on a black box and select Service
Domain > Display/Modify Ports.

Result:

The Service Domain Query Form is displayed.

............................................................................................................................................................

2 From the Ports tab, press Node.

Result:

A query form appears.

............................................................................................................................................................

3 From this form, specify a new node.

............................................................................................................................................................

4 Press OK.

Result:

The form disappears, and the Node field alters to reflect the
choice.

............................................................................................................................................................

5 Select Rate to specify a new rate for the black box.

............................................................................................................................................................

6 If applicable, specify a new Service Domain.

............................................................................................................................................................

7 Press OK.

Result:

A form appears.

Section II: Noncontrolled Network Elements Network Element Configuration Tasks
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............................................................................................................................................................

8 Using the arrow icons, specify a member port from the Non-Member
ports list.

............................................................................................................................................................

9 Press OK.

Result:

A window appears to confirm the modification.

Section II: Noncontrolled Network Elements
Modify a black box
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Display black box list
....................................................................................................................................................................................................................................

Purpose Use this procedure to view all currently existing black boxes known
to WaveStar NMS.

Task Perform the following steps to display a complete listing of all
existing black boxes.
............................................................................................................................................................

1 From the Network Map, select Configuration > Black Box > Display
List.

Result:

The Black Box Display List Query window appears.

............................................................................................................................................................

2 Enter * within the Black Box ID field.

............................................................................................................................................................

3 Press OK.

Result:

All the currently existing black boxes appear within the Black
Box Display List window.

Section II: Noncontrolled Network Elements Network Element Configuration Tasks
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Search for a specific black box
....................................................................................................................................................................................................................................

Purpose Use this procedure to search for a specific black box.

Task Perform the following steps to search for a specific black box.
............................................................................................................................................................

1 From the Network Map, select Configuration > Black Box > Display
List.

Result:

The Black Box Display List Query window appears.

............................................................................................................................................................

2 Enter the black box name within the Black Box ID field.

............................................................................................................................................................

3 Press OK.

Result:

If you entered a valid name, the specified black box will appear
within the Black Box Display List window.

Section II: Noncontrolled Network Elements Network Element Configuration Tasks
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Delete a black box
....................................................................................................................................................................................................................................

Purpose Use the following procedure to delete a black box from the Network
Map.

Before you begin Before you delete a black box from the Network Map, consider the
following items:

• Similar to deleting a network element, users must delete any
digital links or circuits/trails associated with the black box prior
to deleting it.

Task Perform the following procedure to delete a black box from the
Network Map.
............................................................................................................................................................

1 From the Network Map, right-click on the black box you wish to
delete.

Result:

The Node menu appears.

............................................................................................................................................................

2 From the menu, select Node Operation > Delete Node.

Result:

A confirmation window appears asking you to confirm the
deletion.

............................................................................................................................................................

3 Select Yes.

Result:

A confirmation window appears and informs you of either the
success or failure of the operation.

............................................................................................................................................................

4 Press OK.

Result:

The black box is deleted from the Network Map.

Section II: Noncontrolled Network Elements Network Element Configuration Tasks
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Add equipment
....................................................................................................................................................................................................................................

Purpose Use this procedure to add equipment to the Network Map.

Task Complete the following task to add equipment to the Network
Map.
............................................................................................................................................................

1 From the Network Map, select Configuration > Equipment > Add.

Result:

The Add equipment form is displayed. The Model field displays
EQPT.

............................................................................................................................................................

2 In the Equipment ID field, enter the network element identification.

............................................................................................................................................................

3 In the Acronym field, enter the acronym.

............................................................................................................................................................

4 In the Customer Information field, enter any information you wish
other users to view.

............................................................................................................................................................

5 Click OK.

Result:

A window informs you of the success or failure of the operation,
and the newly added equipment can be viewed on the
Equipment Display List.

Section II: Noncontrolled Network Elements Network Element Configuration Tasks
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Modify equipment
....................................................................................................................................................................................................................................

Purpose Use this procedure to modify existing equipment.

Task Perform the following steps to modify existing equipment.
............................................................................................................................................................

1 From the Network Map, select Configuration > Equipment >
Display List.

Result:

The Equipment Display List Query Box appears.

............................................................................................................................................................

2 In the Equipment ID field, enter an equipment ID (or enter * to list
all equipment).

............................................................................................................................................................

3 Press OK.

Result:

The Equipment Display List window appears.

............................................................................................................................................................

4 From the list, select the equipment you wish to modify.

Result:

The equipment becomes highlighted, and the Actions menu
item becomes enabled.

............................................................................................................................................................

5 Select Actions > NE Port Assignments.

Result:

The NE Port Assignments Query Box form appears.

............................................................................................................................................................

6 From this form, make your modifications and then press Apply.

Result:

The equipment is modified.

Section II: Noncontrolled Network Elements Network Element Configuration Tasks
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Display equipment list
....................................................................................................................................................................................................................................

Purpose Use this task to display a listing of existing equipment.

Task Perform the following steps to display a listing of existing
equipment.
............................................................................................................................................................

1 From the Network Map, select Configuration > Equipment >
Display List.

Result:

The Equipment Display List Query Box form displays.

............................................................................................................................................................

2 In the Equipment ID field, enter the ID of the equipment you wish to
display (or enter * to list all existing equipment).

............................................................................................................................................................

3 Click OK.

Result:

The Equipment Display List appears and displays all the
equipment in the network with the specified ID.
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Delete equipment
....................................................................................................................................................................................................................................

Purpose Use this procedure to delete equipment from the Network Map.

Task Complete the following task to delete equipment from the
Network Map.
............................................................................................................................................................

1 Displays the equipment list (see last task).

............................................................................................................................................................

2 Select an entry.

............................................................................................................................................................

3 Select Actions > Delete Node.

Result:

The equipment is deleted from the Network Map.
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Display ODO List
....................................................................................................................................................................................................................................

Purpose The following procedure allows users to display the out-of-domain
objects (ODOs) existing for WaveStar NMS and WaveStar TMS.

Task Perform the following steps to display a list of ODOs.
............................................................................................................................................................

1 From the Network Map, select Configuration > ODO Display List.

Result:

The ODO Display List Query Box form appears.

............................................................................................................................................................

2 Enter * within the ODO ID field to get a complete listing of all ODOs.
To locate a specific object, enter its name within this field.

............................................................................................................................................................

3 Press OK.

Result:

The specified ODOs appear within the ODO Display List form.

Section II: Noncontrolled Network Elements Network Element Configuration Tasks
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3 Provisioning Tasks

Overview
....................................................................................................................................................................................................................................

Purpose This chapter presents provisioning tasks usable with WaveStar NMS.

Contents
Section I: Digital Links 3-4

Add a digital link between two controlled network
elements

3-6

Add a digital link between a controlled network
element and a noncontrolled network element

3-9

Provision a 1+1 MSP digital link 3-12

Provision a 1x1 MSP digital link 3-15

Display protection group names associated with
digital links

3-19

Add a regenerator to a digital link 3-20

Delete a regenerator from a digital link 3-22

Modify a digital link 3-24

Disconnect a digital link 3-25

Section II: Connections 3-27

Add a circuit between two controlled network
elements

3-29
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Add a circuit between two noncontrolled network
elements

3-32

Add a circuit between a controlled network element
and a noncontrolled network element

3-35

Provision an AU3-AU4 trail using the WaveStar
BandWidth Manager’s adaptation feature

3-38

Display circuit list 3-42
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3-58
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Add an optical amplifier to an optical multiplex
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3-66

Delete an optical amplifier from an optical
multiplex section

3-68
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Section I: Digital Links

Overview
....................................................................................................................................................................................................................................

Purpose Digital Links are transport facilities that are assignable to high order
and low order digital links to carry customer services. In WaveStar
NMS, digital links are always modelled as bi-directional links that
carry two way traffic. Digital Links are of two types - SDH/SONET
and PDH.

SDH digital links are synonymous with multiplexer sections, in SDH
standard terminology, that connect two SDH network elements or
black boxes/equipment. In WaveStar NMS, the regenerator sections
within the multiplexer section layer are not explicitly provisioned;
however the WaveStar NMS will be able to add regenerators to the
digital links and monitor alarms at regenerator sections. The similar
rules/applications using SONET terminology/NEs applied to SONET
digital links.

PDH digital links are physical links that connect two PDH ports of
SDH network elements or black boxes/equipment. Except for LAN8
(a.k.a.TransLAN) (SDH), VACTDL (a.k.a. TransLAN+) (SDH) and
GigaLanDL (SDH/SONET), all digital links are channelized in
WaveStar NMS in order to be able to be assigned to carry SDH trails
or PDH circuits. The digital links can be unprotected or protected.
When protected by another link, it is called Multiplex Section
Protection (MSP). The MSP protection can be of two types - 1+1 or
1x1. When MSP is 1+1, the protection link is totally dedicated to the
working (service) link and cannot carry preemptible extra traffic.
When MSP is 1x1, the protection link serves as a protection to the
working (service) link but can be configured to carry extra traffic that
is preemptible when the traffic in the working link gets switched.

This section discusses provisioning tasks associated with digital links.

Contents
Add a digital link between two controlled network
elements

3-6

Add a digital link between a controlled network
element and a noncontrolled network element

3-9
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Provision a 1+1 MSP digital link 3-12

Provision a 1x1 MSP digital link 3-15

Display protection group names associated with
digital links

3-19

Add a regenerator to a digital link 3-20

Delete a regenerator from a digital link 3-22

Modify a digital link 3-24

Disconnect a digital link 3-25
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Add a digital link between two controlled network elements
....................................................................................................................................................................................................................................

Purpose Use this procedure to add a digital link between two controlled
(ITM-SC or ITM-XM) network elements.

Task Complete the following task to add a digital link between two
controlled network elements on the Network Map. This task
assumes that two controlled network elements are already
provisioned.
............................................................................................................................................................

1 From the Network Map, select two controlled (either ITM-SC or
ITM-XM) network elements.

Result:

The selected network elements are highlighted.

............................................................................................................................................................

2 Right click on one network element.

Result:

The Node menu appears.

............................................................................................................................................................

3 Select Session > Start Database Synchronization.

Result:

A window appears.

............................................................................................................................................................

4 Under Type, select Port.

............................................................................................................................................................

5 Press Apply.

Result:

The network element’s ports are synchronized.

............................................................................................................................................................

6 Repeat Steps 2 through 5 to synchronize the ports of the second
network element.
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............................................................................................................................................................

7 Synchronize the cross-connects of both network elements by
performing Steps 2 through 5 (except select Cross-connect for the
Type).

Result:

The cross-connects associated with both network elements are
synchronized.

............................................................................................................................................................

8 On the Network Map, select Configuration > Digital Link > Add >
(Select a digital link type from the list).

Result:

The Network Map becomes the Provisioning Profile form.

............................................................................................................................................................

9 Under the Essentials tab, enter a circuit ID.

............................................................................................................................................................

10 Press the A port button.

Result:

A window appears.

............................................................................................................................................................

11 Select a port and press OK.

Result:

The selected port appears within the Essentials tab as the A
port.

............................................................................................................................................................

12 Repeat steps 10 and 11 to add the Z port (of course, exchange any
instances of A port with Z port).

Result:

The selected port appears within the Essentials tab as the Z port.

............................................................................................................................................................

13 Verify that Auto is checked for Path Selection.

............................................................................................................................................................

14 Under the Parameters tab, verify that Order Action is set to Add.
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............................................................................................................................................................

15 Press OK.

Result:

The graphical layout form appears.

............................................................................................................................................................

16 Press OK.

Result:

A confirmation window appears.

............................................................................................................................................................

17 Confirm all confirmation windows that appear.

............................................................................................................................................................

18 From the Network Map, select File > Query Again.

Result:

The new digital link, linking the specified network elements,
appears on the Network Map.
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Add a digital link between a controlled network element and a
noncontrolled network element
....................................................................................................................................................................................................................................

Purpose Use this procedure to add a digital link between a controlled network
element and a noncontrolled network element.

Task Complete the following task to add a digital link between a
controlled network element and a noncontrolled network element.
............................................................................................................................................................

1 From the Network Map, select a controlled network element (either
ITM-SC or ITM-XM) and a noncontrolled network element (such a
black box or equipment).

Result:

The selected network elements are highlighted.

............................................................................................................................................................

2 Right click on one network element.

Result:

The Node menu appears.

............................................................................................................................................................

3 Select Session > Start Database Synchronization.

Result:

A window appears.

............................................................................................................................................................

4 Under Type, select Port.

............................................................................................................................................................

5 Press Apply.

Result:

The network element’s ports are synchronized.

............................................................................................................................................................

6 Repeat Steps 2 through 5 to synchronize the ports of the second
network element.
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............................................................................................................................................................

7 Synchronize the cross-connects of both network elements by
performing Steps 2 through 5 (except select Cross-connect for the
Type).

Result:

The cross-connects associated with both network elements are
synchronized.

............................................................................................................................................................

8 On the Network Map, select Configuration > Digital Link > Add >
(Select a digital link type from the list).

Result:

The Network Map becomes the Provisioning Profile form.

............................................................................................................................................................

9 Under the Essentials tab, enter a circuit ID.

............................................................................................................................................................

10 Press the A port button.

Result:

A window appears.

............................................................................................................................................................

11 Select a port and press OK.

Result:

The selected port appears within the Essentials tab as the A
port.

............................................................................................................................................................

12 Repeat steps 10 and 11 to add the Z port (of course, exchange any
instances of A port with Z port).

Result:

The selected port appears within the Essentials tab as the Z port.

............................................................................................................................................................

13 Verify that Auto is checked for Path Selection.

............................................................................................................................................................

14 Under the Parameters tab, verify that Order Action is set to Add.
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............................................................................................................................................................

15 Press OK.

Result:

The graphical layout form appears.

............................................................................................................................................................

16 Press OK.

Result:

A confirmation window appears.

............................................................................................................................................................

17 Confirm all confirmation windows that appear.

............................................................................................................................................................

18 From the Network Map, select File > Query Again.

Result:

The new digital link, linking the specified network elements,
appears on the Network Map.
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Provision a 1+1 MSP digital link
....................................................................................................................................................................................................................................

Purpose Use this task to provision a 1+1 multiplex section protected (MSP)
digital link.

Task Complete the following procedure to provision a 1+1 MSP digital
link.
............................................................................................................................................................

1 From the Network Map, select two network elements that allow for
1+1 protection.

Result:

The selected network elements are highlighted.

............................................................................................................................................................

2 Right click on one network element.

Result:

The Node menu appears.

............................................................................................................................................................

3 Select Session > Start Database Synchronization.

Result:

A window appears.

............................................................................................................................................................

4 Under Type, select Port.

............................................................................................................................................................

5 Press Apply.

Result:

The network element’s ports are synchronized.

............................................................................................................................................................

6 Repeat Steps 2 through 5 to synchronize the ports of the second
network element.

............................................................................................................................................................

7 Synchronize the cross-connects of both network elements by
performing Steps 2 through 5 (except select Cross-connect for the
Type).
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Result:

The cross-connects associated with both network elements are
synchronized.

............................................................................................................................................................

8 On the Network Map, select Configuration > Digital Link > Add >
(Select a digital link type from the list).

Result:

The Network Map becomes the Provisioning Profile form.

............................................................................................................................................................

9 Under the Essentials tab, enter a circuit ID.

............................................................................................................................................................

10 Press the A port button.

Result:

A window appears.

............................................................................................................................................................

11 Select a port and press OK.

Result:

The selected port appears within the Essentials tab as the A
port.

............................................................................................................................................................

12 Repeat steps 10 and 11 to add the Z port (of course, exchange any
instances of A port with Z port).

Result:

The selected port appears within the Essentials tab as the Z port.

............................................................................................................................................................

13 Verify that Auto is checked for Path Selection.

............................................................................................................................................................

14 In the MSP Protected? field, select 1+1. Note: this field will only
allow a selection if the network elements specified earlier in this
procedure allow for 1+1 protection.

............................................................................................................................................................

15 Under the Parameters tab, verify that Order Action is set to Add.
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............................................................................................................................................................

16 Press OK.

Result:

The graphical layout form appears.

............................................................................................................................................................

17 Press OK.

Result:

A confirmation window appears.

............................................................................................................................................................

18 Confirm all confirmation windows that appear.

............................................................................................................................................................

19 From the Network Map, select File > Query Again.

Result:

The new 1+1 digital link, linking the specified network
elements, appears on the Network Map.
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Provision a 1x1 MSP digital link
....................................................................................................................................................................................................................................

Purpose Use this task to provision a 1x1 MSP digital link.

1x1 MSP occurs when a single protection link protects a single
service digital link. With a 1x1 MSP digital link, the protection link
can carry extra traffic that will be preempted whenever the MSP
switching takes place. As a result, both the service and protection
links of a 1x1 MSP have separate digital link identifications.

Before you begin Before you provision a 1x1 MSP-protected digital link, consider the
following items:

• 1x1 MSP provides a dedicated protection to a digital link that
remains idle until it is needed. When not used to carry traffic
from the working digital link, the line can carry extra,
unprotected traffic which can be pre-empted if a switching fault
occurs in the working digital link.

• 1x1 MSP is primarily used as a span protection in a 4-fiber
MS-SPRING. Users must first create a protection digital link
before any service digital links are created and associated to it.

• The only allowed value for the MSP Switch Type is BI
(bidirectional switching). All other values are disabled.

• Each of the two digital links (service and protection) for a 1x1
MSP must be created or deleted with two separate provisioning
orders having separate implementations.

• Prior to provisioning, the system will validate that both the
service and protection links terminate on the same network
element at their A and Z ends. The system will also check the
uniqueness of the MS Protection Group Name.

• Separate channel termination and assignment records for the
service and protection digital links are created when each service
and protection link are provisioned. This allows you or the
system to provision unprotected pre-emptable extra traffic on the
protection digital link.

• You cannot rearrange a 1x1 MSP-protected digital link. You can
only delete and add a new digital link with a new layout.

• A protection link cannot be associated to more than one service
link.
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• You may specify a switching operation to preempt extra traffic
carried on a protection link. Note, however, that WaveStar NMS
does not determine if a protection link is carrying extra traffic.
Thus, users must manually check for extra traffic.

• Separate channel termination and assignment records for service
and protection digital links will be created when each service and
protection link are provisioned. This allows the system or user to
provision unprotected preemptible extra traffic on the protection
digital link.

Task Perform the following procedure to provision a 1x1
MSP-protected digital link.
............................................................................................................................................................

1 From the Network Map, select two network elements that allow for
1x1 protection (WaveStar bandwidth manager or black boxes) .

Result:

The selected network elements are highlighted.

............................................................................................................................................................

2 Right click on one network element.

Result:

The Node menu appears.

............................................................................................................................................................

3 Select Session > Start Database Synchronization.

Result:

A window appears.

............................................................................................................................................................

4 Under Type, select Port.

............................................................................................................................................................

5 Press Apply.

Result:

The network element’s ports are synchronized.

............................................................................................................................................................

6 Repeat Steps 2 through 5 to synchronize the ports of the second
network element.
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............................................................................................................................................................

7 Synchronize the cross-connects of both network elements by
performing Steps 2 through 5 (except select Cross-connect for the
Type).

Result:

The cross-connects associated with both network elements are
synchronized.

............................................................................................................................................................

8 On the Network Map, select Configuration > Digital Link > Add >
(Select a digital link type from the list).

Result:

The Network Map becomes the Provisioning Profile form.

............................................................................................................................................................

9 Under the Essentials tab, enter a circuit ID.

............................................................................................................................................................

10 Press the A port button.

Result:

A window appears.

............................................................................................................................................................

11 Select a port and press OK.

Result:

The selected port appears within the Essentials tab as the A
port.

............................................................................................................................................................

12 Repeat steps 10 and 11 to add the Z port (of course, exchange any
instances of A port with Z port).

Result:

The selected port appears within the Essentials tab as the Z port.

............................................................................................................................................................

13 Verify that Auto is checked for Path Selection.
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............................................................................................................................................................

14 In the MSP Protected? field, select 1x1. Note: this field will only
allow a selection if the network elements specified earlier in this
procedure allow for 1x1 protection.

............................................................................................................................................................

15 For Role, choose a value depending on what the link type should be.
There are two choices — Service and Protection. Note: a protection
link should always be created before any service links.

Result:

MS Protection Group Name field gets enabled.

............................................................................................................................................................

16 Enter a name for the MS protection group. Note: for a service link,
the MS protection group name must already exist with the
provisioning of the protection link.

............................................................................................................................................................

17 Under the Parameters tab, verify that Order Action is set to Add.

............................................................................................................................................................

18 Press OK.

Result:

The graphical layout form appears.

............................................................................................................................................................

19 Press OK.

Result:

A confirmation window appears.

............................................................................................................................................................

20 Confirm all confirmation windows that appear.

............................................................................................................................................................

21 From the Network Map, select File > Query Again.

Result:

The new 1x1 digital link, linking the specified network
elements, appears on the Network Map.
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Display protection group names associated with digital links
....................................................................................................................................................................................................................................

Purpose Use this task to display a list of protection group names associated
with MSP digital links.

In addition to the procedure described below, MSP group names are
also displayed in the Graphical Layout, Modify Parameters, and Order
Parameters forms. This procedure allows you to view a complete
listing of protection group names.

Task Use this task to display a list of protection group names
associated MSP digital links.
............................................................................................................................................................

1 From the Network Map, select Configuration > Connection >
Display > MS Protection Group Names.

Result:

The Protection Group Names list is displayed.
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Add a regenerator to a digital link
....................................................................................................................................................................................................................................

Purpose Use this task to add a regenerator to a digital link.

Task Complete the following task to add a regenerator to a digital link.
............................................................................................................................................................

1 From the Network Map, select a digital link.

............................................................................................................................................................

2 Right click on the digital link.

Result:

The Node menu appears.

............................................................................................................................................................

3 Select Circuit/Trail List.

Result:

The Circuit/Trail List form appears.

............................................................................................................................................................

4 Select the CKT/Trail ID corresponding to the digital link you wish to
add the regenerator to.

Result:

The selection becomes highlighted, and the Actions menu item
becomes enabled.

............................................................................................................................................................

5 Select Actions > Graphical Layout.

Result:

The Graphical Layout form appears.

............................................................................................................................................................

6 Select Actions > Modify > Regenerators/Optical Amplifiers.

Result:

The Regenerator Selection form appears.

............................................................................................................................................................

7 Select a regenerator from the Non-Members sub-window.
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Result:

The Add and Remove buttons become enabled.

............................................................................................................................................................

8 Press Add.

Result:

The regenerator is moved to the Service window.

............................................................................................................................................................

9 Specify the regenerator’s left/right ports and the service protection.

............................................................................................................................................................

10 Press OK.

Result:

A confirmation window appears.

............................................................................................................................................................

11 Press OK.

............................................................................................................................................................

12 From the Network Map, select File > Query Again.

Result:

A regenerator is added to the digital link.
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Delete a regenerator from a digital link
....................................................................................................................................................................................................................................

Purpose Use this task to delete a regenerator from a digital link.

Task Perform the following steps to delete a regenerator from a digital
link.
............................................................................................................................................................

1 From the Network Map, select a digital link.

............................................................................................................................................................

2 Right click on the digital link.

Result:

The Node menu appears.

............................................................................................................................................................

3 Select Circuit/Trail List.

Result:

The Circuit/Trail List form appears.

............................................................................................................................................................

4 Select the CKT/Trail ID corresponding to the digital link you wish to
add the regenerator to.

Result:

The selection becomes highlighted, and the Actions menu item
becomes enabled.

............................................................................................................................................................

5 Select Actions > Graphical Layout.

Result:

The Graphical Layout form appears.

............................................................................................................................................................

6 Select Actions > Modify > Regenerators/Optical Amplifiers.

Result:

The Regenerator Selection form appears.

............................................................................................................................................................

7 Select a regenerator from the Service window.
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Result:

The Add and Remove buttons become enabled.

............................................................................................................................................................

8 Press Remove.

Result:

The regenerator is moved to the Non-Members window.

............................................................................................................................................................

9 Press OK.

Result:

A confirmation window appears.

............................................................................................................................................................

10 Press OK.

............................................................................................................................................................

11 From the Network Map, select File > Query Again.

Result:

The regenerator is deleted from the digital link.
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Modify a digital link
....................................................................................................................................................................................................................................

Purpose Use this procedure to modify the features of an existing digital link.

Task Perform the following procedure to modify the features of an
existing digital link.
............................................................................................................................................................

1 From the Network Map, select a digital link by clicking on it.

............................................................................................................................................................

2 Right-click on the digital link.

Result:

A menu appears.

............................................................................................................................................................

3 Select Service Domain > Display/Modify Trails/Channels.

Result:

The Service Domain Query form appears.

............................................................................................................................................................

4 Use the Trails tab to modify the digital link’s trail information; use
the Channels tab to modify the digital link’s channel information.

............................................................................................................................................................

5 After making your modifications, click OK.

Result:

The Service Domain Display/Modify Channels form appears.

............................................................................................................................................................

6 Specify member channels using the arrow icons. The arrow icons
become enabled once you select a trail from the list.

............................................................................................................................................................

7 After making modifications, click Apply.

Result:

The modifications made to the digital link go into effect.
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Disconnect a digital link
....................................................................................................................................................................................................................................

Purpose Use this procedure to disconnect a digital link. The below listed
caveats apply to this procedure depending upon the type of digital link
you wish to disconnect.

Before you begin Before disconnecting a digital link, note the following:

• Users are not required to stop already running performance
monitoring data collection prior to disconnecting the digital link.

• Deletion of a digital link is permitted only if there are no
in-effect and/or pending circuits or paths riding on it.

• Any circuits or lower-order paths riding on a higher order path,
must be disconnected before there is any attempt at disconnecting
a digital link.

• Any preplan paths riding on a soon to be disconnected circuit
must be disassociated from the service path they are protecting
before there is any attempt to disconnect them.

• When deleting 1x1 digital links, the working service link must be
deleted before the protection link.

Task Complete the following task to disconnect a digital link from a
facility or circuit. Be sure to read the Before You Begin
information for important considerations to make before
attempting to disconnect a digital link.
............................................................................................................................................................

1 From the Network Map, select a digital link.

............................................................................................................................................................

2 From the Network Map, select Configuration > Digital Link >
Disconnect.

Result:

The Ckt/Trail Query Box is displayed.

............................................................................................................................................................

3 In the Order Number field, enter the order number of the digital link
to be disconnected.

............................................................................................................................................................

4 Click OK.
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Result:

A confirmation window appears.

............................................................................................................................................................

5 Click Yes.

Result:

An action window appears.

............................................................................................................................................................

6 Click OK.

Result:

The system disconnects the digital link if all validations are
successful.

............................................................................................................................................................

7 From the Network Map, select File > Query Again.

Result:

The digital link, linking the specified network elements,
disappears from the Network Map.
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Section II: Connections

Overview
....................................................................................................................................................................................................................................

Purpose A circuit/trail is a concatenation of link connections and sub-network
connections (cross-connects in WaveStar NMS terminology) to
provide an end-to-end service to a customer. A circuit/trail is
identified by a rate at which the service is provided. The “rate” of a
circuit/trail is defined by the ITU and ETSI standards for SDH and
PDH circuit/trails and by ITU and ANSI standards for SONET and
Asynchronous circuit/trails. An SDH/SONET trail is provisioned over
the SDH/SONET link connections and over SDH/SONET
cross-connects in WaveStar NMS managed network elements. It is
possible that the link connections (SDH/SONET) may go through an
optical layer. In general, a PDH/Asynchronous circuit is provisioned
on SDH/SONET trails. With the “One-Step (Combo) Provisioning”
feature in WaveStar NMS, it is possible to provision both SDH trails
and PDH circuits or SONET/trails and Asynchronous circuits in a
single provisioning step.

A circuit is a PDH/Asynchronous terminology that provides a service
to a customer at a specified rate.

A trail is a SDH/SONET terminology that is often referred as a path.
A trail can be assignable or non-assignable depending on the
terminating port or based on the sub-structuring of the port to carry
lower order traffic. In WaveStar NMS, if one or both end ports of a
trail are PDH/Asynchronous, or if one or both end ports are
sub-structured to carry lower order traffic, the trail is called an
“assignable” entity. If both end ports are SDH/SONET and not
sub-structured to carry low order traffic, then the trail is called as an
“non-assignable” entity. Certain trails, such as VC4-4c, VC4-16c and
VC2, are always non-assignable. WaveStar NMS creates channels for
assignable trails in order to carry the low order trails or
PDH/asynchronous circuits.
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WavStar NMS allows users to provision a circuit/trail in one of the
three modes - auto, manual or partial.

• In auto mode, WaveStar NMS finds a route from the user
specified end ports for the trail and presents it to the user for
approval, if requested.

• In manual mode, the user can select the link and channel along a
path, and WaveStar NMS shall build the layout based on the user
selection(s).

• In partial mode, the user can pick all the links along the path of
the circuit/trail. The channels within the link are picked by
WaveStar NMS.

This section discusses provisioning tasks associated with connections.

Contents
Add a circuit between two controlled network
elements

3-29

Add a circuit between two noncontrolled network
elements

3-32
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Add a circuit between two controlled network elements
....................................................................................................................................................................................................................................

Purpose Use this procedure to add a circuit between two controlled network
elements.

Before you begin Before adding a circuit between two controlled network elements,
note the following items:

• WaveStar NMS does not support the provisioning of an
unprotected broadcast circuit on an ADM4/1 STM4 network
element.

• Not all controlled network elements (e.g., ADM 16/1, TM1,
AM1, AM1Plus) can implement a one-way cross-connection.

Task Complete the following task to add a circuit between two
controlled network elements.
............................................................................................................................................................

1 On the Network Map, select two network element icons.

Result:

The icons become highlighted.

............................................................................................................................................................

2 Right click on one network element.

Result:

The Node menu appears.

............................................................................................................................................................

3 Select Session > Start Database Synchronization.

Result:

A window appears.

............................................................................................................................................................

4 Under Type, select Port.

............................................................................................................................................................

5 Press Apply.

Result:

The network element’s ports are synchronized.
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............................................................................................................................................................

6 Repeat Steps 2 through 5 to synchronize the ports of the second
network element.

............................................................................................................................................................

7 Synchronize the cross-connects of both network elements by
performing Steps 2 through 5 (except select Cross-connect for the
Type).

Result:

The cross-connects associated with both network elements are
synchronized.

............................................................................................................................................................

8 On the Network Map, select Configuration > Connection > Add >
(Desired Circuit Rate).

Result:

The Provision Profile form is displayed.

............................................................................................................................................................

9 Under the Essentials tab, enter a circuit ID next to where the
connection type is listed.

............................................................................................................................................................

10 Press the A port button.

Result:

A window appears.

............................................................................................................................................................

11 Select a port and press OK.

Result:

The selected port appears within the Essentials tab as the A
port.

............................................................................................................................................................

12 Repeat steps 10 and 11 to add the Z port (of course, exchange any
instances of A port with Z port).

Result:

The selected port appears within the Essentials tab as the Z port.
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............................................................................................................................................................

13 Verify that Auto is checked for Path Selection.

............................................................................................................................................................

14 Under the Parameters tab, verify that Order Action is set at Add.

............................................................................................................................................................

15 Press OK.

Result:

The graphical layout form appears.

............................................................................................................................................................

16 Press OK.

Result:

A confirmation window appears.

............................................................................................................................................................

17 Press OK.

Result:

The circuit is created.
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Add a circuit between two noncontrolled network elements
....................................................................................................................................................................................................................................

Purpose Use this procedure to add a circuit between two noncontrolled
network elements.

Before you begin Before you add a circuit between two noncontrolled network
elements, note the following items:

• A circuit cannot be created directly between two noncontrolled
network elements without at least one intermediate controlled
network element.

• Digital links must already be provisioned from the network
element to each of the two equipment.

Task Complete the following task to add a circuit between two
noncontrolled network elements.
............................................................................................................................................................

1 On the Network Map, select two noncontrolled network element icons
that already have a digital link joining them and have at least one
intermediate controlled network element.

Result:

The icons become highlighted.

............................................................................................................................................................

2 Right click on one network element.

Result:

The Node menu appears.

............................................................................................................................................................

3 Select Session > Start Database Synchronization.

Result:

A window appears.

............................................................................................................................................................

4 Under Type, select Port.

............................................................................................................................................................

5 Press Apply.
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Result:

The network element’s ports are synchronized.

............................................................................................................................................................

6 Repeat Steps 2 through 5 to synchronize the ports of the second
network element.

............................................................................................................................................................

7 Synchronize the cross-connects of both network elements by
performing Steps 2 through 5 (except select Cross-connect for the
Type).

Result:

The cross-connects associated with both network elements are
synchronized.

............................................................................................................................................................

8 On the Network Map, select Configuration > Connection > Add >
(Desired Circuit Rate).

Result:

The Provision Profile form is displayed.

............................................................................................................................................................

9 Under the Essentials tab, enter a circuit ID next to where the
connection type is listed.

............................................................................................................................................................

10 Press the A port button.

Result:

A window appears.

............................................................................................................................................................

11 Select a port and press OK.

Result:

The selected port appears within the Essentials tab as the A
port.

............................................................................................................................................................

12 Repeat steps 10 and 11 to add the Z port (of course, exchange any
instances of A port with Z port).
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Result:

The selected port appears within the Essentials tab as the Z port.

............................................................................................................................................................

13 Verify that Auto is checked for Path Selection.

............................................................................................................................................................

14 Under the Parameters tab, verify that Order Action is set at Add.

............................................................................................................................................................

15 Press OK.

Result:

The graphical layout form appears.

............................................................................................................................................................

16 Press OK.

Result:

A confirmation window appears.

............................................................................................................................................................

17 Press OK.

Result:

The circuit is created.
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Add a circuit between a controlled network element and a
noncontrolled network element
....................................................................................................................................................................................................................................

Purpose Use this procedure to add a circuit between a controlled network
element and a noncontrolled network element.

Before you begin Before you add a circuit between a controlled network element and a
noncontrolled equipment, note the following items:

• A digital link between the noncontrolled equipment and the
network element must exist.

• Provisioning of broadcast circuits through WaveStar DACS is
supported on all rates (TU3/TU12/AU3/AU4).

• The equipment list menu item is only highlighted on the node
menu for those network elements connected to originating or
terminating equipment.

Task Perform the following steps to add a circuit between a controlled
network element and a noncontrolled network element.
............................................................................................................................................................

1 On the Network Map, select one noncontrolled network element icon
and one controlled network element icon that already have a digital
link joining them.

Result:

The icons become highlighted.

............................................................................................................................................................

2 Right click on one network element.

Result:

The Node menu appears.

............................................................................................................................................................

3 Select Session > Start Database Synchronization.

Result:

A window appears.

............................................................................................................................................................

4 Under Type, select Port.
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............................................................................................................................................................

5 Press Apply.

Result:

The network element’s ports are synchronized.

............................................................................................................................................................

6 Repeat Steps 2 through 5 to synchronize the ports of the second
network element.

............................................................................................................................................................

7 Synchronize the cross-connects of both network elements by
performing Steps 2 through 5 (except select Cross-connect for the
Type).

Result:

The cross-connects associated with both network elements are
synchronized.

............................................................................................................................................................

8 On the Network Map, select Configuration > Connection > Add >
(Desired Circuit Rate).

Result:

The Provision Profile form is displayed.

............................................................................................................................................................

9 Under the Essentials tab, enter a circuit ID next to where the
connection type is listed.

............................................................................................................................................................

10 Press the A port button.

Result:

A window appears.

............................................................................................................................................................

11 Select a port and press OK.

Result:

The selected port appears within the Essentials tab as the A
port.
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............................................................................................................................................................

12 Repeat steps 10 and 11 to add the Z port (of course, exchange any
instances of A port with Z port).

Result:

The selected port appears within the Essentials tab as the Z port.

............................................................................................................................................................

13 Verify that Auto is checked for Path Selection.

............................................................................................................................................................

14 Under the Parameters tab, verify that Order Action is set at Add.

............................................................................................................................................................

15 Press OK.

Result:

The graphical layout form appears.

............................................................................................................................................................

16 Press OK.

Result:

A confirmation window appears.

............................................................................................................................................................

17 Press OK.

Result:

The circuit is created.
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Provision an AU3-AU4 trail using the WaveStar BandWidth
Manager’s adaptation feature
....................................................................................................................................................................................................................................

Purpose Use this procedure to provision a trail using the WaveStar BandWidth
Manager’s AU3-AU4 adaptation feature.

The AU3-AU4 adaptation feature maps a higher order VC3 payload
(AU3) at the interface of a STM1E port to a lower order VC3 payload
(TUG structured), which is multiplexed into a VC4 (AU4). A STM1E
port can be provisioned to carry one AU4/VC4 or three AU3 (higher
order VC3) signals, in which case the AU3-AU4 adaptation is not
enabled, or it can be provisioned to enable the adaptation. If the
adaptation is enabled, the STM1E signal at the (external) interface
will represent 3 AU3 signals, and a single AU4 (VC4) signal
structured to contain 3 TU3/VC3 signals will leave the port unit
(internally in the BandWidth Manager) to interface with the switching
structure of the BandWidth Manager. Although the AU3-AU4
adaptation can be enabled in one direction (ingress or egress), only
bidirectional TU3-AU3 type trails are supported.

In the most common application of the feature, a DS3 is mapped into
a lower order VC3 at one end of the trail (e.g. in Europe), which in
turn is multiplexed into a VC4. The DS3 is extracted from a higher
order VC3/AU3 (STS1) at the other end of the trail (e.g. in N.
America). If the DS3 within the AU3 needs to be dropped at the same
BandWidth Manager, or the AU3 needs to be multiplexed into a
higher level optical signal (OC3 or higher) to be transported farther,
an external loop-back can be employed at the BandWidth Manager.

The adaptation feature is supported as a provisionable option on
STM1E ports only, on the BandWidth Manager’s STM1E universal
shelf. An STM-1 signal can be looped back at a BandWidth Manager,
and the AU3 signals from the STM1E port can be dropped at DS3
ports or consolidated over higher level facilities after being
cross-connected through the same BandWidth Manager as AU3
signals. Note that a loop-back is external to BandWidth Manager. It
should be configured in advance as a digital link and inventoried in
WaveStar NMS.
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Before you begin Before provisioning a trail using the WaveStar BandWidth Manager’s
AU3-AU4 adaptation feature, note the following items:

• WaveStar NMS only supports bi-directional TU3-AU3 trails.

• WaveStar NMS only supports the manual provisioning of
TU3-AU3 trails.

• WaveStar NMS supports merge and protection feaures for
TU3-AU3 trails.

• WaveStar NMS does not support preplan restoration for
TU3-AU3 trails.

Task Complete the following task to provision a trail using the
WaveStar BandWidth Manager’s AU3-AU4 adaptation feature.
This task assumes that you have already provisioned a VC4 trail
that terminates on a WaveStar BandWidth Manager.
............................................................................................................................................................

1 On the Network Map, select a pair of WaveStar BandWidth Manager
icons.

Result:

The icons become highlighted.

............................................................................................................................................................

2 Right click on the icon.

Result:

The Node menu appears.

............................................................................................................................................................

3 Select Session > Start Database Synchronization.

Result:

A window appears.

............................................................................................................................................................

4 Under Type, select Port.

............................................................................................................................................................

5 Press Apply.

Result:

The network element’s ports are synchronized.
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............................................................................................................................................................

6 Repeat Steps 2 through 5 to synchronize the ports of the second
network element.

............................................................................................................................................................

7 Synchronize the cross-connects of both network elements by
performing Steps 2 through 5 (except select Cross-connect for the
Type).

Result:

The cross-connects associated with both network elements are
synchronized.

............................................................................................................................................................

8 On the Network Map, select Configuration > Connection > Add >
(select a VC4 rate).

Result:

The Provision Profile form is displayed.

............................................................................................................................................................

9 Under the Essentials tab, enter a circuit ID next to where the
connection type is listed.

............................................................................................................................................................

10 Press the A port button.

Result:

A window appears.

............................................................................................................................................................

11 Select a port and press OK.

Result:

The selected port appears within the Essentials tab as the A
port.

............................................................................................................................................................

12 Repeat steps 10 and 11 to add the Z port (of course, exchange any
instances of A port with Z port).

Result:

The selected port appears within the Essentials tab as the Z port.

Section II: Connections
Provision an AU3-AU4 trail using the
WaveStar BandWidth Manager’s adaptation
feature

Provisioning Tasks

....................................................................................................................................................................................................................................

3 - 4 0 Lucent Technologies 365-309-243
Issue 1, July 2001



............................................................................................................................................................

13 Verify that Auto is checked for Path Selection.

............................................................................................................................................................

14 Under the Parameters tab, verify that Order Action is set at Add.

............................................................................................................................................................

15 For the Enable AU4-AU3 option, select Yes.

............................................................................................................................................................

16 Press OK.

Result:

The graphical layout form appears.

............................................................................................................................................................

17 Press OK.

Result:

A confirmation window appears.

............................................................................................................................................................

18 Press OK.

Result:

The AU3-AU4 trail is created.
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Display circuit list
....................................................................................................................................................................................................................................

Purpose Use this procedure to display a list of existing circuits.

Task Perform the following procedure to display a complete listing of
existing circuits.
............................................................................................................................................................

1 From the Network Map, select Configuration > Display >
Circuit/Trail List.

Result:

The Circuit/Trail List Query Box form appears.

............................................................................................................................................................

2 Place a check in the Free Form box.

Result:

The Free Form field alters.

............................................................................................................................................................

3 Within the Free Form field, enter *.

............................................................................................................................................................

4 From the field’s pull-down menu, select All.

Result:

The OK button will become active.

............................................................................................................................................................

5 Click OK.

Result:

The Circuit/Trail List form appears listing all existing circuits.
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Display circuit list by type
....................................................................................................................................................................................................................................

Purpose Use this procedure to display a list of particular circuit types.

Task Perform the following procedure to display a list of particular
circuit types.
............................................................................................................................................................

1 From the Network Map, select Configuration > Display >
Circuit/Trail List.

Result:

The Circuit/Trail List Query Box form appears.

............................................................................................................................................................

2 Place a check in the Free Form box.

Result:

The Free Form field alters.

............................................................................................................................................................

3 Within the Free Form field, enter *.

............................................................................................................................................................

4 From the field’s drop-down menu, specify a transmission rate.

Result:

The OK button becomes active.

............................................................................................................................................................

5 For Status, specify an order status. Your query will show all the
circuits that abide by this criteria. For example, if you select Pending,
only pending circuits will be polled for.

............................................................................................................................................................

6 For Order Action, select an order action if desired.

............................................................................................................................................................

7 Press the More button if you wish to apply additional search criteria.

Result:

If pressed, the form lengthens to provide additional selections.
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............................................................................................................................................................

8 Click OK.

Result:

The Circuit/Trail List form appears and lists all existing circuits
that fit the search criteria.
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Copy a connection using the Clone feature
....................................................................................................................................................................................................................................

Purpose Use this task to use the Clone feature to copy an existing circuit.

Task Perform the following steps to copy a circuit using the Clone
feature.
............................................................................................................................................................

1 From the Network Map, select Configuration > Connection > Clone.

Result:

A query box form appears.

............................................................................................................................................................

2 Enter a circuit identification so as to filter through all the currently
existing circuits.

............................................................................................................................................................

3 Press OK.

Result:

The Circuit/Trail List form appears.

............................................................................................................................................................

4 Select a circuit to clone.

Result:

A provisioning screen appears pre-populated.

............................................................................................................................................................

5 From the Essentials tab, change the ID field to name the clone of the
circuit.

............................................................................................................................................................

6 Change the port addresses for the circuit clone.

............................................................................................................................................................

7 Click OK.

Result:

The circuit is cloned.
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View a work order record document
....................................................................................................................................................................................................................................

Purpose Use the following procedure to view a work order record document
(WORD). The WORD feature describes a customer service order or a
network infrastructure/engineering order and includes the end-to-end
design of the circuit associated with that order. The primary use of the
WORD feature is for circuit installation, testing and fault tracing by
technicians in the field.

Before you begin Before you view a work order record document, consider the
following items:

• The WORD feature must be turned on by an administrator.
Administrators may turn on/off the WORD feature using the
license tool. Refer to the WaveStar NMS 4.0 Administration
Guide for details.

• Prior to using the WORD feature, an administrator must set the
IP address of the DNA server.

• The user’s system must have a web browser installed in order to
view the WORD.

Task Use the following procedure to view a work order record
document (WORD).
............................................................................................................................................................

1 From the Network Map, select Configuration > Connection >
Display > Circuit/Trail List.

Result:

The Circuit/Trail Query box form appears.

............................................................................................................................................................

2 Within the CKT/Trail ID field, enter a valid circuit/trail identification.

............................................................................................................................................................

3 Select a valid Order Status and Order Action.

Result:

The OK button becomes active.

............................................................................................................................................................

4 Press OK.
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Result:

The Circuit/Trail List form appears.

............................................................................................................................................................

5 With the circuit selected, go to Actions > Enable WORD Display.

Result:

The system will launch the resident web browser (in most cases,
Microsoft Internet Explorer).

............................................................................................................................................................

6 In the web page’s entry field, enter a valid IP address.

Result:

The WORD for the entered IP address will appear.
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Modify circuit order transmission parameters
....................................................................................................................................................................................................................................

Purpose Use this procedure to modify circuit order transmission parameters.

Important! Modifying transmissions can only be done for in-effect
circuits only.

Task Complete the following task to modify a circuit’s order
transmission parameters.
............................................................................................................................................................

1 From the Network Map, select a circuit.

............................................................................................................................................................

2 Right click on the circuit.

Result:

The Node menu appears.

............................................................................................................................................................

3 Select Circuit/Trail List.

Result:

The Circuit/Trail List form appears.

............................................................................................................................................................

4 Select the CKT/Trail ID corresponding to the circuit you wish to
disconnect.

Result:

The selection becomes highlighted, and the Actions menu item
becomes enabled.

............................................................................................................................................................

5 Select Actions > Graphical Layout.

Result:

The Graphical Layout form appears.

............................................................................................................................................................

6 Select Actions > Modify > Transmission Parameters.

Result:

The Transmission Parameters form appears.
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............................................................................................................................................................

7 Make the modifications to the circuit’s order parameters.

............................................................................................................................................................

8 Select OK.

Result:

The circuit’s new transmission parameters are saved.
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Disconnect a circuit
....................................................................................................................................................................................................................................

Purpose Use this procedure to disconnect a circuit.

When attempting to disconnect a circuit, note that a backbone circuit
cannot be disconnected unless all its tributaries, or other backbones it
is feeding, are disconnected first. Users may disconnect backbones
and tributaries in the same manner as with any other circuit except for
the first circuit that terminates at a customers location containing the
backbone.

Keep the following items in mind:

• You must disconnect all circuits fed by the backbone circuit.

• You may not disconnect the first circuit in WaveStar NMS.

• You must disconnect the circuit that contains the backbone and
add a new circuit. This circuit will contain the new backbone.

• You may then add remaining circuits you wish to maintain.

Before you begin Before you disconnect a circuit, consider the following items:

• You are not required to stop data collection prior to disconnecting
a circuit.

• Preplan paths, riding on a circuit to be disconnected, must be
first disassociated from the service path they are protecting
before there is any attempt at canceling them.

• If the circuit to be deleted is part of a broadcast circuit, the
circuit that was added last must be disconnected first.

Task Complete the following task to disconnect a circuit.
............................................................................................................................................................

1 From the Network Map, select a circuit.

............................................................................................................................................................

2 Right click on the circuit.

Result:

The Node menu appears.

............................................................................................................................................................

3 Select Circuit/Trail List.
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Result:

The Circuit/Trail List form appears.

............................................................................................................................................................

4 Select the CKT/Trail ID corresponding to the circuit you wish to
disconnect.

Result:

The selection becomes highlighted, and the Actions menu item
becomes enabled.

............................................................................................................................................................

5 Select Actions > Graphical Layout.

Result:

The Graphical Layout form appears.

............................................................................................................................................................

6 Select Actions > Disconnect > Actual.

Result:

A confirmation window appears.

............................................................................................................................................................

7 Select Yes.

Result:

The circuit is disconnected.
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Perform a virtual disconnect
....................................................................................................................................................................................................................................

Purpose Use this procedure to perform a virtual disconnect on a circuit.

Task Complete the following task to perform a virtual disconnect on a
circuit.
............................................................................................................................................................

1 From the Network Map, select a circuit.

............................................................................................................................................................

2 Right click on the circuit.

Result:

The Node menu appears.

............................................................................................................................................................

3 Select Circuit/Trail List.

Result:

The Circuit/Trail List form appears.

............................................................................................................................................................

4 Select the CKT/Trail ID corresponding to the circuit you wish to
disconnect.

Result:

The selection becomes highlighted, and the Actions menu item
becomes enabled.

............................................................................................................................................................

5 Select Actions > Graphical Layout.

Result:

The Graphical Layout form appears.

............................................................................................................................................................

6 Select Actions > Disconnect > Virtual (DB only).

Result:

A confirmation window appears.

............................................................................................................................................................

7 Select Yes.
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Result:

A virtual disconnect is performed on the circuit.
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Section III: Optical Layers

Overview
....................................................................................................................................................................................................................................

Purpose An optical layer refers to an existing optical multiplex section (OMS),
optical link or optical channel trail that connects particular types of
network elements on the Network Map. For example, an optical link
can connect a SDH network element with a DWDM network element,
a DWDM network element with a Lambda Router, two Lambda
Routers together, or a Lambda Router with an SDH network element.
Unlike an optical multiplex section (OMS), however, an optical link
can not join two DWDM network elements.

This section discusses the provisioning tasks associated with optical
layers.
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Create an optical multiplex section
....................................................................................................................................................................................................................................

Purpose Use this procedure to create an optical multiplex section (OMS). An
OMS is used to connect two DWDM network elements.

Before you begin Before you create an OMS, note the following:

• The OMS between two OLS80G DWDMs can be unprotected or
1+1 protected.

• The optical amplifier list contains only the amplifiers that support
the OMS section with the appropriate number of channels (16 or
40/80). It is assumed that the optical amplifiers are all
bi-directional.

Task Use the following procedure to create an OMS. This procedure
assumes that the appropriate network elements have already been
provisioned.
............................................................................................................................................................

1 From the Network Map, select two DWDM network element icons.

Result:

The two selected network elements become highlighted.

............................................................................................................................................................

2 Right click on one network element.

Result:

The Node menu appears.

............................................................................................................................................................

3 Select Session > Start Database Synchronization.

Result:

A window appears.

............................................................................................................................................................

4 Under Type, select Port.

............................................................................................................................................................

5 Press Apply.
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Result:

The network element’s ports are synchronized.

............................................................................................................................................................

6 Repeat Steps 2 through 5 to synchronize the ports of the second
network element.

............................................................................................................................................................

7 Synchronize the cross-connects of both network elements by
performing Steps 2 through 5 (except select Cross-connect for the
Type).

Result:

The cross-connects associated with both network elements are
synchronized.

............................................................................................................................................................

8 From the Network Map, select Configuration > Optical Layer > Add
> OMS.

Result:

The Network Map becomes the Provisioning Profile form.

............................................................................................................................................................

9 Under the Essentials tab, enter a circuit ID next to where OMS is
listed.

............................................................................................................................................................

10 Press the A port button.

Result:

A window appears.

............................................................................................................................................................

11 Select a port and press OK.

Result:

The selected port appears within the Essentials tab as the A
port.

............................................................................................................................................................

12 Repeat steps 10 and 11 to add the Z port (of course, exchange any
instances of A port with Z port).
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Result:

The selected port appears within the Essentials tab as the Z port.

............................................................................................................................................................

13 Verify that Auto is checked for Path Selection.

............................................................................................................................................................

14 Press OK.

Result:

The graphical layout form appears.

............................................................................................................................................................

15 Press OK.

Result:

A confirmation window appears.

............................................................................................................................................................

16 Confirm all confirmation windows that appear.

Result:

The newly created OMS appears on the Network Map.
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Create an optical multiplex section with 1+1 protection
....................................................................................................................................................................................................................................

Purpose Use this procedure to create an optical multiplex section (OMS) with
1+1 protection.

Before you begin Before you create an OMS with 1+1 protection, note the following:

• The OMS must be between two OLS80G DWDMs.

• The optical amplifier list contains only the amplifiers that support
the OMS section with the appropriate number of channels (16 or
40/80). It is assumed that the optical amplifiers are all
bi-directional.

Task Use the following procedure to create an OMS with 1+1
protection. This procedure assumes that the appropriate network
elements have already been provisioned.
............................................................................................................................................................

1 From the Network Map, select two OLS80G DWDM network element
icons.

Result:

The two selected network elements become highlighted.

............................................................................................................................................................

2 Right click on one network element.

Result:

The Node menu appears.

............................................................................................................................................................

3 Select Session > Start Database Synchronization.

Result:

A window appears.

............................................................................................................................................................

4 Under Type, select Port.

............................................................................................................................................................

5 Press Apply.

Result:

The network element’s ports are synchronized.

Section III: Optical Layers Provisioning Tasks

....................................................................................................................................................................................................................................

3 - 5 8 Lucent Technologies 365-309-243
Issue 1, July 2001



............................................................................................................................................................

6 Repeat Steps 2 through 5 to synchronize the ports of the second
network element.

............................................................................................................................................................

7 Synchronize the cross-connects of both network elements by
performing Steps 2 through 5 (except select Cross-connect for the
Type).

Result:

The cross-connects associated with both network elements are
synchronized.

............................................................................................................................................................

8 From the Network Map, select Configuration > Optical Layer > Add
> OMS.

Result:

The Network Map becomes the Provisioning Profile form.

............................................................................................................................................................

9 Under the Essentials tab, enter a circuit ID next to where OMS is
listed.

............................................................................................................................................................

10 Press the A port button.

Result:

A window appears.

............................................................................................................................................................

11 Select a port and press OK.

Result:

The selected port appears within the Essentials tab as the A
port.

............................................................................................................................................................

12 Repeat steps 10 and 11 to add the Z port (of course, exchange any
instances of A port with Z port).

Result:

The selected port appears within the Essentials tab as the Z port.
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............................................................................................................................................................

13 Verify that Auto is checked for Path Selection.

............................................................................................................................................................

14 Set MSP (for multiplex section protection) to Y.

............................................................................................................................................................

15 Press OK.

Result:

The graphical layout form appears.

............................................................................................................................................................

16 Press OK.

Result:

A confirmation window appears.

............................................................................................................................................................

17 Confirm all confirmation windows that appear.

Result:

The newly created OMS with 1+1 protection appears on the
Network Map.
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Create an optical link
....................................................................................................................................................................................................................................

Purpose Use this procedure to create an optical link. An optical link can
connect a SDH network element with a DWDM network element, a
DWDM network element with a Lambda Router, two Lambda Routers
together, or a Lambda Router with an SDH network element. Unlike
an OMS, an optical link can not join two DWDM network elements.

Task Use the following procedure to create an optical link. This
procedure assumes that the appropriate network elements have
already been provisioned.
............................................................................................................................................................

1 From the Network Map, select two network element icons. As stated
previously, the network elements can be DWDM, SDH or a Lambda
Router. However, only one network element you select can be a
DWDM.

Result:

The two selected network elements become highlighted.

............................................................................................................................................................

2 Right click on one network element.

Result:

The Node menu appears.

............................................................................................................................................................

3 Select Session > Start Database Synchronization.

Result:

A window appears.

............................................................................................................................................................

4 Under Type, select Port.

............................................................................................................................................................

5 Press Apply.

Result:

The network element’s ports are synchronized.
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............................................................................................................................................................

6 Repeat Steps 2 through 5 to synchronize the ports of the second
network element.

............................................................................................................................................................

7 Synchronize the cross-connects of both network elements by
performing Steps 2 through 5 (except select Cross-connect for the
Type).

Result:

The cross-connects associated with both network elements are
synchronized.

............................................................................................................................................................

8 From the Network Map, select Configuration > Optical Layer > Add
> OL.

Result:

The Network Map becomes the Provisioning Profile form.

............................................................................................................................................................

9 Under the Essentials tab, enter a circuit ID next to where OL is
listed.

............................................................................................................................................................

10 Press the A port button.

Result:

A window appears.

............................................................................................................................................................

11 Select a port and press OK.

Result:

The selected port appears within the Essentials tab as the A
port.

............................................................................................................................................................

12 Repeat steps 10 and 11 to add the Z port (of course, exchange any
instances of A port with Z port).

Result:

The selected port appears within the Essentials tab as the Z port.
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............................................................................................................................................................

13 Ensure that Auto is checked for Path Selection.

............................................................................................................................................................

14 Press OK.

Result:

The graphical layout form appears.

............................................................................................................................................................

15 Press OK.

Result:

A confirmation window appears.

............................................................................................................................................................

16 Confirm all confirmation windows that appear.

Result:

The newly created optical link appears on the Network Map.
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Create an optical channel trail
....................................................................................................................................................................................................................................

Purpose Use this procedure to create an optical channel trail. An optical
channel trail transverses the connections established by either an OMS
or and OMS/optical link combination. As such, an optical channel trail
can span such combinations as two DWDMs (in the case of a single
OMS), or an SDH network element (optical link) DWDM (OMS)
DWDM (optical link) SDH network element scheme.

Before you begin Before you create an optical channel trail, note the following:

• There must be at least one OMS provisioned. There also must be
the desired number of optical links provisioned prior to creating
an optical channel trail.

• Optical channel SNCP is supported for Lambda Router 256/128.

• Cascaded SNCPs are not supported.

Task Use the following procedure to create an optical channel trail.
This procedure assumes that the appropriate network elements,
OMSs and optical links have already been provisioned.
............................................................................................................................................................

1 From the Network Map, select an existing OMS. For sake of clarity,
this procedure will discuss the provisioning of an optical channel trail
for a single OMS. Note that an optical channel trail can be
provisioned so as to include several optical links and OMSs.

Result:

The selected OMS becomes highlighted.

............................................................................................................................................................

2 From the Network Map, select Configuration > Optical Layer > Add
> OChTrail.

Result:

The Network Map becomes the Provisioning Profile form.

............................................................................................................................................................

3 Under the Essentials tab, enter a circuit ID next to where OChTrail
is listed.

............................................................................................................................................................

4 Press the A port button.
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Result:

A window appears.

............................................................................................................................................................

5 Select a port and press OK.

Result:

The selected port appears within the Essentials tab as the A
port.

............................................................................................................................................................

6 Repeat steps 10 and 11 to add the Z port (of course, exchange any
instances of A port with Z port).

Result:

The selected port appears within the Essentials tab as the Z port.

............................................................................................................................................................

7 Verify that Auto is checked for Path Selection.

............................................................................................................................................................

8 Press OK.

Result:

The graphical layout form appears.

............................................................................................................................................................

9 Press OK.

Result:

A confirmation window appears.

............................................................................................................................................................

10 Confirm all confirmation windows that appear.

Result:

The newly created optical channel trail appears on the Network
Map.
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Add an optical amplifier to an optical multiplex section
....................................................................................................................................................................................................................................

Purpose Use this task to add an optical amplifier to an optical multiplex
section (OMS).

Task Complete the following task to add an optical amplifier to an
OMS.
............................................................................................................................................................

1 From the Network Map, select an OMS.

............................................................................................................................................................

2 Right click on the OMS.

Result:

The Node menu appears.

............................................................................................................................................................

3 Select Circuit/Trail List.

Result:

The Circuit/Trail List form appears.

............................................................................................................................................................

4 Select the CKT/Trail ID corresponding to the OMS you wish to add
the optical amplifier to.

Result:

The selection becomes highlighted, and the Actions menu item
becomes enabled.

............................................................................................................................................................

5 Select Actions > Graphical Layout.

Result:

The Graphical Layout form appears.

............................................................................................................................................................

6 Select Actions > Modify > Regenerators/Optical Amplifiers.

Result:

The Optical Amplifier Selection form appears.
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............................................................................................................................................................

7 Select an optical amplifier from the Non-Members sub-window.

Result:

The Add and Remove buttons become enabled.

............................................................................................................................................................

8 Press Add.

Result:

The optical amplifier is moved to the Service window.

............................................................................................................................................................

9 Specify the optical amplifier’s left/right ports and the service
protection.

............................................................................................................................................................

10 Press OK.

Result:

A confirmation window appears.

............................................................................................................................................................

11 Press OK.

............................................................................................................................................................

12 From the Network Map, select File > Query Again.

Result:

An optical amplifier is added to the OMS.
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Delete an optical amplifier from an optical multiplex section
....................................................................................................................................................................................................................................

Purpose Use this task to delete an optical amplifier from an optical multiplex
section (OMS).

Task Complete the following task to delete an optical amplifier from
an OMS.
............................................................................................................................................................

1 From the Network Map, select an OMS.

............................................................................................................................................................

2 Right click on the OMS.

Result:

The Node menu appears.

............................................................................................................................................................

3 Select Circuit/Trail List.

Result:

The Circuit/Trail List form appears.

............................................................................................................................................................

4 Select the CKT/Trail ID corresponding to the OMS you wish to add
the optical amplifier to.

Result:

The selection becomes highlighted, and the Actions menu item
becomes enabled.

............................................................................................................................................................

5 Select Actions > Graphical Layout.

Result:

The Graphical Layout form appears.

............................................................................................................................................................

6 Select Actions > Modify > Regenerators/Optical Amplifiers.

Result:

The Optical Amplifier Selection form appears.
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............................................................................................................................................................

7 Select an optical amplifier from the Service window.

Result:

The Add and Remove buttons become enabled.

............................................................................................................................................................

8 Press Remove.

Result:

The amplifier is moved to the Non-Members window.

............................................................................................................................................................

9 Press OK.

Result:

A confirmation window appears.

............................................................................................................................................................

10 Press OK.

............................................................................................................................................................

11 From the Network Map, select File > Query Again.

Result:

The optical amplifier is deleted from the OMS.
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Create a preplan for an optical channel trail
....................................................................................................................................................................................................................................

Purpose Use this procedure to create assign preplan restoration to an optical
channel trail. Preplan restoration allows a user to re-route traffic
temporarily so as to restore service in the event of a failure with the
optical channel trail.

Before you begin Before you create a preplan for an optical channel trail, note the
following:

• WaveStar NMS will not perform validation to insure compliance
with the following assumptions: the service path includes the
Lambda Router; the service and preplan paths use the same
Lambda Router where the restoration cross connect occurred.

• WaveStar NMS can provide the capability to restore an optical
channel trail if the following items occur: the service and preplan
paths have the same channel/client service type; the service and
preplan paths have different optical channel trails; the service
path optical channel and the preplan path optical channel trail
have the same end port.

• WaveStar NMS supports preplan for OCh trail for OLS80G and
all models of OLS400G.

• Lambda Router 256 and 128 are supported.

Task Use the following procedure to create a preplan for an optical
channel trail. This procedure assumes that the appropriate
network elements, OMSs and optical links have already been
provisioned.
............................................................................................................................................................

1 From the Network Map, select an existing OMS that supports preplan
(see above caveats). For sake of clarity, this procedure will discuss the
provisioning of an optical channel trail for a single OMS. Note that an
optical channel trail can be provisioned so as to include several
optical links and OMSs.

Result:

The selected OMS becomes highlighted.

............................................................................................................................................................

2 From the Network Map, select Configuration > Optical Layer > Add
> OChTrail.
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Result:

The Network Map becomes the Provisioning Profile form.

............................................................................................................................................................

3 Under the Essentials tab, enter a circuit ID next to where OChTrail
is listed.

............................................................................................................................................................

4 Press the A port button.

Result:

A window appears.

............................................................................................................................................................

5 Select a port and press OK.

Result:

The selected port appears within the Essentials tab as the A
port.

............................................................................................................................................................

6 Repeat steps 10 and 11 to add the Z port (of course, exchange any
instances of A port with Z port).

Result:

The selected port appears within the Essentials tab as the Z port.

............................................................................................................................................................

7 Verify that Auto is checked for Path Selection.

............................................................................................................................................................

8 Under the Parameters tab, specify Order Action as Pre-plan.

............................................................................................................................................................

9 Press OK.

Result:

The graphical layout form appears.

............................................................................................................................................................

10 Press OK.

Result:

A confirmation window appears.
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............................................................................................................................................................

11 Confirm all confirmation windows that appear.

Result:

The newly created optical channel trail with preplan restoration
appears on the Network Map.
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Insert an optical layer into a digital link
....................................................................................................................................................................................................................................

Purpose Use this procedure to insert an optical layer into an existing digital
link. An optical layer, in this case, refers to an existing OMS, optical
link or optical channel trail.

Before you begin Before attempting to insert an optical layer into a digital link, consider
the following items:

• In the case of an MSP-protected digital link, it is not necessary
to have an optical layer both in the service link and protection
link. One of the links need not go through the optical layer.

Task Perform the following steps to insert an optical layer into a
digital link. This task assumes that all necessary optical layer
components are provisioned in WaveStar NMS before attempting
to insert the optical layer.
............................................................................................................................................................

1 From the Network Map, right click on a terminating network element
icon of a digital link.

Result:

The Node menu appears.

............................................................................................................................................................

2 Select Assigned Ports List.

Result:

The Assigned Ports List window appears.

............................................................................................................................................................

3 From the list, select a digital link.

Result:

The digital link becomes highlighted.

............................................................................................................................................................

4 Select Actions > Graphical Layout.

Result:

The Graphical Layout form appears.
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............................................................................................................................................................

5 Select Actions > Insert Optical Layer.

Result:

A confirmation window appears.

............................................................................................................................................................

6 Press Yes.

Result:

The optical layer is inserted into the digital link.
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Create a digital link through an optical channel trail
....................................................................................................................................................................................................................................

Purpose Use this procedure to create a digital link through an optical channel
trail.

Task Perform the following steps to create a digital link through an
optical channel trail. This task assumes that all necessary optical
layer components are provisioned in WaveStar NMS before
attempting to create the digital link.
............................................................................................................................................................

1 From the Network Map, select the terminating SDH network element
icons of an optical trail.

............................................................................................................................................................

2 From the Network Map, select Configurations > Digital Link > Add
> (select rate).

Result:

The Network Map becomes the Provisioning Profile form.

............................................................................................................................................................

3 Under the Essentials tab, enter a circuit ID.

............................................................................................................................................................

4 Press the A port button.

Result:

A window appears.

............................................................................................................................................................

5 Select a port and press OK.

Result:

The selected port appears within the Essentials tab as the A
port.

............................................................................................................................................................

6 Repeat steps 10 and 11 to add the Z port (of course, exchange any
instances of A port with Z port).

Result:

The selected port appears within the Essentials tab as the Z port.
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............................................................................................................................................................

7 Verify that Auto is checked for Path Selection.

............................................................................................................................................................

8 Press OK.

Result:

The graphical layout form appears.

............................................................................................................................................................

9 Press OK.

Result:

A confirmation window appears.

............................................................................................................................................................

10 Confirm all confirmation windows that appear.

Result:

The newly created digital link follows the optical channel trail.
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Disconnect an optical channel trail
....................................................................................................................................................................................................................................

Purpose Use the following procedure to disconnect an optical channel trail.

Task Complete the following steps to disconnect an optical channel
trail.
............................................................................................................................................................

1 From the Network Map, select an optical channel trail (by selecting
one of its end points).

............................................................................................................................................................

2 Right click on the end point (a network element icon).

Result:

The Node menu appears.

............................................................................................................................................................

3 Select Assigned Ports List.

Result:

The Assigned Ports List window appears.

............................................................................................................................................................

4 From the listing, select an optical channel trail. Make sure it is
In-Effect (IE).

Result:

The selection becomes highlighted.

............................................................................................................................................................

5 Select Actions > Graphical Layout.

Result:

The Graphical Layout form appears.

............................................................................................................................................................

6 Select Actions > Disconnect > Actual.

Result:

A confirmation window appears.

............................................................................................................................................................

7 Press OK.
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Result:

The optical channel trail is disconnected.
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Disconnect an optical link
....................................................................................................................................................................................................................................

Purpose Use the following procedure to disconnect an optical link.

Task Complete the following steps to disconnect an optical link.
............................................................................................................................................................

1 From the Network Map, select an optical link (by selecting one of its
end points).

............................................................................................................................................................

2 Right click on the end point (a network element icon).

Result:

The Node menu appears.

............................................................................................................................................................

3 Select Assigned Ports List.

Result:

The Assigned Ports List window appears.

............................................................................................................................................................

4 From the listing, select the optical link. Make sure it is In-Effect (IE).

Result:

The selection becomes highlighted.

............................................................................................................................................................

5 Select Actions > Graphical Layout.

Result:

The Graphical Layout form appears.

............................................................................................................................................................

6 Select Actions > Disconnect > Actual.

Result:

A confirmation window appears.

............................................................................................................................................................

7 Press OK.

Result:

The optical link is disconnected.
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Disconnect an optical multiplex section
....................................................................................................................................................................................................................................

Purpose Use the following procedure to disconnect an optical multiplex section
(OMS).

Task Complete the following steps to disconnect an OMS.
............................................................................................................................................................

1 From the Network Map, select an OMS (by selecting one of its end
points).

............................................................................................................................................................

2 Right click on the end point (a network element icon).

Result:

The Node menu appears.

............................................................................................................................................................

3 Select Assigned Ports List.

Result:

The Assigned Ports List window appears.

............................................................................................................................................................

4 From the listing, select the OMS. Make sure it is In-Effect (IE).

Result:

The selection becomes highlighted.

............................................................................................................................................................

5 Select Actions > Graphical Layout.

Result:

The Graphical Layout form appears.

............................................................................................................................................................

6 Select Actions > Disconnect > Actual.

Result:

A confirmation window appears.

............................................................................................................................................................

7 Press OK.
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Result:

The OMS is disconnected.
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Section IV: Trenches

Overview
....................................................................................................................................................................................................................................

Purpose In order to provide physical separacy between a protected and service
route, WaveStar NMS supports the association of trenches to digital
links. One or more trenches can be associated with one digital link, or
a number of digital links can be associated with one trench.

The main reason to incorporate trench IDs is to achieve physical
separacy for protected and service path. All fibers, cables and conduits
in a given trench may not survive physical disaster. In order to design
a network for maximum survivability, trenches, which are used for
working paths/circuits, must not be used for protection paths/circuits.
In case of rings or linear protection, network designers must take care
of physical separacy, because links and path are well defined.

This section discusses provisioning tasks associated with trenches.

Rules about trenches Before you attempt to create a trench identification, consider the
following items:

• A maximum of five trench identifications can be associated with
a single digital link.

• One trench identification can be used by multiple digital links.

• A trench identification can not exceed 83 alphanumeric
characters.

• A trench identification description can not exceed 32
alphanumeric characters.

• Trench identifications are only applicable to digital links, optical
links and an OMS.

Contents
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Create a trench ID
....................................................................................................................................................................................................................................

Purpose Use this procedure to create a trench ID.

Task Complete the following task to create a trench ID.
............................................................................................................................................................

1 On the Network Map, select Configuration > Trench ID > Add.

Result:

A window containing two fields appears.

............................................................................................................................................................

2 In the Trench ID field, enter a unique identification for the trench.

............................................................................................................................................................

3 In the Description field, provide a description of the trench so as to
distinguish it from other trenches.

............................................................................................................................................................

4 Click OK.

Result:

The trench ID is created.
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Display a list of trenches
....................................................................................................................................................................................................................................

Purpose Use this procedure to display a list of existing trenches.

Task Complete the following task to display a list of existing trenches.
............................................................................................................................................................

1 From the Network Map, select Configuration > Trench ID > Display
List.

Result:

The Trench ID Display Query Box appears.

............................................................................................................................................................

2 In the Trench ID field, enter a trench identification (or enter * to list
all trenches).

............................................................................................................................................................

3 Press OK.

Result:

The Trench Display List form appears and displays a list of all
the existing trenches.
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Display the trenches associated with a digital link
....................................................................................................................................................................................................................................

Purpose Use this task to display the trenches associated with a digital link.

Task Complete the following task to display the trenches associated
with a digital link.
............................................................................................................................................................

1 From the Network Map, select Configuration > Connection >
Display > Circuit/Trail List.

Result:

The Circuit/Trail Query Box window appears.

............................................................................................................................................................

2 In the Order Status field, specify an order status.

............................................................................................................................................................

3 In the Ckt/Trail ID field, select a rate.

............................................................................................................................................................

4 Press OK.

Result:

The Circuit Trail List window appears.

............................................................................................................................................................

5 From the list, select a circuit/trail identification.

Result:

The selected identification is highlighted.

............................................................................................................................................................

6 Select Actions > Trench ID Associations/Display.

Result:

A window appears showing all the trenches associated with the
digital link.
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Display the digital links associated with a trench
....................................................................................................................................................................................................................................

Purpose Use this task to display the digital links associated with a trench.

Task Complete the following task to display the digital links associated
with a trench.
............................................................................................................................................................

1 From the Network Map, select Configuration > Trench ID > Display
List.

Result:

The Trench ID Display Query Box appears.

............................................................................................................................................................

2 In the Trench ID field, enter a trench ID.

............................................................................................................................................................

3 Press OK.

Result:

The Trench Display List form appears and lists the trenches
according to the query information that was specified.

............................................................................................................................................................

4 From the list, select a trench.

Result:

The selection is highlighted.

............................................................................................................................................................

5 Select Actions > Trench ID-Links Associations List.

Result:

The Trench ID-Links Associations List form appears and
displays all the digital links associated with the specified trench.
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Associate a trench with a digital link
....................................................................................................................................................................................................................................

Purpose Perform the following procedure to associate a trench with a digital
link.

Task Complete the following task to associate a trench with a digital
link.
............................................................................................................................................................

1 From the Network Map, select Configuration > Connection >
Display > Circuit/Trail List.

Result:

The Circuit/Trail Query Box form appears.

............................................................................................................................................................

2 In the Order Status field, specify an order status.

............................................................................................................................................................

3 In the Ckt/Trail ID field, select a rate.

............................................................................................................................................................

4 Press OK.

Result:

The Circuit/Trail List form appears.

............................................................................................................................................................

5 From the list, select a circuit/trail identification.

Result:

The selected identification is highlighted.

............................................................................................................................................................

6 Select Actions > Trench ID Associations/Display.

Result:

A form appears displaying all the trenches associated with the
digital link.

............................................................................................................................................................

7 Using the window’s arrow icons, associate (or dissociate) trenches
with a digital link.
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............................................................................................................................................................

8 Select Apply.

Result:

The trench is associated (or disassociated) with the digital link.
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Modify a trench ID
....................................................................................................................................................................................................................................

Purpose Use this task to modify a trench ID.

Task Complete the following task to modify a trench ID.
............................................................................................................................................................

1 From the Network Map, select Configuration > Trench ID > Display
List.

Result:

The Trench ID Display List Query Box form appears.

............................................................................................................................................................

2 In the Trench ID field, enter an existing trench identification. If you
enter nothing, you will get a complete list of existing trenches.

............................................................................................................................................................

3 Press OK.

Result:

The Trench Display List form appears.

............................................................................................................................................................

4 In the Trench ID field, select a trench.

............................................................................................................................................................

5 Select Actions > Update.

Result:

A form appears.

............................................................................................................................................................

6 In the New Trench ID and New Description fields, enter new
information for the trench.

............................................................................................................................................................

7 Click OK.

Result:

The trench ID is modified.
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Delete a trench ID
....................................................................................................................................................................................................................................

Purpose Use this procedure to delete a trench ID.

Task Complete the following task to delete a trench ID.
............................................................................................................................................................

1 From the Network Map, select Configuration > Trench ID > Display
List.

Result:

The Trench ID Display List Query Box form appears.

............................................................................................................................................................

2 In the Trench ID field, enter an existing trench identification. If you
enter nothing, you will get a complete list of existing trenches.

............................................................................................................................................................

3 Press OK.

Result:

The Trench Display List form appears and lists the trenches
according to the query information specified within the previous
window.

............................................................................................................................................................

4 From the list, select a trench.

Result:

The selection is highlighted.

............................................................................................................................................................

5 Select Actions > Delete.

............................................................................................................................................................

6 From the Network Map, select File > Query Again.

Result:

The trench ID is deleted.
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Section V: Subnets

Overview
....................................................................................................................................................................................................................................

Purpose Subnets are defined as devices on a network that shares a common
address component. For example, all devices with IP addresses that
start with 100.100.100. could be part of the same subnet. Dividing a
network into subnets is useful for both security and performance
reasons.

The WaveStar NMS subnet support allows users to create rings from
the Network Map. In terms of the WaveStar NMS Network Map, a
ring is defined as when three or more network elements are connected
in a closed loop. Messages travel around the ring, with each network
element reading those messages addressed to it. One of the advantages
of ring networks is that they can span larger distances than other types
of networks, such as bus networks, because each network element
regenerates messages as they pass through it. Another advantage is
that one half of the ring’s channels can be defined as working
(carrying data) while the other half can be defined as protection.

This section describes the provisioning tasks associated with subnets.
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Add a subnet
....................................................................................................................................................................................................................................

Purpose Use this task to add a subnet to WaveStar NMS.

Manual task Perform the following steps to manually create a subnet. This
task assumes that you have already provisioned the desired
number of network elements and digital links.
............................................................................................................................................................

1 From the Network Map, select Configuration > Subnet > Add >
(select either PSR or LSR depending upon the desired rate) >
(select a rate). Note that the rate you select must be compatible with
the network elements and digital links you are planning to create the
subnet with.

Result:

The Subnet Manual Creation form appears.

............................................................................................................................................................

2 From the Network Map, select a digital link you wish to make part of
the subnet.

Result:

The A and Z fields within the Subnet Manual Creation form
become populated with the digital link information.

............................................................................................................................................................

3 From the Subnet Manual Creation form, select the digital link.

Result:

Selection becomes highlighted and the arrow icon becomes
enabled.

............................................................................................................................................................

4 Press the arrow icon to move the digital link to the Subnet
Designation sub-window.

Result:

The sub-window’s fields become populated with the digital link
information. The digital link on the Network Map becomes
thicker to signify the creation of a piece of the subnet.
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............................................................................................................................................................

5 Repeat Steps 2 through 4 until you form an enclosure using digital
links and network elements.

............................................................................................................................................................

6 Press OK.

Result:

The subnet is created.
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Name a subnet
....................................................................................................................................................................................................................................

Purpose Use this procedure to name an existing subnet.

Task Complete the following task to name a subnet. This task assumes
that a subnet has already been created.
............................................................................................................................................................

1 From the Network Map, select Configuration > Subnet >
Display/Modify.

Result:

The Subnet Display List form appears.

............................................................................................................................................................

2 In the Subnet IDs column, select a subnet.

Result:

The selection is highlighted, and the Actions menu item
becomes enabled.

............................................................................................................................................................

3 Select Actions > Modify Parameters.

Result:

The Subnet window appears.

............................................................................................................................................................

4 Enter a new subnet ID in the Subnet ID field. You must assign a
unique ID.

............................................................................................................................................................

5 Click OK.

Result:

A confirmation window is displayed informing you of the
operation’s success.

............................................................................................................................................................

6 Select File > Query Again.

Result:

The Network Map displays the new subnet name.
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Modify a subnet
....................................................................................................................................................................................................................................

Purpose Use this task to modify an existing subnet.

Task Perform the following steps to modify an existing subnet.
............................................................................................................................................................

1 From the Network Map, select Configuration > Subnet >
Display/Modify.

Result:

The Subnet Display List form appears.

............................................................................................................................................................

2 In the Subnet IDs column, select a subnet.

Result:

The selection is highlighted, and the Actions menu item
becomes enabled.

............................................................................................................................................................

3 Select Actions > Modify Parameters.

Result:

The Subnet window appears.

............................................................................................................................................................

4 Make the desired modifications to the subnet.

............................................................................................................................................................

5 Click OK.

Result:

A confirmation window is displayed informing you of the
operation’s success.

............................................................................................................................................................

6 Select File > Query Again.

Result:

The Network Map reflect any modifications made to the subnet.
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Delete a subnet
....................................................................................................................................................................................................................................

Purpose Use this task to delete a subnet.

Task Perform the following steps to delete a subnet.
............................................................................................................................................................

1 Select a digital link that is part of the subnet you wish to delete.

............................................................................................................................................................

2 From the Network Map, select Configuration > Digital Link >
Disconnect.

Result:

The Ckt/Trail Query Box is displayed.

............................................................................................................................................................

3 In the Order Number field, enter the order number of the digital link.

............................................................................................................................................................

4 Click OK.

Result:

A confirmation window appears.

............................................................................................................................................................

5 Click Yes.

Result:

An action window appears.

............................................................................................................................................................

6 Click OK.

Result:

The system disconnects the digital link if all validations are
successful.

............................................................................................................................................................

7 From the Network Map, select File > Query Again.

Result:

The digital link, that was part of the subnet, disappears from the
Network Map and thus deletes the subnet.
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Section VI: Preplan Restoration

Overview
....................................................................................................................................................................................................................................

Purpose Restoration allows a user to re-route traffic temporarily so as to
restore service in the event of a network failure. Preplan restoration is
one type of restoration provided by WaveStar NMS. Preplan
restoration allows for a back-up circuit to be predefined for an
existing in-service circuit. WaveStar NMS stores a preplan in a
database and accesses it when a failure occurs so as to restore the
circuit.

Preplan restoration works best where:

• one portion of the service circuit is controlled by WaveStar NMS
while the other end is outside WaveStar NMS control and on the
end customers premise;

• customers have mixed network elements in their network;

• restoration paths are “off-network” and must be defined by the
customer;

• ring protection is not provided by the network element;

• there is a fiber cut between rings;

• more efficient usage of spare capacity is desired.

This section describes the provisioning tasks associated with preplan
restoration.
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Cancel a preplan circuit order 3-111

Unlink a preplan pair from a preplan plan 3-112

Unlink a preplan plan from a preplan group 3-113

Delete a preplan plan 3-114

Delete a preplan group 3-115
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Add a preplan circuit
....................................................................................................................................................................................................................................

Purpose Use this procedure to add a preplan circuit. If the service circuit fails,
the associated preplan circuit can be invoked manually or
automatically.

Task Complete the following task to create a preplan circuit that is
reserved for one specific service circuit.
............................................................................................................................................................

1 On the Network Map, select two network element icons.

Result:

The icons become highlighted.

............................................................................................................................................................

2 On the Network Map, select Configuration > Connection > (Desired
Circuit Rate).

Result:

The Provision Profile form is displayed.

............................................................................................................................................................

3 Under the Essentials tab, enter a circuit ID next to where the circuit
rate is displayed.

............................................................................................................................................................

4 Specify an A port and a Z port.

............................................................................................................................................................

5 Under the Parameters tab, specify Order Action as Pre-plan.

............................................................................................................................................................

6 Click OK.

Result:

A preplan circuit is created.
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Assign a preplan circuit to a service circuit
....................................................................................................................................................................................................................................

Purpose Use this procedure to associate a preplan circuit with a service circuit.
By assigning a preplan circuit to a service circuit, you create a
preplan pair.

Before you begin Before you associate a preplan circuit with a service circuit, consider
the following items:

• The service circuit being protected must be in-effect

• The preplan circuit must be in the pending state.

Task Complete the following task to associate a preplan circuit with a
service circuit.
............................................................................................................................................................

1 From the Network Map, select Configuration > Preplan Restore
Management > Preplan Pairs > Add.

Result:

The Preplan Pairs Add form appears.

............................................................................................................................................................

2 In the Service Circuit ID field, enter the service circuit ID.

............................................................................................................................................................

3 In the Preplan Circuit ID field, enter the preplan circuit ID.

............................................................................................................................................................

4 In the Preference field, enter a preference.

............................................................................................................................................................

5 In the Priority field, enter a priority.

............................................................................................................................................................

6 Press Apply.

Result:

An association between the service circuit and the preplan
circuit is created. The preplan circuit now protects the service
circuit.
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Create a preplan plan
....................................................................................................................................................................................................................................

Purpose Use this procedure to create a preplan plan. A preplan plan must be
created before you can assign preplan pairs to it.

Task Complete the following task to create a preplan plan.
............................................................................................................................................................

1 From the Network Map, select Configuration > Preplan Restore
Management > Preplan Plan > Add.

Result:

A window appears.

............................................................................................................................................................

2 In the Preplan ID field, enter a preplan ID.

............................................................................................................................................................

3 Press OK.

Result:

The preplan plan is created. A message appears indicating the
success or failure of the task.
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Assign a preplan pair to a preplan plan
....................................................................................................................................................................................................................................

Purpose A preplan circuit can not be assigned to a preplan plan by itself. It has
to be associated with a service circuit first (becoming a preplan pair),
before it can be assigned to a preplan plan. Use this procedure to
assign a preplan pair to a preplan plan.

Before you begin Before you assign a preplan pair to a preplan plan, the following
conditions must be met:

• The service facility being protected must be in an in-effect (IE)
state.

• The preplan facility must be in a pending state (CPL).

• The preplan pairs must already exist.

Task Complete the following task to assign a preplan pair to a preplan
plan. Note: you can also assign a preplan pair to a preplan plan
through the Preplan Pairs form.
............................................................................................................................................................

1 Create a preplan plan.

............................................................................................................................................................

2 Create a preplan pair by assigning a preplan circuit to a service
circuit.

............................................................................................................................................................

3 Select Configuration > Preplan Restore Management > Preplan
Pairs > Add.

Result:

The Preplan Plan Pairs Add form appears.

............................................................................................................................................................

4 Select a preplan pair.

Result:

The selection becomes highlighted.

............................................................................................................................................................

5 Select Link to Plan.
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Result:

The Plan ID field becomes active.

............................................................................................................................................................

6 Within the Plan ID field, enter a plan ID.

............................................................................................................................................................

7 Press Apply.

Result:

The preplan pair is assigned to the preplan plan. A message
appears indicating the success or failure of the task.
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Create a preplan group
....................................................................................................................................................................................................................................

Purpose Use this procedure to add a preplan group. A preplan group must be
created before you can assign preplan plans to it.

Task Complete the following task to add a preplan group.
............................................................................................................................................................

1 From the Network Map, select Configuration > Preplan Restore
Management > Preplan Group > Add.

Result:

A window appears.

............................................................................................................................................................

2 In the Preplan ID field, enter an ID for the preplan group.

............................................................................................................................................................

3 Press OK.

Result:

The preplan group is created. A message appears indicating the
success or failure of the task.
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Assign a preplan plan to a preplan group
....................................................................................................................................................................................................................................

Purpose Use this procedure to assign a preplan plan to a preplan group.

Before you begin Before you assign a preplan plan to a preplan group, the following
conditions must be met:

• The service facility being protected must be in an in-effect (IE)
state and the preplan facility must be in a pending state (CPL).

• The preplan plan must already exist.

Task Complete the following task to assign a preplan plan to a preplan
group.
............................................................................................................................................................

1 Create a preplan plan.

............................................................................................................................................................

2 From the Network Map, select Configuration > Preplan Restore
Management > Preplan Plan > Display/Modify.

Result:

The Preplan Query Box form appears.

............................................................................................................................................................

3 Press OK.

Result:

The Preplan Plan form appears.

............................................................................................................................................................

4 Select a preplan plan.

............................................................................................................................................................

5 Select Actions > Link Plan to Group.

Result:

The Link Plan to Group form appears.

............................................................................................................................................................

6 For Group ID, enter a valid preplan group ID.

............................................................................................................................................................

7 Press OK.
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Result:

The preplan plan is assigned to the preplan group.
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Restore a service circuit with a preplan circuit
....................................................................................................................................................................................................................................

Purpose Use this procedure to restore service with a preplan circuit.

Task Complete the following task to restore service with a preplan
circuit.
............................................................................................................................................................

1 From the Network Map, select Configuration > Preplan Restore
Management > (select any one of the three preplan types) >
Display/Modify.

Result:

A preplan form appears.

............................................................................................................................................................

2 Select a preplan.

............................................................................................................................................................

3 Select Actions > Reinstate.

Result:

A query window appears.

............................................................................................................................................................

4 Select Yes.

Result:

The Preplan Parameters form appears.

............................................................................................................................................................

5 If desired, specify a value for Reinstatement and Preemption.

............................................................................................................................................................

6 Press OK.

Result:

The preplan circuit restores the service circuit it is associated
with.
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Reinstate a preplan pair
....................................................................................................................................................................................................................................

Purpose Use this procedure to reinstate a preplan pair.

Task Complete the following task to reinstate a preplan pair.
............................................................................................................................................................

1 From the Network Map, select Configuration > Preplan Restore
Management > Preplan Pairs > Display/Modify.

Result:

A preplan form appears.

............................................................................................................................................................

2 Select a preplan pair.

............................................................................................................................................................

3 Select Actions > Reinstate.

Result:

A query window appears.

............................................................................................................................................................

4 Select Yes.

Result:

The Preplan Parameters form appears.

............................................................................................................................................................

5 If desired, specify a value for Reinstatement and Preemption.

............................................................................................................................................................

6 Press OK.

Result:

The preplan pair is reinstated.
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Disassociate a preplan circuit from a service circuit
....................................................................................................................................................................................................................................

Purpose Use this procedure to disassociate a preplan circuit from a service
circuit. You must perform this procedure before you can delete a
preplan pair, preplan plan, or preplan group.

Before you begin Before you disassociate a preplan circuit from a service circuit, the
following conditions must be met:

• The service circuit being protected must be in-effect.

• The preplan circuit must be in the pending state.

• The preplan circuit is associated with a service circuit.

Task Complete this task to disassociate a preplan circuit from a service
circuit.
............................................................................................................................................................

1 Select Configuration > Preplan Restore Management > Preplan
Pairs > Display/Modify.

Result:

The Preplan Pairs query box is displayed.

............................................................................................................................................................

2 Select a preplan pair.

............................................................................................................................................................

3 Select Actions > Delete.

Result:

A confirmation window appears.

............................................................................................................................................................

4 Confirm the confirmation window.

Result:

The preplan pair is dissociated from the service circuit.

Section VI: Preplan Restoration Provisioning Tasks

....................................................................................................................................................................................................................................

3 - 1 1 0 Lucent Technologies 365-309-243
Issue 1, July 2001

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



Cancel a preplan circuit order
....................................................................................................................................................................................................................................

Purpose Use this procedure to cancel a preplan circuit order.

Before you begin Before you cancel a preplan circuit order, consider the following item:

• The preplan cannot be associated with any service paths.

Task Complete the following task to cancel a preplan circuit order.
............................................................................................................................................................

1 From the Network Map, select a service circuit with a preplan
associated with it.

............................................................................................................................................................

2 Right click on either network element icon associated with the circuit.

Result:

The node menu appears.

............................................................................................................................................................

3 Select Assigned Port List.

Result:

The Assigned Port List window appears.

............................................................................................................................................................

4 Press OK.

Result:

A window appears.

............................................................................................................................................................

5 Select a preplan.

............................................................................................................................................................

6 Select Actions > Cancel Order.

Result:

The preplan circuit order is cancelled.
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Unlink a preplan pair from a preplan plan
....................................................................................................................................................................................................................................

Purpose Use this procedure to unlink a preplan pair from a preplan plan.

Task Perform the following steps to unlink a preplan pair from a
preplan plan.
............................................................................................................................................................

1 From the Network Map, select Configuration > Preplan Restore
Management > Preplan Pair > Display/Modify.

Result:

The Preplan Pairs form appears.

............................................................................................................................................................

2 Select a preplan pair.

............................................................................................................................................................

3 Select Actions > Unlink Pair from Plan.

Result:

A window appears.

............................................................................................................................................................

4 For Plan ID, enter the preplan plan ID.

............................................................................................................................................................

5 Press OK.

Result:

A confirmation window appears.

............................................................................................................................................................

6 Confirm the confirmation.

Result:

The preplan pair is unlinked from the preplan plan.
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Unlink a preplan plan from a preplan group
....................................................................................................................................................................................................................................

Purpose Use this procedure to unlink a preplan plan from a preplan group.

Task Perform the following steps to unlink a preplan plan from a
preplan group.
............................................................................................................................................................

1 Ensure that there are no preplan pairs linked to the preplan plan.

............................................................................................................................................................

2 From the Network Map, select Configuration > Preplan Restore
Management > Preplan Plan > Display/Modify.

Result:

The Preplan Plan form appears.

............................................................................................................................................................

3 Select a preplan plan.

............................................................................................................................................................

4 Select Actions > Unlink Plan from Group.

Result:

A window appears.

............................................................................................................................................................

5 For Group ID, enter the preplan group ID.

............................................................................................................................................................

6 Press OK.

Result:

A confirmation window appears.

............................................................................................................................................................

7 Confirm the confirmation.

Result:

The preplan plan is unlinked from the preplan group.
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Delete a preplan plan
....................................................................................................................................................................................................................................

Purpose Use this procedure to delete a preplan plan.

Before you begin Before you delete a preplan plan, consider the following item:

• The preplan circuits included in the preplan plan cannot be
associated with any service paths.

Task Complete the following task to delete a preplan plan.
............................................................................................................................................................

1 Ensure that any preplan pairs are unlinked from the preplan plan.

............................................................................................................................................................

2 Select Configuration > Preplan Restore Management > Preplan
Plan > Display/Modify

Result:

The Preplan Plan query box is displayed.

............................................................................................................................................................

3 Select a preplan plan.

............................................................................................................................................................

4 Select Actions > Delete.

............................................................................................................................................................

5 Click OK.

Result:

The preplan plan is deleted.

Section VI: Preplan Restoration Provisioning Tasks

....................................................................................................................................................................................................................................

3 - 1 1 4 Lucent Technologies 365-309-243
Issue 1, July 2001

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



Delete a preplan group
....................................................................................................................................................................................................................................

Purpose Use this procedure to delete a preplan group.

Before you begin Before you delete a preplan group, consider the following item:

• The preplan circuit included in the preplan group cannot be
associated with any service paths.

Task Complete the following task to delete a preplan group.
............................................................................................................................................................

1 Ensure that there are no preplan plans associated with the preplan
group.

............................................................................................................................................................

2 Select Configuration > Preplan Restore Management > Preplan
Plan Group > Display/Modify.

Result:

The Preplan Group query box is displayed.

............................................................................................................................................................

3 Select a preplan group.

............................................................................................................................................................

4 Select Actions > Delete.

............................................................................................................................................................

5 Click OK.

Result:

The preplan group is deleted.
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4 Provisioning Concepts

Overview
....................................................................................................................................................................................................................................

Purpose This chapter provides conceptual material related to network elements,
digital links, connections, optical layers, subnets, and preplan
restoration with WaveStar NMS. This material supplements the
task-related information presented in the previous chapters.

Contents
Section I: Network Elements 4-3

Controlled network elements 4-4

Noncontrolled network elements 4-5

Section II: Digital Links 4-6

Provisioning concepts 4-7

Protection concepts 4-12

Section III: Connections 4-14

Provisioning concepts 4-15

Circuit provisioning concepts 4-16

Trail provisioning concepts 4-22

AU3-AU4 adaptation feature for the WaveStar
BandWidth Manager

4-35

Work order record document concepts 4-38

....................................................................................................................................................................................................................................

365-309-243
Issue 1, July 2001

Lucent Technologies 4 - 1

4-38

4-35

4-22

4-16

4-15

4-14

4-12

4-7

4-6

4-5

4-4

4-3



Section IV: Optical Layers 4-39

Application concepts 4-40

Provisioning concepts 4-41

Section V: Subnets 4-48

General provisioning concepts 4-49

Subnet creation 4-52

Line-switched rings 4-56

Path-switched rings 4-62

Synchronous line multiplexer rings 4-64

Protection protocol 4-65

Subnet deletion 4-66

Section VI: Preplan Restoration 4-67

How WaveStar NMS manages restoration 4-68

Aspects of preplan restoration 4-70

Preplan creation 4-75

Association of a preplan to a service circuit 4-81

Preplan plans and preplan groups 4-85

Execution concepts 4-87

Preemption concepts 4-89

Reinstatement concepts 4-91

Overview Provisioning Concepts

....................................................................................................................................................................................................................................

4 - 2 Lucent Technologies 365-309-243
Issue 1, July 2001

4-91

4-89

4-87

4-85

4-81

4-75

4-70

4-68

4-67

4-66

4-65

4-64

4-62

4-56

4-52

4-49

4-48

4-41

4-40

4-39



Section I: Network Elements

Overview
....................................................................................................................................................................................................................................

Purpose This section provides conceptual information for controlled and
noncontrolled network elements.
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Controlled network elements
....................................................................................................................................................................................................................................

Definition Controlled network elements are network elements that can be
controlled by WaveStar NMS.

Characteristics Controlled network elements have the following characteristics:

• They are displayed on the Network Maps as nodes (physical
locations) interconnected by digital links. A unique icon
represents each network element type.

• They are in constant communication with their EMS.

• They are controlled by commands sent from the EMS. (The EMS
receives and processes the responses from the controllable
network element.)

• They report and show alarms.

Control techniques Controlled network elements may be controlled:

• Directly, by ITM-XM

• Indirectly, through the ITM-SC or WaveStar SNMS

Additional information For additional information about controlled network elements, refer to
Chapter 3 of the WaveStar NMS 4.0 Applications and Planning
Guide .
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Noncontrolled network elements
....................................................................................................................................................................................................................................

Definition Noncontrolled network elements are network elements that cannot be
controlled by WaveStar NMS.

Characteristics Noncontrolled network elements:

• Support only manual provisioning

• Do not report alarms

• Are listed in the database as part of provisioning records

List of noncontrolled
network elements

There are two noncontrolled network elements:

• Black box

• Customer equipment

Additional information For additional information about noncontrolled network elements,
refer to Chapter 3 of the WaveStar NMS 4.0 Applications and
Planning Guide .
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Section II: Digital Links

Overview
....................................................................................................................................................................................................................................

Purpose This section describes the provisioning concepts associated with
digital links supported by WaveStar NMS.

Contents
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Provisioning concepts
....................................................................................................................................................................................................................................

Overview Digital Links are transport facilities that are assignable to high order
and low order digital links to carry customer services. In WaveStar
NMS, digital links are always modelled as bidirectional links that will
carry two way traffic. Digital Links are of two types - SDH/SONET
and PDH.

SDH digital links are synonymous with multiplexer sections, in SDH
standard terminology, that connect two SDH network elements or
black boxes/equipment. In WaveStar NMS, the regenerator sections
within the multiplexer section layer are not explicitly provisioned;
however the WaveStar NMS will be able to add regenerators to the
digital links and monitor alarms at regenerator sections. The similar
rules/applications using SONET terminology/network elements applied
to SONET digital links.

PDH digital links are physical links that connect two PDH ports of
SDH network elements or black boxes/equipment. Except for LAN8
(a.k.a.TransLAN) (SDH), VACTDL (a.k.a. TransLAN+) (SDH) and
GigaLanDL (SDH/SONET), all digital links are channelized in
WaveStar NMS in order to be able to be assigned to carry SDH trails
or PDH circuits.

Digital links can be unprotected or protected. When protected by
another link, it is called Multiplex Section Protection (MSP). The
MSP protection can be of two types - 1+1 or 1x1. When MSP is 1+1,
the protection link is totally dedicated to the working (service) link
and cannot carry preemptible extra traffic. When MSP is 1x1, the
protection link serves as a protection to the working (service) link but
can be configured to carry extra traffic that is preemptible when the
traffic in the working link gets switched.

Provisioning order action There are basically three order types for any digital link - Add (order
action=A), In-effect (order action=IE) and Delete (order action = D).
There are several order actions for any digital link - A = Add, D =
Disconnect, R = Rearrange, IE = In-Effect, RS = Restoration, RI =
Reinstatement, PP = Pre-Plan.

The “Add” order is used when the digital link is first added in to the
network from WaveStar NMS. This means that port provisioning
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commands will be generated and sent to the EMS for putting the ports
in-service, if they are not already in-service.

The “In-Effect” order is used when the digital link is already put
in-service through the EMS or from a local craft terminal and needs
to be inventoried in WaveStar NMS. Since the digital link is already
provisioned, the appropriate provisioning commands are used by the
EMS to verify that the ports are put “in-service” and the MSP
protection (when specified) exists. The “In-Effect” digital link may or
may not be carrying any higher order trails.

The “DeleteDisconnect” order is used to delete the digital link from
WaveStar NMS database although the link can still physically exist
with the terminations. During the “DeleteDisconnect” order,
commands are generated and send to the EMS to put the ports
“out-of-service”. In WaveStar NMS, the “DeleteDisconnect” order will
not be processed if there are any “in-effect” or “pending” higher order
trails or PDH circuits that are provisioned on any of the channels of
the digital link.

The “Rearrange” order is used when changing any components (e.g.
facilities/channel, A port, A location, Z port, Z location) on the layout
of an In-Effect facility/circuit. The “Restoration” order is used when
rerouting an IE facility/circuit onto an alternate path.

The “Reinstatement” order is used when reinstating a facility/circuit
that was previously restored back to its original service path.

The “Pre-Plan” order is used when restoring the failed facility
including each of the affected circuits over to the pre-planned route.
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Creation of channel
termination records

Depending on the type of digital link and the terminating network
element type, WaveStar NMS creates Channel Termination records
with a fixed number of channels depending on the channel type
specified by the WaveStar NMS during provisioning. In the case of
SDH digital links, the channel types can be either VC4-4c, VC4-16c,
VC4 or AU3. When a network element supports multiple higher order
cross-connect rates, complementary channels are created to give the
flexibility to the user to provision any of those higher order trails
without having the need to re-provision the digital link with other
channel types. The creation of complementary channels is determined
by the capability of the network element(s) that terminate the digital
link. Such network element specific capability data is stored in
WaveStar NMS. In general, an STM-n digital link (where n=0,1,4,16
or 64) will have 3*n AU3 channels (except for n=0 where it will have
one AU3 channel) or n VC4 channels. For PDH links, the channel
type depends on the rate and the terminating port characteristics. For
example, a CEPT-1 digital link will have one C1 channel to carry a
CEPT-1 circuit. A CEPT-3 digital link can have either one C3 channel
or 16 C1 channels depending on the network element type.

Provisioning of STM-n
digital links

Adding regenerators during STM-n digital link provisioning:
WaveStar NMS allows user to add regenerators of appropriate type to
STM-1 (only for NERA Regenerators), STM-4 and STM-16 digital
links during provisioning. No regenerators shall be allowed to be
added for STM-0 or STM-1 or 2.5GB digital links except for STM-1
digital links terminating on NERA Radio terminals. When adding
regenerators to digital links, the user is required to enter the port
addresses for the east and west sides. No validation is made in
WaveStar NMS whether the east and west sides are correctly chosen
by the user, however, the rate shall be compatible as the rate of the
digital link terminating on regenerators. No provisioning commands
are generated for the regenerators when they are either added or
removed from a digital link. However, the layout of the digital link
shall be updated to reflect the addition or deletion of regenerators.

Deleting regenerators from a digital link : user can delete the
regenerators from an “in-effect” digital link. Deleting a regenerator
from a digital link shall only remove the regenerator from the digital
link layout and shall not delete it from WaveStar NMS, e.g. from
Location Reference Table.
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Creation of alternate channel types for STM-n digital links:
depending on the capability in both the terminating network elements
based on the cross-connect rates as listed in Table 2, the channel types
of AU3, V4, V4-4c and V4-16c shall be created for STM-n digital
links as specified in the table below. When more than one channel
type is created based on the network element support, the channels
created are considered as alternate channels.

Provisioning of unprotected STM-64 digital links: users can
provision a regular unprotected STM-64 digital link between two
network elements which both supporting STM-64 (e.g. between two
BWMs, or between a BWM and a TDM 10G, or between a BWM
and a black box, or between two black boxes, etc.). The provisioning
of unprotected STM-64 digital link shall be denied if WaveStar NMS
discovers from SNMS, a Protection Group is already formed on either
of the two (A or Z) ports.

Provisioning of PDH
digital links

Provisioning of unprotected E4 (CEPT-4) digital links: users can
provision an unprotected E4 (CEPT-4) digital link between two 140
Mb/s ports of two network elements or between a 140 Mb/s port of an
network element and a Black Box or Equipment.

Provisioning of unprotected E3 (CEPT-3) digital links: users can
provision an unprotected E3 (CEPT-3) digital link between two 34
Mb/s ports of two network elements or between a 34 Mb/s port of an
network element and a Black Box or Equipment.

Provisioning of unprotected E1 (CEPT-1) digital links: users can
provision an unprotected E1 (CEPT-1) digital link between two 2
Mb/s ports of two network elements or between a 2 Mb/s port of an
network element and a Black Box or Equipment.

Provisioning of unprotected DS-3 digital links: users can provision
an unprotected DS-3 digital link between two 45 Mb/s ports of two
network elements or between a 45 Mb/s port of an network element
and a Black Box or Equipment.

Provisioning of unprotected DS-1 digital links: users can provision
an unprotected DS-1 digital link between two 1.5 Mb/s ports of two
network elements or between a 1.5 Mb/s port of an network element
and a Black Box or Equipment.

Provisioning of PCT digital links : users can provision a PCT digital
link between a PCT port of an ISM-5E network element and a Black
Box (which is used to represent a 5ESS switching system). The PCT
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digital link is inherently always protected and therefore the ‘MSP”
field in the provisioning screen shall always be set to “1+1” and the
MSP Switch Type shall be set to “BI” (bidirectional).

Channel termination creation for PDH links: a channel termination
record is created for every provisioning of a PDH link. There are no
alternate channels that are required for PDH digital links. The
following table summarizes the type and number of channels that shall
be created.
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Protection concepts
....................................................................................................................................................................................................................................

Multiplexer section
protection (MSP)

Multiplexer Section Protection provides protection of service for
STM-n (N=0, 1, 4, 16 or 64), digital links in case of a fiber cut or a
failure. The protection is provided by grouping two physical fibers
(both bidirectional) in to a MSP group. The MSP grouping of the two
ports is performed at each network element where the two fibers
terminate. There are two types of MSP protection - 1+1 MSP and 1x1
MSP. Each type is described in the following two sections.

1+1 MSP protection is supported by most of the network elements
that support provisioning of unprotected STM-n digital links (except
for 2.5 GB digital link). In the case of 1+1 MSP protection, one
worker digital link is protected by a protection digital link and they
are both grouped with one trail ID. In some network elements, the
MSP protection group has to be previously formed from the EMS
before it can be provisioned from WaveStar NMS. Also, in some
network elements the port address for a MSP protected digital link
takes the form a “group address” that always represents the ports in
adjacent physical slots. Where “group address” is not supported by
some network elements, any two physical port with the same rate can
be combined to form a MSP protection, in which case, the WaveStar
NMS allows the user to enter the working and protection port
addresses separately. Depending on the network element support, there
are three types of MSP switch types that can be provisioned on a 1+1
MSP protected digital link. The three switch types are - UNI
(unidirectional), BI (bidirectional) or NTT (a variation of
bi-directional switching for Japanese customers).

Adding Regenerators to 1+1 MSP protected STM-n (n=4 or 16)
digital link: users can add regenerators of appropriate type to the 1+1
MSP protected STM-4 or STM-16 digital link during provisioning.
The user shall be able to add regenerators for working and protection
links separately. Certain regenerators can accept up to two inputs and
two outputs in which case, the same regenerator could be used in both
the working and protection links. The user shall be able to delete the
regenerators from an “in-effect” digital link. No provisioning
commands are generated for the regenerators when they are either
added or removed from a digital link. However, the layout of the
digital link shall be updated to reflect the addition or deletion of
regenerators.
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1x1 MSP Protection on STM-n (n=16 or 64) digital links: the
Bandwidth Manager supports 1x1 MSP protection for STM-n (n=16
or 64 in WaveStar NMS Rel. 1.0) digital links. 1x1 MSP protection is
different from 1+1MSP protection that is well known to the WaveStar
NMS user in the previous releases. In 1x1 MSP protection scheme,
one digital link will protect one service digital link. In the case of 1x1
MSP protected digital link, the protection link can carry extra traffic
that will be preemptible when the MSP switching takes place. Because
of this, both the service and protection links of the 1x1 MSP have to
be separately identified with Digital Link IDs. The Protection Digital
Link must be created first and associated with a unique Protection
Group Name before any of the service digital links are created and
associated.
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Section III: Connections

Overview
....................................................................................................................................................................................................................................

Purpose This section describes the provisioning concepts associated with
connections.

Contents
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4-35
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Provisioning concepts
....................................................................................................................................................................................................................................

Overview A circuit/trail is a concatenation of digital links and cross-connects
used to provide an end-to-end service to a customer. A circuit/trail is
identified by a rate at which the service is provided. The “rate” of a
circuit/trail is defined by the ITU and ETSI standards for SDH and
PDH circuit/trails and by ITU and ANSI standards for SONET and
Asynchronous circuit/trails. An SDH/SONET trail is provisioned over
the SDH/SONET link connections and over SDH/SONET
cross-connects in WaveStar NMS managed network elements. It is
possible that the link connections (SDH/SONET) may go through an
optical layer. In general, a PDH/Asynchronous circuit is provisioned
on SDH/SONET trails. With the “One-Step (Combo) Provisioning”
feature in WaveStar NMS, it is possible to provision both SDH trails
and PDH circuits or SONET/trails and Asynchronous circuits in a
single provisioning step.

A trail is often referred as a path. A trail can be assignable or
non-assignable depending on the terminating port or based on the
sub-structuring of the port to carry lower order traffic. In WaveStar
NMS, if one or both end ports of a trail are PDH/Asynchronous, or if
one or both end ports are sub-structured to carry lower order traffic,
the trail is called an “assignable” entity. If both end ports are
SDH/SONET and not sub-structured to carry low order traffic, then
the trail is called as an “non-assignable” entity. Certain trails, such as
VC4-4c, VC4-16c and VC2, are always non-assignable. WaveStar
NMS creates channels for assignable trails in order to carry the low
order trails or PDH/asynchronous circuits.

Circuit/Trail Provisioning
Modes

Users can provision a circuit/trail in one of the three modes - auto,
manual or partial. In the “auto” mode, the WaveStar NMS shall find a
route from the user specified end ports for the trail and present it to
the user for approval, if requested. The routing requirements are
specified in another document. In the “manual” mode, the WaveStar
NMS user shall be able to select each link and a channel in the
selected link along the path and WaveStar NMS shall build the layout
based on the user selection(s). In the “partial” mode, the WaveStar
NMS user will pick all the links along the path of the circuit/trail. The
channels within the link shall be picked by WaveStar NMS.
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Circuit provisioning concepts
....................................................................................................................................................................................................................................

Overview This section describes the provisioning concepts associated with the
different circuits supported by WaveStar NMS.

One-step provisioning WaveStar NMS supports the provisioning of the following one-step or
simple combo circuits:

• VC3S-672N

• VC4S-1920N

• VC3S-480N

• VC12S-30N

• TU12-VC11S-24N

• AU3S-672N

Note

Please note the following items with regards to one-step provisioning:

• One-step provisioning is an option that is selected at installation
time.

• The selection of either VC12S-30N, VC3S-480N, VC3S-672N or
VC4S-1920N for provisioning is a selection for 30N, 480N,
672N, or 1920N provisioning. However, one-step provisioned
paths/circuits have the characteristic of the SDH (Skipped SDH)
circuits/paths. As such, they possess performance monitoring,
path trace identifier, fault management, and pre-plan
characteristics.

• 30N, 480N, 672N, and 1920N are no longer available for
provisioning to ensure the mutual exclusivity of one-step and
traditional provisioning.

• If a free-format circuit ID is used, the circuit type for one-step
provisioned circuits can be: VC12S-30N, VC3S-480N,
VC3S-672N, VC4S-1920N, TU12-VC11S-24N, or AU3S-672N.

• A one-step provisioned path/circuit can terminate on either an
SDH or PDH port. However, both ends of the path/circuit cannot
be SDH.

- In the case of an SDH termination, the ports will be derived
from the STM-N link on which the circuit is riding.

- In the case of a PDH termination, the port is the appropriate
PDH port.
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• A one-step provisioned circuit can cross or ride SDH links only
and cannot cross or ride on PDH links.

• No PDH bridges are allowed when merging one-step provisioned
paths/circuits.

Provisioning of PDH
circuits

CEPT-4 (E4) : users can provision an unproteced two way or one way
CEPT-4 (E4) circuit that rides on a two way or a one way VC-4 trail.
Since the CEPT-4 circuit rides on a VC-4 trail, the end nodes and the
originating and terminating port addresses of the CEPT-4 circuit shall
be the same as VC-4 trail. In the “auto” mode, if the two ends of the
CEPT-4 circuit do not coincide with the VC-4 trail terminations, then
WaveStar NMS shall find a route using the C4 channels of CEPT-4
digital links or C4 channels of a VC-4 trail. No broadcast CEPT-4
circuit provisioning is allowed from WaveStar NMS. Currently, there
are no parameters that are required to be set at the 140 Mb/s port(s)
for the CEPT-4 circuits.

CEPT-3 (34 Mb/s): users can provision an unproteced two way or one
way CEPT-3 (E3) circuit that rides on a two way or a one way VC-4
trail. Since the CEPT-3 circuit rides on a VC-3 trail, the end nodes
and the originating and terminating port addresses of the CEPT-3
circuit shall be the same as VC-3 trail. In the “auto” mode, if the two
ends of the CEPT-3 circuit do not coincide with the VC-3 trail
terminations, then WaveStar NMS shall find a route using the C3
channels of CEPT-3 digital links or C3 channels of a VC-3 trail.
Currently, there are no parameters that are required to be set at the 34
Mb/s port(s) for the CEPT-3 circuits.

DS-3 (45 Mb/s): users can provision an unproteced two way or one
way DS3 (D3) circuit that rides on a two way or a one way VC-3
trail. Since the DS-3 circuit rides on a VC-3 trail, the end nodes and
the originating and terminating port addresses of the DS-3 circuit shall
be the same as VC-3 trail. In the “auto” mode, if the two ends of the
DS-3 circuit do not coincide with the VC-3 trail terminations, then
WaveStar NMS shall find a route using the D3 channels of DS-3
digital links or D3 channels of a VC-3 trail. For DS-3 circuit
provisioning, the WaveStar NMS user shall be able to specify a new
parameter “Frame Format” in the provisioning screen. The valid
values for the Frame Format field are “cbit” and “unframed”.

CEPT-1 (2 Mb/s): users can provision an unproteced two way or one
way CEPT-1 (E1) circuit that rides on a two way or a one way VC-4
trail. Since the CEPT-1 circuit rides on a VC-12 trail, the end nodes
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and the originating and terminating port addresses of the CEPT-1
circuit shall be the same as VC-12 trail. In the “auto” mode, if the
two ends of the CEPT-1 circuit do not coincide with the VC-12 trail
terminations, then WaveStar NMS shall find a route using the C1
channels of CEPT-1 digital links or C1 channels of a VC-12 trail. The
existing CEPT-1 (E1) circuit (30N) provisioning capabilities shall be
extended to support AM1PLUS.

Broadcast Circuit Provisioning: broadcast circuits are provisioned in
a network where one source signal needs to be sent to multiple end
users, as in video broadcast. To support this capability, many network
elements provide broadcast type cross-connects where one source port
can be cross-connected to more than one destination port in the same
network element. In WaveStar NMS, broadcast circuit provisioning is
supported by provisioning first a back bone circuit from which each
of the broadcast legs can be provisioned. The back bone circuit and
each broadcast leg will have its own circuit ID. However, they are all
linked together by a “broadcast family” name. This “broadcast family”
name is used in WaveStar NMS to identify a set of circuits that derive
the same source signal from a back bone. It also enables the WaveStar
NMS user to be able to display the complete broadcast circuit along
with the broadcast legs. A broadcast leg can be provisioned from a
back bone circuit or from another broadcast leg. All broadcast circuits
are non-assignable.

Circuit ID Supported
formats

This section describes the circuit ID, which is a unique identifier of a
circuit. At installation time, the user can select one of two formats for
circuit ID: user-defined free-format or M.1400.

User-defined free-format

The user-defined free-format circuit ID has the following
characteristics:

• 83 characters in length

• allowable characters include:

- alphanumeric characters (The character string is
case-sensitive and both upper- and lower-case characters are
allowed.)

- Forward slash /

- dash -

- underscore _
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- period

- blank

• Tabs are not allowed.

• The syntax of the format is: <A Location> <Z Location> <Type>
<ID Number>

An example of a user-defined free-format circuit ID is: NY1 NY2
VC4S 0001.

M.1400-specification format

The M.1400 specification. The format consists of four sub-fields:

• The A Location of the path or circuit

• The Z Location of the path or circuit

• The Type of the path or circuit

• The Identification Number of the path or circuit.

Note that the A Location value will alphabetically precede the Z
Location value by default only if the variable to swap network
elements are set up at installation.

Broadcast circuit
provisioning

This section discusses broadcast provisioning. The following design
rules apply to broadcast circuit provisioning:

1. Backbone circuits can be Protected or Unprotected.

2. Tributary circuits can be protected or unprotected.

3. User must specify the source of transmission as either A or Z.

4. The A or Z end of your circuit is determined by the alphabetic,
sub-numeric designation of the end Nodes. The A end is the
Node that comes first alphabetically. If two identical alphabetic
designations are used, then the A end will be the one with the
lowest numerical designation following the alphabetic
designation.

5. The following must be done when provisioning a broadcast
circuit:

• Specify the type of circuit as Broadcast for the backbone
and tributary circuits.

• Specify a Broadcast Family name to associate the various
tributary circuits and associated backbone.
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• Use manual route selection.

• Manually specify both the service and protection paths.

6. Only one-way circuits are supported for Broadcast Circuits. If the
network elementselected can only put up a two way
cross-connection, then the return path is not connected to
anything. This may result in a Loss of Signal alarm that should
be ignored.

7. Broadcast Circuits cannot be:

• Modified

• Restored

• Rearranged

• Merged

• Changed from protected to unprotected or from unprotected
to protected.

8. For the first leg (backbone), the user must specify the Path Trace
Identifier (PTI). This will be applied to all subsequent circuits by
the processor.

9. The first circuit built to a customer’s site must contain the
backbone. If this subscriber disconnects, then the backbone and
all tributaries must be disconnected. To avoid this restriction, you
could build the first circuit to a location that will never be
disconnected unless the entire broadcast family is disconnected.

10. Although backbones cannot be modified or extended, they can be
added to by adding additional backbones (new circuits) fed from
the original backbone.

Important Note: WaveStar NMS does not support the provisioning of
an unprotected broadcast circuit on an ADM4/1 STM4 network
element.

Disconnecting a broadcast
circuit

Before attempting to disconnect a broadcast circuit, note the
following:

• A backbone circuit cannot be disconnected unless all it’s
tributaries or other backbones it is feeding are disconnected first.

• Backbones circuits and tributaries can be disconnected in the
normal manner as any other circuit.
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One-way circuits With regards to provisioning, one-way circuits can be provisioned
only in the manual mode through the network elements listed in Table
6-1.

Note that one-way circuits cannot be provisioned:

• Through the SLM and ADM16/1 network elements

• In a manner in which the circuit starts and stops in the same port
of the same network element (loopback configuration).

Protection: With regards to protection, one-way circuits can be
protected or unprotected with ring protection or 1+1 protection.
One-way circuits cannot be modified from protected to unprotected, or
from unprotected to protected.

Merging: With regards to merging, one-way and broadcast circuits
cannot be merged.

Delete history Whenever a circuit is rearranged, the data from the previous circuit is
retained in the WaveStar NMS database. A circuit that has been
rearranged several times accumulates a large amount of history
information. The Delete History script retains only the necessary
history data associated with each circuit, and deletes all unnecessary
history data from the database.

The Delete History script consists of two parts:

• A script that automatically runs once, when upgrading the
database. If you need to refer to any circuits listed in the history
that are not the most recent non-RS, non-RI circuits, you should
print out these circuits before upgrading the database. The Delete
History script will delete these circuits from the history during
the upgrade.

• A daily script execution that runs immediately following each
successful daily backup.
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Trail provisioning concepts
....................................................................................................................................................................................................................................

Overview This section describes the provisioning concepts associated with the
different paths supported by WaveStar NMS.

VC-3 A VC-3 path can carry a clear DS3(45Mb/s) circuit or a CEPT-3. The
network elements that support this path type are:

• ADM-16/1

• ADM-4/1

• LXC-16/1

• LXC-4/1

• ADM-155E

• PHASE network elements.

• WaveStar DACS (R2.0)

• DACS VI (R2.1)

Fixed Multiplexing

Only bidirectional paths and circuits can ride on a VC-4 with fixed
multiplexing. The port address of the VC-3 (fixed multiplexing) is
derived from a VC-4 port address and is in the form of
D3/x/y/z-[1-3]. More specifically, this fixed multiplexing applies only
to the WaveStar ADM16/1 and the following PHASE network
elements:

• ADM-16/1

• ADM-16/4

• ADM-4/4

• TM-16/4

• TM-4/4

Ports

A VC-3 path may terminate on 45-Mb/s ports, in addition to the
logical ports of an STM-n and a 34-Mb/s ports.

The Automatic Path Selection mode is applicable only to the two way
VC-3 path terminating on a 45-Mb/s port.

The VC-3 path layout riding on a VC-4 and terminating on the 45
Mb/s port on either a 45 Mb/s card or 34/45-Mb/s card that has fixed
multiplexing will have only one port per node.
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The following are new additions to the allowed combinations of
terminating ports:

• Either both ports are 45-Mb/s or one is 45-Mb/s and the other
one is a logical port derived from an STM-n physical port. The
AZ and ZA PTIs and PTI mismatch detection mode are
applicable to a VC-3 path terminating on a 45-Mb/s port.

• A VC-3 path cannot terminate on a 45-Mb/s port at one end and
a 34-Mb/s port at the other end.

Order Actions

The following order actions are available for a VC-3 path terminating
on a 45-Mb/s port:

• Add

• In-effect

• Rearrange

• Restoration

• Pre-plan

• Reinstatement

• Disconnect

Channels Carried

A VC-3 path may carry either a D3 or a C3 channel, depending on
the terminating ports. A D3 channel is valid for a VC-3 path only if
the path terminates either on both 45-Mb/s ports or on a 45-Mb/s and
on a logical port derived from an SDH physical port. A VC-3 path
with D3 channel will carry a 672N circuit.

Transmission Type

The transmission type for a VC-3 path terminating on a 45-Mb/s port
can be:

• One-way

• Two-way

• Broadcast
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Transmission Constraints

• Only two-way transmission is supported by the WaveStar
ADM16/1.

• The specific network element known capabilities, PHASE
network elements that are ADM-16/4, ADM-4/4, TM-16/4,
TM-4/4 do not support the one-way and broadcast VC-3 path.

Protection

A VC-3 path terminating on a 45-Mb/s port can be protected or
unprotected. If the VC-3 path is protected, then all existing protection
types are supported. This is limited only by the specific network
element capabilities (in addition to the transmission type limitations).
WaveStar DACS and DACS VI -2000 do not support protected path.
Also, a switch status and switch requests are possible and are
available on all ports where a 1+1 protected cross-connect exists.

Mismatch Detection Mode

The AZ and ZA PTIs and PTI mismatch detection mode are
applicable to a VC-3 path terminating on a 45-Mb/s port.

VC-4 VC-4 paths ride on STM-1 Digital Links and can be provisioned
between:

• SLM-4 Tributary Port and SLM-4 Tributary Port (can be used to
interconnect two SLM-4 digital rings)

• SLM-4 Tributary Port and SLM-16 Tributary Port (can be used to
interconnect an SLM-4 digital ring and an SLM-16 digital ring)

• SLM-16 Tributary Port and SLM-16 Tributary Port (can be used
to interconnect an SLM-16 digital ring and an SLM-16 digital
ring)

• ADM4/1 or ADM-155E Tributary Port and ADM4/1 or
ADM-155E Tributary Port

• ADM4/1 or ADM-155E Tributary Port and SLM-4 Tributary Port

• ADM4/1 or ADM-155E Tributary Port and SLM-16 Tributary
Port

• ADM4/1 or ADM-155E Tributary Port and DSX, EQPT, or Black
Box.

VC-4 Paths can traverse SLMs.
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Ring Protection

The ring protection for A VC-4 path can be as follows:

• May be ring-protected if they are either non-assignable or has
only one channel.

• May not be ring-protected if they are terminating on an ADM4/1
or ADM155E.

Channel Type

VC-4 Paths can be structured or clear channel. For VC-4 Paths
terminating on ADM4/1 or ADM155E multiplexers, channel type C4
should not be allowed.

VC4-4C Information to be provided.

VC-12 VC-12 Paths ride on channels of structured VC-4 Paths and can. for
example, be provisioned on VC-4 Paths between:

• SLM-4 Tributary Port and SLM-4 Tributary Port (can be used to
interconnect two SLM-4 digital rings)

• SLM-4 Tributary Port and SLM-16 Tributary Port (can be used to
interconnect an SLM-4 digital ring and an SLM-16 digital ring)

• SLM-16 Tributary Port and SLM-16 Tributary Port (can be used
to interconnect an SLM-16 digital ring and an SLM-16 digital
ring)

• ADM4/1 or ADM-155E Tributary Port and ADM4/1 or
ADM-155E Tributary Port

• ADM4/1 or ADM-155E Tributary Port and SLM-4 Tributary Port

• ADM4/1 or ADM-155E Tributary Port and SLM-16 Tributary
Port

• ADM4/1 or ADM-155E Tributary Port and DSX, EQPT or Black
Box.

• VC-4 Paths can traverse any of the following:

- SLMs

- ADM4/1

- ADM-155E
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Ring Protection

VC-12 paths can be ring protected through the following:

• Transmission Restriction: for VC-4 Paths terminating on ADM4/1
or ADM-155E multiplexers, one-way transmission will not be
allowed.

• Line Switched Ring (LSR): when a failure occurs, an LSR loops
back switched lines to restore service. As an example, SLMs
employ LSRs.

• Path Switched Ring (PSR): when a failure occurs, a new path
around the ring is taken. As an example, ADM4/1 network
elements employ PSRs.

• Fixed Cross-connect: cross-connections are pre-determined by
vendor; no commands are sent from WaveStar NMS.

• Digital Cross-Connect System (DXC): a generic term for
electronic cross-connect systems.

Y-protected paths Y protection is a variation of the 1+1 protected path if a portion of
the path goes beyond the WaveStar NMS-managed domain.

The Digital Link/Facility/Circuit Profile Form allows a choice
between Open A and Open Z protection types. Restrictions of Y
protection are:

• The open end cannot be on both the A and Z terminations of a
path.

• For one way transmission, the Protected Port cannot be on the
receiving side where the service and protecting paths converge.
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The following figure shows an example of the supported and
non-supported configurations for one-way Y protection.

Auto routing Auto is one type of routing offered by WaveStar NMS. The following
items apply to auto routing:

• If “Efficient Channel Use” has been installed, and if the ring is
path switched, then when you specify the A Location and Port
and the Z Location and Port, the system automatically chooses a
route based on the available spare capacity between the specified
points.

• If “Efficient Channel Use” has been installed, and if the ring is
line switched, the system attempts to fill up lower channels
around the ring before attempting to use the next channels within
a segment.

Figure 4-1 Supported/Not Supported One-way Y-protection
Configurations

Supported
Protected port is on the transmit side

(one-way transmission)

Not Supported
Protected port is on the receiving side

(one-way transmission)

Protected Port Protected Port

Protected Port

A and Z Open Ended on both sides

Protected Port

Protected Port

Z open end

Z open endA open end

A open end
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• Auto route selection does not work for Open_Ended_Z paths that
are provisioned using one PDH port and two SDH ports, with
one SDH port on the same network element, and the other on the
second network element. Since a channel is in the protection
segment and not in the service segment, the service path
terminates on the single node. The workaround solutions are:

- To reverse the protection segment to the service segment
and include the channels in the service segment instead of
the protection segment

- To use manual path selection instead of auto path selection

The following figure shows an example of this solution.

Manual routing Manual is one type of routing offered by WaveStar NMS. The
following items apply to manual routing:

• In addition to specifying the A/Z Location and Port, theuser must
specify each link, facility, and channel on each facility along the
path. Only manual route selection is allowed for one-way and
broadcast paths.

Partial routing Partial is one type of routing offered by WaveStar NMS. The
following items apply to partial routing:

• In addition to specifying the A/Z Location and Port, theuser must
specify each link along the path. The user also has an option to
additionally specify a facility and a channel on each facility
along the path. As a minimum, each link along the path must be
specified.

Open Ended Z Path:

Workaround:

P1
S1

S1 S1
P1

S1

ZA

P1

S1

svc

prot

svc

prot

S1

P1
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Path trace ID Important! SLM and ADM155C network elements only support
specific string mode and not the non-specific byte mode.

With routing, the user must enter the path trace ID (PTI) for all circuit
types. The user can enable or disable the PTI mismatch detection
mode independently from setting the PTI to specific string or to a
non-specific mode.

Path Trace ID cannot be left blank when provisioning any type of VC
circuit. If the user intends to leave the Path Trace ID blank, the user
must enter the word NONE (in capitals). Additionally, if the user
wants to send a string of zeros as the Path Trace ID, the user must
enter NULL (in capitals).

The following figure shows an example of how PTIs are applied.

VC4–16C (AU4–16C) WaveStar NMS supports the provisioning of VC4-16c trails using
STM-N (N = 16 or 64) subject to the capabilities of the network
element involved. All the network elements in the VC4-16c is
“non-assignable”. The VC4-16c trail can be one way, two way or
broadcast type.

Co-existence support: the system supports co-existence of VC4-16c
with VC4-16c, VC4-4c, VC4 and AU3 in the same STM-N (N>16).

Mutual Exclusion: if a VC4-16c occupies part of (group of time
slots) on an STM-N, the time slots occupied by the VC4-16c shall not
be available for other AU3s, VC4s, VC4-4cs or VC4-16cs. For “auto
or partial” provisioning, which VC4-16c to select becomes an issue
only in the case of STM-N (N >16). For example there are four
VC4-16cs in an STM-64. As stated in the introduction, each VC4-16c
starts specific time AU4 (AU3) time slots. Therefore, in provisioning
VC4-16c, the system is expected to select the first available (see
reference [1]) VC4-16c. The order of selection preference is based on
an ascending order of the VC4-16c starting time slots.

Figure 4-2 Example of a PTI Application

P S

STM-n STM-n

VCn

S S S P

pti=PTI (A-Z) pti=PTI (A-Z)

Section III: Connections
Trail provisioning concepts

Provisioning Concepts

....................................................................................................................................................................................................................................

365-309-243
Issue 1, July 2001

Lucent Technologies 4 - 2 9



Transmission Direction: VC4-16c supports one-way, broadcast and
two-way transmission direction, subject to and consistent with
EMS/network element support. 1809: VC4-16c Protection (two-way)
The provisioning of a VC4-16c shall support two-way protected or
unprotected VC4-16c. 1810: VC4-16c Protection (one-way) The
provisioning of a VC4-4c shall support one-way protected or
unprotected VC4-4c. Merging of VC4-16c 1811: Merging VC4-16c
WaveStar NMS shall support the merging VC4-16c circuits/paths.
VC4-16c circuits/paths can only be merged with VC4-16c circuit/path.
Rearranging VC4-16c 1811: Rearranging VC4-16c WaveStar NMS
shall support rearranging VC4-16c.

Provisioning of VC4-4C
trails

VC4-4c trails can be provisioned on STM-N (N = 4, 16, or 64).
VC4-4c is “non-assignable”. VC-4-4c shall start at timeslot number
(n) for which the MOD4(n-1) is zero. In other words, it starts only on
timeslot number for which the timeslot number minus one is divisible
by four. 1816: VC4-4c Protection (two-way) The provisioning of a
VC4-4c shall support two-way protected or unprotected VC4-4c.
1817: VC4-4c Protection (one-way) The provisioning of a VC4-4c
shall support one-way protected or unprotected VC4-4c.

Merging: WaveStar NMS supports the merging VC4-4c circuits/paths.
VC4-4c circuits/paths can only be merged with VC4-4c circuit/path.

Rearranging: WaveStar NMS supports rearranging VC4-4c. Bridge
and roll shall be used for rearrange involving BWM similar to that of
DACS VI and WaveStar DACS.

Provisioning of AU3 trails From the Network Map, users can provision a two way unprotected
AU-3 trail either in the “auto”, “manual” or “partial” mode.

In “auto” mode, the WaveStar NMS shall find a shortest route using
the V4 channels from each of the links in the path. An AU-3 path can
be assignable or non-assignable based on the following criteria. If one
or both end ports of the AU3 is a DS3 port, then the AU3 is channel
assignable (for a non-combo trail provisioning). In this case, the AU3
shall be created with one DS3 channel. If both end ports of the AU3
are STM-n (n=1,4,16) ports with a cross-connect at the end network
elements, then the AU3 is not assignable.

In the “manual” mode, the WaveStar NMS user shall be able to select
each link from the Network Map that contains one or more AU3
channels from the Network Map and shall be able to bring up a
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display of the Facility Channel List screen showing only the all the
digital links between the two end nodes that terminate the selected
link. Selecting one of the digital links shall list all the AU3 channels
in the selected digital link. The user shall be able to select one of the
channels from the list. The selected AU3 channel shall automatically
get populated in the provisioning screen. In the case of span of
control, the user should be able to select a bridge and intern select a
link which allows user to select AU3 and any on of the contained
channels.

In the “partial” mode, the WaveStar NMS user need to select only the
digital links that are displayed in the Facility Channel List screen. The
WaveStar NMS shall automatically pick an appropriate V4 channel in
the selected digital link and populate it in the provisioning screen.

Transmission Direction: provisioning of a AU3 supports one-way,
broadcast and two-way transmission direction, subject to and
consistent with EMS/network element support.
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Provisioning of VC-4 Trails From the Network Map, the WaveStar NMS user shall be able to
provision a two way unprotected VC-4 trail either in the “auto”,
“manual” or “partial” mode. In the “auto” mode, the WaveStar NMS
shall find a shortest route using the V4 channels from each of the
links in the path. A VC-4 path can be assignable or non-assignable
based on the following criteria. If one or both end ports of the VC-4
is a 140 Mb/s (E4) port, then the VC4 is channel assignable (for a
non-combo trail provisioning). In this case, the VC-4 shall be created
with one C4 channel. If both end ports of the VC4 are STM-n
(n=1,4,16) ports with no cross-connects at the end network elements
or if both end ports of the VC4 are line ports of an ADM, then the
VC-4 is channel assignable. In this case the VC-4 shall be created
with 63 V12, 3 V3 and 21 V2 (where the network element supports a
V2 cross-connect) channels. If either of the above two cases is not
satisfied, then the VC4 is non-assignable. In the “manual” mode, the
WaveStar NMS user shall be able to select each link from the
Network Map that contains one or more V4 channels from the
Network Map and shall be able to bring up a display of the Facility
Channel List screen showing only the all the digital links between the
two end nodes that terminate the selected link. Selecting one of the
digital links shall list all the V4 channels in the selected digital link.
The user shall be able to select one of the channels from the list. The
selected V4 channel shall automatically get populated in the
provisioning screen. In the case of span of control, the user should be
able to select a bridge and intern select a link which allows user to
select V4 and any on of the contained channels.- In the “partial”
mode, the WaveStar NMS user need to select only the digital links
that are displayed in the Facility Channel List screen. The WaveStar
NMS shall automatically pick an appropriate V4 channel in the
selected digital link and populate it in the provisioning screen.

Specifying Path Trace Identifiers and Mismatch Detection Mode:
users can specify two Path Trace Identifiers (PTIs) for each VC-4 trail
- one for A-Z direction and the other for Z-A direction. The PTIs can
be either a specific string of upto 15 alphanumeric characters (case
sensitive) or non-specific (system generated 0s or 1s). The user can
also specify the Mismatch Detection Mode for each trail provisioning.
The valid values for the Mismatch Detection Mode are “Enable”,
“Disable” or “null” (\0). If the user specifies “Enable”, the EMS will
turn on the mismatch detection mode and if the user specifies
“Disable”, the EMS will turn off the mismatch detection mode. The
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value of “null” (\0) is used for in-effect circuit orders to instruct the
EMS to leave the mismatch detection mode in its current setting.

Provisioning of VC2 trails From the Network Map, users can provision a two way unprotected
VC-2 trail either in the “auto”, “manual” or “partial” mode. In the
“auto” mode, the WaveStar NMS shall find a shortest route using the
V2 channels from each of the links in the path. A VC-2 trail is always
non-assignable since it does not have trail termination point on a SDH
port nor has a PDH port corresponding to its rate. In the “manual”
mode, the WaveStar NMS user shall be able to select each link from
the VC-2 provisioning view of the Network Map that shows all VC-4
trail connectivities. Selecting any VC-4 trail connectivity link that
contains one or more V2 channels, the user shall be able to bring up a
display of the Facility Channel List screen showing only the V2
channels in the selected VC-4 trail connectivity link. The user shall be
able to select one of the channels from the list. The selected V2
channel shall automatically get populated in the provisioning screen.
In the “partial” mode, the WaveStar NMS user need to select only the
VC-4 trails that are displayed in the Facility Channel List screen. The
WaveStar NMS shall automatically pick an appropriate V2 channel in
the selected VC-4 and populate it in the provisioning screen.

Provisioning of VC3 trails From the Network Map, users can provision a two way unprotected
VC-3 trail either in the “auto”, “manual” or “partial” mode. In the
“auto” mode, the WaveStar NMS shall find a shortest route using the
V3 channels from each of the links in the path. In the “manual”
mode, the WaveStar NMS user shall be able to select each link from
the VC-3 provisioning view of the Network Map that shows all VC-4
trail connectivities. Selecting any VC-4 trail connectivity link that
contains one or more V3 channels, the user shall be able to bring up a
display of the Facility Channel List screen showing only the V3
channels in the selected VC-4 trail connectivity link. The user shall be
able to select one of the channels from the list. The selected V3
channel shall automatically get populated in the provisioning screen.
In the “partial” mode, the WaveStar NMS user need to select only the
VC-4 trails that are displayed in the Facility Channel List screen. The
WaveStar NMS shall automatically pick an appropriate V3 channel in
the selected VC-4 and populate it in the provisioning screen.

Specifying Path Trace Identifiers and Mismatch Detection Mode:
users can specify two Path Trace Identifiers (PTIs) for each VC-3 trail
- one for A-Z direction and the other for Z-A direction. In the case of
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one way trails, only the PTI for A-Z direction will be applicable. The
PTIs can be either a specific string of upto 15 alphanumeric characters
(case sensitive) or non-specific (system generated 0s or 1s). The
WaveStar NMS user shall also be able to specify the Mismatch
Detection Mode for each trail provisioning. The valid values for the
Mismatch Detection Mode are “Enable”, “Disable” or “null” (\0). If
the user specifies “Enable”, the EMS will turn on the mismatch
detection mode and if the user specifies “Disable”, the EMS will turn
off the mismatch detection mode. The value of “null” (\0) is used for
in-effect circuit orders to instruct the EMS to leave the mismatch
detection mode in its current setting.

Provisioning of VC12 trail From the Network Map, users can provision a two way unprotected
VC-12 trail either in the “auto”, “manual” or “partial” mode. In the
“auto” mode, the WaveStar NMS shall find a shortest route using the
V12 channels from each of the links in the path. In the “manual”
mode, the WaveStar NMS user shall be able to select each link from
the VC-12 provisioning view of the Network Map that shows all
VC-4 trail connectivities. Selecting any VC-4 trail connectivity link
that contains one or more V12 channels, the user shall be able to
bring up a display of the Facility Channel List screen showing only
the V12 channels in the selected VC-4 trail connectivity link. The user
shall be able to select one of the channels from the list. The selected
V12 channel shall automatically get populated in the provisioning
screen. In the “partial” mode, the WaveStar NMS user need to select
only the VC-4 trails that are displayed in the Facility Channel List
screen. The WaveStar NMS shall automatically pick an appropriate
V12 channel in the selected VC-4 and populate it in the provisioning
screen.

Provisioning of VC11–TU12
trails

In some network elements, such as ADM 16/1, a DS-1 (1.5 Mb/s)
port can also terminate an SDH trail that can get cross-connected at
the VC-12 rate. The DS-1 signal first gets adpated to a VC-11 SDH
signal and then mapped to a TU-12 tributary pay load. Those trails
that terminate on the DS-1 port are specially designated as
VC11-TU12 trails. The circuit type for these trails is VC11-TU12. For
VC11-TU12 trails, the end ports can only be a DS1 (1.5 Mb/s) port.
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AU3-AU4 adaptation feature for the WaveStar BandWidth
Manager
....................................................................................................................................................................................................................................

Overview This section describes the provisioning concepts associated with the
AU3-AU4 adaptation feature for the WaveStar BandWidth Manager.

Purpose The AU3-AU4 adaptation feature maps a higher order VC3 payload
(AU3) at the interface of a STM1E port to a lower order VC3 payload
(TUG structured), which is multiplexed into a VC4 (AU4). A STM1E
port can be provisioned to carry one AU4/VC4 or three AU3 (higher
order VC3) signals, in which case the AU3-AU4 adaptation is not
enabled, or it can be provisioned to enable the adaptation. If the
adaptation is enabled, the STM1E signal at the (external) interface
will represent 3 AU3 signals, and a single AU4 (VC4) signal
structured to contain 3 TU3/VC3 signals will leave the port unit
(internally in the BandWidth Manager) to interface with the switching
structure of the BandWidth Manager. Although the AU3-AU4
adaptation can be enabled in one direction (ingress or egress), only
bidirectional TU3-AU3 type trails are supported.

In the most common application of the feature, a DS3 is mapped into
a lower order VC3 at one end of the trail (e.g. in Europe), which in
turn is multiplexed into a VC4. The DS3 is extracted from a higher
order VC3/AU3 (STS1) at the other end of the trail (e.g. in N.
America). If the DS3 within the AU3 needs to be dropped at the same
BandWidth Manager, or the AU3 needs to be multiplexed into a
higher level optical signal (OC3 or higher) to be transported farther,
an external loop-back can be employed at the BandWidth Manager.

The adaptation feature is supported as a provisionable option on
STM1E ports only, on the BandWidth Manager’s STM1E universal
shelf. An STM-1 signal can be looped back at a BandWidth Manager,
and the AU3 signals from the STM1E port can be dropped at DS3
ports or consolidated over higher level facilities after being
cross-connected through the same BandWidth Manager as AU3
signals. Note that a loop-back is external to BandWidth Manager. It
should be configured in advance as a digital link and inventoried in
WaveStar NMS.
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Caveats The following caveats apply to the provisioning of TU3-AU3 trails
with WaveStar NMS:

• WaveStar NMS only supports bi-directional TU3-AU3 trails.

• WaveStar NMS only supports the manual provisioning of
TU3-AU3 trails.

• WaveStar NMS supports a digital link at STM1 rate that
terminates at STM1E ports on the same BandWidth Manager at
both ends. This is referred to as an external loop-back (see Figure
2). The external loop-back type STM1 digital link shall be
channelized for AU3 only (no VC4), and will be used to carry 3
TU3-AU3 type trails.

• WaveStar NMS supports asymmetric VC4 trails, where at one
end the VC4 trail terminates at a network element before being
cross-connected (a VC3/TU3 is cross-connected and
mapped/multiplexed into the VC4), and at the other end the VC4
trail terminates after being cross-connected (e.g., at the
BandWidth Manager AU4-AU3 adaptation point).

• WaveStar NMS supports merge and protection feaures for
TU3-AU3 trails. Only a TU3 (VC3) or an AU3 can be merged at
one end of a TU3-AU3. The resulting trail will be a TU3-AU3.
The merge of a TU3 and an AU3 to get a TU3-AU3 is not
supported. Also, the merge of two TU3-AU3 trails is not
supported.

• WaveStar NMS does not support preplan restoration for
TU3-AU3 trails.
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Protection schemes The following protection schemes asscociated with a TU3-AU3 are
supported:

• Ring protection on a segment of a TU3-AU3 trail. For example,
in Figure 3 the STM16 and/or OC12/STM4 can be ring
configurations. (The STM16 ring actually would be associated
with the VC4 trail.)

• SNCP protection associated with the VC4 trail (if supported by
STM1E). (Again, this would be a characteristics of the VC4 trail
and not the TU3-AU3 trail.)

• End-to-end protection (similar to SNCP at the ends). For
example, Figure 3 can represent the “working” path, and a
similar segment (e.g., between the TU3 X-conn and right-most
AU3 X-conn) that contains another AU4-AU3 adaptation point -
in another BWM - can represent the protection path.

Verifications When the user provisions a TU3-AU3 trail, WaveStar NMS verifies
the following conditions and generates the appropriate error messages
if the conditions are not met:

• A TU3-AU3 trail rides on a VC4/AU4 trail for part of the
connection. If no such trail exists in the TU3-AU3 path selected
(designed) by the user, WaveStar NMs shall generate an error
message.

• Only one of the VC4 paths on which a TU3-AU3 trail rides must
terminate at one end only at a STM1E port of a BandWidth
Manager and be cross-connected at the VC4/AU4 level in the
same BandWidth Manager. If the selected TU3-AU3 trail rides
on one or more VC4 paths but none satisfies this condition,
WaveStar NMS shall generate an same error message.

• The BandWidth Manager at which a VC4 path terminates and
gets converted into three AU3s, must be of release 4.0 or beyond.
Otherwise, an error message will appear.
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Work order record document concepts
....................................................................................................................................................................................................................................

Overview The Work Order Record Document (WORD) describes a customer
service order or an network infrastructure/engineering order and
includes the end-to-end design of the circuit associated with that
order. The primary use of the WORD is for circuit installation, testing,
and fault tracing by technicians in the field.

Logistics The WORD document will contain order-related data and circuit
layout details. The WORD can be populated for any circuit (’circuit’
here is used in a generic sense as a ’link’ in PRM) including
topological links (digital links and optical layer links), facilities, and
customer circuits.
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Application concepts
....................................................................................................................................................................................................................................

Overview This section describes the application concepts associated with optical
layers.

Title The following figure shows the different hierarchy of optical layers
for provisioning between DWDMs and SDH network elements or
black boxes.

Figure 4-3 Hierarchy of Optical Layers

OA OA DWDMDWDM

OMS
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Low Speed Broadband (LSBB)
High Speed Broadband (HSBB)

Client Service Types for
OCh Trails and Optical Links:
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Provisioning concepts
....................................................................................................................................................................................................................................

Overview This section describes the provisioning concepts associated with
optical layers.

Terminology The following terms appear within this section.

Fixed connection: fixed connections are stored in the WaveStar NMS
and used for provisioning. A fixed connection can be terminated by
one or two point(s) of flexibility, the tributary side of a DWDM
network element, a SDH network element or a black box. It can only
be discovered. It is only visible in the ‘trail/channel selection’ screen.
In this document, the fixed connection belows to the OCh layer.
However, it can be used at any level (VC-4, VC-12, ...) to help the
provisioning process.

Paired Fixed Connection: a pair of two fixed connection that share
some common channels.

OCH assignable port: an OCH assignable port terminates an OCH
trail. OCH assignable ports are located either on the SDH network
element, a non managed network element (Black Box/Equipment), or
on the muxed port of a 10G mux card. The OCH assignable port can
also be referred as a OCH TTP.

OCH non assignable port: any intermediate port of an OCH
connection.

OCH connection: an OCH connection is a end to end optical path.

OCH server: is an OCH that is used to carry other OCH connections
instead of regular client types (DL, HSBB, etc.)

Point of flexibility: a port that belongs to a Lambda Router connected
to a DWDM network element via a physical link.

Topological link: in the scope of the optical layer, the topological
links are OMS and OL.
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Provisioning order The following steps are required to provision the different layers in
the Optical Layer. It is important to remember that to be able to use
the Optical Layer for SDH layer provisioning, the physical
connectivities between the Optical Network Elements must have been
established prior to the provisioning of the optical layers from
WaveStar NMS. Provisioning in WaveStar NMS is mainly to provide
the inventory, display and correlation of alarms in the optical layer in
addition to some validations by the EMS. The WaveStar NMS user
provisions the Optical Multiplex Section (OMS) between two similar
types of DWDM network elements specifying any Optical Amplifiers
(OA) between them. The OMS provisioning is always treated in
WaveStar NMS as a bidirectional section. If there are connectivities
from the DWDM network elements to other SDH network elements or
Black Boxes then the user provisions an Optical Link between them
specifying “Client Service Type” (CST). Then the Optical Channel
Trail is provisioned. When provisioning an Optical Channel Trail
(OChTrail) the user is required to specify the client service type that
the OCh trail will carry. The client service types are : V4DL, S4DL,
S16DL, S64DL, OC-48, OC-192, LSBB (Low Speed Broadband) or
HSBB (High Speed Broadband). If there are connectivities with SDH
network elements or Black Boxes to DWDMs, the user can then
provision the conventional SDH Digital Links between them. If the
WaveStar NMS system finds connectivities of the two SDH ports
through the optical layer, it will prompt the user to “insert Optical
Layer” at the time of order completion of digital link.

OMS layer WaveStar NMS supports the provisioning of Optical Multiplex Section
(OMS) between the optical line sides of two OLS400G or OLS80G
DWDM network elements. The cut-through to SNMS-EMS Graphical
User Interface for OLS400G and to ITM-SC for OLS80G for port
selection and automatic population is provided. WaveStar NMS shall
check for the same network element model type for both ends of the
OMS section. For the point and click provisioning, the selection for
“OMS” in the selection menu under “Configuration --> Optical Layer
--> Add --> OMS” shall be enabled only if both the network elements
selected are DWDM network elements of the same type (i.e. both
OLS400G or both OLS80G).

The following table summarizes the interworking of DWDMs and
their types/ releases for OMS provisioning.
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A/Z
End

Type/Rel. No. Z/A End Type/Rel. No.

OLS80GEnd terminal or
dual facing (Any
release)

OLS80G End terminal or dual
facing (any release)

OLS400G
(C-Band)

End terminal or
ring or WAD
terminal (Rel.
3.0/3.1)

OLS400G
(C-Band)

End terminal or ring or
WAD terminal (Rel.
3.0/3.1).

OLS400G
(L-Band)

End terminal
(R4.0)

OLS400G
(L-Band)

End terminal (R4.0)

OLS400G
(C-Band)

End terminal or
ring or WAD
(Type 1 and 2)
terminal (Rel. 5.0
or 6.0)

OLS400G
(C-Band)

End terminal or Ring or
WAD (Type 1 and 2)
Terminal (Rel. 5.0 or
R6.0)

OLS400G
(L-Band)

End terminal or
ring terminal
(R6.0)

OLS400G
(L-Band)

End terminal or Ring
terminal (R6.0)

Optical amplifiers: during provisioning of an OMS, users can add
Optical Amplifiers similar to adding regenerators during digital link
provisioning. The list of Optical Amplifiers that are available shall be
displayed for the user to choose. The list of optical amplifiers shall
contain only those that support the OMS section with the appropriate
number of channels (16 or 40/80). For OMS Section between two
OLS400G (C-band) DWDMs, only the C-band optical amplifiers shall
be displayed for user selection. For OMS section between two
OLS400G (L-band) DWDMs, only the L-band optical amplifiers shall
be displayed for user selection. The order of Optical Amplifiers shall
determine their sequence from left to right in the layout in the Optical
Multiplex Section. It is assumed that the Optical Amplifiers are all
bi-directional providing amplification of the optical signals in both
directions of the fiber. As with regenerators in Digital Links, the user
shall be allowed to add or delete Optical Amplifiers to the Optical
Multiplex Section.

C+L band: the C+L Band OLS400G DWDMs provide more
bandwidth (upto 160 wavelengths) over a single fiber. The output of
C-Band and the L-Band OLS400G R6.0 DWDMs are fed in to a
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CLSC (C and L band Separator and Combiner) unit that combines all
the 160 wavelengths (80 from C-Band and 80 from L-Band) on a
single fiber. This maximizes the output of each fiber in backbone and
longhaul networks. When Repeater stations are needed in long haul
applications, before each Repeater Station, the wavelengths have to be
separated in to the C-band and L-band frequencies and fed in to their
respective Optical Amplifiers and then re-combined for transmission
again. The CLSC unit is a passive device that does not need any
provisioning commands nor does it generate any alarm. However,
when combining a L-band with a C-band system, a parameter has to
be set in the C-band system that tells the C band system that it is
working in conjunction with a L band system. This is required to
adjust some power gain in the C band system. It is not expected that
this parameter is set from WaveStar NMS. From SNMS and WaveStar
NMS perspective, the C-band and L-band DWDMs are treated as two
separate network elements. Therefore the OMS provisioning between
C+L band DWDMs are treated as two separate OMS sections, one
between two C-band DWDMs and the other between two L-band
DWDMs with their own set of Optical Amplifiers (Regenerators). It is
understood that in case of a fiber break between two C+L Band
systems, WaveStar NMS will receive alarms from both C and L band
DWDMs resulting in showing two OMS section failures even though
in reality there is only one fiber break. The functionality of WaveStar
NMS is not in any way affected by this behavior. It is the
responsibility of the WaveStar NMS user to recognize this as a single
failure for dispatching craft people to fix the problem.

Deleting an OMS: when the user tries to delete an OMS Section
through a Delete Order, the request for deletion shall be denied if
there is at least one OCh Trail (in-effect or pending) that is assigned
to one of the OMS channels.

Optical link layer The following section describes the provisioning of optical links
between SDH network element or Black Box and DWDM network
elements or between two DWDM network elements.

End nodes for optical link provisioning : a user can provision an
optical link between: a SDH network element and a DWDM network
element, a black box and a DWDM network element, two DWDM
network elements (back to back OLS or in the case of OLS80G dual
facing terminals or between ORS and an external DWDM network
element) a SDH network element and a Lambda Router, a black box
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and a Lambda Router, a Lambda Router and a DWDM network
element, The WaveStar NMS shall check the model of the nodes that
terminate the optical link. If the models are not correct, the
provisioning request shall be rejected. The cut-through to the selected
EMS graphical user interface for port selection and automatic
population shall be provided.

Automatic creation of internal optical link in OLS400G through
discovery: When an association exists between the output port of a n
ORS (Optical Ring Switch) in a OLS400G (R6.0 onwards), that
association is reported to WaveStar NMS as a link. WaveStar NMS
shall create an optical link for this discovered link with a system
generated ckt/trail ID and order number.

Behavior of NMS when an internal optical link is removed: if, after
an internal optical link is created in WaveStar NMS with a ckt/trail ID
and order number after a database synchronization, the optical link is
detected to be absent from a subsequent dbsync procedure, the
WaveStar NMS shall do the following: If there is no OCh trail
provisioned on the internal optical link, the optical link shall be
deleted from the system and all the associated records (alarm, PM, if
any) shall be removed as per the existing system behavior. In addition,
if the optical Fixed Connections are discovered with the internal
optical link, those Fixed Connections shall be either removed or
reconciled by the system. If an OCh trail is already provisioned on the
internal optical link, this should be treated as improper disconnect and
reported to the user. The improper disconnect notification shall be on
the internal optical link.

’Client service type’ in the Optical Link provisioning screen: when
provisioning an optical link, depending of the end-node types, a
WaveStar NMS user will have to populate a ‘client service type’ field
in the provisioning screen. The ‘client service type’ will have to be
populated only in the following cases: one end-node of the optical
link is a black box and the other end-node is a lambda router one
end-node of the optical link is a black box and the other end-node is a
DWDM network element without OTU one end-node of the optical
link is a lambda router and the other end-node is a DWDM network
element without OTU In other words, the “Client Service Type” field
shall be enabled only when both end nodes of the Optical Link are
not SDH network elements. In the other cases, the ‘client service
type’ in the optical link provisioning screen shall be disabled and
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automatically populated by the system internally without explicit user
input.

Optical channel
connection (trail)

provisioning

This section covers the handling and provisioning of OCh connections
with WaveStar NMS.

An OCh trail is defined as an optical connection that is either
assignable to a digital link or non-assignable. The OCh trail are of
two types. The first type is an OCh trail (assignable OCh trail) that
terminates on an SDH/SONET network element or a Black Box at
either end in its layout (i.e. does not terminate in a Lambda Router
with a cross-connect or in a DWDM network element). The second
type of OCh trail (non-assignable) does not fall in to the above
category of assignable OCh trail but may have a termination in a
Lambda Router having a cross-connect in it.

Preplan for optical trails: WaveStar NMS provides the capability to
restore/reinstate an OCh channel trail if the following conditions are
met: the service path and the preplan path have the same channel
type/client service type, the service path and the preplan path have
different OCh trail and ride on different OMS. the service path OCh
channel trail and the preplan path OCh channel trail have the same
end port. The user shall be able to choose provisioning the protection
OCh channel trail (i.e. the preplan path) using either through another
DWDM or the same DWDM but with different OMS (only if the
DWDW supports more than one set with the same wavelength). If the
protection OCh channel trail runs across another DWDM, it is client
of on another OMS. Note: 1) For protected service path (e.g.
involving DWDM equipped with ORS), both the working and
protection segments of the service OCh channel trail are using the
same OMS (i.e. one fixed OCh). The preplan path can not use the
same OCh trail with the service path regardless it is protected or
unprotected path. 2) The cross connect between the service and
preplan path for optical trail must be done via the same LamdaRouter.

WaveStar NMS shall allow the user to discover fixed connection
between the following network elements:

A-end Z-end Preconditions
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SDH
network
element/
black box

SDH network
element/black box

At least 2 DWDM network
elements between A-end and
Z-end.

No Lambda router between
A-end and Z-end.

DWDM
network
element
(tributary
side)

DWDM network
element (tributary
side)

A-end different from Z-end.

Lambda
router
(point of
flexibility)

Lambda router
(point of flexibility)

A-end different from Z-end

At least 2 DWDM network
elements between A-end and
Z-end.

Lambda
router
(point of
flexibility)

DWDM network
element

At least 1 DWDM network
element between A-end and
Z-end

No Lambda router between
A-end and Z-end

Lambda
router
(point of
flexibility)

SDH network
element/black box

At least two DWDM network
elements between A-end and
Z-end.

No Lambda router between
A-end and Z-end.
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Overview
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Purpose This chapter describes subnets as they relate to WaveStar NMS
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General provisioning concepts
....................................................................................................................................................................................................................................

Overview Subnets are groups of interconnected facilities or network elements
forming a closed ring that provide service protection for WaveStar
NMS if one of the facilities or network elements fail. With ring
protection, there is a loss of efficiency in the utilization of facilities
because bandwidth must be reserved in the protection facility to
provide service restoration.

WaveStar NMS supports two broad categories of rings:

• path-switched rings (PSRs)

• line-switched rings (LSRs)

WaveStar NMS supports the following ring and ring protection
features:

• 2- and 4-fiber PSRs and LSRs.

• The creation of line-switched rings containing two different
network elements, specifically ADM16/1 and TDM10G
(ADM64/4) network elements

• Allowing a single network element to belong to multiple rings.
A network element that belongs to more than one ring is referred
to as a multi-homed node or shared node

- ADM16/1, ADM16/4, ADM4/1, WaveStar AM 1, LXC16/1,
and LXC4/1 can be part of multiple path-switched rings.

- WaveStar BandWidth Manager can be part of multiple
line-switched rings.

• Manual ring creation of path-switched rings

• WaveStar BandWidth Manager four-fiber line switched rings
(MS-SPRING)

Note: An aggregate is not automatically created when WaveStar NMS
creates or discovers a ring.

Ring examples The following are examples of ways in which users can create rings.
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Two path switched rings sharing all nodes

The below figure illustrates two path-switched rings sharing all nodes.

Four rings formed by four nodes

The below figure shows four rings formed using the same four
network elements.

A Z

D

B C

E

Ring One

Ring Two

A ZB D

C

E
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Ring Four

Ring One

Ring Two
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2-fiber rings Two-fiber MSSPRING requires only two fibers for each span of the
ring. For each network element in the ring, one fiber is designated as
the “East” fiber and the other as the “West” fiber. On each fiber half
the channels are defined as working and the other half as protection
channels. In other words, the first half of the channels in the
STM-N/OC-N (channels 1 to N/2) carry protected traffic whereas the
second half (channels N/2 +1 to N) provide protection. The protection
channels can carry pre-emptible traffic. The traffic carried on the
working (protected) channels in one fiber (“East/West”) are protected
by the protection channels travelling in the opposite direction
(“West/East”) of the ring.

4–fiber rings 4-Fiber Ring Note that as opposed to a 2-F ring, protection in a 4-F
ring is provided for the entire capacity of the link.
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Subnet creation
....................................................................................................................................................................................................................................

Overview This section discusses WaveStar NMS support for both automatic and
manual subnet creation.

Automatic creation WaveStar NMS can automatically create two-fiber or four-fiber rings
if the following conditions are met:

Refer to Chapter 3 of this guide for information on creating and
deleting rings.

1. Connectivity is established between two or more network
elements.

2. The protection group of all the network elements in the group is
MSSPRING.

3. Rings must consist of the same network element type. Exceptions
are:

• TDM10G

• ADM4/1

• ADM155E

Manual creation Manual ring creation is supported for line switched rings,
path-switched rings, and homogenous black box rings (rings
comprising of all black boxes).

Refer to Chapter 3 of this guide for information on creating and
deleting rings.

For manual ring creation and deletion, WaveStar NMSprovides the
following features:

• Support of heterogeneous, homogenous and multi-homed (shared)
network elements

• Selection of multiple STM-N links

• Exclusion and deselecting of STM-N links

• Automatic ring name creation

• Creation and deletion notification

• Ring manipulation
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Prerequisites for Manual Creation

Before attempting to manually create a ring, be sure the following
prerequisites are met:

• All nodes participating in a path switched ring have SNC/N or
SNC/I capability.

• With a line switched ring, at least one black box is present and
the all other network elements selected to participate in the line
switched ring have line switched ring capability and would
automatically create such a ring in the absence of the
participating black boxes.

• A minimum of two network element or black boxes are selected
for creating the ring. Note that a selection can be either explicit
or implicit. For example, the selection of an STM-N link
implicitly selects two network elements.

• The STM-N links connecting the participatingnodes form a
closed loop. If the ring to be created is an line switched ring, the
protection group (if applicable) shall be identical on all nodes.

• The STM-N links forming the closed loop are of the same level
(they are either all STM-1, STM-4, STM-16 or STM-64).

• The ring to be created does not already exist.

• The maximum number of nodes that can be part of a manually
created path switched ring is limited only by system resources.

• You can manually delete a created path-switched ring only if
there are no protected paths through it (that is, the path-switched
ring does not provide protection to any path).

Within the context of WaveStar NMS, automatic ring creation is not
supported for Black boxes. That is, a homogenous ring comprising of
only Black boxes is not supported. Therefore, the only way a Black
box can be part of a ring is if the ring is manually created. For the
purpose of this section a ring (either PSR or LSR) is uniquely
identified by the STM-N/OC-N link closing the loop plus all the
participating network elements as well as Black boxes. Therefore, an
STM-1 PSR made up of network elements A, B and C is different
from an STM-16 PSR made up of the same network elements A, B
and C. Any ring-forming network element that belongs to more than
one ring is referred to as ″shared node″. In this document, the word
″Node″ refers to either a network element or a Black box. Here after,
the word ″ring″ implies either a PSR or an LSR ring unless otherwise
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qualified. Black boxes can be part of a ring, be it PSR or LSR. If a
black box is in any ring, it is assumed that the black box supports the
ring capability of the specific ring it belongs to. Ensuring capability of
the black box is the WaveStar NMS user’s responsibility. Black boxes
are included in the inventorying of the number of nodes in a ring. For
example, if a ring contains three black boxes and four network
elements, the total number of nodes in the ring is counted as seven.

Prerequisites: The system shall ensure that the following conditions
are met for manual ring forming:

• All Network Elements selected to participate in a PSR have
SNC/N or SNC/I capability. On the other hand, if the ring to be
created is a 2- or 4-fiber LSR then all network element’s selected
to participate in the 2-or 4-fiber LSR have 2- or 4-fiber LSR
forming capability respectively. (The system is not required to
verify Black box capabilities.)

• In the case of an LSR manual ring creation, at least one Black
box is present and all other network elements selected to
participate in the LSR (2- or 4-fiber) have LSR capability and
would have automatically created an LSR in the absence of the
participating Black boxes.

• At a minimum two nodes have been identified/selected for
creating the ring. (Note that the selection of nodes can be either
explicit or implicit. For example, selection of an STM-N/OC-N
link implicitly selects two nodes.)

• The STM-N/OC-N links connecting the participating nodes form
a closed loop. If the ring to be created is an LSR, the protection
group (if applicable) shall be identical on all nodes.

• The STM-N/OC-N links forming the closed loop are of the same
level (i.e. they are either all STM-1, STM-4, STM-16, or
STM-64, OC-3, OC-12, OC-48 or OC-192).

• If the ring to formed is a PSR, then the STM-N/OC-N forming
the loop are not members of 1+1 MSP, 1X1MPS, 2-F or 4-F
group.

• The ring to be created does not already exist.

• All nodes selected to participate in the desired ring are not all
Black boxes. That is, the manually created ring shall not
comprise of all Black boxes.
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WaveStar NMS supports the forming of path switched rings for the
following SDH network element at the specified STM-N rate when
the manual ring forming criteria are met:

Network Element Rate

ISM-1 STM-1

ISM-4 STM-4

PHASE ADM-16/4 STM-16

PHASE ADM-4/4 STM-4

ADM155E STM-1

WaveStar ADM4/1STM1 STM-1

WaveStar ADM4/1STM4 STM-4

WaveStar AM1 STM-1

WaveStar AM1 + STM1 STM-1

WaveStar AM1 + STM4 STM-4

ADM 16/1 (SNCP model) STM-1, STM-4, STM-16

ADM16/1 Compact (SNCP
model)

STM-1, STM-16

TDM10G STM-1, STM-4, STM-16,
STM-64

BWM STM-1, STM-4, STM-16,
STM–64

Size Limits: there is no requirement imposing a limit on the
maximum number of nodes that can be part of a manually created
PSR as long as the system resources permit. However, the system
shall be able to support the participation of up to sixty-five (65) nodes
within a manually created PSR ring. See subsequent requirements. In
the case of LSR, however, the maximum number of nodes can not
exceed sixteen.
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Line-switched rings
....................................................................................................................................................................................................................................

Overview This section discusses line-switched rings (LSR). With line switched
rings, each network element recognizes all of the other network
elements in the ring. Line-switched rings use one of two protocols, the
standard protocol (G841) or the transoceanic protocol (TOP).
Line-switched rings can be either two-fiber or four-fiber.

Advantages Line-switched rings offer users a few advantages in relation to
protection and traffic management.

• Extra, unprotected traffic can be provisioned on the protection
path. However, in the event of a failure, the unprotected traffic is
preempted to make the channels available for line-switched
protected channels.

• MS-SPRING (multiplexed-shared protocol ring) protection
provides protection for two-fiber or four-fiber line-switched rings.
While MS-SPRING protection is available for both two-fiber and
four-fiber rings, it is assigned in a different method for these two
ring types.

• Extra, unprotected traffic can be provisioned on the protection
path. However, in the event of a failure in the ring, the
unprotected traffic is preempted to make the channels available
for line-switched protected channels.

• Automatic ring protection. When assigning channels in the ring
for a path that is to be protected, you must assign the same
channel all around the ring for the service traffic. If you use
point and click provisioning and select ring protection, the
processor will do this automatically.

Scenarios The following figures illustrate the conditions of a line switched ring
before and after a line failure.

Before a Failure

The first figure displays a two fiber line switched ring consisting of
network elements and STM-16 digital links before the failure.

The current condition of this ring is

• The path of working traffic, transmitting from Node A to Node
C, traverses lines 1 and 2.
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• The path of working traffic, transmitting from Node C to Node
A, traverses lines 6 and 5.

After a Failure

This figure displays the same two-fiber, STM-16 line switched ring
after line 2 has failed. The current conditions of this ring, as a result
of the line 2 failure, are

• Node B loops back channels 1-8 out towards Node C back to 9
-16.

• Node C loops back channels 1-8 out towards Node B back to 9
-16.

• The path of working traffic from Node A to Node C:

- Traverses line 1 using channels 1-8

- Loops back at the output of Node B to Node C 1-8 out to
9-16 In.

- Traverses lines 5, 8 and 7 using channels 9-16 to reach
Node C

Figure 4-4 A Line Switched Ring Before Failure
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• The path of working traffic transmitting from Node C to Node A:

- Loops back at the output of Node C to Node B 1-8 out to
9-16 In

- Traverses lines 3 and 4 using channels 9-16 to reach Node
A.

• If line 6 also fails, nothing changes.

Two-fiber rings With a two-fiber line-switched ring (MS-SPRING), one fiber transmits
and the other receives. Both transmission directions of the
bidirectional connection travel through the ring in opposite directions.
If the working transmit path at a given network element is clockwise,
then the working receive path is counterclockwise and vice versa.

For protection against faults, each fiber’s channels are split. The first,
or top half, fibers are assigned as service paths while the second, or
lower half, fibers are assigned as protection paths. Thus, the protection
channels and service channels are not on the same fiber.

In a two-fiber ring consisting of STM-16 digital links, for example,
the first fiber has channels 1-8 assigned as the service path; the
second digital link meanwhile has channels 9-16 assigned as the
protection path for the first fiber’s 8 channels (channels 1-8).

Figure 4-5 A Line Switched Ring After a Failure
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Traffic Flow

The following figure shows the traffic flow on a two-fiber ring with
MS-SPRING protection. With this figure, note that:

• The path of working traffic transmitting from Node A to Node D
traverses both fibers on the service path.

• The path of protection traffic transmitting from Node D to Node
A traverses both fibers on the protection path.

Example of a fault

The following figure shows that a fault has occurred in the paths from
Node B to Node C. Note how the traffic is re-routed to bypass the

Figure 4-6 Two-Fiber Line Switched Ring
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fault so that the traffic still emerges from the destination node from
the expected port.

Four-fiber rings Four-fiber rings are similar to two-fiber rings in function in that they
possess transmit and receive lines. With a four-fiber ring, however,
there are two pairs of transmit and receive lines on each node rather
than a single pair.

Also, the creation of a four-fiber ring is slightly different from that of
a two-fiber ring in that the protection for the digital links have to be
individually provisioned. It is required that the protection digital links
(STM-16 or STM-64) be provisioned between the WaveStar
BandWidth Manager prior to the provisioning of the working
(protected) digital links (STM-16 or STM-64) in creating a four-fiber
ring.

MS-SPRING protection on a four-fiber rings consists of dedicated
fibers for protection and service. In a four fiber MS-SPRING ring,
two fibers are dedicated for service and two digital links are dedicated
for protection.

Figure 4-7 Two-Fiber Line Switched Ring with Fault
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Traffic Flow

The following figure shows the traffic flow on a four-fiber ring.

LSR forming network
elements

The system shall form line switched rings using the following SDH
network elements at the STM-N level specified when the LSR
pre-requisites are met.

Network Elements Rate Fiber

ADM16/1 (MSSPring
Model

STM-16 2 fiber

ADM16/1 Compact
(MSSPring Model

STM-16 2 fiber

SLM16 STM-16 2 fiber

BWM STM-16, STM-64 2 and 4 fiber

TDM10G STM-16, STM-64 2 fiber

Figure 4-8 Four-Fiber Ring Line Switched Ring
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Path-switched rings
....................................................................................................................................................................................................................................

Overview This section discusses path-switched rings.

Figure The following figure depicts a path-switched ring. In it, the traffic
signal is duplicated as it enters the ring (node A) and is sent out over
both the service and protection paths. Both signals are analyzed and
compared at the end ring destination (Node C). The stronger traffic
signal is sent on to the next destination (out of the ring).

Prerequisites for
Automatically Forming An

SDH PSR

The system shall use the following criteria to automatically form a
Path Switched Ring (PSR): a. An STM-N loop is closed. b. The loop
forming STM-N digital links are of the same level. That is, the value
of N (N = 1, 4, 16) in the STM-N’s are identical. c. None of the loop
forming STM-N are in 1+1 MSP, 1X1 MSP, 2-F, 4-F protection
group. d. The connected network elements have Sub-network
Connection Protection (SNCP) capability using the loop closing
STM-N links. e. All the network elements in the loop can inter-work
in an SNCP capacity within the context of WaveStar NMS.

Automatic PSR forming
network elements

The system shall automatically form a path switched ring for the
following network element at the specified STM-N rate when the PRS
forming criteria are met. Only the add/drop multiplexer model of a
given network element can form a PSR ring.

This table lists automatic PSR forming network elements.

Figure 4-9 Path-Switched Ring
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Network Element Rate

ISM-1 STM-1

ISM-4 STM-4

PHASE ADM-16/4 STM-16

PHASE ADM-4/4 STM-4

ADM155E STM-1

WaveStar ADM4/1STM1 STM-1

ADM155E and WaveStar ADM4/1STM1 STM-1

WaveStar ADM4/1STM4 STM-4

WaveStar AM1 STM-1

WaveStar AM1+STM1 STM-1

WaveStar AM1+STM4 STM-4

Mix of network elements in
automatic PSR forming

The system shall allow automatic ring forming comprising of
ADM155E and WS ADM4/1STM1 at STM-1 rate when the PSR
forming criteria are met.
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Synchronous line multiplexer rings
....................................................................................................................................................................................................................................

Overview This section describes Synchronous Line Multiplexer (SLM) rings.
The following figure shows an SLM ring.

SLM rings can be interconnected by using tributary ports. The
following figure shows two SLM rings at the STM16 rate
interconnected at the STM-1 rate by interconnecting their tributary
ports.

Line switching For line switching, SLM-2000 rings support the following features:

• Only channels 1-8 (VC-4 Paths) of the STM-16 lines will be
assigned working traffic.

• Channels 9-16 (VC-4 Paths) are reserved for protection traffic.

• Channels 9 through 16 (VC-4 Paths), the reserved channels, are
not assigned to protect any particular working channels. Thus,
there is only one layout, the working circuit, and no protection
layout used in line switched protection.

• Each line contains half working traffic and the other half is
reserved for protection channels.

• WaveStar NMS establishes, deletes, or views SLM-2000 rings.

Figure 4-10 SLM-2000 Ring
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Protection protocol
....................................................................................................................................................................................................................................

Overview This section describes the protection protocols with rings. LSR ring
protection protocol be either standard or Transoceanic Protocol (TOP).
Ring protection protocol can not be set from WaveStar NMS. It can,
however, be retrieved from the Element Management System (EMS).
Upon request, the system shall display the ring protection protocol as
reported to it by the EMS.

TOP protection The transoceanic protection protocol is used for very long path (when
the distances between network elements are greater than 1500 km.) in
which a purely multiplex section shared protection scheme results in
signal delay and degradation. The delay and degradation are results of
the added path owing to the fact that the switching in MSSPRING is
not done right at either the source or the destination of the working
traffic. In a transoceanic application, the ring switching at a network
element is augmented such that the bridging from the working
channels to the protections channels is performed at the source
network element in the event of a failure. In current release, line
switched rings formed by some network elements supports
transoceanic protocol. Since rings formed by these network elements
are self-discovering, other than provisioning the links between the
network elements, the network manager (WaveStar NMS) need not
explicitly configure the protection protocol. Therefore, no protection
protocol setting by is necessary. The only requirement on WaveStar
NMS is that it recognizes the protocol as reported to it by the EMS.
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Subnet deletion
....................................................................................................................................................................................................................................

Overview This section describes subnet deletion.

Considerations Digital Link Disconnect Criterion (Both PSR & LSR): WaveStar
NMS allows the disconnection of a digital even if the digital link is
part of a ring loop as long as the ring is not providing any protection.

Effect of Digital Link Disconnect: WaveStar NMS deletes a ring if
the disconnection results in the disconnection of digital link that is
part of a ring forming loop.

Effect of Ring Deletion on Ring Name: if a ring is deleted, the
system shall remove the ring name from the list of ring names.
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Section VI: Preplan Restoration

Overview
....................................................................................................................................................................................................................................

Purpose Restoration is the process for WaveStar NMS users to reroute traffic
temporarily in order to restore service in case of a network failure.
WaveStar NMS manages restoration through two features: automatic
protection switching and preplan restoration. This section focuses on
preplan restoration.

Contents
How WaveStar NMS manages restoration 4-68
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How WaveStar NMS manages restoration
....................................................................................................................................................................................................................................

Overview This section describes how WaveStar NMS manages restoration. In
the event of a network failure, WaveStar NMS can restore service to
an alternative link or path that has been reserved for restoration
purposes. WaveStar NMS manages service recovery with two features:

• Automatic protection switching

• Preplan restoration

Automatic protection
switching

Automatic protection switching restores service to a disrupted circuit
by switching the traffic to a dedicated protection route. It is triggered
by an alarm and allows for only one-stage restoration. This restoration
feature does not require user intervention.

Automatic protection switching requires dedicated spare capacity to be
set up when service is provisioned. Mechanisms for automatic
protection switching include: MSP, MS-SPRing, PSR, 1+1 SNC/P, and
Y-protection. The mechanism is selected during service provisioning,
depending upon the capability of a network element. In the case of
failure, detected by the network element supporting the mechanism, a
protection path will be selected and routed by the network element
automatically.

Preplan Restoration Preplan Restoration allows users to create dedicated backups for
service paths and circuits. Disrupted circuit can then be temporarily
rerouted on an alternate route to restore service. The restoration
process can be triggered manually or automatically by an alarm. Once
the alarm situation is resolved, the restored circuit is reinstated to its
original route.

Preplan restoration works best where:

1. One portion of the service circuit is within control of WaveStar
NMS while the other end is outside the WaveStar NMS control
and on the end customers premise

2. Customers have mixed network elements in their network

3. Restoration paths are “off-network” and must be defined by the
customer.

4. Ring protection not provided in the network element.
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5. Fiber cut between rings

6. More efficient usage of spare capacity is desired

Customers can use preplan restoration to establish specific predefined
path(s) according to their network preference. In the event of a failure,
the service will be restored to one of the predefined paths. The spare
capacity is only used at the time of restoration and can be shared
among different preplans for different failure scenarios.

WaveStar-NMS supports preplan restoration of all the circuit rates that
are allowed under normal service provisioning below the digital link
level. However, only two-way circuit types can be protected by
preplan restoration. The one-way and the broadcast circuits cannot
have preplan. Normally, a preplan path protects a service path with
identical circuit type, including “One Step” provisioned circuits,
except for FLAG application. The service facility/circuit to be
protected must be in the “In-Effect” (IE) state in the network before
preplan association can be invoked. One stage or three stages
restoration/reinstatement process can be allowed if appropriately
supported by network element/EMS.
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Aspects of preplan restoration
....................................................................................................................................................................................................................................

Overview This section discusses the three aspects of Preplan Restoration:

• Restoration: a disrupted circuit is temporarily rerouted to an
alternate route to restore service.

• Reinstatement: a restored circuit is returned to its original route.

• Preemption: a higher priority circuit is restored even if there is a
lower or equal priority circuit already using the channel. In such
a case, the lower priority circuit is disconnected and the higher
priority circuit is restored. The system administrator has the
option of turning preemption on or off for restoration.

Restoration Restoration is when a disrupted circuit is temporarily rerouted to an
alternate route in order to restore service. The process of restoring the
failed facility involves moving each affected circuit over to the
preplanned route. The graphical layout for each moved circuit is
updated with the new port address information.

Soft Restoration

With soft restoration, also referred to as bridge and roll, a bridge is
first established and then traffic is rerouted from service to the
preplan. Once the traffic is rerouted, the bridge is disconnected.
Although traffic is uninterrupted, soft restoration is much slower as
compared to hard restoration. Normally, WaveStar NMS shall support
soft restoration/reinstatement for protected path. The exception is
when cross connection performed between the protection segment of a
protected path and another path (either from service to preplan path or
from preplan to service path) within the same network element node,
where the involving network elements support bridge and roll
capabilities, WaveStar NMS shall not allow preplan soft
restoration/reinstatement (bridge and roll) for protected path. Hard
restoration/reinstatement (default) shall be available for
restoration/reinstatement of all unprotected and protected paths.

Figure 1: With the A node and Z node supporting bridge and roll
capabilities, soft restoration/reinstatement can not be applied in this
scenario because either the A node or the Z node has protection
segment of a protected service path and unprotected preplan path. No
soft restoration/reinstatement shall be allowed for cross connection
between the protection segment of a protected service path and
preplan (either protected or unprotected) path from the same network
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element node. Hard restoration to preplan or reinstatement to service
path must be used.

Figure 2: With the A node and Z node supporting bridge and roll
capabilities, soft restoration/reinstatement can be applied in this
scenario because either the A node or the Z node does not cross
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connect traffic from the protection segment of a protected path to the
preplan path (5-6). Hard restoration/reinstatement can also be used.

Hard restoration

With hard restoration, a network service is first disconnected on the
service path, a switch is made to the preplan and then the service is
connected on the preplan path. Traffic is temporarily interrupted in a
hard restoration.
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Triggers

A preplan form’s preference and priority fields determine whether
restoration is triggered.

• Automatic - if a service circuit is protected by multiple preplans,
the preplan selection criteria is based on the highest preference
level as well as the alarm status of the preplan. If the selected
preplans based on the preference level have alarms or in-effect
circuits on their channels, the preplan shall not be used for
restoration and the next highest preference level available preplan
will be tried.

• Manual - if a restoration fails, the user will go to the Preplan
Pairs, PrePlan Plan, or Preplan Group form to execute restoration
for the selected facility/circuit.

Tracking status of restoration orders

Users can track the status of restoration orders by using the Preplan
Pairs form.

Hard and soft restoration for the Lambda Router

Users can choose to use either hard (default) or soft restoration for
Lambda Router models 256/128 that support 1+1 SNCP protection.
WaveStar NMS can support both hard and soft restoration using
modify SNC operation for Lambda Routers (in lieu of bridge and
roll).

Reinstatement Reinstatement is the process whereby a restored circuit is returned to
its original route. Once a failure has been repaired, a reinstatement
may be initiated which would move circuits from the restoration path
back to the original service path.

Enabling reinstatement

Users can activate the reinstatement process from the Preplan Pairs
form. From that form, users need to specify the facility to be
reinstated and then select the reinstate action from the Actions
pull-down menu.

Preemption Preemption is used to restore a higher-priority circuit to a circuit that
is being currently used by lower or equal priority traffic.

How it works

If preemption is turned on and a facility/circuit is needed for
restoration, a dialogue box appears, during restoration indicating the
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preemption target (CKT/Trail ID), and requests user confirmation.
After user confirmation, the lower-priority circuit on the channel is
disconnected and the higher priority circuit is restored. To maximize
restoration speed, WaveStar NMS does not check whether the
preemption target has another preplan.

After preemption is completed, the preplan that caused the preemption
must be manually re-triggered to complete the restoration process. A
preemption report is available to keep track of all the preempted
circuits.

Constraints

The following constraints apply to preemption:

• Preemption is not allowed on circuits carrying lower order
in-effect traffic (such as a VC-4 carrying a VC-12).

• If any preplan circuit in a preplan plan (or preplan group)
requires preemption, the system displays a message for that
particular preplan and awaits confirmation. Preemption must be
confirmed before the system can continue to process other
preplans in that preplan plan (or preplan group). After the preplan
plan or preplan group execution is completed, there are two
options to re-trigger those circuits that have gone through
preemption:

- A preplan plan (or preplan group) can be triggered for a
second restoration because the preplan, marked for
restoration order, is skipped. Only the circuits with
confirmed preemption are restored.

- Individual circuits can be triggered for restoration through
the preplan pairs form after preemption acknowledgement.

Section VI: Preplan Restoration
Aspects of preplan restoration

Provisioning Concepts

....................................................................................................................................................................................................................................

4 - 7 4 Lucent Technologies 365-309-243
Issue 1, July 2001



Preplan creation
....................................................................................................................................................................................................................................

Overview The preplan restoration creation process begins when the user selects
a service paths/circuits to be protected and creates preplans via
provisioning. The process is done off of the Service Network Map
using the point and click provisioning capabilities. The user shall be
able to provision a preplan path/circuit using the automatic,
semi-automatic or manual route selection, similar to the process used
for adding a service path/circuit except using the value ‘Preplan’ of
Order Action for preplan. Each preplan is reserved for one specific
service path/circuit of its failure condition.

Implementation Preplan restoration is implemented in three phases:

1. The user creates and implements a service circuit.

2. The user creates a preplan circuit to backup the service circuit.

3. The preplan circuit is assigned to the service circuit through the
preplan pairs add form.

4. Once the process is completed, the service facility is
automatically protected in the event of failure.

Selection The user can select a two-way service facility/circuit to be protected
via the Service Network Map and create preplans at that rate (a list of
available circuit types will be displayed for user to select from). The
user can access the Preplan Assignment form to display the preplan
circuit assignment information including corresponding channel status
and preplan circuit execution mode and status for a specified circuit.

The user has the option of picking the exact channels for the preplan
(manually) or allowing the system to pick the channels (automatic). If
the automatic method is selected, then WaveStar NMS shall select and
assign spare channels along the selected path to the preplan restoration
order. If the manual method is selected, the user shall select the
channels on each of the links in the preplan path. A preplan circuit
shall be able to be viewed from the graphical layout similar to a
regular provisioned circuit.
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Using common resources WaveStar NMS supports multiple service paths, which can be
associated with their individual preplan paths using the same common
channel resources. To be able to use a common channel resource, the
user has to manually provision separate preplans (with different circuit
ID for each preplan) for each service path with the common channel
resource. Also the same digital link/channel shall be able to be used
for multiple preplan paths.

Example 1: Service path 1 (1-2-3-4) associated with preplan path 1
(1-9-10-4) and service path 2 (5-6-7-8) associated with preplan path 2
(5-9-10-8). Preplan path 1 and 2 can use a common channel resource
(9-10).

Possible circuit types The following table listed all possible circuit types can be provisioned
as service circuit if ″One Step″ provisioning is selected at installation
and the corresponding preplan circuits that shall be allowed for each
service circuit.

Possible circuit types of
service circuit in ″One
Step″

Allowed circuit types of preplan in ″One
Step″

TU12-VC11S TU12-VC11S, TU12-VC11S-24N

VC12S VC12S, VC12S-30N

VC3S VC3S, VC3S-480N, VC3S-672N

AU3S AU3S, AU3S-672N

VC4S VC4S, VC4S-1920N

TU12-VC11S-24N TU12-VC11S-24N, VC12S

VC12S-30N VC12S-30N, VC12S

1 42 3

Service path 1 (1-2-3-4)

1 41

re-p a p ath 1 (1- -1 -4)

5 8

Service path 2 ( - - - )

5 81

re-p a p ath 2 ( - -1 - )
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VC3S-480N VC3S-480N, VC3S

VC3S-672N VC3S-672N, VC3S

AU3S-672N AU3S-672N, AU3S

VC4S-1920N VC4S-1920N, VC4S

Protected path support A protected path can be protected by preplan path(s). The protected
paths in WaveStar NMS include 1+1 protected, ring-protected and
Y-protected (non-assignable only). The ring-protected paths/preplan
paths involved in preplan pairs can be either SNCP (PSR) or
MSSPRING (LSR). A preplan path in WaveStar NMS can be
provisioned as either a protected or unprotected path. Protected
service path can be protected by either unprotected or protected
preplan path(s).

The same rules of association for unprotected paths will be applied to
the protected paths (e.g. a preplan path shall protect a service path
with identical circuit type).

• Unprotected Service Paths: A service path provisioned as
unprotected path can have either protected path (1+1, ring
protected, or Y-protected) or unprotected path as the preplan path.
In other word, all the existing preplan capabilities for unprotected
service path shall be expanded to allow having either protected
path or unprotected path as preplan path.

• Non-Assignable Y-Protected Paths: WaveStar NMS can
support preplan association for only non-assignable Y-protected
paths at any rate that the path can support.

• Protected Service Paths: The WaveStar NMS can support
preplan provisioning, association and restoration for a service
path provisioned as protected path. A service path provisioned as
protected path can have either unprotected or protected path as
the preplan path. All the existing preplan capabilities for
unprotected preplan path shall be applied to protected preplan
path (e.g. preplan creation, association, preplan plan, preplan
group, alarm-triggered restoration, preemption, reports). A
protected path involves both working and protection segments.
When a failure (e.g. alarm on paths with Disabled fault status)
occurred on the working path, the traffic will be switched
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automatically by the network elements to the protection path
first. If the protection switching can not take place, then the
traffic shall be routed to the associated preplan path manually or
automatically. The manual preplan restoration for protected path
remains the same as for the unprotected path.

The following examples depict some possible situations for service
path provisioned as protected/unprotected having preplan path(s).

The first example illustrates how a service path, provisioned as an
unprotected path, is protected by a preplan path provisioned as an
unprotected path.

The second example shows how a service path provisioned as a
Y-protected path can be protected by a preplan path provisioned as
Y-protected and/or an unprotected and/or a ring-protected path.

Figure 4-12 Service Path Provisioned as an Unprotected Path
Service path (unprotected)

Preplan path (unprotected)

Figure 4-13 Service Path provisioned as a Y-Protected Path
Working path of service
path (Y-protected)

Protection path of service
path (Y-protected)

Working path of preplan path 1
(Y-protected)

Protection path of preplan path 1
(Y-protected)

Preplan path 2 (unprotected)

Preplan path 3 (ring-protected)
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The third example depicts how service paths provisioned as 1+1
protected can be protected by a preplan path provisioned as a ring
protected and/or an unprotected path.

Graphical layout The graphical layout supports the same display capabilities of
unprotected path for the protected path when the implementation of
restoration/reinstatement process is failed.

Only the segment(s) which belong to the old order path and are not
common with the new order path shall be shown in color gray. The
rest segments (if any) of the old order path and the new order path
shall be shown with the color indicating the current status (e.g. blue,
magenta, green depending on the status).

Figure 1:When restore/reinstate implementation from path 1-2-3-4
(old order) to path 1-5-6-4 (new order) failed, the segments C-2-D
and E-3-F of the old order path will be in gray because they are not
common segments with the new order path. The rest segments of the

Figure 4-14 Service paths provisioned as 1+1 Protected
Service path (1+1

protected path)

Preplan path 1 (ring

protected path)

A

B

C

F

Preplan path 2

(unprotected path)
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new and old order paths are in the color(s) indicating the current
status.

Figure 2: When restore/reinstate implementation from path 1 - 2/4 -
3/5 - 6 (old order) to path 7 - 8 (new order) failed, the whole
segments of the old order path (A-1-B, C/G - 2/4 - D/H, E/I - 3/5 -
F/J, K-6-L) will be in gray because no common segment with the new
order path. The segments of the new order path (W-7-X, Y-8-Z) are in
the color(s) indicating the current status.

1 2

5 6

3 4
A B C F G H

W Z

D

X Y

E

A B C

1

W
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4 5

2 3

H I

D E

X

G
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6

8

J

Y
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Association of a preplan to a service circuit
....................................................................................................................................................................................................................................

Introduction To protect an in-effect service circuit, a preplan circuit needs to be
associated with the service circuit to be protected after it is
successfully created.

The service circuit being protected must be in the In-Effect state and
the preplan circuit must be in the pending step (CPL) before an
association can be made. The association shall be made utilizing the
Preplan Pairs Add form, from which the user shall be able to enter
both the service and the preplan circuits IDs to establish the
association or link preplan pairs to a preplan plan. A preplan path
shall protect a service path with identical circuit type, including “One
Step” provisioned circuits, except for FLAG application.

1 x N Preplans: WaveStar NMS has “1 x N” preplan restoration
capability which can be set up through the environmental variable
during system installation process. The “1 x N” preplan restoration
means that an IE service circuit can be protected by “N” (99 less than
or equal to N greater than or equal to 1) preplan circuits.

Preplans with different end nodes: WaveStar NMS can handle
preplan restoration/reinstatement path with one or both end nodes that
are not identical to the end nodes of the associated service path. It
means the preplan path and its corresponding service path may have
two common end nodes, one common end node, or two different end
nodes. However, WaveStar NMS shall block the implementation of
preplans with different end nodes if the end node of the service circuit
contains groomed low-level paths/circuits. A non-channel assignable
entity (e.g. VC-4, VC-12, VC-3, or VC-2) shall allow preplan with
different end nodes (one or both). An assignable entity but no lower
order paths/circuits provisioned shall allow preplan with different end
nodes (one or both) at the SDH level. TUG structure VC-4 path can
be preplan protected as long as the TUG structure termination points
are not changed.

Preplans with different end nodes (for FLAG only): Normally,
WaveStar NMS shall block the implementation of preplans with
different end nodes if the end node of the service circuit contains
groomed low-level paths/circuits. The check for blocking this
implementation (preplan with different end nodes) shall be done
during the creation of restoration order not during association. The
only exception is for FLAG application. For FLAG only, preplan
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restoration shall support different end nodes containing groomed low
level paths/circuit of the service circuit if the preemption flag is set
(turn on) for low level paths/circuits (e.g. VC-12).

Preplan path with different end ports on the same end node: For
non-infrastructure paths that do not terminate at WS DACS or DACS
VI, WaveStar NMS shall allow preplan restoration/reinstatement
circuit within the same network element node with the service circuit
but sharing one common end port. The preplan path and the
associated service path can be either unprotected or protected. If either
preplan path or service path is provisioned as protected path, only
hard restoration/reinstatement shall be applied regardless the involving
network element has bridge and roll capabilities. Soft
restoration/reinstatement shall be available only when both preplan
and service paths are provisioned as unprotected and the network
element, where the cross connect will be performed, supporting the
bridge and roll capabilities. Restoration/reinstatement shall not be
allowed for the service and preplan paths have no common
terminating port within the same end node.

Preplan preference level: The user can specify the preference level
1-99 (as 99 the highest preference) for each preplan circuit via the
Preplan Pairs form and Preplan Pairs Add form. Preference level of
each service/preplan circuit pair for the same service circuit must be
unique and can be set at the same time the preplan path is established.
This will allow the user to establish multiple preplans to protect
similar type failures. In the automatic (alarm-triggered) restoration, the
preference level shall be used as the order of selection preference. For
example, the preplan with the highest preference will be implemented
when a service circuit is protected by multiple preplans. If the preplan
with the highest preference is not available (i.e. it has a primary alarm
on its route or on its carriers) at the time of restoration, the preplan
with the next highest preference when available will be selected. For
automatic restoration, if no preplan available at the time of restoration
for a service circuit, no restoration action will be taken and the
service circuit shall be left in the failed state until manual resolution
by the user. Preplan preference level is mainly for alarm-triggered
restoration and for 1 x N application.

Preplan priority level: The user has the option of setting the priority
(1-10, default value is set to 5 if not entered by user) of the
service/preplan circuits pair via the Preplan Pairs form and Preplan
Pairs Add form. The user can use priority level to determine which
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service circuit has higher priority when multiple service circuits share
the same preplan. If all service circuits have same priority level then
the preference level will be used. The service circuit with the highest
preference level will use the preplan. The priority level can be used
for preemption.

Automatic triggering of next available preference level preplan
restoration: If turned on, WaveStar NMS shall automatically trigger
the next highest available preference level preplan if the failed service
circuit can not be restored with the highest available preplan because
the highest preference level preplan is already used by other circuits
or is in alarmed state. The process of finding the next preference level
preplan shall be continued until an associated preplan with no alarm
or not in use by other service circuits is found. If no available preplan
is found at the time of restoration for a service circuit, no restoration
action will be taken and the service circuit shall be left in the failed
state until manual resolution by the user.

Disassociation of preplans from service circuits: The user can use
the Preplan Pairs Form to disassociate the service circuits from its
associated preplan circuit. Each disassociation action shall disassociate
one service/preplan pair at a time. For the service/preplan pair linked
to a Preplan Plan and/or Group, the user needs to unlink the preplan
circuits from the Preplan Plan and/or Group before disassociate
preplans from service circuits. If user tries to disassociate a preplan of
a Preplan Plan and/or Group without unlinking it first, an error
message shall be displayed.

Modification of Preplans: The user can modify the preplan from the
Graphical Layout only if it is in the LAY state and not associated with
any service circuit. After association, the preplan can not be modified
because it must be in the pending CPL step. If the preplan not
associated with any service circuit but in the CPL state needs to be
modified, the user shall be able to select Actions Æ Move Order Step
Back from the preplan’s Graphical Layout to bring the preplan’s Order
Step from CPL to LAY. Once the preplan is in the LAY state, the user
shall be able to modify the preplan circuit via the Digital
Link/Facility/Circuit Profile form by selecting Actions Æ Modify Æ
Path from the preplan’s Graphical Layout. The user shall also be able
to bring the preplan’s Order Step from LAY to CPL by selecting
Actions Æ Move Order Step Forward from the preplan’s Graphical
Layout.
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Cancellation of Preplans: The user can cancel a preplan circuit via
the Graphical Layout if the preplan circuit is not associated with a
service circuit and the preplan circuit must be in LAY state. For the
preplan circuits linked to Preplan Plan and/or Group, the user needs to
unlink the preplan circuits from the Preplan Plan and/or Group before
cancelling preplans. If user tries to cancel a preplan of a Preplan Plan
and/or Group without unlinking it first, an error message shall be
displayed.

Preplan restoration on top of preplan: If turned on, the WaveStar
NMS shall allow next available unalarmed preplan circuit (one of the
1 x N preplans associated with the same service circuit) for the
restoration of the original service circuit if the previous preplan
restoration path is alarmed after the restoration has been complete.
This feature shall be for 1 x N application only and applicable for
manual and automatic restorations. For example, preplan P1
(preference level 90) & P2 (preference level 80) protect a service
circuit (S1). First restoration used preplan P1 and completed. Alarmed
on the in effect preplan P1, restoration will execute preplan P2 if
available. When a service circuit protected by only one preplan, if the
preplan restored and then has alarm, the service circuit remains in
alarm/failure status.
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Preplan plans and preplan groups
....................................................................................................................................................................................................................................

Introduction For a single service circuit, WaveStar NMS supports multiple preplans
to be provisioned for different failure scenario in the network. For a
single failure scenario, there can be many service circuits involved.
For these scenarios, the user can utilize Preplan Plan or/and Preplan
Group features. Preplan Plan/Group allows the user to create multiple
preplans against each failure condition providing alternate route option
at the time of restoration. This feature is applicable for manual
restoration/reinstatement process only. Each service circuit can appear
only once in each Preplan Plan/Group. For example, service circuit 1
associated with preplan circuit 1 (pair 1) and preplan circuit 2 (pair
2). The pair 1 and pair 2 can not co-exist in the same Preplan
Plan/Group. Pair 1 can be in Preplan Plan/Group 1 while pair 2 is in
Preplan Plan/Group 2.

Preplan plan: The user can group more than one service/preplan
circuit pairs into a Preplan Plan (Plan ID). Since a Preplan Plan is
intended for a particular restoration route or a specific failure
scenario, a service circuit shall appear only once in a Preplan Plan. A
Preplan Plan can contain a grouping of maximum 500 service/preplan
circuit pairs.

Preplan group: The user can group multiple Preplan Plans into a
Preplan Group (Group ID), so the preplan restorations/reinstatements
can be easily tracked and implemented as a group. Since a Preplan
Group is intended for a particular restoration route or a specific failure
scenario, a service circuit shall appear only once in a Preplan Group.
The preplan circuits in the same Preplan Group shall not have
common channels. A Preplan Group can contain a grouping of
maximum 500 Plan ID.

Preplan plan and preplan group restoration and reistatement:
WaveStar NMS allows the execution of the Preplan Plan or Preplan
Group with some circuits that have been restored or reinstated. In this
scenario, Preplan Plan or Preplan Group restoration/reinstatement shall
proceed with restoration or reinstatement for the remaining circuits.
Upon completion of the restoration/reinstatement, the total count of
already restored or reinstated circuits included in each Preplan
Plan/Group shall be indicated in the ″No Action″ column in the table
of the Preplan Plan or Preplan Group form. For example, Preplan Plan
1 includes service/preplan circuit pairs 1, 2, 3, 4, 5 while pair #2 has
been restored for an alarm situation. When executing restoration from
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the Preplan Plan 1, pairs 1, 3, 4, 5 will be restored and pair 2 will be
skipped (because already in REST status). After the restoration is
completed, the number of pairs that have no action taken because the
pair was already in the requested state shall be indicated in the No
Action column in the Preplan Plan form. In this example, 1 (for pair
#2) will be shown in the No Action column.
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Execution concepts
....................................................................................................................................................................................................................................

Execution of a preplan Manual preplan restoration/reinstatement: The user can go to the
Preplan Pairs, Preplan Plan, or Preplan Group form to execute the
restoration for the selected facility/circuit or reinstate to service circuit
after repair. The user shall be required to set the “Ignore Alarm” (Yes
or No), “Stage” (One Stage or Three Stages) and
“Restoration/Reinstatement” (Soft or Hard) parameters whenever
applicable.

“Ignore Alarm” option for preplan restoration/reinstatement: The
user can specify the “Ignore Alarm” option via the PrePlan Parameters
form. “Ignore Alarm” option allows the user to specify if the alarm
status on the preplan circuit should be ignored and has two choices:
‘Yes’ and ‘No’ (default). If the selection is ‘No’ and the selected
preplan based on the preference level has alarm then the preplan
restoration shall fail. The only exception is when the user sets “Ignore
Alarms” to ‘Yes’, then an alarmed preplan shall be used and
restoration order shall be created.

“Stage” option for preplan restoration/reinstatement: The user can
specify the “Stage” option via the PrePlan Parameters form. The
“Stage” option allows the user to specify whether the ‘one stage’ or
‘three stages’ restoration/reinstatement process should be executed. If
value “One Stage” is selected, then all commands will be executed
automatically. If value “Three Stages” is selected, then the system
stops after each step (IMP – bridge operation, IMR – roll operation)
for user to send commands manually. The default setting for the
“Stage” option is “One Stage” which can be set for Soft or Hard
preplan restoration/reinstatement. Value “Three Stages” shall be
applicable only for Soft preplan restoration/reinstatement.

“Restoration/Reinstatement” option for preplan
restoration/reinstatement: Users can specify the Hard or Soft
restoration/reinstatement via the PrePlan Parameters form at the group
level, plan level or preplan circuit at the time of
restoration/reinstatement. For network elements which support bridge
and roll capabilities, the user shall be able to choose to use either
Hard (default) or Soft restoration/reinstatement. Network elements that
do not support bridge and roll capabilities shall only be able to use
Hard restoration/reinstatement. If value “hard” is selected, then
disconnect (for restoration)/connect (for reinstatement) commands are
used for the alarmed service circuit and the cross-connect operation
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shall be implemented for preplan circuit. If “soft” is selected, then
bridge, roll, and disconnect commands are issued for those network
elements that support this type of activity. Hard option can not be
used together with “Stages” option which has value “Three Stages.”

“Preemption” option for preplan restoration/reinstatement: The
user can set the “preemption” option via the Preplan Parameters form
only when the preemption feature is licensed. This option has two
values, Yes and No (default), to turn preemption feature on or off. If
‘Yes’ is selected then the preemption feature is turned on; otherwise,
the preemption is off. Preemption feature is only for manual
restoration and used to restore a higher priority circuit even when
there is a lower or equal priority circuit already using the channel.

Automatic (alarm-triggered) preplan restoration: If a service circuit
is protected by multiple preplans, the preplan selection criteria shall
be based on the highest preference level as well as the alarm status of
the preplan. If the selected preplans based on the preference level
have alarms or have in-effect circuits on their channels, then the
preplan shall not be used for restoration and the next highest
preference level available preplan shall be tried. Alarmed triggered
restoration shall not allow user to set values and configure the
following defaults for restoration parameters: Ignore Alarm – No,
Stages – One Stage, Restoration – Hard, Preemption - No, during
WaveStar NMS installation.
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Preemption concepts
....................................................................................................................................................................................................................................

Preemption and affected
circuits

If preemption (optional feature) is manually activated, then
preemption may be used in the restoration process to restore a higher
priority circuit even when there is a lower or equal priority circuit
already using the channel. When other in-effect service circuit uses
the channel of a preplan circuit, this preplan can not be used for
restoration until the in-use channel is released/disconnected from the
active traffic. The user will have the option of preemption feature on
WaveStar NMS if licensed. Preemption is an optional feature which
shall be provided as an additional option only if the preplan
restoration feature is installed. Preemption feature can be used to
restore a higher priority circuit even where there is a lower or equal
priority circuit already using the channel. After preemption is
completed, the user needs to manually re-trigger the preplan that
caused the preemption.

Detection: the user can turn preemption on or off when initiating the
restoration. If preemption is turned on, the user shall be notified at
association if any other in-effect circuits use the selected channel.
User confirmation is required before the system can continue to
proceed the preemption. At the time of restoration, WaveStar NMS
shall notify the user if the preplan contains a channel used by other
in-effect circuit. The user shall have the ability to either terminate the
restoration process or disconnect (preempt) the lower/equal priority
circuit on the channel and then implement a preplan restoration with
higher priority circuit. If preemption is not turned on and the channel
of the selected preplan can not be used at the time of restoration, the
system will terminate the restoration process. The user shall be able to
use the Affected Circuits for Preplan Execution form to find out what
circuit affected by the preplan. This form lists the affected service
circuits or circuits have pending circuits where the pending circuits
have commands been sent during the IMP state. The user shall
manually disconnect or rearrange those affected circuits before the
preplan can be executed.

For manual restoration: Preemption feature is applicable for manual
restoration only. If preemption is needed at restoration, a dialogue box
shall appear indicating the preemption target circuit and requesting
user confirmation to continue. After user confirmation, the preemption
process shall create a “dummy” restoration order for the preempted
circuit to keep the original circuit layout for reinstatement purpose and
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disconnect the target circuit. The user shall not be notified when the
preemption is completed. After preemption is completed, the original
preplan that causes the preemption shall be manually triggered again.

For preplan plan or group: If preemption is turned on and if any
circuit in a Preplan Plan (or Group) requires preemption, the WaveStar
NMS shall display a message for that specific preplan and wait for
user confirmation. Once the user confirms the preemption, the system
shall continue or process other preplans in the Plan (or Group). After
the Plan or Group implementation is completed, the user may trigger
the Plan (or Group) operation for a second time for restoration. Only
the circuits of which preemption has been confirmed (not in RS state)
will be restored. The user can also trigger individual circuits for
restoration via the Preplan Pairs Form after the preemption is
completed.

Section VI: Preplan Restoration
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Reinstatement concepts
....................................................................................................................................................................................................................................

Reinstatement
(normalization)

The reinstatement of a service circuit is a manual process. This is to
ensure that the reinstatement is carried out in a way most appropriate
to the customer’s network operation since the reinstatement process
could introduce service interruption if hard reinstatement is required.
The user will be notified at the time of preplan creation that service
will be disrupted on reinstatement if only hard reinstatement is
supported because the restoration facility needs to be disconnected
before the original service path can be re-established. The user can
select hard or soft reinstatement but default is soft. The preempted
circuit can not be reinstated unless the service circuit, which causes
the preemption, has been reinstated. The reinstatement process shall
always bring the current restoration circuit back to the original service
circuit without reverting to any of the intermediate preplan restoration
circuits if any.

Of circuits: If a service circuit is protected by a preplan, after the
faulted service facility has been repaired, WaveStar NMS shall receive
an alarm clear message and update the alarm status of the affected
service facility. The user then shall be able to move the circuits from
the restoration path back to the original service path. The user shall be
able to initiate reinstatement using the Preplan Pairs form or Graphical
Layout of the preplan circuit. Reinstatement process shall be also
applicable for Preplan Plan and Preplan Group reinstatement. For the
reinstatement process, the user shall specify the parameter values in
Preplan Parameters form in the same way as they work for the manual
restoration process. The Ignore Alarm, Stages, and Hard/Soft
Reinstatement options shall also work in a similar fashion as for the
manual restoration process.

Modification or deletion: The user shall be able to modify the “Start
Date” and/or “Start Time” for any scheduled reinstatement or delete a
scheduled reinstatement through the “Scheduled List” screen.
Modifying or deleting scheduled reinstatement shall not be allowed if
the circuit is already undergoing or completing manually initiated
reinstatement. This capability shall be supported at the preplan circuit
level only and shall not include Preplan Plan and Preplan Group
levels.
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5 Digital Transmission Rates

Overview
....................................................................................................................................................................................................................................

Purpose This chapter discusses the digital transmission rates and
interconnections of the circuits and digital links supported by
WaveStar NMS.

Contents
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Section I: Supported Transmission Rates

Overview
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Purpose This section discusses the digital transmission rates supported by
WaveStar NMS.
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Supported digital transmission rates
....................................................................................................................................................................................................................................

Overview This section discusses the digital transmission rates supported by
WaveStar NMS.

Table The following table shows the digital transmission hierarchies and
rates supported by WaveStar NMS.

Table 5-1 Supported Digital Transmission Rates

Designation Description Facility Type Transmission Rate Mb/s Notes

STM-64 Digital Link 64S(10,000LN) 9,953.28

STM-16 Digital Link 16S (2500LN) 2,488.32

STM-4 Digital Link 4S (620LN) 622.0

STM-1 Digital Link 1S (155LN) 155.52

STM-0 Digital Link 0S (52LN) 51.84

VC-4 Path VC4S 150.336

VC-3 Path VC3S 48.960

VC-12 Path VC12S 2.240

CEPT-4 Digital Link E4 (140LN) 139.264

CEPT-3 Digital Link E3 (34LN) 34.368

CEPT-1 Digital Link E1 (2LN) 2.048

CEPT-4 Facility 1920N 139.264 Similar to
CEPT-4 Circuit

CEPT-3 Facility 480N 34.368 Similar to
CEPT-3 Circuit

CEPT-4 Circuit 1920N 139.264

CEPT-3 Circuit 480N 34.368

CEPT-1 Circuit 30N 2.048

DS3 Digital Link 45LN 44.736

DS3 Circuit 672N 44.736

DS1 Digital Link 1.6LN 1.544

DS1 Circuit 24N 1.544

LAN8 Digital Link up to 4 VC-12s AM 1, ADM
16/1 only
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Table 5-1 Supported Digital Transmission Rates (continued)

Designation Description Facility Type Transmission Rate Mb/s Notes

LSBB 45 Mb/s to 750 Mb/s OLS

HSBB 100 Mb/s to 2.5 Gb/s OLS

X.21 Digital Link 2 Mb/s AM 1, Black
Boxes only
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Section II: Network Element-Specific Transmission Rates

Overview
....................................................................................................................................................................................................................................

Purpose This section discusses the interconnections supported by WaveStar
NMS.
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Supported interconnections
....................................................................................................................................................................................................................................

Overview This section describes the WaveStar NMS supported interconnections.

Section II: Network Element-Specific
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Digital links The supported digital links for each Lucent Technologies network
element supported by WaveStar NMS are shown in the following
table.

Digital links with MSP The supported MSP protection capabilities for SDH network elements
are shown in the following table.

Network Element STM-0 STM-1 STM-4 STM-6 STM-64

Section II: Network Element-Specific
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ADM 155E 1+1

WaveStar ADM 4/1
STM-1

1+1

WaveStar ADM 4/1
STM-4

1+1

WaveStar ADM 16/1 1+1 1+1

WaveStar ADM 16/1
Compact

1+1

WaveStar AM 1 1+1

WaveStar AM 1 PLUS 1+1 (Line and
Trib Pairs)

WaveStar TM 1 1+1

WaveStar BandWidth
Manager

1+1 1+1 1+1, 1x1 1x1

WaveStar TDM 10G 1+1 1+1 1+1 1+1, 1x1

WaveStar DACS (Rel.
2.1 and 3.0)

1+1 1+1 1+1

WaveStar DACS (Rel.
2.0)

1+1 1+1

DACS VI (Rel. 2.1) 1+1 1+1

Black Box 1+1 1+1 1+1 1+1 1+1

ISM-1 1+1

ISM-4 1+1

ISM-5E 1+1

SLM-16 1+1 (for SLM
1+1 model
only)

SLM-4 1+1 (for SLM
1+1 model
only)

PHASE ADM 16/4 1+1 1+1 1+1

PHASE ADM 4/4 1+1 1+1

PHASE LXC 16/1 1+1 1+1 1+1

PHASE LXC 4/1 1+1 1+1

PHASE TM 16/4 1+1 1+1 1+1
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PHASE TM 4/4 1+1 1+1
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Section III: SDH Cross-Connects

Overview
....................................................................................................................................................................................................................................

Purpose This section describes the SDH cross-connect types and rates.
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Supported SDH cross-connect types and rates
....................................................................................................................................................................................................................................

Introduction The networks that can be managed with WaveStar NMS include a
variety of SDH cross-connect types and rates.

Supported SDH
cross-connect types and

rates

The following table lists rates at which the cross-connect types are
supported for one-way (O), two-way (T), and broadcast (B) circuits by
WaveStar NMS. The network element by itself may support more
rates than are supported with WaveStar NMS.

The SDH cross-connect types and rates for each network element
supported by WaveStar NMS are shown in the following table:

VC4-64c VC4-16c VC4-4c VC-4 VC-3 VC-2 VC-12 AU-3

ADM 155E T O, T, B T

WaveStar
ADM 4/1
STM-1

T O, T, B T

WaveStar
ADM 4/1
STM-4

T O, T, B T

WaveStar
ADM 16/1

T T T T

WaveStar
ADM 16/1
Compact

T T T T

WaveStar
AM 1

T T

WaveStar
AM 1 PLUS

T T T

WaveStar
TM 1

T
(fixed)

WaveStar
BandWidth
Manager

O, T, B O, T, B O, T,
B

O, T, B

WaveStar
TDM 10G

O, T, B O, T, B O, T,
B

O, T, B
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VC4-64c VC4-16c VC4-4c VC-4 VC-3 VC-2 VC-12 AU-3

WaveStar
DACS
(managed by
ITM-SC)

O, T, B O, T,
B

O, T, B O, T, B O, T, B

WaveStar
DACS
(managed by
ITM-XM)

O, T,
B

O, T, B O, T, B O, T, B

DACS VI O, T,
B

O, T, B O, T, B O, T, B

Black Box O, T, B O, T, B O, T, B O, T,
B

O, T, B T O, T, B O, T, B

ISM-1 T O, T, B T

ISM-4 T O, T, B T

ISM-5E T

SLM-16 T

SLM-4 T
(fixed)

PHASE
ADM 16/4

O, T, B O, T,
B

PHASE
ADM 4/4

O, T,
B

PHASE LXC
16/1

O, T,
B

O, T, B T O, T, B

PHASE LXC
4/1

O, T,
B

O, T, B T O, T, B

PHASE TM
16/4

O, T, B O, T,
B

PHASE TM
4/4

O, T,
B

NERA Radio
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Section IV: SNCP Protection

Overview
....................................................................................................................................................................................................................................

Purpose This section describes the rates at which SNCP protection is supported
for one-way (O), two-way (T), and broadcast (B) circuits in WaveStar
NMS.
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Supported SNCP protection
....................................................................................................................................................................................................................................

Introduction The networks that can be managed with WaveStar NMS include a
variety of SNCP protection.

List of supported SNCP
protection

The following table lists the rates at which SNCP protection is
supported for one-way (O), two-way (T), and broadcast (B) circuits in
WaveStar NMS. The network element by itself may support more
rates than are supported with WaveStar NMS.

The rates at which the SNCP cross-connects are supported by
WaveStar NMS are shown in the following table:

VC4-64c VC4-16c VC4-4c VC-4 VC-3 VC-2 VC-12 AU-3

ADM 155E T O, T,
B

T

WaveStar
ADM 4/1
STM-1

T O, T,
B

T

WaveStar
ADM 4/1
STM-4

T O, T,
B

T

WaveStar
ADM 16/1

T T T T

WaveStar
ADM 16/1
Compact

T T T T

WaveStar
AM 1

T T

WaveStar
AM 1 PLUS

T T T

WaveStar
TM 1

T (fixed)

WaveStar
BandWidth
Manager

O, T, B O, T, B O, T, B O, T,
B

WaveStar
TDM 10G

O, T, B O, T, B O, T, B O, T,
B
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VC4-64c VC4-16c VC4-4c VC-4 VC-3 VC-2 VC-12 AU-3

WaveStar
DACS
(managed by
ITM-SC)

O, T, B O, T, B O, T,
B

O, T, B O, T,
B

WaveStar
DACS
(managed by
ITM-XM)

DACS VI O, T, B O, T,
B

O, T, B O, T,
B

Black Box O, T, B O, T, B O, T, B O, T, B O, T,
B

T O, T, B O, T,
B

ISM-1 T O, T,
B

T

ISM-4 T O, T,
B

T

ISM-5E T

SLM-16 T

SLM-4 T
(fixed)

PHASE
ADM 16/4

O, T, B O, T, B

PHASE
ADM 4/4

O, T, B

PHASE LXC
16/1

O, T, B O, T,
B

T O, T, B

PHASE LXC
4/1

O, T, B O, T,
B

T O, T, B

PHASE TM
16/4

O, T, B O, T, B

PHASE TM
4/4

O, T, B

NERA Radio
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6 Network Element Port Addresses

Overview
....................................................................................................................................................................................................................................

Purpose This chapter describes the concepts associated with port addresses as
they relate to WaveStar NMS.

Contents
Section I: Introduction 6-4
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Port identifiers for WaveStar ADM 16/1 network
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6-18

Port identifiers for WaveStar ADM 4/1 network
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Section IV: WaveStar DACS VI Port Addresses 6-36

Port address information 6-37
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ISM-4 line ports 6-50

ISM-4 virtual ports 6-52
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Terminal line ports (radio side) external addresses 6-63

Terminal tributary ports (electrical side) external
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6-64

Regenerator line ports external addresses 6-65
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Section VIII: PHASE Port Addresses 6-73

Port address information 6-74
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Correlation between external and internal port
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6-96
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About generic port addressing
....................................................................................................................................................................................................................................

Overview Generic port addressing allows for a single address structure across all
network elements. This applies to Lucent and other vendor equipment.
With WaveStar-NMS, the generic port address is commonly referred
to as the external address or network level address.

Terminology The following terminology applies to the material discussed within
this chapter:

• Protection Group: not visible in WaveStar NMS.

• External address: the network level address used in WaveStar
NMS.

• Internal Address: the element level address, which is generally
the ’native’ port address used in the EMS.

• Physical port address: address of the port that physically
terminates a facility.

• Logical port address: address of a logical channel riding on a
higher-order system; the higher-order system is terminated on a
physical port. A logical port address can also be a lower- order
logical channel, riding on a higher-order logical channel, riding
on a facility that terminates on a physical port.

• Virtual port address: allows users to control two line ports; one
line port is the service port while the other is the protection port.
Virtual port addressing is a protection scheme.

• Tributary port: generally refers to the add/drop side of a network
element.

• Virtual port: terminates the two line ports in a protection scheme.
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Address structure
....................................................................................................................................................................................................................................

Generic port address
structure

The generic port address structure is as follows:

Physical Port Type / Physical Port Location / Logical Address(es)

For a lower-order logical channel riding on a higher-order logical
channel, the generic port address structure is as follows:

Physical Port Type / Physical Port Location / Higher Order Logical
Address - Lower Order Logical Address

Physical port types The physical port types associated with the generic port address are as
follows:

• STM-x = Sx. For example, STM-4 is S4.

• CEPT-x = Px. For example, CEPT-3 is P3.

Physical port location The physical port location consists of: Shelf / Slot / Port

If Slot contains only one port, the number one is entered for the port
number.

Logical port location The logical port location consists of:

• Shelf / Slot / Port /higher logical port - lower logical port

• Shelf / Slot / Port /single logical port.

External addresses The external addresses associated with generic port addressing may be
represented through the following form: Sx/m/n/p/h - 1

• x can equal 0, 1, 4, 16, or 64.

• m= mm: physical shelf number

• n=nn: physical slot number

• p: physical port number

• h: high order logical port number

• l: lower order logical port number
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KLM (G707) notation
....................................................................................................................................................................................................................................

Background This feature causes a different notation to be used for external port
addressing. WaveStar NMS uses a “sequential” port addressing
scheme to represent the lower order logical port number.

Definition The KLM (or G707) notation for external port addressing uses a
tributary numbering notation to represent the “channel number” or the
“lower order logical port number” of the VC-3, VC-12, and VC-2
paths.

Examples The following table provides examples of the two external port
addressing schemes:

Path Type Logical Port
Type

WaveStar NMS External
Port Address

K, L, M External Port
Address Notation

VC-12 TU12 S1/PA5/1/2/1-31 S1/PA5/1/2/1-2.4.1

VC-12 TU12 S1/1/12/4-63 S1/1/12/4-3.7.3

VC-2 TU2 S1/1/2/4/1-20 S1/1/2/3/1-3.6.0

VC-3 TU3 S1/PA5/1/3/1-2 S1/PA5/1/3/1-2.0.0
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Section II: ADM Port Addresses

Overview
....................................................................................................................................................................................................................................

Purpose This section provides conceptual information regarding the WaveStar
port addresses for the both the physical and logical ports of the
following network elements:

• ADM-155C

• ADM-155E

• ADM-16CMSSP

• ADM-16CSNCP

• ADM-16MSSP

• ADM-16SNCP

• ADM-41STM1

• ADM-41STM4

Contents
Physical Line Ports 6-9

Tributary Ports 6-14

Port identifiers for WaveStar ADM 16/1 network
elements

6-18

Port identifiers for WaveStar ADM 4/1 network
elements

6-24

Port identifiers for ADM-155E network elements 6-27
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Physical Line Ports
....................................................................................................................................................................................................................................

Overview This section contain information on the physical line ports (external
addresses) for the ADM-4/1 and ADM-155E network elements.

ADM-4/1 The following tables list the ADM-4/1 physical line ports.

Table 6-1 STM-Digital Links

S1/m/nn/p

m 1

nn 20 or 60

p 1

Example There are only two possible addresses:

S1/1/20/1 or S1/1/60/1

Table 6-2 VC-4 Paths

S1/m/nn/p/h

m 1

nn 20 or 60

p 1

h 1

Example There are only two possible addresses:

S1/1/20/1/1

S1/1/60/1/1

Table 6-3 VC-3 Path Riding VC-4

S1/m/nn/p/h-l

m 2

nn 20 or 60

p 1

h 1

l 1 to 3

Example S1/1/20/1/1-1

S1/1/60/1/1-3
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Table 6-4 VC-12 Path Riding VC-4

S1/m/nn/p/h-l

m 1

nn 20 or 60

p 1

h 1

l 1 to 63

Example S1/1/20/1/1-1

S1/1/60/1/1-63

Table 6-5 VC-3 Path Riding a VC-4 Path Riding STM-1 Digital Link Using 1 + 1 MSP
Protection

S1/m/GRPn/p/h-l

m 1

nn 1

p 1

h 1

l 1 to 3

Example There are only three possible addresses:

S1/1/GRP1/1/1-1

S1/1/GRP1/1/1-2

S1/1/GRP1/1/1-3

Table 6-6 VC-12 Path Riding VC-4 Path Riding STM-1 Digital Link Using 1 + 1 MSP
Protection

S1/m/GRPn/p/h-l

m 1

nn 1

p 1

h 1

l 1 to 63

Example S1/1/GRP1/1/1-1

S1/1/GRP1/1/1-63

Section II: ADM Port Addresses
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Table 6-7 STM-1 Digital Link Using 1 + 1 MSP Protection

S1/m/GRPn/p

m 1

n 1 or 2

p 1

Example There are two possible address:

S1/1/GRP1/1

S1/1/GRP2/1

Table 6-8 VC-4 Path Riding on an STM-1 Digital Link Using 1 + 1 MSP Protection

S1/m/GRPn/p/h

m 1

n 1 or 2

p 1

h 1

Example There are two possible addresses:

S1/1/GRP1/1/1

S1/1/GRP2/1/1

Table 6-9 VC-3 Path Riding VC-4 Path Riding STM-1 Digital Link Using 1 + 1 MSP Protection

S1/m/GRPn/p/h-l

m 1

n 1 or 2

p 1

h 1

l 1 to 3

Example There are only six possible addresses:

S1/1/GRP1/1/1-1

S1/1/GRP1/1/1-2

S1/1/GRP1/1/1-3

S1/1/GRP2/1/1-1

S1/1/GRP2/1/1-2

S1/1/GRP2/1/1-3
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Table 6-10 VC-12 Path Riding VC-4 Path Riding STM-1 Digital Link Using 1 + 1 MSP
Protection

S1/m/GRPn/p/h-l

m 1

n 1 or 2

p 1

h 1

l 1 to 63

Example S1/1/GRP1/1/1-1

S1/1/GRP2/1/1-63

ADM-155E The following tables list the ADM-155E physical line ports.

Table 6-11 STM-1 Digital Link

S1/m/nn/p

m 1

nn 20 or 60

p 1

Example There are only two possible addresses:

S1/1/20/1 or S1/1/60/1

Table 6-12 VC-4 Paths

S1/m/nn/p

m 1

nn 6, 7, 16, 17

p 1

Example S1/1/6/1 or S1/17/1

Table 6-13 VC3 Path Riding VC4

S1/m/nn/p/h

m 1

nn 6, 16

p 1

h 1
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Table 6-13 VC3 Path Riding VC4 (continued)

Example There are only two possible addresses:

S1/1/6/1/1

S1/1/16/1/1

Table 6-14 VC12 Path Riding VC-4

S1/m/nn/p/h-l

m 1

nn 6, 16

p 1

h 1

l 1 to 3

Example S1/1/6/1/1-1

S1/1/16/1/1-3

Table 6-15 STM-1 Digital Link Using 1+1 MSP Protection

S1/m/nn/p/h-l

m 1

nn 6, 16

p 1

h 1

l 1 to 63

Example S1/1/6/1/1-1

S1/1/16/1/1-63

Table 6-16 VC-4 Path Riding VC-6

S1/GRPn/p

n 1, 2

p 1

Example S1/1/1 S1/2/1
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Tributary Ports
....................................................................................................................................................................................................................................

Overview This section contains information about the tributary ports (physical
and external addresses).

Physical ports The following tables list the physical tributary ports associated with
the ADM 4/1 and 155E network elements.

Tributary ports for ADM-4/1

Table 6-17 STM-1 Digital Link

S1/m/n/p

m 2

n 21, 31, 41, 51, 61

p 1

Example S1/1/21/1 or S1/1/61/1

Table 6-18 VC-4 Paths

S1/m/n/p/h

m 1

n 21, 31, 41, 51, 61

p 1

h 1

Example S1/1/21/1/1

S1/1/61/1/1

Table 6-19 VC-3 Path Riding VC-4

S1/m/n/p/h-l

m 1

n 21, 31, 41, 51, 61

p 1

h 1

l 1 to 3

Section II: ADM Port Addresses Network Element Port Addresses

....................................................................................................................................................................................................................................

6 - 1 4 Lucent Technologies 365-309-243
Issue 1, July 2001



Table 6-19 VC-3 Path Riding VC-4 (continued)

S1/m/n/p/h-l

Example S1/1/21/1/1-1

S1/1/61/1/1-3

Table 6-20 VC-12 Path Riding VC-4

S1/m/n/p/h-l

m 1

n 21, 31, 41, 51, 61

p 1

h 1

l 1 to 63

Example S1/1/21/1/1-1

S1/1/61/1/1/1-63

CEPT-1/3 Physical Tributary Ports of an ADM-4/1

Table 6-21 CEPT-3 Digital Link/Path/Circuit

P3/m/n/p

m 1

n 21, 31, 41, 51, 61

p 1

Example P3/1/21/1 or P3/1/61 /1

Table 6-22 CEPT-1 Digital Link/Path/Circuit

P1/m/n/pp

m 1

n 21, 22, 31, 31, 41, 51, 52, 61, 62

pp 1 to 16

Example P1/1/21/1 or P1/1/62/16

External addresses The following tables list the external addresses of the tributary ports
associated with the ADM 4/1 and 155E network elements.
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Table 6-23 STM-1 Physical Tributary Port of an ADM-155E

S1/m/nn/p

m 1

nn 8 thru 15

p 1

Example S1/1/8/1 or S1/1/13/1

Table 6-24 STM-1 Logical Tributary Ports of an ADM-155E

S1/m/nn/p/h

m 1

nn 8 thru 15

p 1

h 1

Example S1/1/3/1/1

S1/1/13/1/1

Table 6-25 VC-3 Path Riding VC-4

S1/m/nn/p/h-l

m 1

nn 8 thru 15

p 1

h 1

l 1 to 3

Example S1/1/8/1/1-1

S1/1/14/1/1-3

Table 6-26 VC-12 Path Riding VC-4

S1/m/nn/p/h-l

m 1

nn 8 thru 15

p 1

Section II: ADM Port Addresses
Tributary Ports

Network Element Port Addresses

....................................................................................................................................................................................................................................

6 - 1 6 Lucent Technologies 365-309-243
Issue 1, July 2001



Table 6-26 VC-12 Path Riding VC-4 (continued)

h 1

l 1 to 63

Example S1/1/21/1/1-1

S1/1/41/1/1/1-63

Table 6-27 CEPT-3 Digital Link/Path/Circuit

P3/m/nn/p

m 1

nn 8 thru 15

p 1

Example P3/1/8/1 or P3/1/15/3

Table 6-28 CEPT-1 Digital Link/Path/Circuit

P1/m/n/pp

m 1

n 21, 22, 31, 31, 41, 51, 52, 61, 62

pp 1 to 16

Example P1/1/21/1 or P1/1/62/16
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Port identifiers for WaveStar ADM 16/1 network elements
....................................................................................................................................................................................................................................

Overview This section describes the port identifiers for the WaveStar ADM 16/1
network elements.

Table The following table lists the port identifiers for the WaveStar ADM
16/1 network elements.

Table 6-29 Port Identifiers for WaveStar ADM 16/1 network elements

Description Network
Element

Entity Identifier (EID) Network Level Address

STM-16 Physical Port
(Line)

WS16/1,

WS16/1MSSP

LP[1,2] S16/1/[4,16]/11

STM-16 MSP (Line) WS16/1 LP1 S16/1/GRP1/11

STM-4 Physical Port
(Trib)

WS16/1,
WS16/1MSSP

TP[1-9] S4/1/[5-13]/1a

STM-4 MSP (Trib) WS16/1,
WS16/1MSSP

TP[1,3,5,7] S4/1/GRP[1-4]/11

STM-1 Physical Port
(Trib)

WS16/1,

WS16/1MSSP

TP[1-9].[1-4] S1/1/[5-13]/[1-4]1

STM-1 MSP (Trib) WS16/1,

WS16/1MSSP

TP1.[1-4]

TP3.[1-4]

TP5.[1-4]

TP7.[1-4]

S1/1/GRP1/[1-4]1 2

S1/1/GRP2/[1-4]1 2

S1/1/GRP3/[1-4]1 2

S1/1/GRP4/[1-4]12

STM-0 Physical Port
(Trib)

WS16/1,

WS16/1MSSP

TP[1-9].[1-12] S0/1/[5-13]/[1-12]1 2

STM-0 MSP (Trib) WS16/1,

WS16/1MSSP

TP1.[1-12]

TP3.[1-12]

TP5.[1-12]

TP7.[1-12]

S0/1/GRP1/[1-12]1 2

S0/1/GRP2/[1-12]1 2

S0/1/GRP3/[1-12]1 2

S0/1/GRP4/[1-12]1 2

E4(140 Mb/s) Physical
Port (Trib)

WS16/1,

WS16/1MSSP

TP[2-9].[1-4] P4/1/[6-13]/[1-4]

E3(34 Mb/s) Physical
Port (Trib)

WS16/1,

WS16/1MSSP

TP[1-8].[1-12] P3/1/[5-12]/[1-4]-[1-3]1 2
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Table 6-29 Port Identifiers for WaveStar ADM 16/1 network elements (continued)

Description Network
Element

Entity Identifier (EID) Network Level Address

DS3 (45 Mb/s)
Physical Port (Trib)

WS16/1,

WS16/1MSSP

TP[1-8].[1-12] D3/1/[5-12]/[1-4]-[1-3]3 4

E1(2 Mb/s) Physical
Port (Trib)

WS16/1,

WS16/1MSSP

TP[1-8].[1-63] P1/1/[5-12]/1-[1-63]3

D1 (1.5Mb/s) Physical
Port (Trib)

WS16/1,
WS16/1MSSP

TP[1-8].[1-63] D1/1/[5-12]/1-[1-63]

LAN8 Physical Port
(Trib)

WS16/1,

WS16/1MSSP

TP[1-8].[1-8] LAN8/1/[5-12]/[1-8]

VC4-4c Logical Port
on STM-16 Line Port

WS16/1,

WS16/1MSSP

LP[1-2].1-4

LP[1-2].5-8

LP[1-2].9-12

LP[1-2].13-16

S16/1/[4,16]/1/4c1

S16/1/[4,16]/1/4c2

S16/1/[4,16]/1/4c3

S16/1/[4,16]/1/4c4

VC4-4c Logical Port
on STM-16 MSP Line
Port

WS16/1 LP1.1-4

LP1.5-8

LP1.9-12

LP1.13-16

S16/1/GRP1/1/4c1

S16/1/GRP1/1/4c2

S16/1/GRP1/1/4c3

S16/1/GRP1/1/4c4

VC4-4c Logical Port
on STM-4 Tributary
Port

WS16/1,

WS16/1MSSP

TP[1-9].1-4 S4/1/[5-13]/1/4c1

VC4-4c Logical Port
on STM-4 MSP
Tributary Port

WS16/1,

WS16/1MSSP

TP[1,3,5,7].1-4 S4/1/GRP[1-4]/1/4c1

VC-4 Logical Port on
STM-16 (Line)

WS16/1,

WS16/1MSSP

LP[1,2].[1-16] S16/1/[4,16]/1/[1-16]

VC-4 Logical Port on
STM-16 MSP (Line)

WS16/1 LP1.[1-16] S16/1/GRP1/1/[1-16]1

VC4 Logical Port on
STM-4 Tributary Port

WS16/1,
WS16/1MSSP

TP[1-9].[1-4] S4/1/[5-13]/1/[1-4]h

VC4 Logical Port on
STM-4 MSP Tributary
Port

WS16/1,
WS16/1MSSP

TP[1,3,5,7].[1-4] S4/1/GRP[1-4]/1/[1-4]
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Table 6-29 Port Identifiers for WaveStar ADM 16/1 network elements (continued)

Description Network
Element

Entity Identifier (EID) Network Level Address

VC-4 Logical Port on
STM-1 (Trib)

WS16/1,

WS16/1MSSP

TP[1-9].[1-4].1 S1/1/[5-13]/[1-4]/11

VC-4 Logical Port on
STM-1 MSP(Trib)

WS16/1,

WS16/1MSSP

TP1.[1-4].1

TP3.[1-4].1

TP5.[1-4].1

TP7.[1-4].1

S1/1/GRP1/[1-4]/1 5 6

S1/1/GRP2/[1-4]/15 6

S1/1/GRP3/[1-4]/15 6

S1/1/GRP4/[1-4]/15 6

VC-4 Logical Port on
STM-0 (Trib)

WS16/1,

WS16/1MSSP

TP[1-9].[1-4] S0/1/[5-13]/[1-4]

VC-4 Logical Port on
STM-0 MSP(Trib)

WS16/1,

WS16/1MSSP

TP1.[1-4]

TP3.[1-4]

TP5.[1-4]

TP7.[1-4]

S0/1/GRP1/[1-4]/15 6

S0/1/GRP2/[1-4]/15 6

S0/1/GRP3/[1-4]/15 6

S0/1/GRP4/[1-4]/15 6

VC-4 Logical Port on
PI/E12 card (Trib)

WS16/1,

WS16/1MSSP

TP[1-8] P1/1/[5-12]/1

VC-4 Logical port on
PI-DS1/63 card (Trib)

WS16/1,
WS16/1MSSP

TP[1-8] D1/1/[5-12]/1

VC-4 Logical Port on
PI-E3DS3/12 card
(Trib)

WS16/1,

WS16/1MSSP

TP[1-8].[1-2]

TP[1-8].[3-4]

P3/1/[5-12]/[1-2]

D3/1/[5-12]/[3-4]

VC-4 Logical Port on
PI-DS3/12 card (Trib)

WS16/1,

WS16/1MSSP

TP[1-8].[1-4] D3/1/[5-12]/[1-4]

VC-4 Logical Port on
P4-E4/4 card (Trib)

WS16/1,

WS16/1MSSP

TP[2-9].[1-4] P4/1/[6-13]/[1-4]

VC4 on LAN8
Tributary Port

WS16/1,

WS16/1MSSP

TP[1-8] LAN8/1/[5-12]/1

VC-3 Logical Port on
STM-16 (Line)

WS16/1,

WS16/1MSSP

LP[1,2].[1-16].[1-3].0.0 S16/1/[4,16]/1/[1-16]-[1-3]

VC-3 Logical Port on
STM-16 MSP (Line)

WS16/1 LP1.[1-16].[1-3].0.0 S16/1/GRP1/1/[1-16]-[1-3]5

VC3 on STM-4
Tributary Port

WS16/1,

WS16/1MSSP

TP[1-9].[1-4].[1-3].0.0 S4/1/[5-13]/1/[1-4]-[1-3]
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Table 6-29 Port Identifiers for WaveStar ADM 16/1 network elements (continued)

Description Network
Element

Entity Identifier (EID) Network Level Address

VC3 on STM-4 MSP
Tributary Port

WS16/1,

WS16/1MSSP

TP[1,3,5,7].[1-4].[1-3].0.0 S4/1/GRP[1-4]/1/[1-4]-[1-
3]

VC-3 Logical Port on
STM-1 (Trib)

WS16/1,

WS16/1MSSP

TP[1-9].[1-4].1.[1-3].0.0 S1/1/[5-13]/[1-4]/1-[1-3]

VC-3 Logical port on
STM-1 MSP (Trib)

WS16/1,

WS16/1MSSP

TP1.[1-4].1.[1-3].0.0

TP3.[1-4].1.[1-3].0.0

TP5.[1-4].1.[1-3].0.0

TP7.[1-4].1.[1-3].0.0

S1/1/GRP1/[1-4]/1-[1-3] 5

S1/1/GRP2/[1-4]/1-[1-3] 5

S1/1/GRP3/[1-4]/1-[1-3] 5

S1/1/GRP4/[1-4]/1-[1-3] 5

VC-3 Logical Port on
E3 port (Trib)

WS16/1,

WS16/1MSSP

TP[1-8].[1-12] P3/1/[5-12]/[1-4]-[1-3]4

VC-3 Logical Port on
DS3 port (Trib)

WS16/1,

WS16/1MSSP

TP[1-8].[1-12] D3/1/[5-12]/[1-4]-[1-3]3

VC-12 Logical Port on
STM-16 (Line)

WS16/1,

WS16/1MSSP

LP[1,2].[1-16].[1-3].[1-
7].[1-3]

S16/1/[4,16]/1/[1-16]-[1-
63]

VC-12 Logical Port on
STM-16 MSP (Line)

WS16/1, LP1.[1-16].[1-3].[1-7].[1-3] S16/1/GRP1/1/[1-16]-[1-
63]g

VC12 on STM-4
Tributary Port

WS16/1,

WS16/1MSSP

TP[1-9].[1-4].[1-3].[1-
7].[1-3]

S4/1/[5-13]/1/[1-4]-[1-63]

VC12 on STM-4 MSP
Tributary Port

WS16/1,

WS16/1MSSP

TP[1,3,5,7].[1-4].[1-3].[1-
7].[1-3]

S4/1/GRP[1-4]/1/[1-4]-[1-
63]

VC-12 Logical port on
STM-1 (Trib)

WS16/1,

WS16/1MSSP

TP[1-9].[1-4].1.[1-3].[1-
7].[1-3]

S1/1/[5-13]/[1-4]/1-[1-63]

VC-12 Logical port on
STM-1 MSP (Trib)

WS16/1,

WS16/1MSSP

TP1.[1-4].1.[1-3].[1-7].[1-
3]

TP3.[1-4].1.[1-3].[1-7].[1-
3]

TP5.[1-4].1.[1-3].[1-7].[1-
3]

TP7.[1-4].1.[1-3].[1-7].[1-
3]

S1/1/GRP1/[1-4]/1-[1-63]5

S1/1/GRP2/[1-4]/1-[1-63]5

S1/1/GRP3/[1-4]/1-[1-63]5

S1/1/GRP4/[1-4]/1-[1-63]5

Section II: ADM Port Addresses
Port identifiers for WaveStar ADM 16/1
network elements

Network Element Port Addresses

....................................................................................................................................................................................................................................

365-309-243
Issue 1, July 2001

Lucent Technologies 6 - 2 1



Table 6-29 Port Identifiers for WaveStar ADM 16/1 network elements (continued)

Description Network
Element

Entity Identifier (EID) Network Level Address

VC-12 Logical port on
E1 Port (Trib)

WS16/1,

WS16/1MSSP

TP[1-8].[1-63] P1/1/[5-12]/1-[1-63]

VC12 on LAN8
Tributary Port

WS16/1,

WS16/1MSSP

TP[1-8].[1-8].[1-4] LAN8/1/[5-12]/1/1-[1-32]

VC-11 Logical port on
D1

Port (Trib)

WS16/1,
WS16/1MSSP

TP[1-8].[1-63] D1/1/[5-12]/1-[1-63]

Notes:

1. In general, the ITM-SC Port Selection screen should display both the
physical port and GRP addresses when the parameter from ITM-NM
across the F-interface is UI_PORT_LEVEL. There are, however, two
exceptions which are as follows. 1) If the equipment necessary for
MSP is known to be not present in the network element, then the
display of the MSP Group address should be suppressed. 2) If MSP is
already provisioned, then the standard port addresses (non-GRP) should
be suppressed from the Port Selection screen.

2. With STM-n tributary units, the ITM-SC Port Selection screen should
display the Network Level Address for each physical port, without
regard to the AU3 / AU4 type configured for the port (subject to
footnote ’a’ above).

3. For setting of “In-use” flag for the ports in the ITM-SC Port Selection
screens please refer to Port Status of Immediately Multiplexed Ports in
Port Selection Screen, 8-54.

4. The definitions for EIDs and network level addresses allow for port
addresses that may not be valid. A E3 (34 Mb/s) port, for example,
may have port numbers ranging 1 through 6 only; a D3 port (45 Mb/s)
in a mixed card may have port numbers ranging 7 to 12 only.

5. The ITM-SC Port Selection screen should display the logical GRP
addresses when the corresponding STM-n digital link is provisioned
with MSP. If the logical port is not derived from an MSP STM-n port,
the standard port addresses (without GRP in the Network Level
Address) will be displayed within the ITM-SC Port Selection screens.

6. In the case of the SA-1/4B or SI-L4.1/1 unit, the ITM-SC Port
Selection screen should not display any VC-4 address for a physical
port which has been configured in AU3 mode. It follows that no
low-order port addresses will be displayed for a physical port which
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has been configured in AU3 mode.
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Port identifiers for WaveStar ADM 4/1 network elements
....................................................................................................................................................................................................................................

Overview This section describes the port identifiers for the WaveStar ADM 4/1
network elements.

Table The following table lists the port indentifiers for the WaveStar ADM
4/1 network elements.

Table 6-30 Port Identifiers for WaveStar ADM 4/1 Network Elements

Description Network
Element

Entity Identifier (EID) Network Level Address

[[ MSP Group for
STM-4 ]]

WS4/1STM4 [[ LP[20,60] ]] [[ S4/1/GRP[1,2]/1 ]]

MSP Group for STM-1 WS4/1STM1 LP[20,60] S1/1/GRP[1,2]/1

STM-4 Physical Port
(Line)

WS4/1STM4
WS4/1STM4R

LP[20,30, 50,60]
LP[20,60]

S4/1/[20,30,50,60]/1
S4/1/[20,60]/1

STM-1 Physical Port
(Line)

WS4/1STM1 LP[20,30, 50,60] S1/1/[20,30,50,60]/1

STM-1 Physical Port
(Trib)

WS4/1STM4
WS4/1STM1

TP[21,31,41,51,61]
TP[21,31,41,51,61]

S1/1/[21,31,41,51,61]/1
S1/1/[21,31,41,51,61]/1

CEPT-3 Physical Port
(Trib)

WS4/1STM4
WS4/1STM1

TP[21,31,41,51,61].1
TP[21,31,41,51,61].1

P3/1/[21,31,41,51,61]/1
P3/1/[21,31,41,51,61]/1

DS3 Physical Port
(Trib)

WS4/1STM4
WS4/1STM1

TP[21,31,41,51,61].1
TP[21,31,41,51,61].1

D3/1/[21,31,41,51,61]/1
D3/1/[21,31,41,51,61]/1

CEPT-1 Physical Port
(Trib)

WS4/1STM4
WS4/1STM1

TP[21,22,31,32,41,51,52,61,
62].[1-16]
TP[21,22,31,32,41,51,52,61,
62].[1-16]

P1/1/[21,22,31,32,41,51,52,
61,62]/[1-16]
P1/1/[21,22,31,32,41,51,52,
61,62]/[1-16]

[[ VC-4 Logical Port
on STM-4 (Line MSP)
]]

WS4/1STM4 [[ LP[20,60].[1-4] ]] [[ S4/1/GRP[1,2]/1/[1-4]
]]

VC-4 Logical Port on
STM-4 (Line)

WS4/1STM4 LP[20,30, 50,60].[1-4] S4/1/[20,30, 50,60]/1/[1-4]
3

VC-4 Logical Port on
STM-4 (Virtual)

WS4/1STM4 VP[11,22].[1-4] S4/1/[11,22]/1/[1-4] 3

VC-4 Logical Port on
STM-1 (Line MSP)

WS4/1STM1 LP[20,60].1 S1/1/GRP[1,2]/1/1 2
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Table 6-30 Port Identifiers for WaveStar ADM 4/1 Network Elements (continued)

Description Network
Element

Entity Identifier (EID) Network Level Address

VC-4 Logical Port on
STM-1 (Line)

WS4/1STM1 LP[20,30, 50,60].1 S1/1/[20,30, 50,60]/1/1

VC-4 Logical Port on
STM-1 (Virtual)

WS4/1STM1 VP[11,22].1 S1/1/[11,22]/1/1

VC-4 Logical Port on
STM-1 (Trib)

WS4/1STM4
WS4/1STM1

TP[21,31,41,51,61].1
TP[21,31,41,51,61].1

S1/1/[21,31,41,51,61]/1/1
S1/1/[21,31,41,51,61]/1/1

[[ VC-3 Logical Port
on STM-4 (Line MSP)
]]

WS4/1STM4 [[ LP[20,60].[1-4].[1-
3].0.0 ]]

[[ S4/1/GRP[1,2]/1/[1-4]-
[1-3] 2 ]]

VC-3 Logical Port on
STM-4 (Line)

WS4/1STM4 LP[20,60].[1-4].[1-3].0.0 S4/1/[20,60]/1/[1-4]-[1-3]

VC-3 Logical Port on
STM-4 (Virtual)

WS4/1STM4 VP[11,22].[1-4].[1-3].0.0 S4/1/[11,22]/1/[1-4]-[1-3]

VC-3 Logical Port on
STM-1 (Line MSP)

WS4/1STM1 LP[20,60].1.[1-3].0.0 S1/1/GRP[1,2]/1/1-[1-3] 2

VC-3 Logical Port on
STM-1 (Line)

WS4/1STM1 LP[20,60].1.[1-3].0.0 S1/1/[20,60]/1/1-[1-3]

VC-3 Logical Port on
STM-1 (Virtual)

WS4/1STM1 VP[11,22].1.[1-3].0.0 S1/1/[11,22]/1/1-[1-3]

VC-3 Logical Port on
STM-1 (Trib)

WS4/1STM4
WS4/1STM1

TP[21,31,41,51,61].1.[1-
3].0.0 TP[21,31,41,51,
61].1.[1-3].0.0

S1/1/[21,31,41,51,61]/1/1-
[1-3] S1/1/[21,31,41,51,
61]/1/1-[1-3]

VC-3 Logical Port on
CEPT-3 Physical port
(Trib)

WS4/1STM4
WS4/1STM1

TP[21,31,41,51,61].1
TP[21,31,41,51,61].1

P3/1/[21,31,41,51,61]/1
P3/1/[21,31,41,51,61]/1

VC-3 Logical Port on
DS-3 Physical port
(Trib)

WS4/1STM4
WS4/1STM1

TP[21,31,41,51,61].1
TP[21,31,41,51,61].1

D3/1/[21,31,41,51,61]/1
D3/1/[21,31,41,51,61]/1

[[ VC-12 Logical Port
on STM-4 (Line MSP)
]]

WS4/1STM4 [[ LP[20,60].[1-4].[1-
3].[1-7].[1-3]]]

[[ S4/1/GRP[1,2]/1/[1-4]-
[1-63] 2 ]]

VC-12 Logical Port on
STM-4 (Line)

WS4/1STM4 LP[20,60].[1-4].[1-3].[1-
7].[1-3]

S4/1/[20,60]/1/[1-4]-[1-63]

VC-12 Logical Port on
STM-4 (Virtual)

WS4/1STM4 VP[11,22].[1-4].[1-3].[1-
7].[1-3]

S4/1/[11,22]/1/[1-4]-[1-63]
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Table 6-30 Port Identifiers for WaveStar ADM 4/1 Network Elements (continued)

Description Network
Element

Entity Identifier (EID) Network Level Address

VC-12 Logical Port on
STM-1 MSP (Line)

WS4/1STM1 LP[20,60].1.[1-3].[1-7].[1-
3]

S1/1/GRP[1,2]/1/1-[1-63] 2

VC-12 Logical Port on
STM-1 (Line)

WS4/1STM1 LP[20,60].1.[1-3].[1-7].[1-
3]

S1/1/[20,60]/1/1-[1-63]

VC-12 Logical Port on
STM-1 (Virtual)

WS4/1STM1 VP[11,22].1.[1-3].[1-7].[1-
3]

S1/1/[11,22]/1/1-[1-63]

VC-12 Logical Port on
STM-1 (Trib)

WS4/1STM4
WS4/1STM1

TP[21,31,41,51,61].1.[1-
3].[1-7].[1-3]
TP[21,31,41,51,61].1.[1-
3].[1-7].[1-3]

S1/1/[21,31,41,51,61]/1/1-
[1-63] S1/1/[21,31,41,51,
61]/1/1-[1-63]

VC-12 Logical Port on
CEPT-1 (2 Mb/s)
Physical

port

WS4/1STM4
WS4/1STM1

TP[21,22,31,32,41,51,52,61,
62].[1-16]
TP[21,22,31,32,41,51,52,61,
62].[1-16]

P1/1/[21,22,31,32,41,51,52,
61,62]/[1-16]
P1/1/[21,22,31,32,41,51,52,
61,62]/[1-16]

Notes:

1. For a STM-n physical port which is involved in MSP protection (as
either the worker or protecting port), the ITM-SC Port Selection screen
should display the appropriate GRP address only. For a STM-n physical
port which is not involved in MSP protection, the ITM-SC Port
Selection screen should display the standard port address only
(non-GRP).

2. For a logical port which is derived from a STM-n MSP protection
group, the ITM-SC Port Selection screen should display the logical
GRP address only. For a logical port derived from a STM-n port which
is not involved in MSP protection, the ITM-SC Port Selection screen
should display the standard logical port address only (non-GRP).

3. The ITM-SC Port Selection screen should always display all the
existing AU4 ports, not only the AU4 port available for add/drop use.
The 3 AU4 which are fixed cross connected (line to line transferred)
will be always tagged as in-use. The 4th AU4 (the flexible one) will be
displayed with the in-use tag set depending on its in-use status.
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Port identifiers for ADM-155E network elements
....................................................................................................................................................................................................................................

Overview This section describes the port identifiers for the WaveStar
ADM-155E network elements.

Table The following table lists the port indentifiers for the WaveStar ADM
4/1 network elements.

Table 6-31 Port Identifiers for ADM-155E Network Elements

Description Entity Identifier
(EID)

Network Level
Address

MSP Group for
STM-1

LP[6,16] S1/1/GRP[1,2]/1

STM-1 Physical Port
(Line)

LP[6,7,16,17] S1/1/[6,7,16,17]/1

STM-1 Physical Port
(Trib)

TP[8-15] S1/1/[8-15]/1

CEPT-3 Physical Port
(Trib)

TP[8-15].1 P3/1/[8-15]/1

DS3 Physical Port
(Trib)

TP[8-15].1 D3/1/[8-15]/1

CEPT-1 Physical Port
(Trib)

TP[8-15].[1-16] P1/1/[8-15]/[1-16]

VC-4 Logical Port
(Line MSP)

LP[6,16].1 S1/1/GRP[1,2]/1/1

VC-4 Logical Port
(Line)

LP[6,16].1 S1/1/[6,16]/1/1

VC-4 Logical Port
(Virtual)

VP[21,22].1 S1/1/[21,22]/1/1

VC-4 Logical Port on
STM-1 (Trib)

TP[8-15].1 S1/1/[8-15]/1/1

VC-3 Logical Port
(Line MSP)

LP[6,16].1.[1-
3].0.0

S1/1/GRP[1,2]/1/1-[1-
3]

VC-3 Logical Port
(Line)

LP[6,16].1.[1-
3].0.0

S1/1/[6,16]/1/1-[1-3]

VC-3 Logical Port
(Virtual)

VP[21,22].1.[1-
3].0.0

S1/1/[21,22]/1/1-[1-3]
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Table 6-31 Port Identifiers for ADM-155E Network Elements
(continued)

Description Entity Identifier
(EID)

Network Level
Address

VC-3 Logical Port on
STM-1 (Trib)

TP[8-15].1.[1-
3].0.0

S1/1/[8-15]/1/1-[1-3]

VC-3 Logical Port on
CEPT-3 Physical port
(Trib)

TP[8-15].1 P3/1/[8-15]/1

VC-3 Logical Port on
DS-3 Physical port
(Trib)

TP[8-15].1 D3/1/[8-15]/1

VC-12 Logical Port
(Line MSP)

LP[6,16].1.[1-
3].[1-7].[1-3]

S1/1/GRP[1,2]/1/1-[1-
63]

VC-12 Logical Port
(Line)

LP[6,16].1.[1-
3].[1-7].[1-3]

S1/1/[6,16]/1/1-[1-63]

VC-12 Logical Port
(Virtual)

VP[21,22].1.[1-
3].[1-7].[1-3]

S1/1/[21,22]/1/1-[1-63]

VC-12 Logical Port
on STM-1 (Trib)

TP[8-15].1.[1-
3].[1-7].[1-3]

S1/1/[8-15]/1/1-[1-63]

VC-12 Logical Port
on CEPT-1 (2 Mb/s)
Physical port

TP[8-15].[1-16] P1/1/[8-15]/[1-16]
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Section III: AM 1 Port Addresses

Overview
....................................................................................................................................................................................................................................

Purpose This section provides conceptual information regarding the external
and internal port addresses for both the physical and logical ports of
WaveStar DACS VI (Release 2.0 or later). It also discusses the
correlation between the external and internal port addresses.
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Port identifiers for AM 1 network elements
....................................................................................................................................................................................................................................

Overview This section contains port address information for the physical and
logical ports usable with AM 1 network elements.

Port identifiers The following table shows the port identifier address information for
AM 1 network elements.

Description Entity Identifier (EID) Network Level Address

STM-1 Line Port Physical Port LP[1-2] S1/1/[2-3]/1

Logical Port (AU4 and
VC4 combined)

LP[1-2].1 S1/1/[2-3]/1/1

Logical Port TU3 LP[1-2].1[1-3].0.0 S1/1/[2-3]/1/1-[1-3]

Logical Port TU12 LP[1-2].1[1-3].[1-7].[1-
3]

S1/1/[2-3]/1/1-[1-63]

STM-1 Line MSP
Group

Physical Port LP1 S1/1/GRP1/1

Logical Port (AU4 and
VC4 combined)

LP1.1 S1/1/GRP1/1/1

Logical Port TU3 LP1.1.[1-3].0.0 S1/1/GRP1/1/1-[1-3]

Logical Port TU12 LP1.1.[1-3].[1-7].[1-3] S1/1/GRP1/1/1-[1-63]

DS3 (45Mb/s)
Tributary

Physical Ports TP2.[1-2] D3/1/5/[1-2]

Logical Port VC3 TP2.[1-2] D3/1/5/[1-2]

E3 (CEPT-3) (34Mb/s)
Tributary

Physical Ports TP2.[1-2] P3/1/5/[1-2]

Logical Port VC3 TP2.[1-2] P3/1/5/[1-2]

CMB E1 (CEPT-1)
(2Mb/s) Tributary
(on-board)

Physical Ports TP1.[1-16] P1/1/4/[1-16]

Logical Port VC12 TP1.[1-16] P1/1/4/[1-16]

CMC E1 (CEPT-1)
(2Mb/s) Tributary
(additional)

Physical Ports TP2.[1-16] P1/1/5/[1-16]

Logical Port VC12 TP2.[1-16] P1/1/5/[1-16]

X.21 Tributary
(TransLAN/X.21 card)

Physical X.21 Ports
(X21DL)

TP2.[1-4] X21/1/5/[1-4]

Logical X.21 Ports VC12 TP2.[1-4] X21/1/5/[1-4]
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TransLAN Tributary
(TransLAN/X.21 card)

Physical LAN
10/100baseT Ports
(LAN8DL)

LAN2.[1-2] LAN8/1/5/[1-2]

Logical LAN
10/100baseT ports VC12

LAN2.[1-2].[1-4] LAN8/1/5/[1-2]/[1-4]

TransLAN+ Tributary Physical LAN
10/100baseT Ports

LAN2.[1-4] [[LANACC/1/5/[1-4]]]

[[Logical LAN
10/100baseT LAN
Groups]]

[[LANGRP2.n]] [[NA]]

Logical LAN
10/100baseT LAN Ports

LAN2.[1-4] [[LANACC/1/5/[1-4]]]

Logical LAN
10/100baseT WAN Ports

WAN2.[1-4] [[LANBR/1/5/[1-4]]]

Logical SDH Channel
Ports

SDHChan2.[1-4] [[LANBR/1/5/[1-4]]]

Logical Ports VC3 TP2.abcd [[LANBR/1/5/abcd]]

Logical Ports VC12 TP2.abcd [[LANBR/1/5/abcd]]
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Port identifiers for AM 1+ network elements
....................................................................................................................................................................................................................................

Overview This section contains port address information for the physical and
logical ports usable with AM 1+ network elements.

Port identifiers The following table shows the port identifier address information for
AM 1 network elements.

Network Elements Description Entity Identifier
(EID)

Network Level
Address

WS_AM1PLUS_
STM4

STM-4 Line
Port

Physical Ports LP [1-2] S4/1/[2-3]/1

Logical Port
(AU4 or
AU4/VC4
combined)

LP[1-2].[1-4] S4/1/[2-3]/1/[1-4]

Logical Port
TU3

LP[1-2].[1-4].[1-
3].0.0

S4/1/[2-3]/1/[1-4]-[1-
3]

Logical Port
TU12

LP[1-2].[1-4].[1-
3].[1-7].[1-3]

S4/1/[2-3]/1/[1-4]-[1-
63]

[[STM-4 Line
MSP Group]]

[[Physical
Ports]]

[[LP1]] [[S4/1/GRP1/1]]

[[Logical Port
(AU4 or
AU4/VC4
combined)]]

[[LP1.[1-4]]] [[S4/1/GRP1/1[1-4]]]

[[Logical Port
TU3]]

[[LP1.[1-4].[1-
3].0.0]]

[[S4/1/GRP1/1[1-4]-
[1-3]]]

[[Logical Port
TU12]]

[[LP1.[1-4].[1-
3].[1-7].[1-3]]]

[[S4/1/GRP1/1[1-4]-
[1-63]]]

STM-1
Tributary

Physical Port TP2.[1-2] S1/1/5/[1-2]

Logical Port
(AU4)

TP2.[1-2].1 S1/1/5/[1-2]/1
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WS_AM1PLUS_STM1,
WS_AM1PLUS_STM1_
T

STM-1 Line
Port (Line
Slot 1)

Physical Ports LP1 S1/1/2/1

Logical Port
(AU4 or
AU4/VC4
combined)

LP1.1 S1/1/2/1/1

Logical Port
TU3

LP1.1.[1-3].0.0 S1/1/2/1/1-[1-3]

Logical Port
TU12

LP1.1.[1-3].[1-
7].[1-3]

S1/1/2/1/1-[1-63]

WS_AM1PLUS_
STM1

STM-1 Line
Port (Line
Slot 2)

Physical Ports LP2 S1/1/3/1

Logical Port
(AU4 or
AU4/VC4
combined)

LP2.1 S1/1/3/1/1

Logical Port
TU3

LP2.1.[1-3].0.0 S1/1/3/1/1-[1-3]

Logical Port
TU12

LP2.1.[1-3].[1-
7].[1-3]

S1/1/3/1/1-[1-63]

WS_AM1PLUS_
STM1

STM-1 Line
MSP Group

Physical Ports LP1 S1/1/GRP1/1

Logical Port
(AU4 or
AU4/VC4
combined)

LP1.1 S1/1/GRP1/1/1

Logical Port
TU3

LP1.1.[1-3].0.0 S1/1/GRP1/1/1-[1-3]

Logical Port
TU12

LP1.1.[1-3].[1-
7].[1-3]

S1/1/GRP1/1/1-[1-
63]
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WS_AM1PLUS_STM4,
WS_AM1PLUS_STM1,
WS_AM1PLUS_STM1_
T

DS3 (45Mb/s)
Tributary

Physical Ports TP2.[1-2] D3/1/5/[1-2]

Logical Port
VC3

TP2.[1-2] D3/1/5/[1-2]

E3 (CEPT-3)
(34Mb/s)
Tributary

Physical Ports TP2.[1-2] P3/1/5/[1-2]

Logical Port
VC3

TP2.[1-2] P3/1/5/[1-2]

CMB E1
(CEPT-1)
(2Mb/s)
Tributary
(on-board)

Physical Ports TP1.[1-16] P1/1/4/[1-16]

Logical Port
VC12

TP1.[1-16] P1/1/4/[1-16]

CMC E1
(CEPT-1)
(2Mb/s)
Tributary
(additional)

Physical Ports TP2.[1-16] P1/1/5/[1-16]

Logical Port
VC12

TP2.[1-16] P1/1/5/[1-16]

ISDN PRI
(2Mb/s)
Tributary
(on-board)

Physical Ports TP1.[1-16] P1/1/4/[1-16]

Logical Port
VC12

TP1.[1-16] P1/1/4/[1-16]

ISDN PRI
(2Mb/s)
Tributary
(additional)

Physical Ports TP2.[1-16] P1/1/5/[1-16]

Logical Port
VC12

TP2.[1-16] P1/1/5/[1-16]

DS1 Tributary Physical Ports TP2.[1-16] P1/1/5/[1-16]

Logical Port
VC12

TP2.[1-16] P1/1/5/[1-16]

X.21 Tributary Physical X.21
Ports (X21DL)

TP2.[1-4] X21/1/5/[1-4]

Logical X.21
Ports VC12

TP2.[1-4] X21/1/5/[1-4]
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WS_AM1PLUS_STM4,
WS_AM1PLUS_STM1,
WS_AM1PLUS_STM1_
T

TransLAN+
Tributary

Physical LAN
10/100baseT
Ports

LAN2.[1-4] [[LANACC/1/5/[1-
4]]]

[[Logical LAN
10/100baseT
LAN Groups]]

[[LANGRP2.n]] [[NA]]

Logical LAN
10/100baseT
LAN Ports

LAN2.[1-4] [[LANACC/1/5/[1-
4]]]

Logical LAN
10/100baseT
WAN Ports

WAN2.[1-4] [[LANBR/1/5/[1-4]]]

Logical SDH
Channel Ports

SDHChan2.[1-4] [[LANBR/1/5/[1-4]]]

Logical Ports
VC3

TP2.abcd [[LANBR/1/5/abcd]]

Logical Ports
VC12

TP2.abcd [[LANBR/1/5/abcd]]
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Section IV: WaveStar DACS VI Port Addresses

Overview
....................................................................................................................................................................................................................................

Purpose This section provides conceptual information regarding the external
and internal port addresses for both the physical and logical ports of
WaveStar DACS VI (Release 2.0 or later). It also discusses the
correlation between the external and internal port addresses.
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Port address information
....................................................................................................................................................................................................................................

Overview This section contains port address information for the physical and
logical ports usable with WaveStar DACS VI.

Physical ports The following tables show the address information for the physical
ports usable with WaveStar DACS VI.

Table 6-32 STM-1 Digital Link

S1/mm/n/p

mm 1 to 17

n 1 to 8

p 1

Example S1/12/6/1

S1/mm/n/p

Table 6-33 STM-1 Digital Link using 1 +1 MSP Protection

S1/mm/GRPn/p

mm 1 to 17

n 1 to 4

p 1

Example S1/12/GRP4/1

Table 6-34 CEPT-3 Digital Link

P3/mm/n/p

mm 1 to 32

n 1 to 4 and 6 to 9

p 1

Example P3/32/4/1

Table 6-35 CEPT-4 Digital Link

P4/mm/n/p
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Table 6-35 CEPT-4 Digital Link (continued)

mm 1 to 32

n 1 and 3

p 1

Example P4/12/3/1

Table 6-36 CEPT-1 Digital Link, CEPT-1 Circuit

P1/mm/nn/xx

mm 1 to 32

nn 1 to 8 and 10 to 17

xx if nn = 8 or 17, xx = 1 to7

if nn is not 8 or 17, xx = 1 to 8

Example P1/14/6/ 8

P1/14/8/7

The following table is specific to the PP4A subrack with TPU2DBL
(also designated as TPU-2/16) slot cards.

Table 6-37 CEPT-1 Digital Link, CEPT-1 Circuit

P1/Hmm/nn/xx

mm 1 to 17

nn 1 to 8 and 10 to 17

xx if nn = 4, 8, 13 or 17, xx = 1 to 15

if nn is not 4, 8, 13 or 17, xx = 1 to 16

Example P1/H17/8/15

P1/H17/7/16

The following table is specific to DACs VI with TPU2 Sub-rack

Table 6-38 CEPT-1 Digital Link, CEPT-1 Circuit

P1/mm/nn/xx

mm 1 to 32

nn 1 to 8 and 10 to 17
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Table 6-38 CEPT-1 Digital Link, CEPT-1 Circuit (continued)

xx if nn = 8 or 17, xx = 1 to7

if nn is not 8 or 17, xx = 1 to 8

Example P1/14/6/ 8

P1/14/8/7

The following table is specific to the PP4A subrack with TPU2DBL
(also designated as TPU-2/16) slot cards.

Table 6-39 CEPT-1 Digital Link, CEPT-1 Circuit

P1/Hmm/nn/xx

mm 1 to 17

nn 1 to 8 and 10 to 17

xx if nn = 4, 8, 13 or 17, xx = 1 to 15

if nn is not 4, 8, 13 or 17, xx = 1 to 16

Example P1/H17/8/15

P1/H17/7/16

Logical ports The following tables show the address information for the logical
ports usable with WaveStar DACS VI.

Table 6-40 VC-4 Paths

S1/mm/n/p/h

mm 1 to 17

n 1 to 8

p 1

h 1

Example S1/12/6/1/1

Table 6-41 VC-3 Paths

S1/mm/n/p/h-l

mm 1 to 17

n 1 to 8

p 1
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Table 6-41 VC-3 Paths (continued)

h 1

l 1 to 3

Example S1/12/6/1/1-3

Table 6-42 CEPT-1 Circuit Riding on a Channelized VC-4 Path

S1/mm/n/p/h-l

mm 1 to 17

n 1 to 8

p 1

h 1

l 1 to 63

Example S1/12/6/1/1-63

Table 6-43 VC-4 Path Using a 1 + 1 MSP STM-1 Digital Link

S1/mm/GRPn/p/h

mm 1 to 17

n 1 to 4

p 1

h 1

Table 6-44 VC-3 Path Riding a VC-4 Using a 1 + 1 MSP STM-1
Digital Link

S1/mm/GRPn/p/h-l

mm 1 to 17

n 1 to 4

p 1

h 1

l 1 to 3
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Table 6-45 VC-12 Path Riding VC-4 Path Using 1 + 1 MSP
STM-1 DL/ CEPT-1 Circuit Riding Channelized
VC-4 Path Using 1 + 1 MSP STM-1 Digital Link

S1/mm/GRPn/p/h-l

mm 1 to 17

n 1 to 4

p 1

h 1

l 1 to 63

Example S1/12/GRP4/1/1-63

Table 6-46 CEPT-1 Circuit Riding on a CEPT-3 Digital Link

P3/mm/n/p/l

mm 1 to 32

n 1 to 4 and 6 to 9

p 1

l 1 to 16 for n = 1 to 3 and 6 to 8

1 to 15 for n = 4 or 9

Example P3/32/4/1/15

Table 6-47 CEPT-1 Circuit Riding on a CEPT-4 Digital Link

P4/mm/n/p /l

mm 1 to 32

n 1 and 3

p 1

l 1 to 63

Example P4/12/3/1/63
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Correlation of external and internal port addresses
....................................................................................................................................................................................................................................

Overview This section discusses the correlation between external and internal
port addresses for WaveStar DACS VI.

SDH correlation Important! If a VC-4 path uses a 1 + 1 MSP STM-1 protected digital
link, n (in the internal addresses) can be: 1 (for GRP1), 3 (for GRP2),
5 (for GRP3), 7 (for GRP4), etc.

The following tables show the correlation between SDH physical and
logical ports.

Table 6-48 SDH Physical Ports

External Address Internal Address

STM-1
digital link

S1 / [1-17] /1-8] / 1 LPU155-[1-17]-LPU155-[1-8]-
1

1 + 1 MSP
STM-1
protected
digital link

S1 / [1-17]
/GRP[1-4] /1

LPU155-[1-17]-LPU155-
[GRP1-GRP4]

Table 6-49 SDH Logical Ports

External Address Internal Address

VC-4 Path S1 / [1-17] /1-8] /
1/1

LPU155-[1-17]-LPU155-[1-
8]-1

VC-4 path
using 1 + 1
MSP STM-1
protected
digital link

S1 / [1-17]
/GRP[1-4] /1/1

LPU155-[1-17]-LPU155-[1,3,
5,7]-1

VC-3 Path S1 / [1-17] /1-8] /
1/1-[1-3]

LPU155-[1-17]-LPU155-[1-
8]-1-[1-3]-1

VC-3 path
using 1 + 1
MSP STM-1
protected
digital link

S1 / [1-17]
/GRP[1-4] /1/1-
[1-3]

LPU155-[1-17]-LPU155-[1,3,
5,7]-1- [1-3]-1

Section IV: WaveStar DACS VI Port
Addresses

Network Element Port Addresses

....................................................................................................................................................................................................................................

6 - 4 2 Lucent Technologies 365-309-243
Issue 1, July 2001



Table 6-50 63 Logical Ports of a VC-4 Path (Facility)

External Address Internal Address

S1/[1-17]/[1-8]/1/1-[1-63] LPU155-[1-17]-LPUi55-[1-8]-1-[1-3]-
[1-7]-[1-3]

S1/mm/n/p/h-l LPU155-mm-LPUi55-n-1-x-y-z

Si/[1-17]/GRP[1-4]/1/1-[1-
63]

LPU155-[1-17]-LPUi55-[1,3,5,7]-1-
[1-3]-[1-7]-[1-3]

S1/mm/GRPn/p/h-L LPU155-mm-LPUi55-n-1-x-y-z

Table 6-51 x, y, and z of Internal Address Derived from “l” of External Address

L x y z l x y z l x y z

1 1 1 1 22 2 1 1 43 3 1 1

2 1 1 2 23 2 1 2 44 3 1 2

3 1 1 3 24 2 1 3 45 3 1 3

4 1 2 1 25 2 2 1 46 3 2 1

5 1 2 2 26 2 2 2 47 3 2 2

6 1 2 3 27 2 2 3 48 3 2 3

7 1 3 1 28 2 3 1 49 3 3 1

8 1 3 2 29 2 3 2 50 3 3 2

9 1 3 3 30 2 3 3 51 3 3 3

10 1 4 1 31 2 4 1 52 3 4 1

11 1 4 2 32 2 4 2 53 3 4 2

12 1 4 3 33 2 4 3 54 3 4 3

13 1 5 1 34 2 5 1 55 3 5 1

14 1 5 2 35 2 5 2 56 3 5 2

15 1 5 3 36 2 5 3 57 3 5 3

16 1 6 1 37 2 6 1 58 3 6 1

17 1 6 2 38 2 6 2 59 3 6 2

18 1 6 3 39 2 6 3 60 3 6 3

19 1 7 1 40 2 7 1 61 3 7 1

20 1 7 2 41 2 7 2 62 3 7 2

21 1 7 3 42 2 7 3 63 3 7 3
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PDH correlation The following tables show the correlation between PDH physical and
logical ports.

Table 6-52 PDH Physical Ports

External Address Internal Address

CEPT-4 digital link

CEPT-4 facility/ckt

P4/[1-32]/[1-3]/1 TPU34/140-[1-32]-TPU140MX-[1-3]-1

CEPT-3 digital link

CEPT-3 facility/ckt.

P3/[1-32]/[1-4, 6-9]/1 TPU34/140-[1-32]-TPU34MX- [1-4,
6-9]-1

CEPT-1 digital link

CEPT-1 facility/ckt

(DACS VI release 1.3 or 2.0
with TPU2 subrack):
P1/[1-32]/[1-8, 10-17]/[1-8]

(DACS VI release 2.0 with
PP4A subrack with TPU2DBL
[also designated as TPU-2/16]
slot cards): P1/H[1-17]/[1-8,
10-17]/[1-16]

(DACS VI release 1.3 or 2.0 with
TPU2 subrack): TPU2-[1-32]-TPU2-[1-
8, 10-17]-[1-8]

(DACS VI release 2.0 with PP4A
subrack with TPU2DBL [also
designated as TPU-2/16] slot cards):
PP4A-[1-17]-TPU2DBL-[1-8, 10-17]-
[1-16]

Table 6-53 Logical Ports of a CEPT-4 Digital Link

External Address Internal Address

P4/[1-32]/[1,3]/
1/[1-63]

TPU34/140-[1-32]-TPU140MX-[1,3]-1-[1-4].[1-
4].[1-4]

P4/mm/n/p/L TPU34/140-[1-32]-TPU140MX-[1-3]-1-x.y.z

Table 6-54 x, y, and z Internal Address Derived from “l” of External Address:

L x y z l x y z l x y z

1 1 1 1 22 2 2 2 43 3 3 3

2 1 1 2 23 2 2 3 44 3 3 4

3 1 1 3 24 2 2 4 45 3 4 1

4 1 1 4 25 2 3 1 46 3 4 2

5 1 2 1 26 2 3 2 47 3 4 3

6 1 2 2 27 2 3 3 48 3 4 4

7 1 2 3 28 2 3 4 49 4 1 1

8 1 2 4 29 2 4 1 50 4 1 2

9 1 3 1 30 2 4 2 51 4 1 3
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Table 6-54 x, y, and z Internal Address Derived from “l” of External Address: (continued)

L x y z l x y z l x y z

10 1 3 2 31 2 4 3 52 4 1 4

11 1 3 3 32 2 4 4 53 4 2 1

12 1 3 4 33 3 1 1 54 4 2 2

13 1 4 1 34 3 1 2 55 4 2 3

14 1 4 2 35 3 1 3 56 4 2 4

15 1 4 3 36 3 1 4 57 4 3 1

16 1 4 4 37 3 2 1 58 4 3 2

17 2 1 1 38 3 2 2 59 4 3 3

18 2 1 2 39 3 2 3 60 4 3 4

19 2 1 3 40 3 2 4 61 4 4 1

20 2 1 4 41 3 3 1 62 4 4 2

21 2 2 1 42 3 3 2 63 4 4 3

CEPT-3 digital link (16
logical ports)

The following tables provide information for 16 CEPT-1 circuits
riding on a channelized CEPT-3 digital link.

Table 6-55 16 CEPT-1 Circuits Riding on a Channelized
CEPT-3 Digital Link

External Address Internal Address

P3/[1-32]/[1-4,6-9]/1/[1-
16]

TPU34/140-[1-32]-TPU34TMX-[1-4,6-
9]-1-1.[1-4].[1-4]

P3/mm/n/p /L TPU34/140-mm-TPU34TMX-n-1-1.x.y

Table 6-56 X and Y of Internal Address Re-derived from “l” of
External Address.

L x y

1 1 1

2 1 2

3 1 3

4 1 4

5 2 1
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Table 6-56 X and Y of Internal Address Re-derived from “l” of
External Address. (continued)

L x y

6 2 2

7 2 3

8 2 4

9 3 1

10 3 2

11 3 3

12 3 4

13 4 1

14 4 2

15 4 3

16 4 4

Table 6-57 WaveStar DACS Port Address for STM-0 and
STM-1 Digital Links

Port Card
Type

External Address Internal Address

STM0 S0/PB[4-19]/[1-8,11-
18]/[[1-12]

PSB-[4-19]-STM0-[1-8,11-
18]-[1-12]

STM0 (MSP) S0/PB[4-19]/GRP[1-
8]/[1-12]

PSB-[4-19]-STM0-MSP[1,3,
5,7,11,13,15,17]-[1-12]

STM1 S1/PA[4-19]/[1-8,11-
18]/[[1-4]

PSA-[4-19]-STM1-[1-8,11-
18]-[1-4]

STM1 (MSP) S1/PA[4-19]/GRP[1-
8]/[1-4]

PSA-[4-19]-STM1-MSP[1,3,
5,7,11,13,15,17]-[1-4]

Table 6-58 WaveStar DACS Port Address for AU3 and VC4
Logical Ports

Logical

Port

Port
Card

Type

External Address Internal Address
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Table 6-58 WaveStar DACS Port Address for AU3 and VC4
Logical Ports (continued)

AU3 STM0 S0/PB[4-19]/[1-8,
11-18]/[[1-12]/1

PSB-[4-19]-STM0-[1-8,11-
18]-[1-12]-AUG1#1-AU3#1

AU3 STM1 S1/PA[4-19]/[1-8,
11-18]/[[1-4]/[1-
3]

PSA-[4-19]-STM1-[1-8,11-
18]-[1-4]-AUG1#1-AU3#[1-
3]

AU3 STM0
(MSP)

S0/PB[4-19]/
GRP[1-8]/[1-12]/
1

PSB-[4-19]-STM0-MSP[1,3,5,
7,11,13,15,17]-[1-12]-
AUG1#1-AU3#1

AU3 STM1
(MSP)

S1/PA[4-19]/
GRP[1-8]/[1-4]/
[1-3]

PSA-[4-19]-STM1-MSP[1,3,5,
7,11,13,15,17]-[1-4]-
AUG1#1-AU3#[1-3]

VC4 STM1 S1/PA[4-19]/[1-8,
11-18]/[[1-4]/1

PSA-[4-19]-STM1-[1-8,11-
18]-[1-4]-AUG1#1-AU4

VC4 STM1
(MSP)

S1/PA[4-19]/
GRP[1-8]/[1-4]/1

PSA-[4-19]-STM1-MSP[1,3,5,
7,11,13,15,17]-[1-4]-
AUG1#1-AU4

Table 6-59 WaveStar DACS Network Level Port Address for
VC3 and VC12

Logical

Port

Port Card

Type

External Address Internal Address

VC3 STM1 S1/PA[4-19]/[1-8,
11-18]/[[1-4]/1-[1-
3]

PSA-[4-19]-STM1-[1-
8,11-18]-[1-4]-
AUG1#1-AU4-
TUG3#[1-3]-TU3

VC3 STM1
(MSP)

S1/PA[4-19]/
GRP[1-8]/[1-4]/1-
[1-3]

PSA-[4-19]-STM1-MSP[1,
3,5,7,11,13,15,17]-[1-
4]-AUG1#1-AU4-
TUG3#[1-3]-TU3

VC12 STM1 S1/PA[4-19]/[1-8,
11-18]/[[1-4]/1-[1-
63]

PSA-[4-19]-STM1-[1-
8,11-18]-[1-4]-
AUG1#1-AU4-
TUG3#[1-3]-
TUG2#[1-7]-TU12#[1-
3]
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Table 6-59 WaveStar DACS Network Level Port Address for
VC3 and VC12 (continued)

VC12 STM1
(MSP)

S1/PA[4-19]/
GRP[1-8]/[1-4]/1-
[1-63]

PSA-[4-19]-STM1-MSP[1,
3,5,7,11,13,15,17]-[1-
4]-AUG1#1-AU4-
TUG3#[1-3]-
TUG2#[1-7]-TU12#[1-
3]
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Section V: ISM Port Addresses

Overview
....................................................................................................................................................................................................................................

Purpose This section discusses the external and internal port addresses for both
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This section also describes the correlation between external and
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Contents
ISM-4 line ports 6-50

ISM-4 virtual ports 6-52

ISM-1 line ports 6-53

STM-1 line ports of an ISM-1 6-55

ISM-1 and ISM-4 tributary ports external addresses 6-57

ISM-5E line port external addresses 6-59

ISM-5E tributary ports 6-61

Network Element Port Addresses

....................................................................................................................................................................................................................................

365-309-243
Issue 1, July 2001

Lucent Technologies 6 - 4 9

6-61

6-59

6-57

6-55

6-53

6-52

6-50



ISM-4 line ports
....................................................................................................................................................................................................................................

Overview This section provides the external addresses for the ISM-4 line ports.

Tables The following tables provide the external port addresses for ISM-4
line ports.

Table 6-60 STM-4 digital link of an ISM-4

S4/m/nn/p

m 1

nn 12 or 13

p 1

Example The two possible addresses: S4/1/12/1 and
S4/1/13/1.

Table 6-61 VC-4 Path

S4/m/nn/p/h

m 1

nn 12 or 13

p 1

h 1 to 4

Example The eight possible addresses: S4/1/12/1/1,
S4/1/12/1/2, S4/1/12/1/3, S4/1/12/1/4, S4/1/13/1,
S4/1/13/2, S4/1/13/3, S4/1/13/4

Table 6-62 VC-3 Path riding a VC-4

S4/m/nn/p/h-l

m 1

nn 12 or 13

p 1

h 1 to 4

l 1 to 3
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Table 6-62 VC-3 Path riding a VC-4 (continued)

S4/m/nn/p/h-l

Examples S4/1/12/1/1-1 and S4/1/13/1/4-3

Table 6-63 VC-12 Path riding a VC-4

S4/m/nn/p/h-l

m 1

nn 12 or 13

p 1

h 1 to 4

l 1 to 63

Example S4/1/12/1/1-1

S4/1/13/1/4-63
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ISM-4 virtual ports
....................................................................................................................................................................................................................................

Overview This section provides the external addresses for the ISM-4 line ports.

Tables The following tables provide the external port addresses for ISM-4
line ports.

Table 6-64 VC-4 Path virtual protection

S4/m/nn-x-y/h

m 1

nn 10

x 1 to 4

y 1 to 4

h 1

Examples S4/1/10-1-1/1 and S4/1/10-4-4/1

Table 6-65 VC-12 Path riding a VC-4 Path with virtual
protection

S4/m/nn-x-y/h-l

m 1

nn 10

x 1 to 4

y 1 to 4

h 1

l 1 to 63

Examples S4/1/10-1-1/1-1and S4/1/10-4-4/1-63
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ISM-1 line ports
....................................................................................................................................................................................................................................

Overview This section provides the external addresses for the ISM-1 line ports.

Tables The following tables provide the external port addresses for ISM-1
line ports.

Table 6-66 STM-1 Digital Link

S1/m/nn/p

m 1

nn 12 or 13

p 1

Examples The two possible addresses: S1/1/12/1 and
S1/1/13/1.

Table 6-67 VC-4 Path

S1/m/nn/p/h

m 1

nn 12 or 13

p 1

h 1

Examples The two possible addresses: S1/1/12/1/1 and
S1/1/13/1/1.

Table 6-68 VC-3 Path riding a VC-4

S1/m/nn/p/h-l

m 1

nn 12 or 13

p 1

h 1

l 1 to 3

Examples S1/1/12/1/1-1 and S1/1/13/1/1-3
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Table 6-69 VC-12 Path riding a VC-4

S1/m/nn/p/h-l

m 1

nn 12 or 13

p 1

h 1

l 1 to 63

Examples S1/1/12/1/1-1 and S1/1/13/1/1-63
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STM-1 line ports of an ISM-1
....................................................................................................................................................................................................................................

Overview This section provides the external addresses for the STM-1 (1+1
MSP) physical and logical line ports of an ISM-1.

Physical line ports The following tables provide the external port addresses for the
STM-1 (1+1 MSP) physical line port of an ISM-1.

Table 6-70 STM-1 digital link using 1 + 1 MSP protection

S1/m/GRPn/p

m 1

n 1

p 1

Example S1/1/GRP1/1 is the only possible address.

Logical line ports The following tables provide the external port addresses for the
STM-1 (1+1 MSP) logical line port of an ISM-1.

Table 6-71 (VC-4 Path riding on an STM-1 digital link using 1
+ 1 MSP protection)

S1/m/GRPn/p/h

m 1

nn 1

p 1

h 1

Example S1/1/GRP1/1/1 is the only possible address.

Table 6-72 VC-3 Path riding a VC-4 Path riding on an STM-1
digital link using 1 + 1 MSP protection

S1/m/GRPn/p/h-l

m 1

nn 1

p 1

h 1
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Table 6-72 VC-3 Path riding a VC-4 Path riding on an STM-1
digital link using 1 + 1 MSP protection
(continued)

l 1 to 3

Example The three possible addresses: S1/1/GRP1/1/1-1,
S1/1/GRP1/1/1-2 and S1/1/GRP1/1/1-3

Table 6-73 VC-12 Path riding a VC-4 Path riding on an STM-1
digital link using 1 + 1 MSP protection

S1/m/GRPn/p/h-l

m 1

nn 1

p 1

h 1

l 1 to 63

Examples S1/1/GRP1/1/1-1 and S1/1/GRP1/1/1-63
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ISM-1 and ISM-4 tributary ports external addresses
....................................................................................................................................................................................................................................

Overview This section provides information about the external addresses for the
ISM-1 and ISM-4 logical and physical tributary ports.

Logical ports This section provides the external addresses for the ISM-1 and ISM-4
tributary ports (logical).

Table 6-74 VC-3 Path riding a VC-4

S1/m/n/p/h-l

m 1

n 1 to 8

p 1

h 1

l 1 to 3

Examples S1/1/1/1/1-1 and S1/1/8/1/1-3

Table 6-75 STM-1 digital link

S1/m/n/p

m 1

n 1 to 8

p 1

Examples S1/1/1/1 and S1/1/8/1

Table 6-76 VC-4 Path

S1/m/n/p/h

m 1

n 1 to 8

p 1

h 1 to 4

Examples S1/1/1/1/1 and S1/1/8/1/4
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Table 6-77 VC-12 Path riding a VC-4

S1/m/n/p/h-l

m 1

n 1 to 8

p 1

h 1

l 1 to 63

Examples S1/1/1/1/1-1 and S1/1/8/1/1/1-63

Physical ports The following are the external addresses for the ISM-1/4 tributary
ports (physical).

Table 6-78 CEPT-4 digital link

P4/m/n/p

m 1

n 7 to 8

p 1

Examples P4/1/7/1 and P4/1/8/1

Table 6-79 CEPT-3 digital link

P3/m/n/p

m 1

n 1 to 8

p 1 to 3

Examples P3/1/1/1 and P3/1/8/3

Table 6-80 CEPT-1 digital link

P1/m/n/pp

m 1

n 1 to 8

pp 1 to 16

Examples P1/1/1/1 and P1/1/8/16
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ISM-5E line port external addresses
....................................................................................................................................................................................................................................

Overview This section provides information about the external addresses for the
ISM-5E logical and physical line ports.

Logical line ports This section provides the external addresses for the ISM-1 and ISM-4
tributary ports (logical).

Table 6-81 VC-4 Path

S1/m/nn/p

m 1

nn 7

p 1

h 1

Example S1/1/6/1/1 is the only possible address

Table 6-82 VC-12 Path riding a VC-4

S1/m/nn/p/h-l

m 1

n 7

p 1

h 1

l 1 to 63

Example S1/1/7/1/1-1and S1/1/7/1/1-63

Table 6-83 VC-4 Path riding on an STM-1 digital link using 1 +
1 MSP protection

S1/m/GRPn/p/h

m 1

nn 1

p 1

h 1
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Table 6-83 VC-4 Path riding on an STM-1 digital link using 1 +
1 MSP protection (continued)

Example S1/1/GRP1/1/1 is the only possible
address.

Table 6-84 VC-12 Path riding a VC-4 Path riding on an STM-1
digital link using 1 + 1 MSP protection

S1/m/GRPn/p/h-l

m 1

n 1

p 1

h 1

l 1 to 63

Example S1/1/GRP1/1/1-1

S1/1/GRP1/1/1-63

Physical line ports This section provides the external addresses for the ISM-1 and ISM-4
tributary ports (physical).

Table 6-85 STM-1 digital link

S1/m/nn/p

m 1

nn 7

p 1

Example S1/1/7/1 is the only possible address

Table 6-86 STM-1 digital link using 1 + 1 MSP protection

S1/m/GRPn/p

m 1

n 1

p 1

Example S1/1/GRP1/1 is the only possible
address.

Section V: ISM Port Addresses
ISM-5E line port external addresses

Network Element Port Addresses

....................................................................................................................................................................................................................................

6 - 6 0 Lucent Technologies 365-309-243
Issue 1, July 2001



ISM-5E tributary ports
....................................................................................................................................................................................................................................

Overview This section provides information about the ISM-5E tributary ports.

Logical ports This section provides the external addresses for the ISM-5E logical
ports.

Table 6-87 VC-12 Path riding a CEPT-1 Path riding on an
PCTDL digital link using 1 + 1 MSP protection

PCT/m/n/GRPnn/l

m 1

n 1

nn 1 to 3

l 1 to 21

Example PCT/1/1/GRP3/21

Table 6-88 CEPT-1 Logical Port on the TPU-PCT of a ISM-5E

PCT/m/n/GRPnn/l

m 1

n 1

nn 1 to 3

l 1 to 21

Example PCT/1/1/GRP3/21

Physical ports This section provides the external addresses for the ISM-5E physical
ports.

Table 6-89 PCTDL digital link using 1 + 1 MSP protection

PCT/m/n/GRPnn

m 1

n 1

nn 1 to 3

Example PCT/1/1/GRP3
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Section VI: NERA Radio Port Addresses

Overview
....................................................................................................................................................................................................................................

Purpose This section describes the external port addresses for the physical,
logical and virtual ports of the NERA radio and regenerators.

Contents
Terminal line ports (radio side) external addresses 6-63

Terminal tributary ports (electrical side) external
addresses

6-64

Regenerator line ports external addresses 6-65

Network Element Port Addresses
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Terminal line ports (radio side) external addresses
....................................................................................................................................................................................................................................

Overview This section provides information about the ISM-5E tributary ports.

Tables This section provides the external addresses for the NERA terminal
line ports (radio side) external addresses.

Table 6-90 STM-1 digital link of a NERA Terminal on the
Radio Side

S1/m/nn/p

m 1 - 7

nn 1

p 1

Example s1/2/1/

Table 6-91 VC-4 Path (STM-1 logical line port of a NERA
terminal on the Radio side)

S1/m/nn/p

m 1 - 7

nn 2

p 1

h 1

Example S1/2/2/1/1
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Terminal tributary ports (electrical side) external addresses
....................................................................................................................................................................................................................................

Overview This section provides information about the NERA terminal tributary
ports.

Tables This section provides the external addresses for the NERA terminal
line ports (radio side) external addresses.

Table 6-92 STM-1 Physical Tributary Port of a NERA Terminal
on the Electrical Side

S1/m/nn/p

m 1 - 7

nn 2

p 1

Example S1/1/2/1

Table 6-93 STM-1 Logical Tributary Port of a NERA Terminal
on the Electrical Side (VC4)

S1/m/nn/p

m 1 - 7

nn 1

p 1

h 1

Example S1/3/1/1/1
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Regenerator line ports external addresses
....................................................................................................................................................................................................................................

Overview This section provides information about the NERA regenerator line
ports.

Tables This section provides the external addresses for the NERA regenerator
line ports external addresses.

Table 6-94 STM-1 Physical Line Port of a NERA Regenerator

S1/m/nn/p

m 1 to 16

nn 1

p 1

Example S1/8/1/1
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Section VII: OLS400G Port Addresses

Overview
....................................................................................................................................................................................................................................

Purpose This section describes the external port addresses for the physical,
logical and virtual ports of the NERA radio and regenerators.

Contents
Port address mapping for WaveStar OLS400G 6-67

Network Element Port Addresses

....................................................................................................................................................................................................................................
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Port address mapping for WaveStar OLS400G
....................................................................................................................................................................................................................................

Port identifiers for
OLS400G

(R3.0/R3.1/R4.0/R5.0
C-Band, R4.0 L-Band

OCH Trail or Optical Link (up to OLS400G R5.0)

DescriptionPort
Type

Entity Identifier Network Level Address

No
com-
pat-
ible
Optics

OTU [linenum]/
[BAY]-
[SHELF]-
[SLOT]-freq
(port-num)

OT /[linenum]/[BAY]-[SHELF]-
[SLOT]-freq (port-num)

[1E, 2E, 1W,
2W]/[1-12]-[1-
3]-[1-12]-zzzz
([1, 2])

OT / [1E, 2E, 1W,
2W]/[1-12]-[1-3]-[1-12] /zzzz
([1, 2])

Com-
pat-
ible
Optics

OMU EXT_[linenum]/
[BAY]-
[SHELF]-
[SLOT]-freq

OT/EXT_[linenum]/[BAY]-
[SHELF]-[SLOT]-freq

EXT_[1E, 2E,
1W,
2W]/[1-12]-[1-
3]-[1-12]-zzzz

OT/EXT_[1E, 2E, 1W,
2W]/[1-12]-[1-3]-[1-12]/zzzz

OMS Line Port (up to OLS400G R5.0)

DescriptionPort
Type

Entity Identifier Network Level Address

Section VII: OLS400G Port Addresses Network Element Port Addresses

....................................................................................................................................................................................................................................

365-309-243
Issue 1, July 2001

Lucent Technologies 6 - 6 7



All
OLS400G
models
except
WADs

OA [linenum]/
[BAY]-
[SHELF]-
[SLOT] (for
Add)

/[BAY]-
[SHELF]-
[SLOT] (for
Drop)

OL[40, 80]c/[linenum]/[BAY]-
[SHELF]-[SLOT] (for Add)

[BAY]-[SHELF]-[SLOT] (for
Drop)

[1E, 2E, 1W,
2W] (see lookup
table for
Bay-Shelf-Slot
values)

OL [40, 80]c/[1E, 2E 1W,
2W]/[see lookup table for
Bay-Shelf-Slot values]

For
WAD
model,
2F_
4CH_
AD

OA [linenum]/
[BAY]-
[SHELF]-
[SLOT] (for
Add)

/[BAY]-
[SHELF]-
[SLOT] (for
Drop)

OL[40, 80]c/[linenum]/[BAY]-
[SHELF]-[SLOT] (for Add)

[BAY]-[SHELF]-[SLOT] (for
Drop)

[1E, 2E, 1W,
2W] (see lookup
table for
Bay-Shelf-Slot
values)

OL [40, 80]c/[1E, 2E 1W,
2W]/[see lookup table for
Bay-Shelf-Slot values]

Section VII: OLS400G Port Addresses
Port address mapping for WaveStar
OLS400G

Network Element Port Addresses

....................................................................................................................................................................................................................................

6 - 6 8 Lucent Technologies 365-309-243
Issue 1, July 2001



For
WAD
model,
2F_
4CH_
AD2

OA [linenum]/
[BAY]-
[SHELF]-
[SLOT] (for
Add)

/[BAY]-
[SHELF]-
[SLOT] (for
Drop)

OL[40, 80]c/[linenum]/[BAY]-
[SHELF]-[SLOT] (for Add)

[BAY]-[SHELF]-[SLOT] (for
Drop)

[1E, 2E, 1W,
2W] (see lookup
table for
Bay-Shelf-Slot
values)

OL [40, 80]c/[1E, 2E 1W,
2W]/[see lookup table for
Bay-Shelf-Slot values]

For
WAD
model,
4F_
4CH_
AD

OA [linenum]/
[BAY]-
[SHELF]-
[SLOT] (for
Add)

/[BAY]-
[SHELF]-
[SLOT] (for
Drop)

OL[40, 80]c/[linenum]/[BAY]-
[SHELF]-[SLOT] (for Add)

[BAY]-[SHELF]-[SLOT] (for
Drop)

[1E, 2E, 1W,
2W] (see lookup
table for
Bay-Shelf-Slot
values)

OL [40, 80]c/[1E, 2E 1W,
2W]/[see lookup table for
Bay-Shelf-Slot values]
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Repeater
port

OA [linenum]/
[BAY]-
[SHELF]-
[SLOT] (for
Add)

/[BAY]-
[SHELF]-
[SLOT] (for
Drop)

OL[40, 80]c/[linenum]/[BAY]-
[SHELF]-[SLOT] (for Add)

[BAY]-[SHELF]-[SLOT] (for
Drop)

[1E, 2E, 1W,
2W] / [1-12] -
[1-3] - [1-12] /
[1-12] - [1-3] -
[1-12]

OL [40, 80]c/[1E, 2E 1W,
2W]/[1-12] - [1-3] - [1-12] /
[1-12] - [1-3] - [1-12]

OCH Trail Logical Port on OMS Line (up to OLS400G R5.0)

DescriptionPort
Type

Entity Identifier Network Level Address

All
OLS400G
models
except
WADs

OA [linenum]/
[BAY]-
[SHELF]-
[SLOT] (for
Add)

/[BAY]-
[SHELF]-
[SLOT] (for
Drop) - zzzz

OL[40, 80]c/[linenum]/[BAY]-
[SHELF]-[SLOT] (for Add)

[BAY]-[SHELF]-[SLOT] (for
Drop) zzzz

[1E, 2E, 1W,
2W] (see lookup
table for
Bay-Shelf-Slot
values) - zzzz

OL [40, 80]c/[1E, 2E 1W,
2W]/[see lookup table for
Bay-Shelf-Slot values] zzzz
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For
WAD
model,
2F_
4CH_
AD

OA [linenum]/
[BAY]-
[SHELF]-
[SLOT] (for
Add)

/[BAY]-
[SHELF]-
[SLOT] (for
Drop) zzzz

OL[40, 80]c/[linenum]/[BAY]-
[SHELF]-[SLOT] (for Add)

[BAY]-[SHELF]-[SLOT] (for
Drop) zzzz

[1E, 2E, 1W,
2W] (see lookup
table for
Bay-Shelf-Slot
values) zzzz

OL [40, 80]c/[1E, 2E 1W,
2W]/[see lookup table for
Bay-Shelf-Slot values] zzzz

For
WAD
model,
2F_
4CH_
AD2

OA [linenum]/
[BAY]-
[SHELF]-
[SLOT] (for
Add)

/[BAY]-
[SHELF]-
[SLOT] (for
Drop) zzzz

OL[40, 80]c/[linenum]/[BAY]-
[SHELF]-[SLOT] (for Add)

[BAY]-[SHELF]-[SLOT] (for
Drop) zzzz

[1E, 2E, 1W,
2W] (see lookup
table for
Bay-Shelf-Slot
values) zzzz

OL [40, 80]c/[1E, 2E 1W,
2W]/[see lookup table for
Bay-Shelf-Slot values] zzzz
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For
WAD
model,
4F_
4CH_
AD

OA [linenum]/
[BAY]-
[SHELF]-
[SLOT] (for
Add)

/[BAY]-
[SHELF]-
[SLOT] (for
Drop) zzzz

OL[40, 80]c/[linenum]/[BAY]-
[SHELF]-[SLOT] (for Add)

[BAY]-[SHELF]-[SLOT] (for
Drop) zzzz

[1E, 2E, 1W,
2W] (see lookup
table for
Bay-Shelf-Slot
values) zzzz

OL [40, 80]c/[1E, 2E 1W,
2W]/[see lookup table for
Bay-Shelf-Slot values] zzzz
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Section VIII: PHASE Port Addresses

Overview
....................................................................................................................................................................................................................................

Purpose This section describes the external and internal port addresses for both
the physical and logical ports of the PHASE network elements. This
section also discusses the correlation between the external and internal
port addresses.

Contents
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Port address information
....................................................................................................................................................................................................................................

Overview This section lists the port addresses for the following PHASE network
elements:

• Terminal Multiplexers:

- TM-16/4

- TM-4/4

• Add Drop Multiplexers:

- ADM-16/4

- ADM-4/4

• Digital Cross-Connect Systems:

- LXC-16/4

- LXC-4/4

• Line Repeaters:

- LR-16

- LR-4.

Address format This section describes the network-level address format for the
PHASE network elements.

Note that [] (brackets) indicates that the selection is contained within
brackets. , (comma) denotes ’or.’ - (hyphen) signifies a range of
numbers. Users may select only one number in the range.

Table 6-95 Network Level Address Format Example

Description Network level
address

Read as Example

STM-16
Physical Port
for a TM-16/4

S16/1/[1,2,18]/1 S16/1/1 or 2 or
18/1

S16/1/2/1

STM-16
Physical Port
for an
ADM-16/4

S16/1/[2-5]/1 S16/1/2,3,4,
or5/1

S16/1/5/1
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Table 6-95 Network Level Address Format Example
(continued)

Description Network level
address

Read as Example

VC-3 Logical
Port on STM-4
(Trib)

S4/1/[3-17]/1/
[1-4]-[1-3]

S4/1/3 thru
17/1/1 thru 4 -
1 thru 3

S4/1/12/1/3-2

Port addresses The following lists the valid port addresses for the PHASE network
elements.

Table 6-96 PHASE network element Port Addresses

DescriptionNetwork
Element

Entity Identifier
(EID)

Network
Level
Addresses

STM-16
Physical
Port
(Line)

TM16/4

(CS-17 or
CS-19)

ADM16/4

LR 16

LP[301,302,318]

LP[302-305]

LP[301,302,318]

S16/1/[1,2,
18]/1

S16/1/[2-5]/1

S16/1/[1,2,
18]/1

STM-16
Physical
Port
(Trib)

TM16/4

(CS-17 or
CS-19)

ADM16/4

LXC16/1

LR 16

TP[303-317]

TP[306-318]

GP[301-306]

GP[314-318]

GP[401-406]

GP[414-418]

LP[303-317]

S16/1/[3-17]/1

S16/1/[6-18]/1

S16/1/1-[1-6]/
1

S16/1/2-[14-
18]/1

S16/1/3-[1-6]/
1

S16/1/4-[14-
18]/1

S16/1/[3-17]/1

STM-4
Physical
Port
(Line)

TM4/4

(CS-17 or
CS-19)

ADM4/4

LR 4

LP[301-302,318-
319]

LP[302-305]

LP[301-302,318-
319]

S4/1/[1-2,18-
19]/1

S4/1/[2-5]/1

S4/1/[1-2,18-
19]/1
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Table 6-96 PHASE network element Port Addresses
(continued)

DescriptionNetwork
Element

Entity Identifier
(EID)

Network
Level
Addresses

STM-4
Physical
Port
(Trib)

TM4/4

(CS-17 & CS-19)

TM16/4

ADM4/4

ADM16/4

LXC4/1

LXC16/1

LR 4

TP[303-317]

TP[303-317]

TP[306-319]

TP[306-319]

TP[303-317]

GP[301-306]

GP[314-319]

GP[401-406]

GP[414-419]

TP[303-317]

S4/1/[3-17]/1

S4/1/[3-17]/1

S4/1/[6-19]/1

S4/1/[6-19]/1

S4/1/[3-17]/1

S4/1/1-[1-6]/1

S4/1/2-[14-
19]/1

S4/1/3-[1-6]/1

S4/1/4-[14-
19]/1

S4/[1/[3-17]/1

STM-1
Physical
Port on
TIU-4 or
SIU-1
card
(Trib)

TM4/4

(CS-17 & CS-19)

TM16/4

ADM4/4

ADM16/4

LXC4/1

LXC16/1

TP[303-317].[1-4]

TP[303-317].[1-4]

TP[306-319].[1-4]

TP[306-319].[1-4]

TP[303-317].[1-4]

GP[301-306].[1-4]

GP[314-319].[1-4]

GP[401-406].1

GP[414-419].1

S1/1/[3-17]/
[1-4]

S1/1/[3-17]/
[1-4]

S1/1/[6-19]/
[1-4]

S1/1/[6-19]/
[1-4]

S1/1/[3-17]/
[1-4]

S1/1/1-[1-6]/
[1-4]

S1/1/2-[14-
19]/[1-4]

S1/1/3-[1-6]/1

S1/1/4-[14-
19]/1
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Table 6-96 PHASE network element Port Addresses
(continued)

DescriptionNetwork
Element

Entity Identifier
(EID)

Network
Level
Addresses

CEPT-4
Physical
Port
(Trib)

TM4/4

(CS-17 & CS-19)

TM16/4

ADM4/4

ADM16/4

LXC4/1

LXC16/1

TP[303-317].[1-4]

TP[303-317].[1-4]

TP[306-319].[1-4]

TP[306-319].[1-4]

TP[303-317].[1-4]

GP[301-304].[1-4]

GP[314,
316-319].[1-4]

P4/1/[3-17]/
[1-4]

P4/1/[3-17]/
[1-4]

P4/1/[6-19]/
[1-4]

P4/1/[6-19]/
[1-4]

P4/1/[3-17]/
[1-4]

P4/1/1-[1-4]/
[1-4]

P4/1/2-[14,
16-19]/[1-4]

CEPT-3
Physical
Port
(Trib)

TM4/4

(CS-17 & CS-19)

TM16/4

ADM4/4

ADM16/4

LXC4/1

LXC16/1

TP[303-317].[1-
2].[1-3]

TP[303-317].[1-
2].[1-3]

TP[306-319].[1-
2].[1-3]

TP[306-319].[1-
2].[1-3]

TP[303-317].[1-6]

GP[301-304].[1-6]

GP[314,
316-319].[1-6]

P3/1/[3-17]/
[1-2]-[1-3]

P3/1/[3-17]/
[1-2]-[1-3]

P3/1/[6-19]/
[1-2]-[1-3]

P3/1/[6-19]/
[1-2]-[1-3]

P3/1/[3-17]/
[1-6]

P3/1/1-[1-4]/
[1-6]

P3/1/2-[14,
16-19]/[1-6]
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Table 6-96 PHASE network element Port Addresses
(continued)

DescriptionNetwork
Element

Entity Identifier
(EID)

Network
Level
Addresses

45 Mb/s
Physical
Port
(Trib)

TM4/4

(CS-17 & CS-19)

TM16/4

ADM4/4

ADM16/4

LXC4/1

LXC16/1

TP[303-317].[1-
2].[1-3]

TP[303-317].[1-
2].[1-3]

TP[306-319].[1-
2].[1-3]

TP[306-319].[1-
2].[1-6]

TP[303-317].[1-6]

GP[301-304].[1-6]

GP[314,
316-319].[1-6]

D3/1/[3-17]/
[1-2]-[1-3]

D3/1/[3-17]/
[1-2]-[1-3]

D3/1/[6-19]/
[1-2]-[1-3]

D3/1/[6-19]/
[1-2]-[1-3]

D3/1/[3-17]/
[1-6]

D3/1/1-[1-4]/
[1-6]

D3/1/2-[14,
16-19]/[1-6]

CEPT-1
Physical/
Logical

TM4/4

(CS-17 & CS-19)

TM16/4

ADM4/4

ADM16/4

LXC4/1

LXC16/1

TP[303-317].1.[1-
21]

TP[303-317].1.[1-
21]

TP[306-319].1.[1-
21]

TP[306-319].1.[1-
21]

TP[303-317].[1-21]

GP[301-304].[1-21]

GP[314,
316-319].[1-21]

P1/1/[3-17]/1-
[1-21]

P1/1/[3-17/1-
[1-21]

P1/1/[6-19]/1-
[1-21]

P1/1/[6-19]/1-
[1-21]

P1/1/[3-17]/
[1-21]

P1/1/1-[1-4]/
[1-21]

P1/1/2-[14,
16-19]/[1-21]

VC-4
Logical
Port on
STM-16
(Line)

TM16/4

(CS-17 or
CS-19)

ADM16/4

LP[301-302,
318].[1-16]

LP[302-305].[1-16]

S16/1/[1-2,
18]/1/[1-16]

S16/1/[2-5]/1/
[1-16]
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Table 6-96 PHASE network element Port Addresses
(continued)

DescriptionNetwork
Element

Entity Identifier
(EID)

Network
Level
Addresses

VC-4
Logical
Port on
STM-16
(Trib)

TM16/4

(CS-17 & CS-19)

ADM16/4

LXC16/1

TP[303-317].[1-16]

TP[306-318].[1-16]

GP[301-306].[1-16]

GP[314-318].[1-16]

GP[401-406].[1-16]

GP[414-418][1-16]

S16/1/[3-17]/
1/[1-16]

S16/1/[6-18]/
1/[1-16]

S16/1/1-[1-6]/
1/[1-16]

S16/1/2-[14-
18]/1/[1-16]

S16/1/3-[1-6]/
1/[1-16]

S16/1/4-[14-
18]/1/[1-16]

VC-4
Logical
Port on
STM-4
(Line)

TM4/4

(CS-17 or
CS-19)

ADM4/4

LP[301-302,318-
319].[1-4]

LP[302-305].[1-4]

S4/1/[1-2,18-
19]/1/[1-4]

S4/1/[2-5]/1/
[1-4]
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Table 6-96 PHASE network element Port Addresses
(continued)

DescriptionNetwork
Element

Entity Identifier
(EID)

Network
Level
Addresses

VC-4
Logical
Port on
STM-4
(Trib)

TM4/4

(CS-17 & CS-19)

TM16/4

ADM4/4

ADM16/4

LXC4/1

LXC16/1

TP[303-317].[1-4]

TP[303-317].[1-4]

TP[306-319].[1-4]

TP[306-319].[1-4]

TP[303-317].[1-4]

GP[301-306].[1-4]

GP[314-319].[1-4]

GP[401-406].[1-4]

GP[414-419].[1-4]

S4/1/[3-17]/1/
[1-4]

S4/1/[3-17]/1/
[1-4]

S4/1/[6-19]/1/
[1-4]

S4/1/[6-19]/1/
[1-4]

S4/1/[3-17]/1/
[1-4]

S4/1/1-[1-6]/
1/[1-4]

S4/1/2-[14-
19]/1/[1-4]

S4/1/3-[1-6]/
1/[1-4]

S4/1/4-[14-
19]/1/[1-4]
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Table 6-96 PHASE network element Port Addresses
(continued)

DescriptionNetwork
Element

Entity Identifier
(EID)

Network
Level
Addresses

VC-4
Logical
Port on
STM-1
(Trib)

TM4/4

(CS-17 & CS-19)

TM16/4

ADM4/4

ADM16/4

LXC4/1

LXC16/1

TP[303-317].[1-
4].1

TP[303-317].[1-
4].1

TP[306-319].[1-
4].1

TP[306-319].[1-
4].1

TP[303-317].[1-
4].1

GP[301-306].[1-
4].1

GP[314-319].[1-
4].1

GP[401-406].1.1

GP[414-419].1.1

S1/1/[3-17]/
[1-4]/1

S1/1/[3-17]/
[1-4]/1

S1/1/[6-19]/
[1-4]/1

S1/1/[6-19]/
[1-4]/1

S1/1/[3-17]/
[1-4]/1

S1/1/1-[1-6]/
[1-4]/1

S1/1/2-[14-
19]/[1-4]/1

S1/1/3-[1-6]/
1/1

S1/1/4-[14-
19]/1/1

VC-4
Logical
Port on
TIU-1
card
(Trib)

TM4/4 (CS-17 &
CS-19

TM16/4

ADM4/4

ADM16/4

TP[303-317].1

TP[303-317].1

TP[306-319].1

TP[306-319].1

P1/1/[3-17]/1

P1/1/[3-17]/1

P1/1/[6-19]/1

P1/1/[6-19]/1

VC-4
Logical
Port on
TIU-3
card
(Trib)

TM4/4

(CS-17 & CS-19)

TM16/4

ADM4/4

ADM16/4

TP[303-317].[1-2]

TP[303-317].[1-2]

TP[306-319].[1-2]

TP[306-319].[1-2]

[P,D]3/1/[3-
17]/[1-2]

[P,D]3/1/[3-
17]/[1-2]

[P,D}3/1/[6-
19]/[1-2]

[P,D}3/1/[6-
19]/[1-2]
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Table 6-96 PHASE network element Port Addresses
(continued)

DescriptionNetwork
Element

Entity Identifier
(EID)

Network
Level
Addresses

VC-3
Logical
Port on
STM-16
(Trib)

LXC16/1 GP[301-306].[1-
16].[1-3].0.0

GP[314-318].[1-
16].[1-3].0.0

GP[401-406].[1-
16].[1-3].0.0

GP[414-418][1-
16].[1-3].0.0

S16/1/1-[1-6]/
1/[1-16]-[1-3]

S16/1/2-[14-
18]/1/[1-16]-
[1-3]

S16/1/3-[1-6]/
1/[1-16]-[1-3]

S16/1/4-[14-
18]/1/[1-16]-
[1-3]

VC-3
Logical
Port on
STM-4
(Trib)

LXC4/1

LXC16/1

TP[303-317].[1-
4].[1-3].0.0

GP[301-306].[1-
4].[1-3].0.0

GP[314-319].[1-
4].[1-3].0.0

GP[401-406].[1-
4].[1-3].0.0

GP[414-419].[1-
4].[1-3].0.0

S4/1/[3-17]/1/
[1-4]-[1-3]

S4/1/1-[1-6]/
1/[1-4]-[1-3]

S4/1/2-[14-
19]/1/[1-4]-[1-
3]

S4/1/3-[1-6]/
1/[1-4]-[1-3]

S4/1/4-[14-
19]/1/[1-4]-[1-
3]

VC-3
Logical
Port on
STM-1
(Trib)

LXC4/1

LXC16/1

TP[303-317].[1-
4].1.[1-3].0.0

GP[301-306].[1-
4].1.[1-3].0.0

GP[314-319].[1-
4].1.[1-3].0.0

GP[401-406].[1-
4].1.[1-3].0.0

GP[414-419].[1-
4].1.[1-3].0.0

S1/1/[3-17]/
[1-4]/1- [1-3]

S1/1/1-[1-6]/
[1-4]/1- [1-3]

S1/1/2-[1-6]/
[1-4/1-[1-3]

S1/1/3-[1-6]/
[1-4]/1-[1-3]

S1/1/4-[1-6]/
[1-4]/1-[1-3]

Section VIII: PHASE Port Addresses
Port address information

Network Element Port Addresses

....................................................................................................................................................................................................................................

6 - 8 2 Lucent Technologies 365-309-243
Issue 1, July 2001



Table 6-96 PHASE network element Port Addresses
(continued)

DescriptionNetwork
Element

Entity Identifier
(EID)

Network
Level
Addresses

VC-3
Logical/
Physical
Port on
TIU-3
(Trib)

TM4/4

(CS-17 & CS-19)

TM16/4

ADM4/4

ADM16/4

LXC4/1

LXC16/1

TP[303-317].[1-
2].[1-3]

TP[303-317].[1-
2].[1-3]

TP[306-319].[1-
2].[1-3]

TP[306-319].[1-
2].[1-3]

TP[303-317].[1-6]

GP[301-304].[1-6]

GP[314,
316-319].[1-6]

[P,D]3/1/[3-
17]/[1-2]-[1-3]

[P,D]3/1/[3-
17]/[1-2]-[1-3]

[P,D]3/1/[6-
19]/[1-2]-[1-3]

[P,D]3/1/[6-
19]/[1-2]-[1-3]

[P,D]3/1/[3-
17]/[1-6]

[P,D]3/1/1-[1-
4]/[1-6]

[P,D]3/1/2-[14,
16-19]/[1-6]

TU2
Logical
port on
STM-16
(Trib)

LXC16/1 GP[301-306].[1-
16].[1-3].[1-7].0

GP[314-318].[1-
16].[1-3].[1-7].0

GP[401-406].[1-
16].[1-3].[1-7].0

GP[414-418].[1-
16].[1-3].[1-7].0

S16/1/1-[1-6]/
1/[1-16]-
[1-21]

S16/1/2-[14-
18]/1/[1-16]-
[1-21]

S16/1/3-[1-6]/
1/[1-16]-[1-
21]

S16/1/4-[14-
18]/1/[1-16]-
[1-21]
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Table 6-96 PHASE network element Port Addresses
(continued)

DescriptionNetwork
Element

Entity Identifier
(EID)

Network
Level
Addresses

TU2
Logical
port on
STM-4
(Trib)

LXC4/1

LXC16/1

TP[303-317].[1-
4].[1-3].[1-7].0

GP[301-306].[1-
4].[1-3].[1-7].0

GP[314-319].[1-
4].[1-3].[1-7].0

GP[401-406].[1-
4].[1-3].[1-7].0

GP[414-419].[1-
4].[1-3].[1-7].0

S4/1/[3-17]/1/
[1-4]- [1-21]

S4/1/1-[1-6]/
1/[1-4]- [1-21]

S4/1/2-[14-
19]/1/[1-4]-[1-
21]

S4/1/3-[1-6]/
1/[1-4]-[1-21]

S4/1/4-[14-
19]/1/[1-4]-[1-
21]

TU2
Logical
port on
STM-1
(Trib)

LXC4/1

LXC16/1

TP[303-317].[1-
4].1.[1-3].[1-7].0

GP[301-306].[1-
4].1.[1-3].[1-7].0

GP[314-319].[1-
4].1.[1-3].[1-7].0

GP[401-
406].1.1.[1-3].[1-
7].0

GP[414-
419].1.1.[1-3].[1-
7].0

S1/1/[3-17]/
[1- 4]/1-[1-21]

S1/1/1-[1-6]/
[1- 4]/1-[1-21]

S1/1/2-[14-
19]/[1-4]/1-[1-
21]

S1/1/3-[1-6]/
1/1-[1-21]

S1/1/4-[14-
19]/1/1-[1-21]
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Table 6-96 PHASE network element Port Addresses
(continued)

DescriptionNetwork
Element

Entity Identifier
(EID)

Network
Level
Addresses

VC-12
Logical
port on
STM-16
(Trib)

LXC16/1 GP[301-306].[1-
16].[1-3].[1-7].[1-
3]

GP[314-318].[1-
16].[1-3].[1-7].[1-
3]

GP[401-406].[1-
16].[1-3].[1-7].[1-
3]

GP[414-418].[1-
16].[1-3].[1-7].[1-
3]

S16/1/1-[1-6]/
1/[1-16]-
[1-63]

S16/1/2-[14-
18]/1/[1-16]-
[1-63]

S16/1/3-[1-6]/
1/[1-16]-[1-
63]

S16/1/4-[14-
18]/1/[1-16]-
[1-63]

VC-12
Logical
port on
STM-4
(Trib)

LXC4/1

LXC16/1

TP[303-317].[1-
4].[1-3].[1-7].[1-3]

GP[301-306].[1-
4].[1-3].[1-7].[1-3]

GP[314-319].[1-
4].[1-3].[1-7].[1-3]

GP[401-406].[1-
4].[1-3].[1-7].[1-3]

GP[414-419].[1-
4].[1-3].[1-7].[1-3]

S4/1/[3-17]/1/
[1-4]-[1-63]

S4/1/1-[1-6]/
1/[1-4]-[1-63]

S4/1/2-[14-
19]/1/[1-4]-[1-
63]

S4/1/3-[1-6]/
1/[1-4]-[1-63]

S4/1/4-[14-
19]/1/[1-4]-[1-
63]
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Table 6-96 PHASE network element Port Addresses
(continued)

DescriptionNetwork
Element

Entity Identifier
(EID)

Network
Level
Addresses

VC-12
Logical
port on
STM-1
(Trib)

LXC4/1

LXC16/1

TP[303-317].[1-
4].1.[1-3].[1-7].[1-
3]

GP[301-306].[1-
4].1.[1-3].[1-7].[1-
3]

GP[314-319].[1-
4].1.[1-3].[1-7].[1-
3]

GP[401-406].1.[1-
3].[1-7].[1-3]

GP[414-419].1.[1-
3].[1-7].[1-3]

S1/1/[3-17]/
[1-4]/1-[1-63]

S1/1/1-[1-6]/
[1-4]/1-[1-63]

S1/1/2-[14-
19]/[1-4]/1-[1-
63]

S1/1/3-[1-6]/
1/1-[1-63]

S1/1/4-[14-
19]/1/1-[1-63]

VC-12
Logical/
Physical
port on
TIU-1
(Trib)

TM4/4

(CS-17 & CS-19)

TM16/4

ADM4/4

ADM16/4

LXC4/1

LXC16/1

TP[303-317].1.[1-
21]

TP[303-317].1.[1-
21]

TP[306-319].1.[1-
21]

TP[306-319].1.[1-
21]

TP[303-317].[1-21]

GP[301-304].[1-21]

GP[314,
316-319].[1-21]

P1/1/[3-17]/1-
[1-21]

P1/1/[3-17/1-
[1-21]

P1/1/[6-19]/1-
[1-21]

P1/1/[6-19]/1-
[1-21]

P1/1/[3-17]/
[1-21]

P1/1/1-[1-4]/
[1-21]

P1/1/2-[14,
16-19]/[1-21]

Notes:

1. Port (Trib)

Section VIII: PHASE Port Addresses
Port address information

Network Element Port Addresses

....................................................................................................................................................................................................................................

6 - 8 6 Lucent Technologies 365-309-243
Issue 1, July 2001



Section IX: SLM Port Addresses

Overview
....................................................................................................................................................................................................................................

Purpose This section describes the external and internal port addresses for both
the physical and logical ports of SLM (Release 1.0 or later) network
elements. This section also discusses the correlation between the
external and internal port addresses.

Note SLMs may be configured in six different arrangements:

• SLM-4 0:1 Terminal Mode

• SLM-4 0:2 Terminal Mode

• SLM-4 1+ 1 Terminal Mode

• SLM-16 0:1 Terminal Mode

• SLM-16 1+1 Terminal Mode

• SLM-16 ADM (add/drop multiplexer).

Contents
Line port external addresses 6-88

Tributary port external addresses 6-92

Correlation between external and internal port
addresses

6-96

Network Element Port Addresses
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Line port external addresses
....................................................................................................................................................................................................................................

Overview The tables in this section list the external addresses of the SLM 16
and 4 line ports.

SLM-16 line ports The following tables list the external addresses of the SLM 16 line
ports.

Table 6-97 STM-16 Physical Line Port of an SLM-16
Configured as 0:1 End Terminal

S16/m/nn/p

m 1

nn 13

p 1

Example S16/1/13/1 is the only possible address.

Table 6-98 STM-16 Logical Line Ports of an SLM-16
Configured as 0:1 End Terminal

S16/m/nn/p/h

m 1

nn 13

p 1

h 1 to 16

Example S16/1/13/1/1

S16/1/13/1/16

Table 6-99 STM-16 Physical Line Port of an SLM-16
Configured as 1+1 End Terminal

S16/m/GRPn/p

m 1

n 1

p 1

Example S16/1/GRP1/1 is the only possible address.
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Table 6-100 STM-16 Logical Line Ports of an SLM-16
Configured as 1+1 End Terminal

S16/m/GRPn/p/h

m 1

n 1

p 1

h 1 to 16

Example S16/1/GRP1/1/1

S16/1/GRP1/1/16

Table 6-101 STM-16 Physical Line Port of an SLM-16
Configured as Add/ Drop Terminal

S16/m/n/p

m 1

n 4 or 9

p 1

Example S16/1/4/1

S16/1/9/1

Table 6-102 STM-16 Logical Line Ports of an SLM-16
configured as Add/ Drop Terminal

S16/m/n/p/h

m 1

n 4 or9

p 1

h 1 to 16

Example S16/1/4/1/1

S16/1/9/1/16

SLM-4 line ports The tables in this section provide specific information on the external
address of the SLM-4 line ports.
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Table 6-103 STM-4 Physical Line Port of an SLM-4 configured
as 0:1 End Terminal

S4/m/nn/p

m 1

nn 2 or 11

p 1

Example S4/1/2/1/1 or S4/1/11/1/4.

In a 0:1 configuration nn may equal 2 or 11 but not both.
The address depends on which slots the line and trib cards
are in.

Table 6-104 STM-4 Logical Line Ports of an SLM-4
Configured as 0:1 End Terminal

S4/m/nn/p/h

m 1

nn 2 or 11

p 1

h 1 to 4

Example S4/1/2/1/1 or S4/1/11/1/4.

In a 0:1 configuration nn may equal 2 or 11 but not both.
The address depends on which slots the line and trib cards
are in.

Table 6-105 STM-4 Physical Line Port of an SLM-4
Configured as 0:2 End Terminal

S4/m/nn/p

m 1

nn 2 or 11

p 1

Examples S4/1/2/1 and S4/1/11/1 are the only possible
addresses.

Section IX: SLM Port Addresses
Line port external addresses

Network Element Port Addresses

....................................................................................................................................................................................................................................

6 - 9 0 Lucent Technologies 365-309-243
Issue 1, July 2001



Table 6-106 STM-4 Logical Line Ports of an SLM-4
Configured as 0:2 End Terminal

S4/m/nn/p/h

m 1

nn 2 or 11

p 1

h 1 to 4

Examples S4/1/2/1/1 and S4/1/11/1/4

Table 6-107 STM-4 Physical Line Port of an SLM-4
Configured as 1+1 End Terminal

S4/m/GRPn/p

m 1

n 1

p 1

Example S4/1/GRP1/1 is the only possible address.

Table 6-108 STM-4 Logical Line Ports of an SLM-4
Configured as 1+1 End Terminal

S4/m/GRPn/p/h

m 1

n 1

p 1

h 1 to 4

Examples S4/1/GRP1/1/1 and S4/1/GRP1/1/4
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Tributary port external addresses
....................................................................................................................................................................................................................................

Overview The tables in this section provide specific information on the external
address of SLM-16 tributary ports.

SLM-16 tributary ports The tables in this section provide specific information on the external
address of SLM-16 tributary ports.

Table 6-109 STM-1 Physical Tributary Port of an SLM-16
Configured as 0:1 or 1+1 End Terminal

S1/m/nn/p

m 1

nn 1 to 4 or 7 to 10

p 1 or 2

Examples S1/1/1/1 and S1/1/10/2

Table 6-110 STM-1 Logical Tributary Ports of an SLM-16
Configured as 0:1 or 1+1 End Terminal

S1/m/nn/p/h

m 1

nn 1 to 4 or 7 to 10

p 1 or 2

h 1

Examples S1/1/1/1/1 and S1/1/10/2/1

Table 6-111 STM-1 Physical Tributary Port of an SLM-16
Configured as Add Drop Terminal

S1/m/nn/p

m 1

nn 15 to 18 or 20 to 23

p 1 or 2

Examples S1/1/15/1 and S1/1/23/2
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Table 6-112 STM-1 Logical Tributary Ports of an SLM-16
Configured as Add Drop Terminal

S1/m/nn/p/h

m 1

nn 15 to 18 or 20 to 23

p 1 or 2

h 1

Examples S1/1/15/1/1 and S1/1/23/2/1

Table 6-113 STM-1 Physical Tributary Port of an SLM-16 2FAD
Add Drop Terminal Configured as 1 + 1MSP

S1/m/GRP n/p

m 1

nn 1 to 4

p 1 or 2

Examples S1/1/GRP1/1 and S1/1/GRP4/2

Table 6-114 STM-1 Logical Tributary Ports of an SLM-16 2FAD
Add/ Drop Terminal Configured as 1 + 1 MSP

S1/m/GRPn/p/h

m 1

n 1 to 4

p 1 or 2

h 1

Examples S1/1/GRP1/1/1 and S1/1/GRP4/2/1

Table 6-115 CEPT-4 Physical Tributary Port of an SLM-16
Configured as 0:1 or 1+1 End Terminal

P4/m/nn/p

m 1

nn 1 to 4 or 7 to 10

p 1 or 2
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Table 6-115 CEPT-4 Physical Tributary Port of an SLM-16
Configured as 0:1 or 1+1 End Terminal
(continued)

Examples P4/1/1/1 and P4/1/10/2

Table 6-116 CEPT-4 Physical Tributary Port of an SLM-16
Configured as Add/ Drop Terminal

P4/m/nn/p

m 1

nn 15 to 18 or 20 to 23

p 1 or 2

Examples P4/1/15/1 and P4/1/23/2

SLM-4 tributary ports The tables in this section provide specific information on the external
addresses of the SLM-4 tributary ports.

Table 6-117 STM-1 Physical Tributary Port of an SLM-4
Configured as 0:1, 0:2 or 1+1 End Terminal

S1/m/n/p

m 1

n 4, 5, 8 or 9

p 1 or 2

Examples S1/1/4/1 and S1/1/9/2

Table 6-118 STM-1 Logical Tributary Ports of an SLM-16
Configured as 0:1, 0:2 or 1+1 End Terminal

S1/m/n/p/h

m 1

n 4, 5, 8 or 9

p 1 or 2

h 1

Examples S1/1/4/1/1 and S1/1/9/2/1
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Table 6-119 CEPT-4 Physical Tributary Port of an SLM-4
Configured as 0:1, 0:2 or 1+1 End Terminal

P4/m/n/p

m 1

n 4, 5, 8 or 9

p 1 or 2

Examples P4/1/4/1 and P4/1/9/2
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Correlation between external and internal port addresses
....................................................................................................................................................................................................................................

Overview The tables in this section contain information on the correlation
between external and internal STM-16 and STM-4 port addresses.

Tables The tables in this section show the correlation between external and
internal port addresses.

Note that in the following table, numbers within brackets { }
represent a choice where only one number within the brackets may be
used for a port address.

Table 6-120 Correlation of STM-16 and STM-4 Port Addresses

Port Terminal
Configuration

Physical
/Logical

External Address Internal Address

STM-16 0:1 Physical S16/1/13/1 LR1.1

STM-16 0:1 VC-4 Logical S16/1/13/1/{1-16} LR1.1,{1-16}

STM-16 1+1 Physical S16/1/GRP1/1 LR1.1

STM-16 1+1 VC-4 Logical S16/1/GRP1/{1-16} LR1.1,{1-16}

STM-16 Add/Drop Physical S16/1{4,9}/1 LR1.1

STM-16 Add/Drop VC-4 Logical S16/1{4,9}/{1-16} LR1.1,{1-16}

STM-4 0:1 Physical S4/1/{2 or 11}/1 * LR{1,2}.1 *

STM-4 0:1 VC-4 Logical S4/1/{2 or 11}/1/{1-4} ** LR{1,2}.1.{1-4} **

STM-4 0:2 Physical S4/1/{2 or 11}/1 LR{1,2}.1

STM-4 0:2 VC-4 Logical S4/1/{2 or 11}/1/{1-4} LR{1,2}.1.{1-4}

STM-4 1+1 Physical S4/1/{GRP1}/1 LR1.1

STM-4 1+1 VC-4 Logical S4/1/{GRP1}/1/{1-4} LR1.1,{1-4}

Table 6-121 Correlation of STM-1 and CEPT 4 Port Addresses

Port Terminal
Configuration

Physical
/Logical

External Address Internal Address

STM-1 0:1 or 1+1 Physical S1/1/{1-4,7-10}/{1-2} TP{1-8}.{1-2}

STM-1 0:1 or 1+1 VC-4 Logical S1/1/{1-4,7-10}/{1-2}/1 TP{1-8}.{1-2}.1

STM-1 Add/Drop Physical S1/1/{15-18,20-23}/{1-2} TP{1-8}.{1-2}

STM-1 Add/Drop VC-4 Logical S1/1/{15-18,20-23}/{1-
2}/1

TP{1-8}.{1-2}.1
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Table 6-121 Correlation of STM-1 and CEPT 4 Port Addresses (continued)

Port Terminal
Configuration

Physical
/Logical

External Address Internal Address

STM-1 Add/Drop *** Physical S1/1/Grp{1-4}/{1-2} TP{1,3,5,7}.{1-2}

STM-1 Add/Drop *** VC-4 Logical S1/1/Grp{1-4}/{1-2}/1 TP{1,3,5,7}.{1-2}.1

CEPT-4 0:1 or 1+1 Physical P4/1/{1-4,7-10}/{1-2} TP{1-8}.{1-2}

CEPT-4 Add/Drop Physical P4/1/{15-18,20-23}/{1-2} TP{1-8}.{1-2}

STM-1 0:1, 0:2 or 1+1 Physical S1/1/{4,5,8,9}/{1-2} TP{1-4}.{1-2}

STM-1 0:1, 0:2 or 1+1 VC-4 Logical S1/1/{4,5,8,9}/{1-2}/1 TP{1-4}.{1-2}.1

CEPT-4 0:1, 0:2 or 1+1 Physical P4/1/{4,5,8,9}/{1-2} TP{1-4}.{1-2}

* - S4/1/2/1 or S4/1/11/1. In a 0:1 configuration only one address may
be used, not both. The address depends upon which slots the line and
trib cards are in. ** - S4/1/2/1/1 or S4/1/11/1/4. In a 0:1 configuration
nn may equal 2 or 11, not both. The address depends upon which
slots the line and trib cards are in.*** SLM - 16 2FAD only
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Section X: TDM 10G Port Addresses

Overview
....................................................................................................................................................................................................................................

Purpose This section provides conceptual information regarding the external
and internal port addresses for both the physical and logical ports of
the TDM 10G. It also discusses the correlation between the external
and internal port addresses.
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Port identifiers
....................................................................................................................................................................................................................................

Overview This section presents the port identifiers for the TDM 10G.

Table
Description Entity Identifiers

(Internal Addresses)
Network Level Address
(External Address)

STM-64
Physical Port

1-2-#-#-[tre, trw]-1 S64/ 1-2 - #-# - [tre, trw]
- 1

VC4-16c
logical port
on STM-64
physical port

1-2-#-#-[tre, trw]-1-[1,
49, 97, 145]

S64/ 1-2 - #-# - [tre, trw]
- 1 / 16c.[1-4]

VC4-4c
logical port
on STM-64
physical port

1-2-#-#-[tre, trw]-1-[1,
13, 25, 37, 49, 61, 73,
85, 97, 109, 121, 133,
145, 157, 169, 181]

S64/ 1-2 - #-# - [tre, trw]
- 1/4c.[1-16]

VC4 logical
port on
STM-64
physical port

1-2-#-#-[tre, trw]-1-[1,
4, 7, 10, 13, 16, 19,
22, 25, 28, 31, 34, 37,
40, 43, 46, 49, 52, 55,
58, 61, 64, 67, 70, 73,
76, 79, 82, 85, 88, 91,
94, 97, 100, 103, 106,
109, 112, 115, 118,
121, 124, 127, 130,
133, 136, 139, 142,
145, 148, 151, 154,
157, 160, 163, 166,
169, 172, 175, 178,
181, 184, 187, 190]

S64/ 1-2 - #-# - [tre, trw]
-1 / AU.[1-64].0

AU3 logical
port on
STM-64
physical port

1-2-#-#-[tre,
trw]-1-[1-192]

S64/ 1-2 - #-# - [tre, trw]
-1 / AU.[1-64].[1-3]

STM-16
Physical Port

[1-4]-[1-3]-#-#-[02, 04,
06...16]-1

S16/[1-4]-[1-3]-#-#- [02,
04,06.....16]/ 1
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VC4-16c
logical port
on STM-16
physical port

[1-4]-[1-3]-#-#-[02, 04,
06...16]-1-[1]

S16/[1-4]-[1-3]-#-#- [02,
04,06.....16] -1/ 16c.[1]

VC-4c logical
port on
STM-16
physical port

[1-4]-[1-3]-#-#-[02, 04,
06...16]-1-[1, 13, 25,
37]

S16/[1-4]-[1-3]-#-#- [02,
04,06.....16] -1/ 4c.[1-4]

VC4 logical
port on
STM-16
physical port

[1-4]-[1-3]-#-#-[02, 04,
06...16]-1-[1, 4, 7, 10,
13, 16, 19, 22, 25, 28,
31, 34, 37, 40, 43, 46]

S16/[1-4]-[1-3]-#-#- [02,
04,06.....16] -1/
AU.[1-16].0

AU3 logical
port on
STM-16
physical port

[1-4]-[1-3]-#-#-[02, 04,
06...16]-1-[1-48]

S16/[1-4]-[1-3]-#-#- [02,
04,06.....16] -1/
AU.[1-16].[1-3]

STM-4
Physical Port

[1-4]-[1-3]-#-#-[01-16]-
[1-2]

S4/[1-4]-[1-3]-#-#-
[01-16]-[1-2]

VC4-4c
logical port
on STM-4
physical port

[1-4]-[1-3]-#-#-[01-16]-
[1-2]-[1]

S4/[1-4]-[1-3]-#-#-
[01-16]-[1-2] / 4c.[1]

VC4 logical
port on
STM-4
physical port

[1-4]-[1-3]-#-#-[01-16]-
[1-2]-[1, 4, 7, 10]

S4/[1-4]-[1-3]-#-#-
[01-16]-[1-2] AU.[1-4].0

AU3 logical
port on
STM-4
physical port

[1-4]-[1-3]-#-#-[01-16]-
[1-2]-[1-12]

S4/[1-4]-[1-3]-#-#-
[01-16]-[1-2] /
AU.[1-4].[1-3]

STM-1
Physical Port

[1-4]-[1-3]-#-#-[01-16]-
[1-8]

S1/[1-4]-[1-3]-#-#-
[01-16]-[1-8]

VC4 logical
port on
STM-1
physical port

[1-4]-[1-3]-#-#-[01-16]-
[1-8]-1

S1/[1-4]-[1-3]-#-#-
[01-16]-[1-2] / AU. 1.0
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AU3 logical
port on
STM-1
physical port

[1-4]-[1-3]-#-#-[01-16]-
[1-8]-[1-3]

S1/[1-4]-[1-3]-#-#-
[01-16]-[1-8] / AU.1[1-3]
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Section XI: TM 1 Port Addresses

Overview
....................................................................................................................................................................................................................................

Purpose This section provides the port identifiers for TM 1 network elements.
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Port identifiers
....................................................................................................................................................................................................................................

Overview This section presents the port identifiers for TM 1 network elements.

Table
Description Entity Identifier

(EID)
Network Level
Address

STM-1 Line
Port 1

Physical Port LP1 S1/1/2/1

Logical Port
(AU4 and
VC4
combined)

LP1.1 S1/1/2/1/1

Logical Port
TU12

LP1.1.1.[1-6].[1-
3]

S1/1/2/1/1-[1-
16]

E1 (CEPT-1)
(2Mb/s)
Tributary
(on-board)

Physical
Ports

TP1.[1-16] P1/1/3/[1-16]

TP1.[1-16] P1/1/3/[1-16]
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Section XII: WaveStar DACS Port Addresses

Overview
....................................................................................................................................................................................................................................

Purpose This section provides conceptual information regarding the external
and internal port addresses for both the physical and logical ports of
WaveStar DACS. It also discusses the correlation between the external
and internal port addresses.

Contents
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External addresses
....................................................................................................................................................................................................................................

Overview This section contains the external address information for WaveStar
DACS.

Physical ports The following tables list the physical port addresses.

Table 6-122 STM-1 Digital Link

S1/PAmm/n/p

PA (STM1) Subrack of WaveStar DACS

mm 1 to 17

n 1 to 18

p 1

Example S1/B12/6/1

Table 6-123 STM-0 Digital Link

S0/PBmm/n/p/h

PB (STM0) Subrack of WaveStar DACS

mm 1 to 17

n 1 to 18

p 1

h 1

Example S0/B12/6/0/1

Table 6-124 STM-0 Digital Link Using 1 + 1 MSP Protection

S1/PBmm/GRPn/p

PB (STM0) Subrack of WaveStar DACS

mm 1 to 17

n 1 to 18

p 1

Example S0/B12/GRP4/1
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Table 6-125 STM-1 Digital Link Using 1 + 1 MSP Protection

S1/PBmm/GRPn/p

PB (STM0) Subrack of WaveStar DACS

mm 1 to 17

n 1 to 18

p 1

Example S1/B12/GRP4/1

Logical ports The following tables list the logical port addresses.

Table 6-126 VC-4 - AU4 Path

S1/Bmm/n/p/h

B PSA subrack (WaveStar DACS)

mm 1 to 17

n 1 to 18

p 1

h 1

Example S1/B12/6/1/1

Table 6-127 VC-3 - AU3 Path

S1/Bmm/n/p/h

B PSA subrack (WaveStar DACS);
P PSB subrack (for
SO/Bmm/n/p/h)

mm 1 to 17

n 1 to 18

p 1

h 1 to 3

Example S1/B12/6/1/3

Table 6-128 VC-4 Path Using a 1+1 MSP STM-1 Digital Link

S1/Bmm/GRPn/p/h
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Table 6-128 VC-4 Path Using a 1+1 MSP STM-1 Digital Link
(continued)

B PSA subrack (WaveStar DACS)

mm 1 to 17

n 1 to 18

p 1

h 1 to 3

Example S1/B12/GRP4/2/3

Table 6-129 VC-3 Path Riding a VC-4 Using a 1+1 MSP STM-1
Digital Link

S1/Bmm/GRPn/p/h

B PSA subrack (WaveStar DACS)

mm 1 to 17

n 1 to 18

p 1

h 1 to 3

Example S1/B12/GRP4/1/2

Table 6-130 VC-3 Path Riding a VC-4 Using a 1+1 MSP STM-1
Digital Link

S1/Bmm/GRPn/p/h

B PSA subrack (WaveStar DACS)

mm 1 to 17

n 1 to 18

p 1

h 1

Example S0/B12/GRP4/1/1
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Module A logical port addresses
....................................................................................................................................................................................................................................

Overview This section contains information for the WaveStar DACS Module A
logical port addresses.

Obtaining The Module A logical port addresses are extensions of the physical
port addresses and can be obtained from the physical port addresses
by appending /# to the physical port address (where # is the AU3 or
AU4 channel number within the physical port).

Format The formats of the Module A logical port addresses are as follows:

• The low-speed logical port address format is: S[0,1]/X/Y/Z/K.

• The high-speed logical port address format is: S[1,4,16,
64]/(H)X/1/1/N. (H is used for ModA-1 only).

Mapping When mapping a low-speed logical port to a high-speed logical port,
the “X” value in the low- and high-speed addresses should be the
same.

Low-speed logical port
addresses

The following table lists the Module A low-speed logical port
addresses for WaveStar DACS.

With this table, the logical port number # should be consistent with
the AU3 or AU4 channel number. This number will be the Channel &
Assign number in the Facility Channel List selection form.

• With an STM-0 unit, the logical port number is always “1.”

• With an STM-1 unit, and if the channel type is AU4, the logical
port number should always be “1.”

• With an STM-1 unit, and if the channel type is AU3, the logical
port number can be 1, 2, or 3.

• In the case of an STM-0 or STM-1 MSP, the low-speed logical
port address should adhere to the previous bullet items except
that the third subfield should contain “GRP,” as shown in the
physical port external addresses.

Table 6-131 Module A Low-Speed Logical Port Addresses

Unit Type Module A External Address

STM0 ModA-1 S0/[0-8]/1/[1-3]/1
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Table 6-131 Module A Low-Speed Logical Port Addresses
(continued)

Unit Type Module A External Address

STM1 ModA-1 S1/[0-8]/1/1/#

STM0 ModA-4 S0/[0-3]/[1-4]/[1-3]/1

STM1 ModA-4 S1/[0-3]/[1-4]/[1-3]/#

STM0 ModA-16 S0/[0-3]/[1-16]/[1-3]/1

STM1 ModA-16 S1/[0-3]/[1-16]/[1-3]/#

STM0 ModA-64 S0/[0-3]/[1-64]/[1-3]/1

STM1 ModA-64 S1/[0-3]/[1-64]/[1-3]/#

High-speed logical port
addresses

The following table lists the Module A high-speed logical port
addresses for WaveStar DACS.

Table 6-132 Module A Low-Speed Logical Port Addresses

Unit Type Module A External Address

STM0 ModA-1 S0/H[0-8]/1/[1-3]/1

STM1 ModA-1 S1/H[0-8]/1/1/#

STM0 ModA-4 S0/H[0-3]/[1-4]/[1-3]/1

STM1 ModA-4 S1/H[0-3]/[1-4]/[1-3]/#

STM0 ModA-16 S0/H[0-3]/[1-16]/[1-3]/1

STM1 ModA-16 S1/H[0-3]/[1-16]/[1-3]/#

STM0 ModA-64 S0/H[0-3]/[1-64]/[1-3]/1

STM1 ModA-64 S1/H[0-3]/[1-64]/[1-3]/#

External port addresses This section provides tables for each Module A type. For AU3
channel types, the low-speed addresses are shown for both STM0 and
STM1 units.
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Table 6-133 Module A AU3 Logical Port External Addresses

AU3 Low-Speed
Logical Port
Address
STM0 Unit

AU3 Low-Speed
Logical Port Address
STM1 Unit

AU3 High-Speed
Logical Port
Addresses

S0/[0-8]/1/1/1 S1/[0-8]/1/1/1 S1/H[0-8]/1/1/1

S0/[0-8]/1/2/1 S1/[0-8]/1/1/2 S1/H[0-8]/1/1/2

S0/[0-8]/1/3/1 S1/[0-8]/1/1/3 S1/H[0-8]/1/1/3

Table 6-134 Module A AU4 Logical Port Extensions

AU4 Low-Speed
Logical Port
Address
STM0 Unit

AU4 Low-Speed
Logical Port Address
STM1 Unit

AU4 High-Speed
Logical Port
Addresses

S1/[0-8]/1/1/1 S1/H[0-8]/1/1/1

S1/[0-8]/1/1/1 S1/H[0-8]/1/1/1

S1/[0-8]/1/1/1 S1/H[0-8]/1/1/1

Table 6-135 ModA-4 AU3 Logical Port External Addresses

AU3 Low-Speed
Logical Port
Address
STM0 Unit

AU3 Low-Speed
Logical Port Address
STM1 Unit

AU3 High-Speed
Logical Port
Addresses

S0/[0-3]/1/1/1 S1/[0-3]/1/1/1 S4/H[0-3]/1/1/1

S0/[0-3]/1/2/1 S1/[0-3]/1/1/2 S4/H[0-3]/1/1/2

S0/[0-3]/1/3/1 S1/[0-3]/1/1/3 S4/H[0-3]/1/1/3

S0/[0-3]/2/1/1 S1/[0-3]/2/1/1 S4/H[0-3]/1/1/4

S0/[0-3]/2/2/1 S1/[0-3]/2/1/2 S4/H[0-3]/1/1/5

S0/[0-3]/2/3/1 S1/[0-3]/2/1/3 S4/H[0-3]/1/1/6

S0/[0-3]/3/1/1 S1/[0-3]/3/1/1 S4/H[0-3]/1/1/7

S0/[0-3]/3/2/1 S1/[0-3]/3/1/2 S4/H[0-3]/1/1/8

S0/[0-3]/3/3/1 S1/[0-3]/3/1/3 S4/H[0-3]/1/1/9

S0/[0-3]/4/1/1 S1/[0-3]/4/1/1 S4/H[0-3]/1/1/10
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Table 6-135 ModA-4 AU3 Logical Port External Addresses
(continued)

AU3 Low-Speed
Logical Port
Address
STM0 Unit

AU3 Low-Speed
Logical Port Address
STM1 Unit

AU3 High-Speed
Logical Port
Addresses

S0/[0-3]/4/2/1 S1/[0-3]/4/1/2 S4/H[0-3]/1/1/11

S0/[0-3]/4/3/1 S1/[0-3]/4/1/3 S4/H[0-3]/1/1/12

Table 6-136 ModA-4 AU4 Logical Port External Addresses

AU4 Low-Speed Logical
Port Address - STM1 Unit

AU4 High-Speed Logical Port
Addresses

S1/[0-3]/1/1/1 S4/H[0-3]/1/1/1

S1/[0-3]/2/1/1 S4/H[0-3]/1/1/2

S1/[0-3]/3/1/1 S4/H[0-3]/1/1/3

S1/[0-3]/4/1/1 S4/H[0-3]/1/1/4

Table 6-137 ModA-16 AU3 Logical Port External Addresses

AU3 Low-Speed
Logical Port
Address
STM0 Unit

AU3 Low-Speed Logical
Port Address
STM1 Unit

AU3
High-Speed
Logical Port
Addresses

S0/[0-3]/1/1/1 S1/[0-3]/1/1/1 S16/H[0-3]/1/1/1

S0/[0-3]/1/2/1 S1/[0-3]/1/1/2 S16/H[0-3]/1/1/2

S0/[0-3]/1/3/1 S1/[0-3]/1/1/3 S16/H[0-3]/1/1/3

S0/[0-3]/2/1/1 S1/[0-3]/2/1/1 S16/H[0-3]/1/1/4

S0/[0-3]/2/2/1 S1/[0-3]/2/1/2 S16/H[0-3]/1/1/5

S0/[0-3]/2/3/1 S1/[0-3]/2/1/3 S16/H[0-3]/1/1/6

S0/[0-3]/3/1/1 S1/[0-3]/3/1/1 S16/H[0-3]/1/1/7

S0/[0-3]/3/2/1 S1/[0-3]/3/1/2 S16/H[0-3]/1/1/8

S0/[0-3]/3/3/1 S1/[0-3]/3/1/3 S16/H[0-3]/1/1/9

S0/[0-3]/4/1/1 S1/[0-3]/4/1/1 S16/H[0-3]/1/1/
10

Section XII: WaveStar DACS Port
Addresses
Module A logical port addresses

Network Element Port Addresses

....................................................................................................................................................................................................................................

365-309-243
Issue 1, July 2001

Lucent Technologies 6 - 1 1 1



Table 6-137 ModA-16 AU3 Logical Port External Addresses
(continued)

AU3 Low-Speed
Logical Port
Address
STM0 Unit

AU3 Low-Speed Logical
Port Address
STM1 Unit

AU3
High-Speed
Logical Port
Addresses

S0/[0-3]/4/2/1 S1/[0-3]/4/1/2 S16/H[0-3]/1/1/
11

S0/[0-3]/4/3/1 S1/[0-3]/4/1/3 S16/H[0-3]/1/1/
12

S0/[0-3]/5/1/1 S1/[0-3]/5/1/1 S16/H[0-3]/1/1/
13

S0/[0-3]/5/2/1 S1/[0-3]/5/1/2 S16/H[0-3]/1/1/
14

S0/[0-3]/5/3/1 S1/[0-3]/5/1/3 S16/H[0-3]/1/1/
15

S0/[0-3]/6/1/1 S1/[0-3]/6/1/1 S16/H[0-3]/1/1/
16

S0/[0-3]/6/2/1 S1/[0-3]/6/1/2 S16/H[0-3]/1/1/
17

S0/[0-3]/6/3/1 S1/[0-3]/6/1/3 S16/H[0-3]/1/1/
18

S0/[0-3]/7/1/1 S1/[0-3]/7/1/1 S16/H[0-3]/1/1/
19

S0/[0-3]/7/2/1 S1/[0-3]/7/1/2 S16/H[0-3]/1/1/
20

S0/[0-3]/7/3/1 S1/[0-3]/7/1/3 S16/H[0-3]/1/1/
21

S0/[0-3]/8/1/1 S1/[0-3]/8/1/1 S16/H[0-3]/1/1/
22

S0/[0-3]/8/2/1 S1/[0-3]/8/1/2 S16/H[0-3]/1/1/
23

S0/[0-3]/8/3/1 S1/[0-3]/8/1/3 S16/H[0-3]/1/1/
24

S0/[0-3]/9/1/1 S1/[0-3]/9/1/1 S16/H[0-3]/1/1/
25
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Table 6-137 ModA-16 AU3 Logical Port External Addresses
(continued)

AU3 Low-Speed
Logical Port
Address
STM0 Unit

AU3 Low-Speed Logical
Port Address
STM1 Unit

AU3
High-Speed
Logical Port
Addresses

S0/[0-3]/9/2/1 S1/[0-3]/9/1/2 S16/H[0-3]/1/1/
26

S0/[0-3]/9/3/1 S1/[0-3]/9/1/3 S16/H[0-3]/1/1/
27

S0/[0-3]/10/1/1 S1/[0-3]/10/1/1 S16/H[0-3]/1/1/
28

S0/[0-3]/10/2/1 S1/[0-3]/10/1/2 S16/H[0-3]/1/1/
29

S0/[0-3]/10/3/1 S1/[0-3]/10/1/3 S16/H[0-3]/1/1/
30

S0/[0-3]/11/1/1 S1/[0-3]/11/1/1 S16/H[0-3]/1/1/
31

S0/[0-3]/11/2/1 S1/[0-3]/11/1/2 S16/H[0-3]/1/1/
32

S0/[0-3]/11/3/1 S1/[0-3]/11/1/3 S16/H[0-3]/1/1/
33

S0/[0-3]/12/1/1 S1/[0-3]/12/1/1 S16/H[0-3]/1/1/
34

S0/[0-3]/12/2/1 S1/[0-3]/12/1/2 S16/H[0-3]/1/1/
35

S0/[0-3]/12/3/1 S1/[0-3]/12/1/3 S16/H[0-3]/1/1/
36

S0/[0-3]/13/1/1 S1/[0-3]/13/1/1 S16/H[0-3]/1/1/
37

S0/[0-3]/13/2/1 S1/[0-3]/13/1/2 S16/H[0-3]/1/1/
38

S0/[0-3]/13/3/1 S1/[0-3]/13/1/3 S16/H[0-3]/1/1/
39

S0/[0-3]/14/1/1 S1/[0-3]/14/1/1 S16/H[0-3]/1/1/
40
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Table 6-137 ModA-16 AU3 Logical Port External Addresses
(continued)

AU3 Low-Speed
Logical Port
Address
STM0 Unit

AU3 Low-Speed Logical
Port Address
STM1 Unit

AU3
High-Speed
Logical Port
Addresses

S0/[0-3]/14/2/1 S1/[0-3]/14/1/2 S16/H[0-3]/1/1/
41

S0/[0-3]/14/3/1 S1/[0-3]/14/1/3 S16/H[0-3]/1/1/
42

S0/[0-3]/15/1/1 S1/[0-3]/15/1/1 S16/H[0-3]/1/1/
43

S0/[0-3]/15/2/1 S1/[0-3]/15/1/2 S16/H[0-3]/1/1/
44

S0/[0-3]/15/3/1 S1/[0-3]/15/1/3 S16/H[0-3]/1/1/
45

S0/[0-3]/16/1/1 S1/[0-3]/16/1/1 S16/H[0-3]/1/1/
46

S0/[0-3]/16/2/1 S1/[0-3]/16/1/2 S16/H[0-3]/1/1/
47

S0/[0-3]/16/3/1 S1/[0-3]/16/1/3 S16/H[0-3]/1/1/
48

Table 6-138 ModA-16 AU4 Logical Port External Addresses

AU4 Low-Speed Logical Port
Address - STM1 Unit

AU4 High-Speed Logical Port
Addresses

S1/[0-3]/1/1/1 S16/H[0-3]/1/1/1

S1/[0-3]/2/1/1 S16/H[0-3]/1/1/2

S1/[0-3]/3/1/1 S16/H[0-3]/1/1/3

S1/[0-3]/6/1/1 S16/H[0-3]/1/1/6

S1/[0-3]/7/1/1 S16/H[0-3]/1/1/7

S1/[0-3]/8/1/1 S16/H[0-3]/1/1/8

S1/[0-3]/9/1/1 S16/H[0-3]/1/1/9

S1/[0-3]/10/1/1 S16/H[0-3]/1/1/10

S1/[0-3]/11/1/1 S16/H[0-3]/1/1/11
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Table 6-138 ModA-16 AU4 Logical Port External Addresses
(continued)

AU4 Low-Speed Logical Port
Address - STM1 Unit

AU4 High-Speed Logical Port
Addresses

S1/[0-3]/12/1/1 S16/H[0-3]/1/1/12

S1/[0-3]/13/1/1 S16/H[0-3]/1/1/13

S1/[0-3]/14/1/1 S16/H[0-3]/1/1/14

S1/[0-3]/15/1/1 S16/H[0-3]/1/1/15

S1/[0-3]/16/1/1 S16/H[0-3]/1/1/16

Table 6-139 ModA-64 AU3 Logical Port External Addresses

AU3 Low-Speed
Logical Port
Address
STM0 Unit

AU3 Low-Speed Logical
Port Address
STM1 Unit

AU3
High-Speed
Logical Port
Addresses

S0/[0-3]/1/1/1 S1/[0-3]/1/1/1 S64/H[0-3]/1/1/1

S0/[0-3]/1/2/1 S1/[0-3]/1/1/2 S64/H[0-3]/1/1/2

S0/[0-3]/1/3/1 S1/[0-3]/1/1/3 S64/H[0-3]/1/1/3

S0/[0-3]/2/1/1 S1/[0-3]/2/1/1 S64/H[0-3]/1/1/4

S0/[0-3]/2/2/1 S1/[0-3]/2/1/2 S64/H[0-3]/1/1/5

S0/[0-3]/2/3/1 S1/[0-3]/2/1/3 S64/H[0-3]/1/1/6

S0/[0-3]/3/1/1 S1/[0-3]/3/1/1 S64/H[0-3]/1/1/7

S0/[0-3]/3/2/1 S1/[0-3]/3/1/2 S64/H[0-3]/1/1/8

S0/[0-3]/3/3/1 S1/[0-3]/3/1/3 S64/H[0-3]/1/1/9

S0/[0-3]/4/1/1 S1/[0-3]/4/1/1 S64/H[0-3]/1/1/
10

S0/[0-3]/4/2/1 S1/[0-3]/4/1/2 S64/H[0-3]/1/1/
11

S0/[0-3]/4/3/1 S1/[0-3]/4/1/3 S64/H[0-3]/1/1/
12

S0/[0-3]/5/1/1 S1/[0-3]/5/1/1 S64/H[0-3]/1/1/
13

S0/[0-3]/5/2/1 S1/[0-3]/5/1/2 S64/H[0-3]/1/1/
14
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Table 6-139 ModA-64 AU3 Logical Port External Addresses
(continued)

AU3 Low-Speed
Logical Port
Address
STM0 Unit

AU3 Low-Speed Logical
Port Address
STM1 Unit

AU3
High-Speed
Logical Port
Addresses

S0/[0-3]/5/3/1 S1/[0-3]/5/1/3 S64/H[0-3]/1/1/
15

S0/[0-3]/6/1/1 S1/[0-3]/6/1/1 S64/H[0-3]/1/1/
16

S0/[0-3]/6/2/1 S1/[0-3]/6/1/2 S64/H[0-3]/1/1/
17

S0/[0-3]/6/3/1 S1/[0-3]/6/1/3 S64/H[0-3]/1/1/
18

S0/[0-3]/7/1/1 S1/[0-3]/7/1/1 S64/H[0-3]/1/1/
19

S0/[0-3]/7/2/1 S1/[0-3]/7/1/2 S64/H[0-3]/1/1/
20

S0/[0-3]/7/3/1 S1/[0-3]/7/1/3 S64/H[0-3]/1/1/
21

S0/[0-3]/8/1/1 S1/[0-3]/8/1/1 S64/H[0-3]/1/1/
22

S0/[0-3]/8/2/1 S1/[0-3]/8/1/2 S64/H[0-3]/1/1/
23

S0/[0-3]/8/3/1 S1/[0-3]/8/1/3 S64/H[0-3]/1/1/
24

S0/[0-3]/9/1/1 S1/[0-3]/9/1/1 S64/H[0-3]/1/1/
25

S0/[0-3]/9/2/1 S1/[0-3]/9/1/2 S64/H[0-3]/1/1/
26

S0/[0-3]/9/3/1 S1/[0-3]/9/1/3 S64/H[0-3]/1/1/
27

S0/[0-3]/10/1/1 S1/[0-3]/10/1/1 S64/H[0-3]/1/1/
28

S0/[0-3]/10/2/1 S1/[0-3]/10/1/2 S64/H[0-3]/1/1/
29
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Table 6-139 ModA-64 AU3 Logical Port External Addresses
(continued)

AU3 Low-Speed
Logical Port
Address
STM0 Unit

AU3 Low-Speed Logical
Port Address
STM1 Unit

AU3
High-Speed
Logical Port
Addresses

S0/[0-3]/10/3/1 S1/[0-3]/10/1/3 S64/H[0-3]/1/1/
30

S0/[0-3]/11/1/1 S1/[0-3]/11/1/1 S64/H[0-3]/1/1/
31

S0/[0-3]/11/2/1 S1/[0-3]/11/1/2 S64/H[0-3]/1/1/
32

S0/[0-3]/11/3/1 S1/[0-3]/11/1/3 S64/H[0-3]/1/1/
33

S0/[0-3]/12/1/1 S1/[0-3]/12/1/1 S64/H[0-3]/1/1/
34

S0/[0-3]/12/2/1 S1/[0-3]/12/1/2 S64/H[0-3]/1/1/
35

S0/[0-3]/12/3/1 S1/[0-3]/12/1/3 S64/H[0-3]/1/1/
36

S0/[0-3]/13/1/1 S1/[0-3]/13/1/1 S64/H[0-3]/1/1/
37

S0/[0-3]/13/2/1 S1/[0-3]/13/1/2 S64/H[0-3]/1/1/
38

S0/[0-3]/13/3/1 S1/[0-3]/13/1/3 S64/H[0-3]/1/1/
39

S0/[0-3]/14/1/1 S1/[0-3]/14/1/1 S64/H[0-3]/1/1/
40

S0/[0-3]/14/2/1 S1/[0-3]/14/1/2 S64/H[0-3]/1/1/
41

S0/[0-3]/14/3/1 S1/[0-3]/14/1/3 S64/H[0-3]/1/1/
42

S0/[0-3]/15/1/1 S1/[0-3]/15/1/1 S64/H[0-3]/1/1/
43

S0/[0-3]/15/2/1 S1/[0-3]/15/1/2 S64/H[0-3]/1/1/
44
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Table 6-139 ModA-64 AU3 Logical Port External Addresses
(continued)

AU3 Low-Speed
Logical Port
Address
STM0 Unit

AU3 Low-Speed Logical
Port Address
STM1 Unit

AU3
High-Speed
Logical Port
Addresses

S0/[0-3]/15/3/1 S1/[0-3]/15/1/3 S64/H[0-3]/1/1/
45

S0/[0-3]/16/1/1 S1/[0-3]/16/1/1 S64/H[0-3]/1/1/
46

S0/[0-3]/16/2/1 S1/[0-3]/16/1/2 S64/H[0-3]/1/1/
47

S0/[0-3]/16/3/1 S1/[0-3]/16/1/3 S64/H[0-3]/1/1/
48

S0/[0-3]/17/1/1 S1/[0-3]/17/1/1 S64/H[0-3]/1/1/
49

S0/[0-3]/17/2/1 S1/[0-3]/17/1/2 S64/H[0-3]/1/1/
50

S0/[0-3]/17/3/1 S1/[0-3]/17/1/3 S64/H[0-3]/1/1/
51

S0/[0-3]/18/1/1 S1/[0-3]/18/1/1 S64/H[0-3]/1/1/
52

S0/[0-3]/18/2/1 S1/[0-3]/18/1/2 S64/H[0-3]/1/1/
53

S0/[0-3]/18/3/1 S1/[0-3]/18/1/3 S64/H[0-3]/1/1/
54

S0/[0-3]/19/1/1 S1/[0-3]/19/1/1 S64/H[0-3]/1/1/
55

S0/[0-3]/19/2/1 S1/[0-3]/19/1/2 S64/H[0-3]/1/1/
56

S0/[0-3]/19/3/1 S1/[0-3]/19/1/3 S64/H[0-3]/1/1/
57

S0/[0-3]/20/1/1 S1/[0-3]/20/1/1 S64/H[0-3]/1/1/
58

S0/[0-3]/20/2/1 S1/[0-3]/20/1/2 S64/H[0-3]/1/1/
59
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Table 6-139 ModA-64 AU3 Logical Port External Addresses
(continued)

AU3 Low-Speed
Logical Port
Address
STM0 Unit

AU3 Low-Speed Logical
Port Address
STM1 Unit

AU3
High-Speed
Logical Port
Addresses

S0/[0-3]/20/3/1 S1/[0-3]/20/1/3 S64/H[0-3]/1/1/
60

S0/[0-3]/21/1/1 S1/[0-3]/21/1/1 S64/H[0-3]/1/1/
61

S0/[0-3]/21/2/1 S1/[0-3]/21/1/2 S64/H[0-3]/1/1/
62

S0/[0-3]/21/3/1 S1/[0-3]/21/1/3 S64/H[0-3]/1/1/
63

S0/[0-3]/22/1/1 S1/[0-3]/22/1/1 S64/H[0-3]/1/1/
64

S0/[0-3]/22/2/1 S1/[0-3]/22/1/2 S64/H[0-3]/1/1/
65

S0/[0-3]/22/3/1 S1/[0-3]/22/1/3 S64/H[0-3]/1/1/
66

S0/[0-3]/23/1/1 S1/[0-3]/23/1/1 S64/H[0-3]/1/1/
67

S0/[0-3]/23/2/1 S1/[0-3]/23/1/2 S64/H[0-3]/1/1/
68

S0/[0-3]/23/3/1 S1/[0-3]/23/1/3 S64/H[0-3]/1/1/
69

S0/[0-3]/24/1/1 S1/[0-3]/24/1/1 S64/H[0-3]/1/1/
70

S0/[0-3]/24/2/1 S1/[0-3]/24/1/2 S64/H[0-3]/1/1/
71

S0/[0-3]/24/3/1 S1/[0-3]/24/1/3 S64/H[0-3]/1/1/
72

S0/[0-3]/25/1/1 S1/[0-3]/25/1/1 S64/H[0-3]/1/1/
73

S0/[0-3]/25/2/1 S1/[0-3]/25/1/2 S64/H[0-3]/1/1/
74
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Table 6-139 ModA-64 AU3 Logical Port External Addresses
(continued)

AU3 Low-Speed
Logical Port
Address
STM0 Unit

AU3 Low-Speed Logical
Port Address
STM1 Unit

AU3
High-Speed
Logical Port
Addresses

S0/[0-3]/25/3/1 S1/[0-3]/25/1/3 S64/H[0-3]/1/1/
75

S0/[0-3]/26/1/1 S1/[0-3]/26/1/1 S64/H[0-3]/1/1/
76

S0/[0-3]/26/2/1 S1/[0-3]/26/1/2 S64/H[0-3]/1/1/
77

S0/[0-3]/26/3/1 S1/[0-3]/26/1/3 S64/H[0-3]/1/1/
78

S0/[0-3]/27/1/1 S1/[0-3]/27/1/1 S64/H[0-3]/1/1/
79

S0/[0-3]/27/2/1 S1/[0-3]/27/1/2 S64/H[0-3]/1/1/
80

S0/[0-3]/27/3/1 S1/[0-3]/27/1/3 S64/H[0-3]/1/1/
81

S0/[0-3]/28/1/1 S1/[0-3]/28/1/1 S64/H[0-3]/1/1/
82

S0/[0-3]/28/2/1 S1/[0-3]/28/1/2 S64/H[0-3]/1/1/
83

S0/[0-3]/28/3/1 S1/[0-3]/28/1/3 S64/H[0-3]/1/1/
84

S0/[0-3]/29/1/1 S1/[0-3]/29/1/1 S64/H[0-3]/1/1/
85

S0/[0-3]/29/2/1 S1/[0-3]/29/1/2 S64/H[0-3]/1/1/
86

S0/[0-3]/29/3/1 S1/[0-3]/29/1/3 S64/H[0-3]/1/1/
87

S0/[0-3]/30/1/1 S1/[0-3]/30/1/1 S64/H[0-3]/1/1/
88

S0/[0-3]/30/2/1 S1/[0-3]/30/1/2 S64/H[0-3]/1/1/
89
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Table 6-139 ModA-64 AU3 Logical Port External Addresses
(continued)

AU3 Low-Speed
Logical Port
Address
STM0 Unit

AU3 Low-Speed Logical
Port Address
STM1 Unit

AU3
High-Speed
Logical Port
Addresses

S0/[0-3]/30/3/1 S1/[0-3]/30/1/3 S64/H[0-3]/1/1/
90

S0/[0-3]/31/1/1 S1/[0-3]/31/1/1 S64/H[0-3]/1/1/
91

S0/[0-3]/31/2/1 S1/[0-3]/31/1/2 S64/H[0-3]/1/1/
92

S0/[0-3]/31/3/1 S1/[0-3]/31/1/3 S64/H[0-3]/1/1/
93

S0/[0-3]/32/1/1 S1/[0-3]/32/1/1 S64/H[0-3]/1/1/
94

S0/[0-3]/32/2/1 S1/[0-3]/32/1/2 S64/H[0-3]/1/1/
95

S0/[0-3]/32/3/1 S1/[0-3]/32/1/3 S64/H[0-3]/1/1/
96

S0/[0-3]/33/1/1 S1/[0-3]/33/1/1 S64/H[0-3]/1/1/
97

S0/[0-3]/33/2/1 S1/[0-3]/33/1/2 S64/H[0-3]/1/1/
98

S0/[0-3]/33/3/1 S1/[0-3]/33/1/3 S64/H[0-3]/1/1/
99

S0/[0-3]/34/1/1 S1/[0-3]/34/1/1 S64/H[0-3]/1/1/
100

S0/[0-3]/34/2/1 S1/[0-3]/34/1/2 S64/H[0-3]/1/1/
101

S0/[0-3]/34/3/1 S1/[0-3]/34/1/3 S64/H[0-3]/1/1/
102

S0/[0-3]/35/1/1 S1/[0-3]/35/1/1 S64/H[0-3]/1/1/
103

S0/[0-3]/35/2/1 S1/[0-3]/35/1/2 S64/H[0-3]/1/1/
104
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Table 6-139 ModA-64 AU3 Logical Port External Addresses
(continued)

AU3 Low-Speed
Logical Port
Address
STM0 Unit

AU3 Low-Speed Logical
Port Address
STM1 Unit

AU3
High-Speed
Logical Port
Addresses

S0/[0-3]/35/3/1 S1/[0-3]/35/1/3 S64/H[0-3]/1/1/
105

S0/[0-3]/36/1/1 S1/[0-3]/36/1/1 S64/H[0-3]/1/1/
106

S0/[0-3]/36/2/1 S1/[0-3]/36/1/2 S64/H[0-3]/1/1/
107

S0/[0-3]/36/3/1 S1/[0-3]/36/1/3 S64/H[0-3]/1/1/
108

S0/[0-3]/37/1/1 S1/[0-3]/37/1/1 S64/H[0-3]/1/1/
109

S0/[0-3]/37/2/1 S1/[0-3]/37/1/2 S64/H[0-3]/1/1/
110

S0/[0-3]/37/3/1 S1/[0-3]/37/1/3 S64/H[0-3]/1/1/
111

S0/[0-3]/38/1/1 S1/[0-3]/38/1/1 S64/H[0-3]/1/1/
112

S0/[0-3]/38/2/1 S1/[0-3]/38/1/2 S64/H[0-3]/1/1/
113

S0/[0-3]/38/3/1 S1/[0-3]/38/1/3 S64/H[0-3]/1/1/
114

S0/[0-3]/39/1/1 S1/[0-3]/39/1/1 S64/H[0-3]/1/1/
115

S0/[0-3]/39/2/1 S1/[0-3]/39/1/2 S64/H[0-3]/1/1/
116

S0/[0-3]/39/3/1 S1/[0-3]/39/1/3 S64/H[0-3]/1/1/
117

S0/[0-3]/40/1/1 S1/[0-3]/40/1/1 S64/H[0-3]/1/1/
118

S0/[0-3]/40/2/1 S1/[0-3]/40/1/2 S64/H[0-3]/1/1/
119
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Table 6-139 ModA-64 AU3 Logical Port External Addresses
(continued)

AU3 Low-Speed
Logical Port
Address
STM0 Unit

AU3 Low-Speed Logical
Port Address
STM1 Unit

AU3
High-Speed
Logical Port
Addresses

S0/[0-3]/40/3/1 S1/[0-3]/40/1/3 S64/H[0-3]/1/1/
120

S0/[0-3]/41/1/1 S1/[0-3]/41/1/1 S64/H[0-3]/1/1/
121

S0/[0-3]/41/2/1 S1/[0-3]/41/1/2 S64/H[0-3]/1/1/
122

S0/[0-3]/41/3/1 S1/[0-3]/41/1/3 S64/H[0-3]/1/1/
123

S0/[0-3]/42/1/1 S1/[0-3]/42/1/1 S64/H[0-3]/1/1/
124

S0/[0-3]/42/2/1 S1/[0-3]/42/1/2 S64/H[0-3]/1/1/
125

S0/[0-3]/42/3/1 S1/[0-3]/42/1/3 S64/H[0-3]/1/1/
126

S0/[0-3]/43/1/1 S1/[0-3]/43/1/1 S64/H[0-3]/1/1/
127

S0/[0-3]/43/2/1 S1/[0-3]/43/1/2 S64/H[0-3]/1/1/
128

S0/[0-3]/43/3/1 S1/[0-3]/43/1/3 S64/H[0-3]/1/1/
129

S0/[0-3]/44/1/1 S1/[0-3]/44/1/1 S64/H[0-3]/1/1/
130

S0/[0-3]/44/2/1 S1/[0-3]/44/1/2 S64/H[0-3]/1/1/
131

S0/[0-3]/44/3/1 S1/[0-3]/44/1/3 S64/H[0-3]/1/1/
132

S0/[0-3]/45/1/1 S1/[0-3]/45/1/1 S64/H[0-3]/1/1/
133

S0/[0-3]/45/2/1 S1/[0-3]/45/1/2 S64/H[0-3]/1/1/
134
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Table 6-139 ModA-64 AU3 Logical Port External Addresses
(continued)

AU3 Low-Speed
Logical Port
Address
STM0 Unit

AU3 Low-Speed Logical
Port Address
STM1 Unit

AU3
High-Speed
Logical Port
Addresses

S0/[0-3]/45/3/1 S1/[0-3]/45/1/3 S64/H[0-3]/1/1/
135

S0/[0-3]/46/1/1 S1/[0-3]/46/1/1 S64/H[0-3]/1/1/
136

S0/[0-3]/46/2/1 S1/[0-3]/46/1/2 S64/H[0-3]/1/1/
137

S0/[0-3]/46/3/1 S1/[0-3]/46/1/3 S64/H[0-3]/1/1/
138

S0/[0-3]/47/1/1 S1/[0-3]/47/1/1 S64/H[0-3]/1/1/
139

S0/[0-3]/47/2/1 S1/[0-3]/47/1/2 S64/H[0-3]/1/1/
140

S0/[0-3]/47/3/1 S1/[0-3]/47/1/3 S64/H[0-3]/1/1/
141

S0/[0-3]/48/1/1 S1/[0-3]/48/1/1 S64/H[0-3]/1/1/
142

S0/[0-3]/48/2/1 S1/[0-3]/48/1/2 S64/H[0-3]/1/1/
143

S0/[0-3]/48/3/1 S1/[0-3]/48/1/3 S64/H[0-3]/1/1/
144

S0/[0-3]/49/1/1 S1/[0-3]/49/1/1 S64/H[0-3]/1/1/
145

S0/[0-3]/49/2/1 S1/[0-3]/49/1/2 S64/H[0-3]/1/1/
146

S0/[0-3]/49/3/1 S1/[0-3]/49/1/3 S64/H[0-3]/1/1/
147

S0/[0-3]/50/1/1 S1/[0-3]/50/1/1 S64/H[0-3]/1/1/
148

S0/[0-3]/50/2/1 S1/[0-3]/50/1/2 S64/H[0-3]/1/1/
149
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Table 6-139 ModA-64 AU3 Logical Port External Addresses
(continued)

AU3 Low-Speed
Logical Port
Address
STM0 Unit

AU3 Low-Speed Logical
Port Address
STM1 Unit

AU3
High-Speed
Logical Port
Addresses

S0/[0-3]/50/3/1 S1/[0-3]/50/1/3 S64/H[0-3]/1/1/
150

S0/[0-3]/51/1/1 S1/[0-3]/51/1/1 S64/H[0-3]/1/1/
151

S0/[0-3]/51/2/1 S1/[0-3]/51/1/2 S64/H[0-3]/1/1/
152

S0/[0-3]/51/3/1 S1/[0-3]/51/1/3 S64/H[0-3]/1/1/
153

S0/[0-3]/52/1/1 S1/[0-3]/52/1/1 S64/H[0-3]/1/1/
154

S0/[0-3]/52/2/1 S1/[0-3]/52/1/2 S64/H[0-3]/1/1/
155

S0/[0-3]/52/3/1 S1/[0-3]/52/1/3 S64/H[0-3]/1/1/
156

S0/[0-3]/53/1/1 S1/[0-3]/53/1/1 S64/H[0-3]/1/1/
157

S0/[0-3]/53/2/1 S1/[0-3]/53/1/2 S64/H[0-3]/1/1/
158

S0/[0-3]/53/3/1 S1/[0-3]/53/1/3 S64/H[0-3]/1/1/
159

S0/[0-3]/54/1/1 S1/[0-3]/54/1/1 S64/H[0-3]/1/1/
160

S0/[0-3]/54/2/1 S1/[0-3]/54/1/2 S64/H[0-3]/1/1/
161

S0/[0-3]/54/3/1 S1/[0-3]/54/1/3 S64/H[0-3]/1/1/
162

S0/[0-3]/55/1/1 S1/[0-3]/55/1/1 S64/H[0-3]/1/1/
163

S0/[0-3]/55/2/1 S1/[0-3]/55/1/2 S64/H[0-3]/1/1/
164
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Table 6-139 ModA-64 AU3 Logical Port External Addresses
(continued)

AU3 Low-Speed
Logical Port
Address
STM0 Unit

AU3 Low-Speed Logical
Port Address
STM1 Unit

AU3
High-Speed
Logical Port
Addresses

S0/[0-3]/55/3/1 S1/[0-3]/55/1/3 S64/H[0-3]/1/1/
165

S0/[0-3]/56/1/1 S1/[0-3]/56/1/1 S64/H[0-3]/1/1/
166

S0/[0-3]/56/2/1 S1/[0-3]/56/1/2 S64/H[0-3]/1/1/
167

S0/[0-3]/56/3/1 S1/[0-3]/56/1/3 S64/H[0-3]/1/1/
168

S0/[0-3]/57/1/1 S1/[0-3]/57/1/1 S64/H[0-3]/1/1/
169

S0/[0-3]/57/2/1 S1/[0-3]/57/1/2 S64/H[0-3]/1/1/
170

S0/[0-3]/57/3/1 S1/[0-3]/57/1/3 S64/H[0-3]/1/1/
171

S0/[0-3]/58/1/1 S1/[0-3]/58/1/1 S64/H[0-3]/1/1/
172

S0/[0-3]/58/2/1 S1/[0-3]/58/1/2 S64/H[0-3]/1/1/
173

S0/[0-3]/58/3/1 S1/[0-3]/58/1/3 S64/H[0-3]/1/1/
174

S0/[0-3]/59/1/1 S1/[0-3]/59/1/1 S64/H[0-3]/1/1/
175

S0/[0-3]/59/2/1 S1/[0-3]/59/1/2 S64/H[0-3]/1/1/
176

S0/[0-3]/59/3/1 S1/[0-3]/59/1/3 S64/H[0-3]/1/1/
177

S0/[0-3]/60/1/1 S1/[0-3]/60/1/1 S64/H[0-3]/1/1/
178

S0/[0-3]/60/2/1 S1/[0-3]/60/1/2 S64/H[0-3]/1/1/
179
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Table 6-139 ModA-64 AU3 Logical Port External Addresses
(continued)

AU3 Low-Speed
Logical Port
Address
STM0 Unit

AU3 Low-Speed Logical
Port Address
STM1 Unit

AU3
High-Speed
Logical Port
Addresses

S0/[0-3]/60/3/1 S1/[0-3]/60/1/3 S64/H[0-3]/1/1/
180

S0/[0-3]/61/1/1 S1/[0-3]/61/1/1 S64/H[0-3]/1/1/
181

S0/[0-3]/61/2/1 S1/[0-3]/61/1/2 S64/H[0-3]/1/1/
182

S0/[0-3]/61/3/1 S1/[0-3]/61/1/3 S64/H[0-3]/1/1/
183

S0/[0-3]/62/1/1 S1/[0-3]/62/1/1 S64/H[0-3]/1/1/
184

S0/[0-3]/62/2/1 S1/[0-3]/62/1/2 S64/H[0-3]/1/1/
185

S0/[0-3]/62/3/1 S1/[0-3]/62/1/3 S64/H[0-3]/1/1/
186

S0/[0-3]/63/1/1 S1/[0-3]/63/1/1 S64/H[0-3]/1/1/
187

S0/[0-3]/63/2/1 S1/[0-3]/63/1/2 S64/H[0-3]/1/1/
188

S0/[0-3]/63/3/1 S1/[0-3]/63/1/3 S64/H[0-3]/1/1/
189

S0/[0-3]/64/1/1 S1/[0-3]/64/1/1 S64/H[0-3]/1/1/
190

S0/[0-3]/64/2/1 S1/[0-3]/64/1/2 S64/H[0-3]/1/1/
191

S0/[0-3]/64/3/1 S1/[0-3]/64/1/3 S64/H[0-3]/1/1/
192
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Table 6-140 ModA-64 AU4 Logical Port External Addresses

AU4 Low-Speed Logical
Port Address - STM1 Unit

AU4 High-Speed Logical Port
Addresses

S1/[0-3]/1/1/1 S64/H[0-3]/1/1/1

S1/[0-3]/2/1/1 S64/H[0-3]/1/1/2

S1/[0-3]/3/1/1 S64/H[0-3]/1/1/3

S1/[0-3]/4/1/1 S64/H[0-3]/1/1/4

S1/[0-3]/5/1/1 S64/H[0-3]/1/1/5

S1/[0-3]/6/1/1 S64/H[0-3]/1/1/6

S1/[0-3]/7/1/1 S64/H[0-3]/1/1/7

S1/[0-3]/8/1/1 S64/H[0-3]/1/1/8

S1/[0-3]/9/1/1 S64/H[0-3]/1/1/9

S1/[0-3]/10/1/1 S64/H[0-3]/1/1/10

S1/[0-3]/11/1/1 S64/H[0-3]/1/1/11

S1/[0-3]/12/1/1 S64/H[0-3]/1/1/12

S1/[0-3]/13/1/1 S64/H[0-3]/1/1/13

S1/[0-3]/14/1/1 S64/H[0-3]/1/1/14

S1/[0-3]/15/1/1 S64/H[0-3]/1/1/15

S1/[0-3]/16/1/1 S64/H[0-3]/1/1/16

S1/[0-3]/17/1/1 S64/H[0-3]/1/1/17

S1/[0-3]/18/1/1 S64/H[0-3]/1/1/18

S1/[0-3]/19/1/1 S64/H[0-3]/1/1/19

S1/[0-3]/20/1/1 S64/H[0-3]/1/1/20

S1/[0-3]/21/1/1 S64/H[0-3]/1/1/21

S1/[0-3]/22/1/1 S64/H[0-3]/1/1/22

S1/[0-3]/23/1/1 S64/H[0-3]/1/1/23

S1/[0-3]/24/1/1 S64/H[0-3]/1/1/24

S1/[0-3]/25/1/1 S64/H[0-3]/1/1/25

S1/[0-3]/26/1/1 S64/H[0-3]/1/1/26

S1/[0-3]/27/1/1 S64/H[0-3]/1/1/27

S1/[0-3]/28/1/1 S64/H[0-3]/1/1/28
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Table 6-140 ModA-64 AU4 Logical Port External Addresses
(continued)

AU4 Low-Speed Logical
Port Address - STM1 Unit

AU4 High-Speed Logical Port
Addresses

S1/[0-3]/29/1/1 S64/H[0-3]/1/1/29

S1/[0-3]/30/1/1 S64/H[0-3]/1/1/30

S1/[0-3]/31/1/1 S64/H[0-3]/1/1/31

S1/[0-3]/32/1/1 S64/H[0-3]/1/1/32

S1/[0-3]/33/1/1 S64/H[0-3]/1/1/33

S1/[0-3]/34/1/1 S64/H[0-3]/1/1/34

S1/[0-3]/35/1/1 S64/H[0-3]/1/1/35

S1/[0-3]/36/1/1 S64/H[0-3]/1/1/36

S1/[0-3]/37/1/1 S64/H[0-3]/1/1/37

S1/[0-3]/38/1/1 S64/H[0-3]/1/1/38

S1/[0-3]/39/1/1 S64/H[0-3]/1/1/39

S1/[0-3]/40/1/1 S64/H[0-3]/1/1/40

S1/[0-3]/41/1/1 S64/H[0-3]/1/1/41

S1/[0-3]/42/1/1 S64/H[0-3]/1/1/42

S1/[0-3]/43/1/1 S64/H[0-3]/1/1/43

S1/[0-3]/44/1/1 S64/H[0-3]/1/1/44

S1/[0-3]/45/1/1 S64/H[0-3]/1/1/45

S1/[0-3]/46/1/1 S64/H[0-3]/1/1/46

S1/[0-3]/47/1/1 S64/H[0-3]/1/1/47

S1/[0-3]/48/1/1 S64/H[0-3]/1/1/48

S1/[0-3]/49/1/1 S64/H[0-3]/1/1/49

S1/[0-3]/50/1/1 S64/H[0-3]/1/1/50

S1/[0-3]/51/1/1 S64/H[0-3]/1/1/51

S1/[0-3]/52/1/1 S64/H[0-3]/1/1/52

S1/[0-3]/53/1/1 S64/H[0-3]/1/1/53

S1/[0-3]/54/1/1 S64/H[0-3]/1/1/54

S1/[0-3]/55/1/1 S64/H[0-3]/1/1/55

S1/[0-3]/56/1/1 S64/H[0-3]/1/1/56
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Table 6-140 ModA-64 AU4 Logical Port External Addresses
(continued)

AU4 Low-Speed Logical
Port Address - STM1 Unit

AU4 High-Speed Logical Port
Addresses

S1/[0-3]/57/1/1 S64/H[0-3]/1/1/57

S1/[0-3]/58/1/1 S64/H[0-3]/1/1/58

S1/[0-3]/59/1/1 S64/H[0-3]/1/1/59

S1/[0-3]/60/1/1 S64/H[0-3]/1/1/60

S1/[0-3]/61/1/1 S64/H[0-3]/1/1/61

S1/[0-3]/621/1 S64/H[0-3]/1/1/62

S1/[0-3]/63/1/1 S64/H[0-3]/1/1/63

S1/[0-3]/64/1/1 S64/H[0-3]/1/1/64
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Section XIII: WaveStar LambdaRouter Port Addresses

Overview
....................................................................................................................................................................................................................................

Purpose This section provides conceptual information regarding the external
and internal port addresses for both the physical and logical ports of
the WaveStar LambdaRouter. It also discusses the correlation between
the external and internal port addresses.
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Port address information
....................................................................................................................................................................................................................................

Table The following port addresses (internal and external) are applicable to
the WaveStar LambdaRouter. Entries enclosed in { } are variables.
Fields enclosed in [] are optional fields.

The following port identifiers are applicable to the WaveStar
LambdaRouter R1.0, 256 R2.0, and 128 Release 2.0

Description Internal Address External Address

Optical
Channel Port
(Transparent
Ports)

och-{1-32}-{1-32}-
{1-4}

OT/och-{1-32}-{1-32}-
{1-4}

Optical Link
Logical Port
(Transparent
Ports)

och-{1-32}-{1-32}-
{1-4}

OT/och-{1-32}-{1-32}-
{1-4}
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Section XIV: WaveStar BandWidth Manager Port Addresses

Overview
....................................................................................................................................................................................................................................

Purpose This section contains WaveStar BandWidth Manager port addresses
specific to WaveStar NMS.

Contents
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Port address information
....................................................................................................................................................................................................................................

Overview This section discusses the address format of the WaveStar BandWidth
Manager.

Address format The format for the WaveStar BandWidth Manager addresses are:

<bay>-<Shelf>-<Protection group#>-<w/p>-<slot>-<port>

Important! The Protection group# and the w/p are not used. Enter the
# character for both of these.

External addresses This section contains the external addresses (the addresses that the
user types in) for WaveStar BandWidth Manager, and the valid port
configuration values.

• STM-64 Address
S64/<bay>-<Shelf>-<Protection group#>-<w/p>-TR<slot>-<port>

• STM-64 Valid Port Configuration Values
For any physical port not in a protection group:
Sn/[1-99]-[1-2]-#-#-tr[1-4]-1
For a physical port in a 1+1 protection group configuration:
Sn/[1-99]-[1-2]-#-#-tr[1-4] -1

• STM-16 Address
S16/<bay>-<Shelf>-<Protection group#>-<w/p>-<slot>-<port>

• STM-16 Valid Port Configuration Values
For any physical port not in a protection group:
Sn/[1-99]-[1-2]-#-#-[01-16]-1
For a physical port in a 1+1 protection group configuration:
Sn/[1-99]-[1-2]-#-#-[01-16]-1

• STM-4 Address
S4/<bay>-<Shelf>-<Protection group#>-<w/p>-<slot>-<port>

• STM-4 Valid Port Configuration Values
For any physical port not in a protection group:
Sn/[1-99]-[1-2]-#-#-[01-16]-[1-2]
For a physical port in a 1+1 protection group configuration:
Sn/[1-99]-[1-2]-#-#-[01-16]-[1-2]

• STM-1 Address
S1/<bay>-<Shelf>-<Protection group#>-<w/p>-<slot>-<port>

• STM-1 Valid Port Configuration Values

Section XIV: WaveStar BandWidth Manager
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For any physical port not in a protection group:
Sn/[1-99]-[1-2]-#-#-[01-16]-[1-4]
For a physical port in a 1+1 protection group configuration:
Sn/[1-99]-[1-2]-#-#-[01-16]-[1-4]

• DS3 Address
D3/<bay>-<Shelf>-<Protection group#>-<w/p>-<slot>-<port>

• DS3 Valid Port Configuration Values
D3/[1-99]-[1-2]-#-#-[01-16]-[1-8]

External addresses - V4
and AU3

The number of ports per slot may differ based on the rate. This
section contains the V4 and AU3 addresses.

• V4 Address
Sm/<bay>-<Shelf>-<Protection group#>-<w/p>-<slot>-
<port>/AU.[1-n].0, n=1 for STM1, n=4 for STM-4, n=16 for
STM-16, n=64 for STM-64. The internal address will be as
follows: <bay>-<Shelf>-<Protection group#>-<w/p>-<slot>-
<port>-X where X=(n-1)*3+1

• AU3 Address
Sm/<bay>-<Shelf>-<Protection group#>-<w/p>-<slot>-
<port>/AU.[1-j].[1-i] where j=1 for STM1, j=4 for STM-4, j=16
for STM-16, j=64 for STM-64 and i ranges from 1-3. The
internal address will be as follows: <bay>-<Shelf>-<Protection
group#>-<w/p>-<slot>-<port>-X, where X=3*(j-1)+i
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Port identifiers
....................................................................................................................................................................................................................................

Table This table contains the port addresses (internal and external) for the
WaveStar BandWidth Manager.

Description (BWM) Entity Identifier (EID) (Internal
Address)

Network Level Address (External
Address)

STM-64 Physical Port [1-99]-[1-2]-#-#-tr[1-4]-1 S64/[1-99]-[1-2]-#-#-tr[1-4]-1

VC4-16c logical port on
STM-64 physical port

[1-99]-[1-2]-#-#-tr[1-4]-1-[1, 49,
97, 145]

S64/[1-99]-[1-2]-#-#-tr[1-4]-1/16c.[1-
4]

VC4-4c logical port on
STM-64 physical port

[1-99]-[1-2]-#-#-tr[1-4]-1-[1, 13,
25, 37, 49, 61, 73, 85, 97, 109,
121, 133, 145, 157, 169, 181]

S64/[1-99]-[1-2]-#-#-tr[1-4]-1/4c.[1-
16]

VC4 logical port on
STM-64 physical port

[1-99]-[1-2]-#-#-tr[1-4]-1-[1, 4,
7, 10, 13, 16, 19, 22, 25, 28, 31,
34, 37, 40, 43, 46, 49, 52, 55,
58, 61, 64, 67, 70, 73, 76, 79,
82, 85, 88, 91, 94, 97, 100, 103,
106, 109, 112, 115, 118, 121,
124, 127, 130, 133, 136, 139,
142, 145, 148, 151, 154, 157,
160, 163, 166, 169, 172, 175,
178, 181, 184, 187, 190]

S64/[1-99]-[1-2]-#-#-tr[1-4]-1/AU.[1-
64].0

AU3 logical port on
STM-64 physical port

[1-99]-[1-2]-#-#-tr[1-4]-1-[1-
192]

S64/[1-99]-[1-2]-#-#-tr[1-4]-1/AU.[1-
64].[1-3]

OC-192 physical port [1-99]-[1-2]-#-#-tr[1-4]-1 OC192/[1-99]-[1-2]-#-#-tr[1-4]-1

VC4-16c logical port on
OC-192 physical port

[1-99]-[1-2]-#-#-tr[1-4]-1-[1, 49,
97, 145]

OC192/[1-99]-[1-2]-#-#-tr[1-4]-
1/16c.[1-4]

VC4-4c logical port on
OC-192 physical port

[1-99]-[1-2]-#-#-tr[1-4]-1-[1, 13,
25, 37, 49, 61, 73, 85, 97, 109,
121, 133, 145, 157, 169, 181]

OC192/[1-99]-[1-2]-#-#-tr[1-4]-
1/4c.[1-16]
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VC4 logical port on
OC-192 physical port

[1-99]-[1-2]-#-#-tr[1-4]-1-[1, 4,
7, 10, 13, 16, 19, 22, 25, 28, 31,
34, 37, 40, 43, 46, 49, 52, 55,
58, 61, 64, 67, 70, 73, 76, 79,
82, 85, 88, 91, 94, 97, 100, 103,
106, 109, 112, 115, 118, 121,
124, 127, 130, 133, 136, 139,
142, 145, 148, 151, 154, 157,
160, 163, 166, 169, 172, 175,
178, 181, 184, 187, 190]

OC192/[1-99]-[1-2]-#-#-tr[1-4]-
1/AU.[1-64].0

AU3 logical port on
OC-192 physical port

[1-99]-[1-2]-#-#-tr[1-4]-1-[1-
192]

OC192/[1-99]-[1-2]-#-#-tr[1-4]-
1/AU.[1-64].[1-3]

STM-16 physical port [1-99]-[1-2]-#-#-[02, 04,
06.....16]-1

S16/[1-99]-[1-2]-#-#-[02, 04,
06.....16]-1

VC4-16c logical port on
STM-16 physical port

[1-99]-[1-2]-#-#-[02, 04,
06.....16]-1-[1]

S16/[1-99]-[1-2]-#-#-[02, 04,
06.....16]-1/16c.[1]

VC4-4c logical port on
STM-16 physical port

[1-99]-[1-2]-#-#-[02, 04,
06.....16]-1-[1, 13, 25, 37]

S16/[1-99]-[1-2]-#-#-[02, 04,
06.....16]-1/4c.[1-4]

VC4 logical port on
STM-16 physical port

[1-99]-[1-2]-#-#-[02, 04,
06.....16]-1-[1, 4, 7, 10, 13, 16,
19, 22, 25, 28, 31, 34, 37, 40,
43, 46]

S16/[1-99]-[1-2]-#-#-[02, 04,
06.....16]-1/AU.[1-16].0

AU3 logical port on
STM-16 physical port

[1-99]-[1-2]-#-#-[02, 04,
06.....16]-1-[1-48]

S16/[1-99]-[1-2]-#-#-[02, 04,
06.....16]-1/AU.[1-16].[1-3]

OC-48 physical port [1-99]-[1-2]-#-#-[02, 04,
06.....16]-1

OC48/[1-99]-[1-2]-#-#-[02, 04,
06.....16]-1

VC4-16c logical port on
OC-48 physical port

[1-99]-[1-2]-#-#-[02, 04,
06.....16]-1-[1]

OC48/[1-99]-[1-2]-#-#-[02, 04,
06.....16]-1/16c.[1]

VC4-4c logical port on
OC-48 physical port

[1-99]-[1-2]-#-#-[02, 04,
06.....16]-1-[1, 13, 25, 37]

OC48/[1-99]-[1-2]-#-#-[02, 04,
06.....16]-1/4c.[1-4]

VC4 logical port on OC-48
physical port

[1-99]-[1-2]-#-#-[02, 04,
06.....16]-1-[1, 4, 7, 10, 13, 16,
19, 22, 25, 28, 31, 34, 37, 40,
43, 46]

OC48/[1-99]-[1-2]-#-#-[02, 04,
06.....16]-1/AU.[1-16].0

AU3 logical port on
OC-48 physical port

[1-99]-[1-2]-#-#-[02, 04,
06.....16]-1-[1-48]

OC48/[1-99]-[1-2]-#-#-[02, 04,
06.....16]-1/AU.[1-16].[1-3]

STM-4 physical port [1-99]-[1-2]-#-#-[01-16]-[1-2] S4/[1-99]-[1-2]-#-#-[01-16]-[1-2]
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VC4-4c logical port on
STM-4 physical port

[1-99]-[1-2]-#-#-[01-16]-[1-2]-
[1]

S4/[1-99]-[1-2]-#-#-[01-16]-[1-
2]/4c.[1]

VC4 logical port on
STM-4 physical port

[1-99]-[1-2]-#-#-[01-16]-[1-2]-[1,
4, 7, 10]

S4/[1-99]-[1-2]-#-#-[01-16]-[1-
2]/AU.[1-4].0

AU3 logical port on
STM-4 physical port

[1-99]-[1-2]-#-#-[01-16]-[1-2]-
[1-12]

S4/[1-99]-[1-2]-#-#-[01-16]-[1-
2]/AU.[1-4].[1-3]

OC-12 Physical Port [1-99]-[1-2]-#-#-[01-16]-[1-2] OC12/[1-99]-[1-2]-#-#-[01-16]-[1-2]

VC4-4c logical port on
OC-12 physical port

[1-99]-[1-2]-#-#-[01-16]-[1-2]-
[1]

OC12/[1-99]-[1-2]-#-#-[01-16]-[1-
2]/4c.[1]

VC4 logical port on OC-12
physical port

[1-99]-[1-2]-#-#-[01-16]-[1-2]-[1,
4, 7, 10]

OC12/[1-99]-[1-2]-#-#-[01-16]-[1-
2]/AU.[1-4].0

AU3 logical port on
OC-12 physical port

[1-99]-[1-2]-#-#-[01-16]-[1-2]-
[1-12]

OC12/[1-99]-[1-2]-#-#-[01-16]-[1-
2]/AU.[1-4].[1-3]

STM-1 and STM1E
Physical Port

[1-99]-[1-2]-#-#-[01-16]-[1-4] S1/[1-99]-[1-2]-#-#-[01-16]-[1-4]

VC4 logical port on
STM-1 physical port

[1-99]-[1-2]-#-#-[01-16]-[1-4]-
[1]

S1/[1-99]-[1-2]-#-#-[01-16]-[1-
4]/AU.1.0

AU3 logical port on
STM-1 physical port

[1-99]-[1-2]-#-#-[01-16]-[1-4]-
[1-3]

S1/[1-99]-[1-2]-#-#-[01-16]-[1-
4]/AU.1.[1-3]

OC-3 Physical Port [1-99]-[1-2]-#-#-[01-16]-[1-4] OC3/[1-99]-[1-2]-#-#-[01-16]-[1-4]

VC4 logical port on OC-3
physical port

[1-99]-[1-2]-#-#-[01-16]-[1-4]-
[1]

OC3/[1-99]-[1-2]-#-#-[01-16]-[1-
4]/AU.1.0

AU3 logical port on OC-3
physical port

[1-99]-[1-2]-#-#-[01-16]-[1-4]-
[1-3]

OC3/[1-99]-[1-2]-#-#-[01-16]-[1-
4]/AU.1.[1-3]

EC1 and STS1E Physical
Port

[1-99]-[1-2]-#-#-[01-16]-[1-8] EC1/[1-99]-[1-2]-#-#-[01-16]-[1-8]

DS3 Physical Port [1-99]-[1-2]-#-#-[01-16]-[1-8] D3/[1-99]-[1-2]-#-#-[01-16]-[1-8]

AU3 logical port on DS3
physical port

[1-99]-[1-2]-#-#-[01-16]-[1-8]-1 D3/[1-99]-[1-2]-#-#-[01-16]-[1-8]/1

AU3 logical port on EC1
physical port

[1-99]-[1-2]-#-#-[01-16]-[1-8]-1 EC1/[1-99]-[1-2]-#-#-[01-16]-[1-
8]/AU.1.1

T3 logical port on T3
physical port

[1-99]-[1-2]-#-#-[01-16]-[1-8]-1 D3/[1-99]-[1-2]-#-#-[01-16]-[1-8]/1

D3 riding on AU3 logical
port

[1-99]-[1-2]-#-#-[01-16]-[1-8]-1 D3/[1-99]-[1-2]-#-#-[01-16]-[1-8]/1
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Index

A Add

black box, 2-11

circuit between
controlled network
element and
noncontrolled network
element, 3-35

circuit between
controlled network
elements, 3-29

circuit between
noncontrolled network
elements, 3-32

digital link between
controlled network
element and
noncontrolled network
element, 3-9

digital link between
controlled network
elements, 3-6

equipment, 2-17

ITM-SC-controlled
network element, 2-4

ITM-XM-controlled
network element, 2-6

optical amplifier to an
OMS, 3-66

preplan circuit, 3-100

preplan group, 3-105

regenerator to a digital
link, 3-20

subnet, 3-93

trail using the
AU3-AU4 adaption
feature, 3-38

Addresses

external;External
addresses, 6-105

Aggregates

definition, 1-3

Areas

definition, 1-3

Assign

preplan circuit to a
service circuit, 3-101

preplan pair to a
preplan group, 3-106

preplan pair to a
preplan plan, 3-103

Associate

trench with a digital
link, 3-88

AU3-AU4 Adaptation
feature

Provisioning concepts,
4-35

audience

intended, xxiii
........................................................

B Black boxes

adding, 2-11

definition, 1-3

deleting, 2-16

list of, 2-14

modifying, 2-12

search for a specific,
2-15

........................................................

C Cancel

preplan circuit order,
3-111

Channels

definition, 1-3

Circuit

Broadcast provisioning
concepts, 4-19

PDH provisioning
concepts, 4-17

Provisioning concepts,
4-16

Circuit order transmission
parameters

modifying, 3-48
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Circuit/trail

Provisioning concepts,
4-15

Circuits

adding between
controlled network
element and
noncontrolled network
element, 3-35

adding between
controlled network
elements, 3-29, 3-32

definition, 1-4

disconnecting, 3-50

list of, 3-42

list of by type, 3-43

relationship to trails and
digital links, 1-4

virtual disconnect, 3-52

Clone feature, 3-45

comments, xxvi

Concept information, 1-1

Connections

copy using the Clone
feature, 3-45

provisioning, 3-27

Controlled network
elements, 2-3, 4-4

Create

digital link through
optical channel trail,
3-75

optical channel trail,
3-64

optical link, 3-61

optical multiplex
section, 3-55

optical multiplex section
with 1+1 protection,
3-58

preplan for optical
channel trail, 3-70

preplan plan, 3-102

trench ID, 3-84

Cross-connects

SDH network elements,
5-10

........................................................

D Delete

black box, 2-16

equipment, 2-20

ITM-SC-controlled
network element, 2-8

ITM-XM-controlled
network element, 2-8

optical amplifier to an
OMS, 3-68

preplan group, 3-115

preplan plan, 3-114

regenerator from a
digital link, 3-22

subnet, 3-97

trench ID, 3-91

WaveStar
SNMS-controlled
network element, 2-8

Digital links

1+1 MSP digital link,
3-12

1x1 MSP digital link,
3-15

adding between
controlled network
element and
noncontrolled network
element, 3-9

adding between
controlled network
elements, 3-6

adding regenerators to,
3-20

Channel termination
records, 4-9

Conceptual information,
4-6

creating through an
optical channel trail,
3-75

definition, 1-4

deleting regenerators
from, 3-22

disconnecting, 3-25

displaying protection
group names, 3-19

modifying, 3-24

MSP, 5-7

MSP protection
concepts, 4-12

PDH provisioning
concepts, 4-10

Protection concepts,
4-12

provisioning, 3-4

Provisioning concepts,
4-7

Provisioning order
action, 4-7

relationship to trails and
circuits, 1-4
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4-122-8

2-3 4-4
4-10

3-91
3-27

4-123-97
3-45

3-22
5-7
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1-1
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3-68
3-45 3-25

3-52 3-222-8
1-4

1-42-8
3-43 3-75

2-203-42
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3-29 3-32
4-9

5-10

3-20
3-35

3-63-84

3-102

3-70
3-9
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STM provisioning
concepts, 4-9

Disassociate

preplan circuit from a
service circuit, 3-110

Disconnect

circuit, 3-50

digital link, 3-25

optical channel trail,
3-77

optical link, 3-79

optical multiplex
section, 3-80

virutual disconnect a
circuit, 3-52

Display

digital links associated
with a trench, 3-87

trenches associated with
a digital link, 3-86

Documentation

font usage, xxv

list of; Information
products, xxv

........................................................

E Equipment

adding, 2-17

definition, 1-5

deleting, 2-20

list of, 2-19

modifying, 2-18

External addresses;Ad-
dresses

external, 6-6

........................................................

I

Information products

how to
comment;Documentation,
xxvi

Insert

optical layer into digital
link, 3-73

Interconnections

supported, 5-6

ITM-SC-controlled network
elements

adding, 2-4

deleting, 2-8

ITM-XM-controlled
network elements

adding, 2-6

deleting, 2-8
........................................................

K KLM

notation, 6-7
........................................................

L Lists

black boxes, 2-14

circuits, 3-42

circuits by type, 3-43

equipment, 2-19

ODOs, 2-21

trenches, 3-85

Logical port addresses

Module A, 6-108

........................................................

M Modify

black box, 2-12

circuit order
transmission
parameters, 3-48

digital link, 3-24

equipment, 2-18

subnet, 3-96

trench ID, 3-90

MSP digital links, 3-12,
3-15

Multiplex Section
Protection (MSP), 5-7

........................................................

N Name

subnet, 3-95

naming conventions;con-
ventions

naming, xxv

Network elements

adding
ITM-SC-controlled
network elements, 2-4

adding
ITM-XM-controlled
network elements, 2-6

Conceptual information,
4-3

controlled, 4-4

controlled network
elements, 2-3

definition, 1-5

deleting
ITM-SC-controlled
network elements, 2-8
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2-19
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3-43
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3-42
2-62-17

2-14

2-4

xxv
6-7

xxv

xxv

2-83-86

2-6
3-953-87

2-8

3-52 2-4 5-7

3-80
3-15

3-125-6
3-79

3-90
3-77

3-963-73

2-18
3-25

3-24
3-50

xxvi 3-48

3-110
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deleting
ITM-XM-controlled
network elements, 2-8

deleting WaveStar
SNMS-controlled
network elements, 2-8

LSR-forming, 4-61

noncontrolled, 4-5

noncontrolled network
elements, 2-10

Networks

definition, 1-5

Noncontrolled network
elements, 4-5

Nonontrolled network
elements, 2-10

........................................................

O OCh
See: Optical channel trail

(OCh)

ODOs
See: Out-of-domain

objects (ODOs)

OL
See: Optical link (OL)

OMS
See: Optical multiplex

section (OMS)
See: Optical multiplex

section (OMS)

adding optical
amplifiers to, 3-66

deleting optical
amplifiers from, 3-68

Optical amplifiers

adding to an OMS, 3-66

deleting from an OMS,
3-68

Optical channel trail

disconnecting, 3-77

Optical channel trail (OCh)

creating, 3-64

Optical layer

inserting into digital
link, 3-73

Optical layers

Application concepts,
4-40

Optical channel, 4-46

Optical link, 4-44

provisioning, 3-54

Provisioning concepts,
4-39, 4-41

Provisioning order, 4-42

Optical link

disconnecting, 3-79

Optical link (OL)

creating, 3-61

Optical multiplex section
(OMS)

creating, 3-55, 3-58

disconnecting, 3-80

Out-of-domain objects
(ODOs)

list of, 2-21
........................................................

P PDH
See: Plesiochronous

Digital Hierarchy (PDH)

Plesiochronous Digital
Hierarchy (PDH)

definition, 1-6

Port addresses

ADM network elements,
6-8

ADM-4/1 tributary
ports, 6-14

correlation of external
and internal, 6-96

high-speed logical,
6-109

ISM network elements,
6-49

low-speed logical, 6-108

NERA, 6-62

PHASE network
elements, 6-73

SLM network elements,
6-87

SLM-16, 6-92

SLM-4, 6-94

SLM-4 line ports, 6-89

WaveStar AM 1
network elements, 6-29

WaveStar BandWidth
Manager, 6-133

WaveStar DACS
network elements,
6-104

WaveStar DACS VI
network elements, 6-36

WaveStar
LambdaRouter, 6-131

Ports

address structure, 6-6

address terminology, 6-5

external addresses, 6-6

logical location, 6-6

physical location, 6-6
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1-6
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3-66

6-5
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3-68

6-1313-66

2-21 6-36

6-104

3-80

3-55 3-58
6-133

6-29
3-61

6-89

3-79 6-94

6-92

4-42 6-87

4-39 4-412-10
6-73

3-544-5
6-624-44

6-1081-5 4-46

6-494-40

2-10
6-109

4-5 3-73
6-96

4-61

2-8
6-14

3-64

6-8
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physical types, 6-6

Preplan circuit orders

cancelling, 3-111

Preplan circuits

adding, 3-100

assigning to service
circuits, 3-101

disassociating from a
service circuit, 3-110

using to restore a
service circuit, 3-108

Preplan group

deleting, 3-115

Preplan groups

adding, 3-105

Preplan pairs

assigning to preplan
plans, 3-103

reinstating, 3-109

unlinking from a
preplan plan, 3-112

Preplan plan

creating, 3-102

deleting, 3-114

Preplan plans

assigning to a preplan
group, 3-106

unlinking from a
preplan group, 3-113

Preplan restoration

Aspects of, 4-70

Association of preplan
to service, 4-81

Circuit types, 4-76

Preplan Restoration

definition, 1-6

Preplan restoration

Execution, 4-87

Graphical layout, 4-79

Implementation, 4-75

Plans and groups, 4-85

Preemption concepts,
4-89

Preplan creation, 4-75

Protected path support,
4-77

Preplan Restoration

provisioning, 3-98

Preplan restoration

Provisioning concepts,
4-67

Reinstatement, 4-73

Reinstatement concepts,
4-91

Protection

Supported SNCP, 5-13

Protection group names,
3-19

Provisioning

clone provisioning, 3-45

connections, 3-27

definition, 1-2

digital links, 3-4

optical layers, 3-54

Preplan Restoration,
3-98

process, 1-8

rings, 3-92

subnets, 3-92

trenches, 3-82

........................................................

R Regenerators

adding to a digital link,
3-20

deleting from a digital
link, 3-22

Reinstate

preplan pair, 3-109

Restoration

Automatic protection
switching, 4-68

Preplan restoration,
4-68

Restore

service circuit with a
preplan circuit, 3-108

Rings
See: Subnets

definition, 1-6

provisioning, 3-92
........................................................

S SDH
See: Synchronous Digital

Hierarchy (SDH)

SDH cross-connect types
and rates

supported, list of, 5-11

Service circuits

restoring with a preplan
circuit, 3-108

Service recovery, 4-68

SNCP protection

supported, list of, 5-14

Subnet

Automatic creation,
4-52
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3-4
3-106

5-111-2

3-27
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3-102

3-19

3-112
5-13 3-92

3-109 1-6

3-103 4-91

4-73 3-108
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4-683-115
3-98
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3-110
3-1094-75
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3-111 4-79
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Creation, 4-52

Manual creation, 4-52

Provisioning concepts,
4-48

Subnets

adding, 3-93

deleting, 3-97

Deletion, 4-66

Line-switched rings,
4-56

modifying, 3-96

naming, 3-95

Path-switched rings,
4-62

Protection protocol,
4-65

provisioning, 3-92

SLM rings, 4-64

Supported interconnections,
5-6

Supported SDH
cross-connect types and
rates, 5-11

Supported SNCP
protection, 5-14

Synchronous Digital
Hierarchy (SDH)

definition, 1-6
........................................................

T Tandem connections

definition, 1-6

Task information, 1-1

Terminology, 1-3

Trail

Provisioning concepts,
4-22

Trails

definition, 1-6

relationship to digital
links and circuits, 1-6

using the AU3-AU4
adaption feature, 3-38

Transmission parameters

modifying, 3-48

Transmission rates

Network
element-specific, 5-5

Supported, 5-2

Trench ID

creating, 3-84

Trench IDs

deleting, 3-91

modifying, 3-90

Trenches

associate with a digital
link, 3-88

display associations
with a digital link,
3-86, 3-87

list of, 3-85

provisioning, 3-82

typographical
conventions;conventions

typographical, xxv
........................................................

U Unlink

preplan pair from a
preplan plan, 3-112

preplan plan from a
preplan group, 3-113

........................................................

V Virtual disconnect, 3-52

........................................................

W WaveStar SNMS-controlled
network elements

deleting, 2-8

WORD
See: Work order record

document (WORD)

Provisioning concepts,
4-38

Work order record
document (WORD), 3-46
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